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Hardware Warranty

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and

workmanship for a period of one (1) year from the date of shipment. If a product proves defective during this

warranty period, Tektronix, at its option, either will repair the defective product without charge for parts and labor,

or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration

of the warranty period and make suitable arrangements for the performance of service. Customer shall be

responsible for packaging and shipping the defective product to the service center designated by Tektronix, with

shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a

location within the country in which the Tektronix service center is located. Customer shall be responsible for

paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate

maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage

resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;

b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any

damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been

modified or integrated with other products when the effect of such modification or integration increases the time

or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS

OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’

RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND

EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.

TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,

INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR

THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



Software Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on

the media will be free from defects in materials and workmanship for a period of three (3) months from the date of

shipment. If a medium or encoding proves defective during the warranty period, Tektronix will provide a

replacement in exchange for the defective medium. Except as to the media on which this software product is

furnished, this software product is provided “as is” without warranty of any kind, either express or implied.

Tektronix does not warrant that the functions contained in this software product will meet Customer’s

requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration

of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and

workmanship within a reasonable time thereafter, Customer may terminate the license for this software product

and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS

OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’

RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS

THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS

WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,

SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER

TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH

DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Use Proper Power Cord. To avoid fire hazard, use only the power cord specified
for this product.

Avoid Electric Overload. To avoid electric shock or fire hazard, do not apply a
voltage to a terminal that is outside the range specified for that terminal.

Avoid Overvoltage. To avoid electric shock or fire hazard, do not apply potential
to any terminal, including the common terminal, that varies from ground by
more than the maximum rating for that terminal.

Avoid Electric Shock. To avoid injury or loss of life, do not connect or disconnect
probes or test leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Do Not Operate Without Covers. To avoid electric shock or fire hazard, do not
operate this product with covers or panels removed.

Use Proper Fuse. To avoid fire hazard, use only the fuse type and rating specified
for this product.

Do Not Operate in Wet/Damp Conditions. To avoid electric shock, do not operate
this product in wet or damp conditions.

Do Not Operate in an Explosive Atmosphere. To avoid injury or fire hazard, do not
operate this product in an explosive atmosphere.

Use Proper Power Source. Do not operate this product from a power source that
applies more than the voltage specified.

Provide Proper Ventilation. To prevent product overheating, provide proper
ventilation.

Injury Precautions

Product Damage
Precautions
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Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Terms in this Manual. These terms may appear in this manual:

WARNING.Warning statements identify conditions or practices that could result

in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in

damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

Protective Ground

(Earth) Terminal

ATTENTION

Refer to Manual

Double

Insulated

DANGER

High Voltage

Refer to the specifications section for a listing of certifications and compliances
that apply to this product.

Symbols and Terms

Certifications and
Compliances
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Preface

This document describes how to install and use the following Tektronix MTS300
MPEG Test System Stream Creation Applications:

� MPEG2 DVB/ATSC/ISDB-S Transport Stream Multiplexer

� DVB Table Editor

� PSIP Table Editor

� ARIB Table Editor

� Jitter Adder

� Error Injector

� DVB Channel Coder/Decoder

� TMCC Combiner

� Real-Time Multiplexer

If you purchased a Tektronix MTS300 MPEG Test System and are looking for
installation instructions, first-time operation procedures, or specification
information, refer to theMTS300 MPEG Test System Hardware and Software

Installation Technical Reference, Tektronix part number, 071-0667-XX.

Manual Structure

This manual is organized into the following sections:

Getting Started.Getting Started describes the functional characteristics for each
of the stream creation applications; lists minimum requirements for installing the
software; and provides installation, configuration, and first-time operation
information and procedures.

Operating Basics.Operating Basics provides tutorials for the multiplexer, DVB
table editor, and the MTS300 MPEG Test System Stream Player Client.

Reference. Reference contains in-depth descriptions of the capabilities, the
software interface, and configuration options for each of the stream creation
applications. It also fully describes the parameters for PSI, SI, PSIP, and
ISDB/ARIB tables.

Appendix A: What to Do if an Application Locks Up.Appendix A describes how to
recover if the test system locks up. This appendix applies only to the Tektronix
MTS300 MPEG Test System. If you have installed the stream creation
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applications onto a personal computer, use the documentation that came with the
computer for recovery procedures.

Appendix B: Software Repair.Appendix B contains information you might need
to interpret system disk errors, inadvertent software erasures, or corrupt
application files.

Glossary. The Glossary contains definitions of new, uncommon, and/or unique
terms used in this manual.

Index. The Index provides a comprehensive alpha-numeric reference to the topics
covered in this manual.

Manual Conventions

Throughout this manual the following conventions apply:

� Bold terms are found in procedures and denote interface items that you need
to select in order to cause an event to occur. For instance, to configure
default directories the procedure would read as follows:

Select Directories from the Options menu.

In this example, even though the Options menu is an interface element, the
Directories selection is the element that displays the needed dialog box
(causes an event to occur) and is the only bold term in the step. When
interface items are referred to outside of procedures, the terms are not
boldface.

� Manual names, manual section names, and words that are defined in the text
are italicized.

� Specific input that you need to make is indicated in the text using
mono-spaced font. Unless otherwise stated, do not enter punctuation at the
end of a mono-spaced font entry.

This manual uses symbols and terminology consistent with the following
publications:

� For PSI elements, ISO/IEC Standard 11172 and 13818 (parts 1, 2, and 3)

� For DVB elements, ETSI Publication prETS 300 468

� For DVB-T elements, ETSI Publication TS 101 191 V1.2.1

� For ATSC elements, ATSC Document A/65

Typographic Conventions

Symbols and Terminology
Conventions
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� For Windows elements, The Microsoft Manual of Style for Technical

Publications, 2nd ed.

The following ARIB (Association of Radio Industries and Business) and ITU-R
(International Telecommunications Union) standards were used to develop the
added ARIB and TMCC enhancements to the stream creation applications:

� ARIB STD-B10 (1.2), 1999, Service Information for Digital Broadcasting

System

� ARIB STD-B16 (1.1), 1999, Digital Receiver Commonly Used for Digital

Satellite Broadcasting Services Using Communication Satellites

� ARIB STD--B20 (1.1), 1999, Digital Broadcasting System and Related

Operational Guidelines for Broadcasting Satellites

� ITU-R BO. 1408, Transmission System for Advanced Multimedia Services

Provided by Integrated Services Digital Broadcasting in A Broadcasting

Satellite Channel

In cases where terms, symbols, or references are or may be ambiguous, check the
Glossary located at the back of this manual for definitions. Also, refer to the
Glossary for definitions unique to the MTS300 test system and applications.

Refer to the your Windows documentation for definitions and explanations of
Windows specific terminology.

Related Documents

For additional information about using MTS300 software to monitor, analyze,
and generate MPEG-2, DVB, and ATSC data streams, refer to the following
manuals:

� TheMTS300 MPEG Test System Real-Time Analysis User Manual,
Tektronix part number 071-0658-XX, contains information about using the
real-time MPEG-2 System Analyzer application.

� TheMTS300 MPEG Test System MPEG-2 DVB/ATSC System Analyzer User

Manual, Tektronix part number 071-0659-XX, contains information about
using the deferred-time MPEG-2 System Analyzer.

� TheMTS300 MPEG Test System Program Stream Analyzer User Manual,
Tektronix part number 071-0662-XX, contains information about using the
deferred-time Program Stream Analyzer application.

� TheMTS300 MPEG Test System Dolby Digital Audio Stream Analyzer User

Manual, Tektronix part number 071-0661-XX, contains information about
using the deferred-time AC-3 Audio Stream Analyzer application.
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� TheMTS300 MPEG Test System MPEG Audio Stream Analyzer User

Manual, Tektronix part number 071-0663-XX, contains information about
using the deferred-time MPEG Audio Stream Analyzer application.

� TheMTS300 MPEG Test System Video Stream Analyzer User Manual,
Tektronix part number 071-0664-XX, contains information about using the
deferred-time MPEG Video Stream Analyzer application.

Software Version

Table i lists the version numbers for the MTS300 MPEG Test System Stream
Creation Applications supported by this manual. To verify an application version
number, select About from the Help menu.

Table i: Supported applications version numbers

Application name Version supported

MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream Multiplexer 3.08

MTS300 DVB Table Editor 2.07

MTS300 PSIP Table Editor 1.02

MTS300 ARIB Table Editor 2.10

MTS300 OpenMux 1.60

MTS300 Error Injector 1.02

MTS300 Jitter Adder 2.00

MTS300 DVB Channel Coder/Decoder 1.00

MTS300 TMCC Combiner (MTS3FTM) 2.00

Related Applications

The stream creation applications described in this manual are part of the suite of
software and hardware components that comprise the Tektronix MTS300 MPEG
Test System. Table ii shows the program icons for each MTS300 application,
briefly describes the purposes for each application, and lists the manual name
and number that you should look to for information about that test system
component.

The applications that appear in the Tektronix MPEG Test System program group
and Start menu depend on the system configuration and its installed options.
Table ii on page xiii summarizes all test system applications available in the
version 6.0 release of the Tektronix MTS300 MPEG Test System.
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Table ii: Tektronix MPEG Test System version 6.0 applications

Icon Application title Function User document

Master Client Continuously monitor an input bitstream for
compliance with the MPEG-2, DVB-SI,
ATSC PSIP, and ISDB/ARIB digital television
standards. Use this client to start or assign to an
input/output the following real-time applications
and servers:

Analysis Server, used to perform real-time
analysis on a transport stream input

TMCC Analysis Server, used to perform
real-time analysis on a TMCC transport stream
input

Expert Client, used display the results of
real-time transport stream analysis performed by
an analysis server.

TMCC Expert Client, used to display the results
of real-time transport stream analysis performed
by a TMCC analysis server.

Configuration Client, used to configure
analysis servers for specific errors.

TMCC Configuration Client, used to configure
TMCC analysis servers for specific errors.

Stream Player, used to generate transport
streams from a local file.

Stream Recorder, used to capture transport
stream input.

OpenMux, used to configure and generate
transport streams from local transport stream
and elementary stream files

MTS300 MPEG Test System
Real-Time Analysis User Manual
071-0658-XX

Hardware Diagnostic Perform onboard self-tests for the MPEG Test
System.

MTS300 MPEG Test System
Hardware and Software Installation
Technical Reference 071-0667-XX

(Information repeated in both
manuals)

Private Syntax Interpreter Create table definitions used by the Real-Time
Analyzer to interpret private syntax sections.
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Table ii: Tektronix MPEG Test System version 6.0 applications (Cont.)

Icon User documentFunctionApplication title

MPEG-2 DVB/ATSC
System Analyzer

Analyze transport streams and packetized
elementary streams saved to the system disks.

MTS300 MPEG Test System
MPEG-2 DVB/ATSC System
Analyzer User Manual 071-0659-XX

DVB Channel Coding
and Decoding

Code and decode transport stream files to DVB
specifications.

MTS300 MPEG Test System
Stream Creation Applications User
Manual 071-0778-XX

(Information repeated in both
manuals)

Program Stream Analyzer Analyze MPEG program stream files. MTS300 MPEG Test System
Program Stream Analyzer User
Manual 071-0662-XX

MPEG Video Stream
Analyzer

Analyze MPEG-1 and MPEG-2 video elementary
streams files or streams extracted from the
MPEG-2 System Analyzer or Program Stream
Analyzer.

MTS300 MPEG Test System Video
Stream Analyzer User Manual
071-0664-XX

MPEG Audio Stream
Analyzer

Analyze MPEG-1 and MPEG-2 audio elementary
streams files or streams extracted from the
MPEG-2 System Analyzer or Program Stream
Analyzer.

MTS300 MPEG Test System Audio
Stream Analyzer User Manual
071-0663-XX

Dolby Digital Audio Stream
Analyzer

Analyze Dolby Digital (AC-3) audio elementary
stream files or streams extracted from the
MPEG-2 System Analyzer.

MTS300 MPEG Test System Dolby
Digital Audio Stream Analyzer User
Manual 071-0661-XX

MPEG-2 Transport Stream
Multiplexer

Create transport stream files from PSI/SI/PSIP
table files, elementary stream files, and data
files.

MTS300 MPEG Test System
Stream Creation Applications User
Manual 071-0778-XX

DVB Table Editor Create and edit PSI and DVB SI table files for
use with the transport stream multiplexer.

ATSC Table Editor Create and edit PSI and ATSC PSIP table files
for use with the transport stream multiplexer.

ARIB Table Editor Create and edit PSI and ISDB ARIB table files
for use with the transport stream multiplexer. You
also use this editor to create and modify the SIT
and DIT.

Jitter Adder Add jitter to PCR data in MPEG-2 transport
stream files.

Error Injector Insert or correct errors in transport stream
packets.
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Table ii: Tektronix MPEG Test System version 6.0 applications (Cont.)

Icon User documentFunctionApplication title

TMCC Combiner Adds TMCC information to a multiplex to
generate a valid ISDB-S transport stream file.

MTS300 MPEG Test System
Stream Creation Applications User
Manual 071-0778-XX

Tektronix Software
Protection

Enter or reenter the general password to enable
licensed applications.

Read This First, MTS300 MPEG
Test System Software V6.0
071-0666-XX

MPEG2_Part1
(ISO/IEC 13818-1)

The international MPEG-2 system standard in
Windows Help format.

none

Uninstall MTS Remove MPEG Test System software from the
system disk.

MTS300 MPEG Test System User
Manuals

Other Information Sources

For information about the Windows NT operating system, refer to the Microsoft
documentation that accompanied your system.

For the latest information about MTS300 Series Real-Time Analyzer features
and bugs, refer to theMTS300 Series Software Version 6.0 Read This First

document that accompanied your Tektronix MPEG Test System product.

Two sources of online information are provided with the MTS300 MPEG Test
System Stream Creation Applications: the application online help files and an
online help file of the MPEG-2, Part 1 (Systems) document. You can access
these sources of information using the following techniques:

� Access help topics by selecting Contents from the Help menu.

� To display the help, double click theMPEG-2 icon in the Tektronix MPEG

Test System program group window.

Included on the software application CD-ROM is a Read Me file for the
software. This file lists the application files included with the software installa-
tion types and other important information.
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The following URLs access the websites for the standards organizations listed
(the URLs listed were valid as of January, 2001):

� MPEG-2 standards (International Organization for Standards)

http://www.iso.ch/

� DVB standards (European Technical Standards Institute)

http://www.etsi.org/

� ATSC standards (Advanced Television Systems Committee)

http://www.atsc.org/
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Contacting Tektronix

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Web site www.tektronix.com

Sales support 1-800-833-9200, select option 1*

Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com

1-800-833-9200, select option 3*
1-503-627-2400

6:00 a.m. -- 5:00 p.m. Pacific time

* This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.
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Getting Started

This section describes the features of the following Tektronix MTS300 MPEG
Test System Stream Creation Applications:

� MPEG2 DVB/ATSC/ISDB-S Transport Stream Multiplexer

� PSIP Table Editor

� DVB Table Editor

� ARIB Table Editor

� DVB Channel Coder/Decoder

� TMCC Combiner

� Jitter Adder

� Error Injector

� OpenMux Configuration Client and Real-Time Multiplexer Server

The Tektronix MTS300 MPEG Test System software and hardware components
are used to create, generate, and analyze MPEG, DVB, ATSC and ISDB-S/ARIB
compliant transport streams, program streams, MPEG-1 and -2 audio and video
elementary streams, and both Dolby Digital (AC-3) and AAC (Advanced Audio
Coding) audio elementary streams. (Only ADTS, Audio Data Transport Stream,
format is implemented for AAC elementary streams.) Using the applications
documented in this manual, you can create known good transport stream files or
transport stream files with known errors. Using the generation and analysis
functions enabled by other MTS300 Series applications, you can then generate
transport streams to test your MPEG system components.

MTS300 Series Stream Creation Product Descriptions

This section briefly describes the MTS300 MPEG Test System Stream Creation
Applications. For complete information on the function and operation of each
application, refer to the Reference section.

The Multiplexer allows you to create a limitless variety of MPEG transport
stream files using the elementary streams provided on the Bit Stream CD-ROM.
Up to 40 programs, with 20 elementary streams each, can be included in one
transport stream file. A hierarchy display similar to the Analyzer displays the
structure of the transport stream.

MTS300 MPEG-2 DVB /
ATSC / ISDB-S Transport

Stream Multiplexer
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Elementary stream files containing both stationary test signals and motion
sequences are provided on the Bit Stream CD-ROM. Using the multiplexer and
table editors, you can create a variety of transport stream files that contain one or
more of the provided test signals and motion sequences.

The MTS300 PSIP Table Editor allows you to create and change both program
specific information tables (PSI tables) and program and system information
protocol tables (PSIP tables).

Program and System Information Protocol (PSIP) tables provide information
(descriptive and technical) about channels and events multiplexed in transport
streams and are used to enable decoders to properly decode the stream. PSIP
tables also permit services to be grouped into categories with relevant schedule
information and can provide information about channels and events on other
physical transmission channels. For example, ATSC-compliant transport streams
carried over terrestrial broadcast networks can provide information about
channels and events for programs in transport streams carried over cable
networks.

Data necessary for the DVB IRD (Digital Video Broadcasting Integrated
Receiver Decoder) to automatically configure itself is available in the MPEG-2
Program Specific Information (PSI). Digital Video Broadcasting Specific
Information (DVB-SI) adds information that enables DVB IRDs to automatically
tune to a particular service and allows services to be grouped into categories with
relevant schedule information.

Using the table editor you can enter and change data in SI and PSI tables to fit
the requirements for your transport stream and environment.

The MTS300 ARIB Table Editor allows you to create and change PSI and ARIB
table structures and parameters.

ARIB tables that you can edit using the ARIB Table Editor include the follow-
ing:

� Broadcaster Information Table (BIT)

The BIT provides name and ID parameters and descriptions of the services
encoded in the transport stream for each broadcaster.

� Download Control Table (DCT)

The DCT provides a list of modules available in the transport stream for
download.

� Download Table (DLT)

The DLT is used to download code to set top boxes.

MTS300 PSIP Table Editor

MTS300 DVB Table Editor

MTS300 ARIB Table Editor
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� Software Download Trigger Table (SDTT)

The SDTT is used to define the service, group, and schedule for items
encoded in the transport stream that can be downloaded.

The European Digital Broadcasting Project specifies a baseline system for
satellite broadcasting. The Channel Coding portion of the specification has the
following coding flow:

� MPEG-2 Transport stream file (Multiplexer)

� Energy Dispersal ( randomizing)

� Outer Coder RS (204, 188, byte error correction)

� Interleaver (burst error correction)

� Inner Coder (Viterbi p/q, bit error correction)

� QPSK Modulator

This application provides the defined channel coding for the transport stream file
and the decoding to return the file to a standard transport stream file.

The MTS300 TMCC Combiner is a wizard--like application that helps you
configure TMCC information that you want added to the Reed-Solomon area of
204 byte transport stream packets. Once you specify this information, the TMCC
Combiner re-multiplexes your transport stream file with the added information,
creating a valid TMCC stream.

The jitter adder allows you to create transport stream files with simulated timing
errors. These errors will affect the clocks derived from the transport file. Create
error-free transport streams and transport streams with known errors to test the
robustness of decoders under various conditions.

Using the error injector, you can introduce errors into an MPEG-2 transport
stream and use the erroneous stream to stress-test MPEG-2 systems and
components.

The Error Injector reads the input transport stream file, modifies selected
transport packets according to instructions in a user-defined configuration file,
and writes the modified stream into another file.

This real-time multiplexer allows you to configure a maximum of 26 inputs and
remultiplex all or part of them, in real time, into a valid transport stream. The
following list describes the multiplexer inputs:

MTS300 DVB Channel
Coder/Decoder

MTS300 TMCC Combiner

MTS300 Jitter Adder

MTS300 Error Injector

MTS300 OpenMux
Configuration Client
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� MPEG-2, DVB, ATSC, and/or ISDB-S/ARIB transport streams (single or
multiple program)

� Elementary streams (MPEG-2 audio and video, and AC-3 audio)

� PSI/SI/ATSC/ARIB tables (generated by the real-time multiplexer)

The OpenMux dynamically manages PID allocation among the inputs, avoiding
PID collisions in the output. Using the real-time multiplexer, you can filter input
transport streams for specific programs to be included in the remultiplexed
transport stream. Finally, when a new transport stream is created, the multiplexer
automatically regenerates program clock references.

You can output the remultiplexed transport stream using one of the rear-panel
outputs on the test system. The output can be a single-shot or you can continu-
ously loop the transport stream.

Related Tektronix MTS300 MPEG Test System Components

The MTS300 MPEG Test System Stream Creation Applications are part of the
Tektronix MTS300 MPEG Test System. Related software components that
comprise the full-featured MPEG test system are briefly described in this
section.

The new MTS300 Series MPEG Test System client/server architecture provides
unmatched analysis power and ease of use for monitoring and analyzing MPEG,
DVB, and ATSC transport streams.

Master Client. The Master Client interface and functionality is similar to the
Tektronix MTM300 MPEG Transport Monitor Master Client, optimized to
manage the MTS300 Series clients and servers. Using the Master Client you can
assign analysis servers to monitor a transport stream in real-time; you can also
manage the Stream Recorder, Stream Player, and Real-Time Multiplexer servers
to capture and generate transport streams on specific inputs and outputs.

The Master client provides an intuitive interface for monitoring the status of
transport stream inputs. The Master client characteristics are shown in the
following list:

� The Port Manager panel displays icons showing the current configuration of
servers, inputs, and outputs.

� The Services panel displays icons for the services (also called programs)
encoded in the monitored transport stream.

� The Details panel displays icons indicating the type, status, and severity of
errors on a transport stream or service.

Master, Expert, and
Configuration Clients
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The Expert and TMCC Expert clients, the Configuration and TMCC Configura-
tion clients, and the Real-Time Multiplexer (OpenMux), Stream Player, and
Stream Recorder clients are all started from the Master client.

Expert Client. Start the Expert Client from the Master Client to analyze the
transport stream, in real time, in greater detail. The Expert Client uses the same
interface and has the same functionality as the MTS200 Series Real-Time
Analyzer.

The Expert client characteristics are shown in the following list:

� Graphical displays that show the structure (hierarchy) of the input transport
stream and display characteristics of each component of the input stream
(for example: PID and type allocation, section rate analyses, and timing
analyses).

� Report views that indicate the types of errors recorded by the Analysis
Server and the characteristics of the input stream.

� Error views that show specific errors recorded for the various components
of the transport stream; for instance, PMT section rate errors and ETR290
errors.

� ARIB table recognition

� AAC audio elementary stream recognition

� AC-3 audio elementary stream recognition in DVB mode

� Digicipher II video elementary stream recognition

The TMCC (Transmission and Multiplexing Configuration Control) Expert
Client is a new application included with version 6.0 of the Tektronix MTS300
MPEG Test System. This client allows you to analyze the TMCC data of an
ARIB-compliant transport stream input real time. You can also analyze an
ARIB-compliant transport stream file stored on your local disk using the TMCC
Deferred-Time Client.

The TMCC Expert client has the following characteristics:

� Indicates the presence of sync bytes (0x47 for TMCC basic streams and W1,
W2, or W3 sync bytes for TMCC data streams)

� Displays the syntax of TMCC data

� Displays Slot, TSID, TS Name, and Modulation mode information

� Displays information, warning, and error messages

TMCC Expert Client
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� Indicates the presence of TMCC alarm and update flags in the transport
stream

� Displays the overall stream rate

� Provides access to the Stream Recorder client, enabling you to capture all or
part of a TMCC transport stream input

When you use the TMCC client to analyze local transport stream files, the
TMCC Configuration Client is automatically started, allowing you to specify the
file you need to analyze. The toolbar for the Deferred-Time Client provides
buttons with which you can navigate transitions in the TMCC data. Finally, the
stream capture buttons are replaced with buttons that you can use to save all or a
specific part of the transport stream file to a disk.

Configuration Client. The Configuration Client allows you to specify which
transport stream parameters you want monitored, and how you want errors in
your system to be reported.

The Configuration client allows you to perform the following tasks:

� Specify the standard to which you are testing an input: MPEG-2, DVB,
ATSC, or ISDB

� Set, remove, or modify the probes that test transport streams for valid syntax
and semantics and rates.

� Specify the way in which errors are reported in both the Expert and Master
clients. You can configure each probe to report an error as Critical, Major,
Minor, Warning, or as information only.

� Stop and restart an Analysis Servers running on a transport monitor.

� Set passwords on specific inputs that prevent others from changing the
Analysis Server configuration for that input.

� Set parameters for capturing part of an input transport stream.

Using these applications, you can continuously monitor an input bitstream for
compliance with the MPEG-2, DVB, ATSC, and ISDB-S/ARIB digital
television standards. You can monitor an array of stream parameters to ensure
decodability, or you can concentrate on just a few parameters for closer
examination.

The Tektronix MTS300 MPEG Test System provides the a full range of
program, ETR 290, multiplex, syntax, timing, and rate analyses. The results of
these analyses are displayed using graphical representations of the structure of
the transport stream and data flow, reports, and error messages. You can enable
or disable any analysis, or set of analyses, with the exception of sync loss, which
is always enabled.
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The TMCC (Transmission Multiplexing Configuration Control) Configuration
client is a new application included with this version of the Tektronix MTS300
MPEG Test System. This client allows you to set the monitoring, analysis, and
reporting parameters of the TMCC Analysis Servers.

The TMCC Configuration client has the following characteristics:

� Configures the TMCC Analysis Servers to operate in either TMCC basic or
TMCC data stream modes

� Enables you to specify a transport stream ID to analyze using the MPEG-2
Analysis Server (only in the TMCC data stream mode)

� Sets parameters for the following TMCC probes:

� Frame size

� Super frame size

� Modulation mode and slot consistency

� TMCC syntax

� TMCC update counter (only in TMCC data stream mode)

You can capture transport streams using the Stream Recorder Client, and you can
generate transport streams with the Stream Recorder using transport stream files
that are local to the MTS300 MPEG Test System hardware. (Both of these
clients are started from the Master Client.)

Stream Recorder Client. The Stream Recorder can be triggered to capture a
section of an input based on an error detected by the analysis server, or by an
external trigger.

Stream Player Client.Using the Stream Player, you can output transport stream
files as a single shot or in loop mode. You can also specify ASI (both packet and
byte modes) and M2S output formats.

TMCC Configuration
Client

Stream Recorder and
Stream Player Clients



Getting Started

1- 8 MTS300 Stream Creation Applications User Manual

This deferred-time analyzer application enables in-depth analysis of MPEG-2,
DVB, ATSC, or ISDB-S/ARIB transport stream files for errors in syntax,
semantics, rate, timing, and other multiplex characteristics. The application uses
several graphical views that provide access to each field, and each bit if you
wish, in the transport packets, PES packets, and the various PSI and SI tables.

Hierarchic View. The hierarchic view provides a diagram of the data components
carried by the transport stream. Icons are used to identify the PSI, SI, PSIP, and
ARIB tables; PES (Packetized Elementary Stream) packets; and three types of
elementary streams (video, audio, and data).

Interpreted View. The interpreted view shows all of the fields in the selected
transport packet, table section, or PES (packetized elementary stream) packet.

Timing Displays. Two types of timing displays are available: PCR (Program
Clock Reference) contained in the transport packet headers and PTS/DTS
(Presentation/Decode Time Stamp) contained in PES packet headers. The PCRs
are shown in a graphical format indicating their arrival time. The graphical
display of the PTS/DTS shows a time line for each access unit (such as a video
frame) indicating data arrival and value of each time stamp.

With the optional MPEG Program Stream Analyzer you can view the fields and
values of MPEG-2 program streams and MPEG-1 system streams at the pack
and PES packet level, extract and save all or part of program and system streams,
and analyze streams for coherence to the MPEG standards.

With the optional Audio Stream Analyzer you can test MPEG-1 and MPEG-2
audio layer I and II specification streams. The Program Stream Analyzer or the
MPEG-2 DVB/ATSC System Analyzer can extract audio elementary streams
from transport or program streams and open the analyzer with the extracted
elementary stream displayed.

With the optional Video Stream Analyzer you can test MPEG-1 and MPEG-2
video elementary streams. The Program Stream Analyzer or the MPEG-2
DVB/ATSC System Analyzer can extract video elementary streams from
program and transport streams and open the analyzer with the extracted
elementary stream displayed.

With the optional Dolby Digital (AC-3) Audio Stream Analyzer you can analyze
and save Dolby Digital audio streams files. The Program Stream Analyzer or the
MPEG-2 DVB/ATSC System Analyzer can extract AC-3 audio streams from
program and transport streams and open the analyzer with the extracted
elementary stream displayed.

MPEG-2
DVB/ATSC/ISDB-S/ARIB

System Analyzer

Program Stream Analyzer

MPEG Audio Stream
Analyzer

MPEG Video Stream
Analyzer

Dolby Digital (AC-3) Audio
Stream Analyzer
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The Tektronix MTS300 MPEG Test System Option DT, the MTSSWO Option
DT, or the MTS3FDT includes two discs that contain well-known Sarnoff
Corporation MPEG video test sequences used to test MPEG components.

Installation

This section describes procedures for installing the MTS300 MPEG Test System
Stream Creation Applications onto a personal computer. If you are installing the
software on a Tektronix MTS300 MPEG Test System, refer to theMPEG Test

System Hardware and Software Installation Technical Reference (included with
the test system) for instructions. You can also use this procedure to reinstall
software if it is deleted or corrupt.

Installation includes three separate processes:

� Attach the software key to the parallel printer port of your computer.

� Install required program files and sample files using the installation wizard.

� Enter your license password, which enables you to run the installed
applications.

Before you install the stream creation applications, ensure that your system
meets the minimum hardware and software requirements.

You can install the stream creation applications on a personal computer with the
following minimum requirements:

� 150 MHz Intel Pentium processor

� 32 MB RAM

� 140 MB free disk space (for MTS application software) plus adequate space
for transport stream test files.

� CD ROM drive (for software installation)

� Windows NT 4.0 (Service Pack 6) operating system

� 1024 x 768 pixel video monitor with 256 available colors

MPEG Video Test
Sequences

Minimum Requirements
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Attach the software key (shown in the following illustration) to the parallel
printer port of your computer. MTS300 Series applications do not run without
the software key installed.

To use the printer port with the software key installed, attach printer cables
directly to the software key. The software key will not interfere with parallel
communications.

NOTE. To run MTS300 MPEG Test System Stream Creation Applications, the

software key must be installed on the computer parallel printer port.Do not

remove or misplace the software key.

If you are installing the stream creation applications on a personal computer, use
the procedures described in this section. The minimum hardware and software
requirements for installing the stream creation applications are described in
Minimum Requirements (see page 1--9).

1. Install the software key as described in Software Key.

NOTE. If you have just uninstalled an earlier version of the MTS300 software,

ensure that you have rebooted your PC before starting this procedure.

2. If your system requires a user name and password, log on to Windows NT as
Administrator, using MPEG2 as the password (the default auto-login for the
MTS300 system).

3. Right-click theMy Computer icon on your desktop, and then select
Explore from the resulting submenu. In the Exploring window, select the
icon that represents the disk drive onto which you will install the software
(usually drive C:).

Software Key

Installing Software
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4. Check the status bar at the bottom of the Exploring window to verify that the
target disk has at least 140 Mbytes of free space. You cannot install the
software on a disk with less than 140 Mbytes of free space.

Free space

5. Place theMTS300 MPEG Test System Software Recovery CD into the
CD--ROM drive.

6. Click the Windows NT Start button and select Run... from the submenu.

7. Enter d:\Setup.exe in the resulting Run window as depicted in the
following illustration. In this example, d is the drive letter for the CD ROM
drive; use the drive letter that is correct for your computer.

8. Click OK to start the software installation.

9. In a few seconds, the Tektronix MTS300 Series window appears on the
computer screen.

10. Read the Copyright and Setup text and click Next to proceed to the Choose
Destination Directory window.

11. The default destination folder is C:\Mts300. Click Next to accept the default
folder.

NOTE. It is strongly recommended that you use the default destination folder.
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12. The Setup Type window opens. Select MTS Software Only Products, and
then click Next.

13. The Select Program Folder window opens. Click Next to accept the default
folder name (Tektronix MPEG Test System) and continue.

14. Review the Destination Directory, System Product, and Start Menu Folder
selections in the Selection Summary window. If the selections are incorrect,
click Back and change the information as needed. Once the information is
correct, click Next to proceed with installation.

The setup program begins installing the software and related files. The
activity and progress gauges appear at first to show that the installation is
progressing. Installation proceeds without your input (and sometimes with
no apparent activity) for approximately 2 1/2 minutes, depending on your
computer.

15. During a normal setup, the computer displays two empty program group
windows after it copies the program files to your disk drive. After the
windows appear, a message reminds you to verify that the software key is
installed.

16. Verify that the software key is installed on the parallel (printer) port as
described in Software Key on page 1--10; then click OK.
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17. The Setup Complete window opens; click Finish to continue.

18. A Notepad window opens to display the Readme file. Scan the text for
important information, and then select Exit from the File menu to close the
window.

19. Another Setup Complete window opens. Accept Yes, I want to restart my

computer now.

20. Remove the test system software installation disk from the CD ROM drive
and click Finish to complete the setup and reboot the system.

Perform the remaining steps to enter the general password that corresponds to the
attached software key. Doing so enables the applications that are included with
your MTS300 MPEG Test System product.

1. Double-click the License Manager icon to start the application. The
Tektronix Software Protection window appears.

2. Consult the password document supplied with your software and identify the
general password.

3. Enter the three 6-character hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields (lowercase
characters are acceptable).

4. Click OK. A License message window appears.

5. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK and return to step 3.

When you enter the correct password, software installation is complete. You will
need to restart the computer before you can start any of the stream creation
applications.

Entering the General
License Password
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Software Repair

If you experience operating problems following installation of application
software or if the system becomes corrupt, refer to Reinstalling the MTS300

Series Software in Appendix B of this manual.

First Time Operation

As noted in the headings of this section, some of the following procedures apply
only if you are using the Tektronix MTS300 MPEG Test System. See your
computer user documentation for similar procedures if you are using a personal
computer/workstation.

This section describes the following procedures:

� Turning on the Tektronix MTS300 MPEG Test System

� Logging on to the Tektronix MTS300 MPEG Test System

� Starting the applications for which you have a license password

� Exiting the applications

� Shutting down the Tektronix MTS300 MPEG Test System

To power on the MTS300 MPEG Test System computer, press the power switch.

On/Stby switch

Turning on the MTS300
Series MPEG Test System
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The Windows NT initialization process takes up to two minutes to complete.
Under normal circumstances, no action is required. (For further information on
the Windows NT initialization process, see the Windows NT online help
included with the test system.) When the Begin Logon window appears,
simultaneously press the CTRL +ALT + Delete keys to open the Logon
Information dialog box.

The MTS300 system is configured to auto-logon using the Administrator user
name and MPEG2 password. You should not need to log on to NT unless you
have changed the default characteristics.

Changing Passwords.You can change passwords at this time. See the Win-
dows NT documentation for instructions. If you change any password, be sure to
create a new emergency repair disk as explained in Appendix B: Software Repair.

After you have logged on, the Tektronix MPEG Test System program group
window appears as shown below. Start the applications by double-clicking the
appropriate icon (refer to Table ii on page xiii for descriptions of the various
icons and the applications each represents).

Logging On to the MTS300
Series MPEG Test System

Starting Applications
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To exit the stream creation applications, select Exit from the File menu or click
the close box in the upper-right corner of the application window. The current
configuration is preserved and used the next time you start the application.

Close
button

In the default configuration, application information and error messages (up to
2048 kbytes) are automatically saved in the Windows NT Event Viewer. No
additional information is saved.

To avoid loss of data and possible problems during subsequent Windows NT
initialization, always shut down Windows NT before switching the computer
power off. To shut down Windows NT, use the following procedure:

1. Select Shut Down from the Start menu.

2. In the Shut Down Windows dialog box, select Shut down the computer?,
and then click Yes.

CAUTION. Do not switch the computer power off until after the following

message appears: It is now safe to turn off your computer. Turning your

computer power off before this message appears can cause you to lose data and

may make restarting Windows NT more difficult.

After a few seconds, the Shutdown Computer window appears with the
following message: It is now safe to turn off your computer.

3. Press the power switch on the front of the computer to turn the computer off
(see the illustration on page 1--14).

Exiting Applications

Shutting Down the
Tektronix MTS300 MPEG

Test System
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Operating Basics

Operating Basics provides a functional overview of the MTS300 MPEG Test
System Stream Creation Applications and tutorials in which you create transport
stream files using the following applications:

� MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream Multiplexer

� MTS300 DVB Table Editor

You will also learn how to output a transport stream using the MTS300 MPEG
Test System Stream Player Client.

You will find operating information about the remaining stream creation
applications and more detailed information about the multiplexer and table
editors in the Reference section of this manual.

Running the Software

Start stream creation applications by double-clicking the appropriate icon in the
Tektronix MPEG Test System program group window. The software key and
passwords must be installed for the applications to operate (see Installing
Software on page 1--10 for additional information).

NOTE. This manual is written assuming a basic level of familiarity with the

Windows NT 4.0 operating system. If you are not comfortable with this environ-

ment, see your Windows NT online help.

Operating Basics Tutorials

The three tutorials in this section will help you become familiar with the
MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream Multiplexer, the
MTS300 DVB Table Editor, and, if installed, the MTS300 Series Stream Player.

The first tutorial, which begins on page 2--7, shows you how to create a simple
MPEG-2 configuration file. The tutorial then shows you how to multiplex the
transport stream file using the configuration file you create.

The second tutorial (beginning on page 2--21), extends the first tutorial and
shows you how to create a more complex configuration file and transport stream
file. It also shows you how to output the transport stream file as a transport
stream, provided you are using a Tektronix MTS300 MPEG Test System.
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The third tutorial (beginning on page 2--39), shows you how to create a
configuration file and a transport stream file with DVB components.

The tutorials were created using the Tektronix MTS300 MPEG Test System;
however, you can perform most of the tutorial without a test system. The video,
audio, and table template files required to work through these tutorials are
installed on your hard disk when the MTS300 Series program files are installed.

Tutorial Terms

The following list defines some common terms used in the three tutorials
provided in this section:

� In this tutorial, multiplex refers to the process the multiplexer uses to create a
transport stream file. Transport stream files are multiplexed using the
information included in the configuration file and other referenced files
(PSI/SI/PSIP/ARIB tables and elementary streams).

� Since transport stream files can be very large, they are not generated
immediately. Instead, configuration files (*.cfg) are created first. A
configuration file is a text file that you create using the multiplexer. The
configuration file lists various multiplex parameters and provides references
to the table files and the elementary stream files that you specify as you
create the configuration file. The multiplexer uses these parameters and
referenced files to generate (multiplex) transport stream files.

For further information on how configuration files work, refer to File
Conventions, beginning on page 3--3. To see what a typical configuration file
looks like, see An Example Configuration File on page 3--85.

� A transport stream file is a file on your disk that you create by multiplexing
the tables and elementary streams referenced in your configuration file using
the rates and other parameters indicated in your configuration file.

� A transport stream is a transport stream file that is properly timed and output
using one of the rear-panel connectors on the back of the Tektronix MTS300
MPEG Test System.
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Acquiring Elementary Bit Stream Files

The standard configuration MPEG Test System includes sample video and audio
elementary stream files and a sample transport stream file. These files contain
pictures, common industry test signals, and sample signals in MPEG-2 format.
Use the files as example formats for the tutorials and to construct your own
sample transport streams.

Two additional sources of elementary stream files are available: three CD-ROM
discs, which are supplied with the MTS300 Deferred-Time products (MTS300
Option DT, the real-time test system with deferred-time analysis capability;
MTS3FDT, an upgrade; or MTSSWO Option DT, a software only product), and
the Tektronix FTP site. Two of the CD-ROM discs (STRM100 and STRM101)
contain well-known Sarnoff Corporation MPEG video test sequences. There are
test sequences for both NTSC and PAL broadcast environments on these two
discs. (See the manual that accompanies the Sarnoff discs for further informa-
tion, Tektronix part number 070--9644--xx). The following sections describe the
contents of the third disc (Tektronix part number 063-1914-xx) and the Tektronix
FTP site.

To access the elementary stream files on the CD-ROM, either copy the files to
the appropriate directories on the MTS300 Series system disk (drive C) or leave
the CD-ROM in drive D.

Audio Files. The CD-ROM contains the following audio files in the Audio
directory:

15kz_064.mp2
15kz_128.mp2
15kz_192.mp2
15kz_256.mp2
1kz_064.mp2
1kz_128.mp2
1kz_192.mp2
1kz_256.mp2
400_064.mp2
400_128.mp2
400_192.mp2
400_256.mp2

4kz_064.mp2
4kz_128.mp2
4kz_192.mp2
4kz_256.mp2
Music064.mp2
Music128.mp2
Music192.mp2
Music256.mp2
Sync_064.mp2
Sync_128.mp2
Sync_192.mp2
Sync_256.mp2

The file names indicate the elementary stream bit rate. For example, the file
15kz_256.mp2 contains a 15 kHz audio tone at 0.256 Mbps.

MPEG-2 Elementary
Streams CD-ROM



Operating Basics

2- 4 MTS300 Stream Creation Applications User Manual

Video Files. The CD-ROM contains the following video files. The Video\525
directory contains streams with 525-line video; the Video\625 directory contains
streams with 625-line video. Both directories contain all listed files.

100b_015.mp2
100b_060.mp2
100b_120.mp2
Bbc3_015.mp2
Bbc3_060.mp2
Bbc3_120.mp2
Cact_015.mp2
Cact_060.mp2
Cact_120.mp2
Mobl_015.mp2
Mobl_060.mp2
Mobl_120.mp2
Mulb_015.mp2
Mulb_060.mp2

Mulb_120.mp2
Pulb_015.mp2
Pulb_060.mp2
Pulb_120.mp2
Sync_015.mp2
Sync_060.mp2
Sync_120.mp2
Tens_015.mp2
Tens_060.mp2
Tens_120.mp2
V700_015.mp2
V700_060.mp2
V700_120.mp2

The file names indicate the elementary stream bit rate. The file 100b_060.mp2,
for example, contains a video elementary stream with a bit rate of 6.0 Mbps.

Examples. The CD-ROM also contains the following files in the Examples
directory:

10khz.mp2
1khz.mp2
Demo_015.mp2

Demo_060.mp2
Sample.trp
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You can access the same signals (and any new bit streams that become available)
via anonymous FTP from the Tektronix FTP site, ftp.tek.com. If you have a web
browser, go to the following URL:

FTP://ftp.tek.com/tv/test/streams/Element/

Or, use FTP to contact ftp.tek.com. Log in as “anonymous” and use your email
address as the the password. MPEG files are available in the subdirectories of
/tv/test/streams/Element. Each directory contains a Readme.txt file that describes
its contents.

The following script illustrates the procedure for connecting to the MPEG Test
System FTP site using a command line interface. The entries you need to make
are indicated with bold face type. Remember to transfer data in binary mode.

% ftp ftp.tek.com

Connected to inet1.tek.com.
220 inet1 FTP server (Version wu-2.4(1) Sun Jan 29 12:29:00 GMT
1995) ready.

Name (ftp.tek.com:user): anonymous

331 Guest login ok, send your complete e-mail address as
password.

Password: enter your email address

230-

230- T E K T R O N I X F T P A R C H I V E

/

230 Guest login ok, access restrictions apply.

ftp> cd /tv/test/streams/Element

250 CWD command successful.

ftp> get README.TXT

The data included in this FTP site distribution is available to you on an “as-is”
basis. Tektronix disclaims any and all warranties, whether express, implied, or
statuary, including any implied warranties of merchantability or of fitness for a
particular purpose.

If you do not have access to the FTP site, or cannot use FTP, contact Tektronix at
1-800-TEK-WIDE and ask for MPEG Test System support. A Tektronix
representative will help you obtain the data.

The MPEG Test System
FTP Site
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Creating an MPEG-2 Transport Stream File

This section explains how to create a simple MPEG-2 transport stream file. The
tutorial will show you how to perform the following tasks:

� Start the multiplexer

� Create and save configuration files

� Add elementary streams to configuration files

� Multiplex transport stream files

See Tutorial Terms on page 2--2 for definitions of terms used in this tutorial.

Start the Multiplexer Application

Double-click the Multiplexer icon in the Tektronix MPEG Test System program
group window to start the application.

Create a Simple Configuration File

1. Choose New from the File menu (or click the New button on the toolbar).

2. Enter the name simple in the File Name text box (the *.cfg extension is
added automatically), and then click OK.

The Multiplexer application now displays the default configuration file.
(See Figure 2--1.) The application window has three parts: the Duration gauge, at
the top of the display; the Multiplex Rate gauge, at the left of the display; and
the Hierarchic View, at the right of the display. Each part is explained in the
following three sections (use Figure 2--1 to locate each part of the multiplexer
application window).

See Using the Multiplexer beginning on page 3--3 for more information about the
Multiplexer application window elements.

Multiplexer Application
Window
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Duration gauge

Multiplex
Rate gauge

Hierarchic View

Figure 2- 1: The default configuration in the application window

Duration Gauge. The Duration gauge shows the status of the multiplex operation.
The gauge displays 0% until you begin to create a transport stream file. Once
you start multiplexing a transport stream file, the gauge tells what percentage of
the multiplex operation is complete.

Rate Gauge. The Rate gauge graphically shows the percentage of the available
transport stream currently used. The value displayed above the rate gauge is the
maximum target multiplex rate. The value displayed below the rate gauge is the
maximum actual multiplex rate for the time frame indicated at the very bottom
of this section.

The actual rate is calculated using the following formula:

Actual rate = PSI rate + Video rate + Audio rate + Data rate

For configuration files using SI, PSIP, MIP, and ARIB information, add the SI,
PSIP, MIP, and ARIB rates.

Below the actual rate is the time period when the highest multiplex rate occurs.
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Hierarchic View. The Hierarchic View displays the current configuration file in
hierarchic form. Several icons, which represent specific elements of the
multiplex, appear in this part of the multiplexer window. These icons are
explained in Table 2--1. (For a complete list of the multiplexer Hierarchic view
icons, see Hierarchy Icons on page 3--10.)

Table 2- 1: Multiplexer Hierarchic view icons

Icon Meaning

Multiplex. The main icon for the configuration file.

Required.

Program Specific Information (PSI). Contains the data that allows the
demultiplexing of the programs by decoders.

Required.

Program Association Table (PAT). The main PSI table. It links the program
numbers and the Program Map Table (PMT) PID.

Every transport stream must have a PAT that is always PID 0. This table is
required to identify the PID numbers for the table(s) defining each program.

Required.

Program Map Table (PMT). Specifies the PID values and describes the program
components.

There is a PMT for every program in the transport stream. The table states the
PID for each elementary stream associated with a specific program. There are
no specific PID values for PMTs in the MPEG-2 standards, however certain
transmission systems (such as ATSC and DVB) require specific values.

Required.

Network Information Table (NIT). Provides information about the physical
network.

Program. Allows you to set the program start delay and PCR period values.

Required. Each transport stream is required to have at least one program with
one elementary stream.

Note that the program numbering starts at two to avoid conflicts between the
NIT table ID and the ATSC program paradigm (the PMT PID for a program one
would be the same as the NIT PID).
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The simplest transport stream possible would have one program with one
elementary stream in it. In this tutorial, you will put two elementary streams in
one program.

Add elementary stream icons to Program 1.

1. Select the Program 1 icon.

2. Click the + (Add) button on the toolbar (or select Add from the Edit menu).
This opens the dialog box shown in Figure 2--2.

Figure 2- 2: The Stream to add dialog box

3. Check the Video option, and then click OK. This adds a Video icon to
Program 1 as shown in Figure 2--3.

Figure 2- 3: The hierarchy with a video icon added to Program 2

Add Elementary Streams
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4. Repeat this procedure (click + on the toolbar, select a type of stream, and
click OK) twice to add an Audio icon and a Data icon to the hierarchy. The
completed Hierarchic view resembles Figure 2--4.

Figure 2- 4: The hierarchy with the video, audio, and data icons added

Notice that there is no information alongside the three elementary stream icons.
This is because you have not yet indicated which elementary stream files you
will use in your multiplex (associated a file with an icon). In the next procedure,
you will associate elementary stream files with the video, audio, and data icons.

Associate a video elementary stream file with the Video icon.

1. Double-click the Video icon. This opens the Video Stream dialog box shown
in Figure 2--5 on page 2--12.

2. Click the Browse button. This allows you to select a video elementary
stream from existing files using the Video Stream Selection dialog box.

3. Select C:\MTS300\VIDEO\625\MOBL_060.MP2 and click OK.
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Figure 2- 5: The Video Stream dialog box

NOTE. The List Files of Type box in the Video Stream Selection dialog box does

not specify the *.mp2 file extension. However, you can only use *.mp2 files as

video elementary stream files. If you select an unacceptable file, you will see the

message box shown in Figure 2--6.

Figure 2- 6: Error message

4. If you see the error message shown in Figure 2--6, click OK and select
another (*.mp2) file.

After you have selected an acceptable video elementary stream file, all of the
information about the file loads automatically into the Video Stream dialog
box, as shown in Figure 2--7.
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Figure 2- 7: Details of the selected video elementary stream

You can change the following four parameters in the Video Stream dialog
box (use the default values for this tutorial):

� Elementary Stream Rate

� PES Packet Size

� Elementary Stream Initial Delay

� Offset DTS

For more information about editing these parameters, refer to Selecting a

Video Stream, beginning on page 3--47.
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5. Click OK to accept these settings and close the dialog box. The lower
portion of the multiplexer application window now resembles Figure 2--8.
The fileMOBL_060.MP2 is associated with the video icon and the multiplex
rate gauge is beginning to fill.

Figure 2- 8: Video icon and video elementary stream file

The fact that the rate gauge fill color is green indicates that you would not
likely have multiplexer overflow problems if you were to create a transport
stream file from the current configuration file.
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Associate an audio elementary stream file with the Audio icon.

1. Double-click the Audio icon. This opens the Audio Stream dialog box
shown in Figure 2--9.

Figure 2- 9: The Audio Stream dialog box

2. Click the Browse button to open the Audio Stream Selection dialog box.
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3. Select C:\MTS300\AUDIO\10KHZ.MP2 and click OK. This returns you to
the Audio Stream dialog box with all the information about the 10KHZ.MP2
file entered, as shown in Figure 2--10.

Figure 2- 10: Details of the selected audio elementary stream

You can change the following four parameters in the Audio Stream dialog
box (use the default values for this tutorial):

� Elementary Stream Rate

� PES Packet Size

� Elementary Stream Initial Delay

� Offset PTS

For more information about editing these parameters, see Selecting an Audio

Stream, on page 3--49.



Creating an MPEG-2 Transport Stream File

MTS300 Stream Creation Applications User Manual 2- 17

4. Click OK to accept these settings and close the dialog box. This returns you
to the hierarchic display of the configuration file as shown in Figure 2--11.

Figure 2- 11: The display after an audio file is associated

The file 10khz.mp2 is now associated with the audio icon and the Multiplexer
Rate gauge is a little closer to full.
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Display the Data Stream dialog box; delete the Data icon from the hierarchy.

1. Double-click on the Data icon to open the Data Stream dialog box shown in
Figure 2--12.

Figure 2- 12: The Data Stream dialog box

This dialog box does not show as much information as the Video Stream or
Audio Stream dialog boxes because it is for private-data elementary streams;
a file of any type is acceptable.

Rather than add a data elementary stream file to the multiplex, delete the
data icon from the Hierarchic view.

2. Click Cancel to close this dialog box without entering a file.

3. Select the Data icon.

4. Click the – (Delete) button on the toolbar (or select Delete from the Edit
menu), and then click Yes when the message box appears. The Hierarchic
view should now resemble Figure 2--13.
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Figure 2- 13: The hierarchy with the Data icon deleted

5. Choose Save from the File menu to save the configuration file.

In this section, you will create a transport stream file using the information from
the configuration file and the PSI tables referenced by the configuration file.

1. Select Go from the Multiplex menu (or click the Go button on the toolbar).

2. Using the Multiplex Output File dialog box, specify the location and file
name into which you will save your transport stream file.

Notice that the current configuration file name becomes the default transport
stream file name (with the file name extension changed to *.TRP).

NOTE. Transport stream files can be large. Make sure you have adequate space

on the selected drive before beginning.

3. Choose OK to begin creating the simple.trp transport stream file in the
default directory (C:\MTS300\cfg-trp).

Create the Transport
Stream File
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As the multiplexer generates the transport stream file, the duration gauge at
the top of the display fills, showing the status of the operation. When the
transport stream file has been generated, the gauge reads 100% and a
message box appears to indicate that the transport stream has been multi-
plexed.

4. Click OK close the message window. You have successfully created a simple
transport stream file, and the multiplexer resembles Figure 2--14.

Figure 2- 14: Transport stream creation is complete
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Creating a Complex Transport Stream File

To create a more complicated configuration file, add to the simple.cfg file you
created in the previous tutorial.

Create a Complex Configuration File

1. Continuing from page 2--19, choose Save As from the File menu. The
standard Windows Save As dialog box appears.

2. Use standard Windows techniques to save the file as complex.cfg.

Saving the information to a new configuration file creates a new .pmt file
(called complex.pmt), and places the name “complex” in the title bar. The
Duration gauge also resets itself to 0%.

Add two additional programs to complex.cfg.

1. Select theMUX icon.

2. Click + on the toolbar, or select Add from the Edit menu. This creates
Program 2.

3. Click + on the toolbar a second time to create Program 3. Figure 2--15 shows
the resulting hierarchy.

Figure 2- 15: The hierarchy with Programs 2 and 3 added

Add More Programs
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NOTE. The configuration file can accept up to 40 programs.

4. Follow the procedures on pages 2--10 to 2--19 to associate the following files
to the video and audio icons for Program 3:

� C:\MTS300\625\testpat\BARS_015.MP2 (video elementary stream)

� C:\MTS300\audio\10KHZ.MP2 (audio elementary stream)

NOTE. Each program can accept up to 40 elementary streams, with a maximum

of five video elementary streams and ten elementary streams of any one type.

The lower portion of the resulting application window looks like
Figure 2--16. The Multiplex Rate gauge is yellow after adding the video and
audio streams to Program 3. This indicates the transport stream is beginning
to get full. If you were to multiplex a transport stream file from the
configuration file when the rate gauge is yellow, you may experience
multiplexer overflow problems.

Figure 2- 16: Elementary streams added to Program 3
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5. Repeat step 4 and add the same video and audio elementary stream files to
Program 4. The lower portion of the application window now resembles
Figure 2--17.

Figure 2- 17: The rate gauge shows an overflowed multiplex

The rate gauge reads 100% and is now displayed in red. The rate reported at
the bottom of the gauge is greater than the specified maximum rate at the
top. If you multiplex the stream now, you risk losing data. To avoid losing
data you need to change the start delay for one or more of the programs in
the multiplex.
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Change the start times for Program 2 and Program 3 so that the multiplex rate
drops to an acceptable level.

1. Change the view from hierarchic to dynamic; choose Dynamic from the
View menu or click Dynamic on the toolbar.

The display now resembles Figure 2--18.This view shows the timing
relationships between programs. For more information about this view, see
The Dynamic View on page 3--16.

Program bars

Multiplex global start time Estimated stop time

Timing cursor

Actual maximum multiplex
rate time frame

Figure 2- 18: The dynamic view of the complex.cfg configuration file

Notice that the time frame for the actual multiplex rate, shown at the bottom
of the multiplex rate gauge, is from 0.00 s to 15.07 s. In order to decrease the
actual bit rate when you multiplex the configuration file to safe parameters,
you need to delay the start time for Program 2 and Program 3 so that both
start after Program 1 ends.

Change Program Starting
Time
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NOTE. In the Dynamic view, the program number refers to the order of programs

in the configuration file, so Program 1 is the first program in the file. The PMT

program_number parameter value for this program will be 2 in the multiplexer

Hierarchic view. In order to avoid conflicts with the ATSC program paradigm

and the DVB requirement for a NIT (PID = 16), the multiplexer does not use

program_number 1.

You modify the start times for individual programs through the Program icon
in the Hierarchic view. Referring to Figure 2--18, note the estimated stop
time for Program 1 (roughly 15.0 seconds).

2. Return to the Hierarchic view by clicking the Hierarchic button on the
toolbar.

3. Double-click the PROG (Program) icon for Program 3. This opens the
Program Parameters dialog box shown in Figure 2--19.

Figure 2- 19: The Program Parameters dialog box for Program 2

4. Enter 15.2 in the Enter the Program Start Delay text box.

5. Click OK. The rate gauge drops and turns yellow.

6. Repeat steps 4 and 5 for Program 4, setting the Program Start Delay to 20.5.
The rate gauge now shows 67% and is again green.

7. Switch to the Dynamic view to see the new timing relationships between
programs (see Figure 2--20). Programs 2 and 3 do not begin until Program 1
ends, and the resulting transport stream now takes longer (note the Estimated
Stop Time).
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Timing cursor
handle

Estimated
stop time

Figure 2- 20: The dynamic view after you delay Programs 3 and 4

8. You can move the timing cursor by clicking and dragging the timing cursor
handle at the bottom of the Program Dynamic View window. Click and drag
the timing cursor to the right and left. Once the timing cursor is selected, you
can also move it 0.01 second at a time with the the left and right arrow keys.

9. Move the timing cursor into the area that contains only the second and third
programs; the Multiplex Rate drops even lower.

10. For practice, see if you can move the timing cursor to the space between the
end of the first program and the start of the second. Use the left and right
arrow keys for fine cursor movement.

11. Return to the Hierarchic view.
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You can customize PSI for the transport stream file by double-clicking the PSI
table icons.

PSI. The PSI icon accesses the PSI period values for three PSI tables.

1. Double-click on the PSI Icon. This opens the PSI Period dialog box. See
Figure 2--21.

The PSI Period dialog box allows you to change how often the following
program specific information (PSI) appears in the stream.

� PMT (Program Map Table)

� PAT (Program Allocation Table)

� CAT (Conditional Access Table)

� TSDT (Transport Stream Descriptor Table)

NOTE. If you have the conditional access option installed on your system, the

CAT period is accessible in the PSI Period dialog box, regardless of whether you
have enabled a scrambling option. See Using Option CA: Scrambling /
Conditional Access beginning on page 3--89 for more information about the

CAT. Modifying the CAT period has no effect unless a scrambling option is

enabled.

The NIT period is set separately. See Editing the NIT, beginning on page 3--42.

Figure 2- 21: The PSI period is changed to 0.01 seconds

Customize Program
Specific Information (PSI)
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In this example, you want to send the PSI more often than the default, so you
must decrease the period for one or more of the tables.

2. Enter 0.01 in the PMT and PAT text boxes as shown in Figure 2--21, and
then click OK. (Clicking Cancel will close the dialog box without making
any changes to the periods to the PSI tables.)

Notice the changes to the Hierarchic view and the multiplex rate. First, the
new period is displayed after the PAT and PMT icons in the hierarchy;
second, decreasing the period for the PAT and PMT (increasing the rate) used
an additional 3% of the available multiplex space as shown in the rate gauge.
See Figure 2--22.

Changed PAT
and PMT periods

Figure 2- 22: The configuration file after changing the PSI period
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PAT. The PAT (Program Association Table) lists the Transport Stream ID and the
PIDs for the PSI tables. In this case, it includes the NIT and three PMTs (one for
each program).

1. Double-click on the PAT icon. This opens the Program Association Table
dialog box as shown in Figure 2--23.

Figure 2- 23: The Program Specific Information dialog box

2. Select NetWork Information Table.

3. Click Modify to open the PID Modification dialog box as shown in
Figure 2--24.

Figure 2- 24: PID Modification dialog box

This dialog box allows you to change the Program ID of the selected table
(in this case the Network Information Table). To change the PID, enter a new
number in the text box. Usually you do not need to change the PID of the
NIT or PMTs since the multiplexer allocates these values dynamically and as
required for the selected environment (MPEG-2, DVB, or ATSC).

4. Cancel the PID Modification dialog box.
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5. Cancel the Program Association Table dialog box.

PMT. The PMT (Program Map Table) contains specific information about the
programs in the transport stream file.

1. Double-click on the PMT icon. This automatically starts the DVB Table
Editor application with complex.pmt (the PMT for the complex.cfg
configuration file) loaded, as shown in Figure 2--25.

The two views displayed in the table editor are described below:

� The Hierarchic view displays icons representing the table and table
elements.

� The Edit view displays the parameters and values for the table elements

Elementary
streams

Program
number

Section
number

Hierarchic view Edit view

Figure 2- 25: The DVB Table Editor with complex.pmt loaded

Note the following before continuing:

� There is one section for each program and the current file has three pro-
grams.

� Section 1 of 3 is currently being displayed.
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� There are two elementary ES streams (one video and one audio) associated
with this program.

For more information about using the DVB Table Editor application, refer to
Using the DVB and PSIP Table Editors, beginning on page 3--93.

NOTE. You can change the PCR PID (in the last text box of the right hand

window). The default is the first elementary stream in the program. If you

change it to a different value, and that value is not the PID of another elementa-

ry stream in the program, PCRs will then reside in their own transport packets.

Use this technique if the elementary stream that would carry the PCR by default

is not the longest elementary stream in the program.

2. Add some descriptors to Section 2 of PMT (Program 2). To display
Section 2, chose Next from the Section menu or click � in the lower toolbar.
See Figure 2--26.

Figure 2- 26: Section 2 (Program 3) of the PMT

3. Select the PMT icon.

4. Choose either Add from the Edit menu or “+” from the toolbar. This opens
the Descriptors Selection dialog box. See Figure 2--27.
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Figure 2- 27: The Descriptors Selection dialog box

5. Click on the List of Descriptors drop-down list to display the available
descriptors.

6. Add a registration descriptor

a. Select registration from the drop-down list.

b. Choose Add. This adds the descriptor to the Descriptors Selected list.
The dialog box now resembles Figure 2--28.

Figure 2- 28: Registration selected

7. Click OK to add the descriptor. (See Figure 2--29.)
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Figure 2- 29: A registration descriptor added to PMT section 2

8. To check the information added in the descriptor, click on the descriptor icon
(see Figure 2--30). Do not change any of the information.

Figure 2- 30: The information for the Video Stream descriptor field

9. To add a video stream descriptor to the video elementary stream, select the
PID 49 elementary stream icon.

10. Choose Add from the toolbar.
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11. Select video_stream from the List of Descriptors.

12. Click the Add command button to add it to the Descriptors Selected list.

13. Choose OK.

14. Click on the resulting descriptor icon to open the display shown in
Figure 2--31.

Figure 2- 31: The descriptor at the Elementary Stream level

15. Choose Save from the File menu.

16. Exit the table editor and return to the Multiplexer application.

You can find additional information on customizing the PSI for your transport
stream in Using the DVB ,PSIP, and ARIB Table Editors (beginning on page
3--93) and Using the Multiplexer (beginning on page 3--3), in the Reference
section of this manual.
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1. Choose Go from the Multiplex menu. This opens the Multiplex Output File
dialog box.

2. Enter the path and file name into which you will save the transport stream
file.

3. Choose OK to begin the multiplex process.

When the multiplex is complete, the duration gauge reads 100% and the message
shown in Figure 2--32 appears.

Figure 2- 32: Multiplex complete message

4. Click OK, and then exit the Multiplexer application.

Generate a Transport Stream

In this section of the tutorial you need to have the transport stream file located on
the Tektronix MTS300 MPEG Test System with the Master Client and Stream
Player applications.

1. Start the Master client.

a. Double click the Master Client icon in the MPEG Test System program
group window.

b. Click the Connect locally button on the toolbar. See Figure 2--33.

Figure 2- 33: Connect locally button

Multiplex the Transport
Stream File

Starting the Master and
Stream Player Clients
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The Master Client display changes showing that you are connect to a Server
Manager (in this case the local Server Manager). See Figure 2--34 on
page 2--36.

Port Manager Panel

Free I/O ports

Figure 2- 34: Master Client application window

2. In the Master Client Port Manager panel, right click the port from which you
will output the transport stream, point to Assign Server in the popup menu,
and then select Stream Player from the submenu as shown Figure 2--35.
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In this illustration, the Stream Player Server is being assigned to I/O port
two.

Figure 2- 35: Assigning the Stream Player Server to I/O port two

3. Right click the icon that appears at the port you selected, and then select
Launch Stream Player Client. The Stream Player application is displayed.

Figure 2- 36: Stream Player Client application window
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Now you can generate a transport stream from the transport stream file.

1. Click the Browse button, and then navigate to and select Complex.trp.
When you return to the Stream Player application the file you have selected
is shown in the File Name text box as shown in Figure 2--37.

Figure 2- 37: Select Complex.trp from the File information list

2. Click the Start Generation in Loop Mode button, accepting the default
settings.

This completes the basic tutorial on generating a transport stream. If you need
additional information, please see the Using the Multiplexer and Using the DVB

and PSIP Table Editors in the Reference section of this manual.

For more information about the Stream Player, Master Client, and Analysis
Servers, and for information about analyzing the stream you are generating, see
theMTS300 MPEG Test System Real-Time Analysis User Manual.

For more information about the Stream Player, see theMTS 300 Series Real-

Time Analysis User Manual.

Output the Transport
Stream
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Creating a Transport Stream File with DVB Information

The multiplexer can generate transport stream files for MPEG-2, DVB, ATSC,
and ISDB-S/ARIB broadcast environments. In this tutorial, you will create a
transport stream file for the DVB environment.

In addition to introducing you to the capabilities of the multiplexer, this tutorial
will also help you become more familiar with the capabilities of the table editors.
You use only the MTS300 DVB Table Editor for this tutorial, but the basic
procedures are similar for the MTS300 PSIP Table Editor.

For more detailed information about using the table editors see Using the DVB

and PSIP Table Editors beginning on page 3--93. For detailed descriptions of
specific table item parameters, see PSI, DVB SI, and ATSC PSIP Table Item

Parameters beginning on page 3--143.

Create a DVB Configuration File

This section is a continuation from the previous tutorial. It assumes that you
have completed the previous work and have the resulting files.

1. If not already open, start the multiplexer by double-clicking the Multiplexer
icon in the Tektronix MPEG Test System program group window.

2. Select Open from the multiplexer File menu.

3. Select complex.CFG.

4. Click OK. This opens the previous configuration file and displays it in the
application window.

5. Select Save As from the File menu.

6. Type dvb in the File Name text box, and then click OK.
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To create a configuration file with DVB information, you must set the multi-
plexer environment for DVB.

� To change the multiplexer environment, select DVB from the Options menu.

The SI (Service Information) icon is added to the Hierarchic view and the NIT
(Network Information Table) icon appears below the SI icon, as shown in the
following illustration.

To create a valid DVB transport stream file, you must add more DVB table icons
to the configuration file. When you installed the stream creation applications, a
number of default DVB table files were installed in the C:\MTS300\CFG-TRP
directory. You will use these files as templates for the tables files needed for the
configuration file.

Change the Multiplexer
Environment

Add DVB SI Tables
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1. Double-click on the SI icon to open the DVB File Selection dialog box.

NIT file group

2. Click Browse in the NIT file group of the DVB Files Selection window. The
Selection SI File dialog box is displayed.

3. Navigate to the C:\MTS300\CFG-TRP directory.

NOTE. All table template files are located in the C:\MTS300\CFG-TRP directory.

4. Select Default.NIT in the Selection SI File dialog box, and then click OK.

5. Click Browse in the BAT File section of the DVB Files Selection window.

6. Select Default.BAT in the Selection SI File dialog box, and then click OK.

7. Click Browse in the SDT File section of the DVB Files Selection window.

8. Select Default.SDT in the Selection SI File dialog box, and then click OK.



Creating a Transport Stream File with DVB Information

2- 42 MTS300 Stream Creation Applications User Manual

9. Click Yes in the warning message box if displayed. You will correct the
Transport Stream ID error in a later step of this tutorial.

10. Click Browse in the EIT File section of the DVB Files Selection window.

11. Select Default.EIT in the Selection SI File dialog box, and then click OK.

12. Click Yes in the warning message box if displayed. You will correct the
Transport Stream ID error in a later step of this tutorial.

13. Click OK in the DVB Files Selection dialog box. The Hierarchic view now
includes icons for the tables you added, as shown in the following illustra-
tion.

NOTE. You can also edit the TDT parameters using the DVB Files Selection

dialog box. Initially the TDT text boxes are grayed out; in order to edit these

parameters, click the TDT check box in the lower right of the display. However,

you will edit these parameters using a different technique in this tutorial.
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You can edit DVB table periods using the multiplexer. However, to create a
coherent transport stream file, you also need to add some table descriptors and
edit table parameters using the MTS300 DVB Table Editor. In this section, you
will edit the NIT using the table editor.

1. Double-click on the NIT icon to open the NIT dialog box.

2. Click Edit. This starts the Table Editor application with Default.NIT file
displayed.

3. Select Consistency from the Analysis menu (or click the A command button
on the toolbar). This runs a coherence analysis on the NIT. A message
window appears listing the problems found in the table.

Edit the NIT
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NOTE. Some table editor error messages include error codes at the end of the

error message text (you may have to scroll the window to make it visible). You

can use these error codes to locate descriptions of the messages, and possible

solutions, in the table editor online help. See Interpreting Error Messages,
beginning on page 3--130 for more information.

4. To resolve the current next indicator warning, select currently applicable

from the current next indicator drop down list box.

5. Click A again on the toolbar. This runs another analysis on the NIT. The
message window changes to list the remaining problem found in the table.

6. To resolve the Network Name descriptor is not present for this subtable
warning, you must add the network_name descriptor to the NIT.

7. Choose Add from the Edit menu (or click the + command button). This
displays the Add dialog box.

8. Select Descriptor, and then click OK. This displays the Descriptors
Selection dialog box.
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9. Select network_name from the List of Descriptors drop-down selection box.

Drop-down list box

10. Click Add and network_name appears in the Descriptors Selected list.

11. Click OK to complete the descriptor selection and close the dialog box.

12. The descriptor icon is added to the right of the NIT icon in the Hierarchic
view window.

13. Click the Netwo (Network) descriptor icon, and type Tektronix in the name
text box (to the right in the application window).
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NOTE. In the following step, do not choose the Save command. Doing so will

change the Default.NIT file, which is provided as a template.

14. Select Save As from the File menu.

15. Type dvb in the file name box and click OK. The .NIT file name extension is
added automatically.

16. Select Exit from the File menu.

17. In the NIT dialog box, click Browse.

18. Select dvb.NIT from the Selection SI File dialog box, and then click OK.

19. Click OK in the NIT dialog box to confirm the file selection and dismiss the
window. The NIT file associated with the dvb.cfg configuration file is now
dvb.NIT.

In this section, you will edit the BAT using the table editor.

1. Double-click on the BAT icon to open the BAT dialog box.

2. Click Edit in the BAT dialog box. This starts the DVB table editor with
Default.BAT open for editing.

Edit the BAT
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3. Click the A (Analyze) command button to perform an analysis of the BAT. A
message window lists the problems found in the table.

4. To resolve the current next indicator warning, select currently applicable

from the current next indicator drop down list box.

5. To resolve the Bouquet Name descriptor is not present for this sub-table
warning, click the + (Add) command button, and then select Descriptor
from the Add dialog box. This displays the Descriptors Selection dialog box.

6. Select bouquet_name from the List of Descriptors drop-down selection box.

7. Click Add, and then click OK to complete the descriptor selection and close
the dialog box.

8. Click the Bouqu (Bouquet) descriptor icon, and type a name for the bouquet
in the Name text box (to the right in the application window).

9. Click the A (Analyze) command button. There should be no more warnings
in the message window.
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NOTE. In the following step, do not choose the Save command. Doing so will

change the Default.BAT file, which is provided as a template.

10. Select Save As from the File menu.

11. Type dvb in the File Name text box and click OK. The table description is
saved as dvb.BAT.

12. Select Exit from the File menu. This returns you to the BAT dialog box of
the Multiplexer application.

13. In the BAT dialog box, click Browse.

14. Select dvb.BAT from the Selection SI File dialog box.

15. Click OK in the BAT dialog box to accept the selection of dvb.BAT and
dismiss the box. This associates dvb.BAT with the BAT icon in the dvb.cfg
configuration file.

In this section, you will edit the SDT using the table editor.

1. Double-click on the SDT icon to display the SDT dialog box.

2. Click Edit in the SDT dialog box. This starts the Table Editor application
with Default.SDT open for editing.

3. Perform an analysis of the SDT (select Consistency from the Analysis menu
or click the A button in the toolbar).

4. Again, the warning states that the current next indicator field value is
incorrect. Select currently applicable from the Service Description Table
current next indicator drop-down list.

5. Save the SDT as dvb.sdt.

Edit the SDT
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6. Exit the table editor. The error message that appeared when you first added
Default.SDT to the hierarchy may reappear. Click OK.

7. If you see the message shown above, identify the Transport Stream ID from
the PAT icon in the Multiplexer hierarchy:

a. You must close the SDT dialog box before you can scroll to the PMT
icon. Click OK in the SDT dialog box.

b. Scroll the multiplexer window until you can see the PMT icon. Note that
the Transport Stream ID is 1.

8. Open the dvb.sdt file in the table editor:

a. Scroll the SDT icon back into view and double-click on it.

b. Click Browse and select dvb.SDT from the Selection SI File dialog box.

c. Click OK. You will receive the “Different Stream ID” warning message.

d. Click Yes in the warning message window; then click Edit in the SDT
dialog box.
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9. When the table editor opens, change the value of the Transport stream ID
text box to 1.

10. Click in the Hierarchy view and note that the text under the SDT icon
changes to TS 1.

11. Choose Save and then Exit from the File menu. Click OK in the SDT dialog
box. The Transport Stream ID Error message no longer appears.
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In this section, you will edit the EIT using the table editor.

1. Double-click the EIT icon to open the EIT dialog box and edit the EIT file.

2. Click Edit in the EIT dialog box to start the Table Editor application.

3. Perform an analysis (click the A command button).

4. The resulting Messages window contains three warnings and an error
message:

� The service id value is incorrect (Warning)

� The current next indicator should be “1” (Warning)

� The last table id value is incorrect (Warning and Error)

5. Change the Event Information Table current next indicator field to currently

applicable.

6. Type 78 (the ID of this table) in the last table id text box.

7. Perform an analysis again and note that there is only one message left, which
indicates that the the service id should be identical to the Program ID of the
associated PMT: Use the following procedure to identify the correct value
for the Service ID.

a. Click the PMT command button on the Table Editor toolbar. The Table
dialog box appears.

b. Click Open, and then select the dvb.PMT PMT file (located in
C:\MTS300\CFG-TRP).

Edit the EIT
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The table editor changes to show the beginning of the PMT and its
values. The Program ID of the first PMT section is 2 as shown in the
following illustration.

c. Select Close from the File menu to close the PMT file and return to the
EIT display.

8. In the Edit view of the EIT, change the value of the Service ID text box to 2,
and then click in the Hierarchic view. Note that the text under the EIT icon
changes to S 2.
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9. Perform an analysis on the EIT to confirm that all reported errors are
corrected.

10. Remember that when you first added the Default.EIT to the multiplexer
hierarchy, you saw a Transport Stream ID warning message. Correct this
error now by entering 1 in the transport stream id text box.

11. Save the EIT as dvb.EIT and exit the table editor. The Transport Stream ID
error message appears because Default.EIT is still selected.

12. Click OK to dismiss the error message; then click Browse in the EIT dialog
box and select dvb.EIT using the Selection SI File dialog box.

13. Click OK to accept the selection, and then click OK again to dismiss the
EIT dialog box.

The SI hierarchy of the multiplexer now appears as shown below:
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The time date table information can be created using the multiplexer alone.

1. Select the SI icon, and then click the + command button. The following
dialog box is displayed.

2. Select TDT, and then click OK. The Time and Date Table dialog box is
displayed with the current date, time and default TDT Period displayed in
the respective text boxes.

3. Change the values in the text boxes to a future date and time and for a more
frequent table period:

a. Type 12/31/2000 in the TDT Starting Date text box.

b. Type 01:00:00 in the TDT Starting Time text box.

c. Type 0.1 in the TDT Period text box. The TDT Period specifies how
often the time and date stamp is placed into the transport stream.

Create TDT Information
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NOTE. You can also edit TDT parameters using the DVB Files Selection dialog

box shown on page 2--41 (display the dialog box by double-clicking the SI icon).

Initially the TDT text boxes are grayed out. In order to edit the date, time, and

period values, you must first select the TDT check box in the lower right corner

of the dialog box.

4. Click OK. The Hierarchic view now shows a TDT icon.

5. Choose Save from the File menu (or click the Save command button) to
save all the changes to the dvb.CFG file.
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Create a Set of Complete Tables with DVB Information

So far, you have created a set of coherent tables for the transport stream file you
are creating. However, the tables are incomplete because you have included
information for only one program: Program 2 (Service 2). Now you need to
modify your existing tables to include the other two programs in your configura-
tion file.

You are already familiar with the basic procedures associated with the multi-
plexer and table editor; therefore, not all of the steps in this part of the tutorial
are fully described. If you have trouble completing a basic procedure, see the
relevant section of the first or second tutorial. New procedures are described
more fully.

In this part of the tutorial, you will use the MTS300 DVB Table Editor to modify
the NIT, EIT, and SDT tables and you will learn how to use a new table editor
view: the Global view.

1. Double-click the NIT icon, and then click the Edit button to start the table
editor with the dvb.NIT table file displayed.

2. Display the NIT, SDT, and EIT in the Global view window:

a. Click the G command button on the toolbar (or select Global View from
the File menu). This displays the Global View File Selection dialog box
with the NIT file selection showing the dvb.NIT file selected.

b. Use the Browse buttons to select the dvb.SDT and the dvb.EIT table
files, and then click OK. The Global View window is displayed showing
the icons for the tables you selected.

Display the DVB Table
Editor Global View
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3. Arrange the both view windows so that they look similar to the following
illustration. It is easier to see the effects of the edits you will be making on
the relationships between tables using this arrangement.

The Global View window shows interrelationships between NIT, SDT, and
EIT table files; in this case, there are no apparent relationships. The DVB
NIT, SDT, and EIT files are normally associated using the following
mechanisms:

� NIT files and SDT files are associated through Transport Stream IDs.

� SDT files and EIT files are associated through Service IDs.

� EIT files and NIT files are associated through Transport Stream ID and
the Service ID pairs.

NOTE. PSIP table file interrelationships are somewhat more complex. See Using
the PSIP Table Editor Global View Window on page 3--136 for more information

about making table associations for PSIP tables.

4. Click each of the table icons in the Global view and notice how the
Hierarchic view updates to show the selected table each time. The Edit view
shows the top level of the selected table.
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1. To associate the SDT to the NIT, you need to add a transport stream to the
NIT. Click the NIT icon in the Global view window.

2. In the Hierarchic view, select the NIT icon, then press the Ins (Insert) key on
your keyboard. This displays the Add dialog box.

3. Select Transport stream, and then click OK. Notice the addition of the
transport stream icon to both the Global and Hierarchic view windows.

4. In the Global View window, select the SDT icon and check the Transport
Stream ID value.

5. Click the TS icon in the Global view window, and then update the Transport
Stream ID text box to 1.

6. Click in the Hierarchic view and notice the update to the TS icon in both the
Hierarchic and Global view windows.

7. Perform an analysis (click A on the toolbar).

8. Clear the INTER ANALYSIS warning for the NIT-SDT tables by adding a
cable_delivery_system descriptor to the transport stream table element
(TS 1 icon). Under normal circumstance you would update the Cable
Delivery System parameters with the characteristics of your environment.
For the purposes of this tutorial, leave the parameters at their default values.

9. Perform an analysis again and note that the NIT-SDT analysis is clear.

Create the NIT-SDT
Relationship



Creating a Transport Stream File with DVB Information

MTS300 Stream Creation Applications User Manual 2- 59

The warning message for the SDT-EIT INTER ANALYSIS indicates that there is
no service defined for the Transport Stream ID-Service ID pair.

1. Add a Service and a Service Descriptor to the SDT and change the default
values:

a. Select the SDT icon and press the Ins (Insert) key on your keyboard. A
service icon is added to the SDT icon.

b. Change the Service ID value to 2, and then select Present from the EIT
Present Following Flag drop-down selection box.

c. Select the Service icon (S2) and click + (or press Ins), select Descriptor
in the dialog box and click OK.

d. From the drop down list, select service, click the Add button, and then
click OK.

e. Click in the Hierarchic view window. The Hierarchic and the Global
View windows are updated to reflect the changes you have made.

Create the SDT-EIT
Relationship
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2. Now, add services for the other two programs in your configuration file.
(Recall that the Program ID values are found in the PMT.)

a. Select the S (Service) icon, and press CTRL-C. This copies the contents
of the service and descriptor icons to the clipboard.

b. Select the SDT icon and press CTRL-V twice. This pastes the service
and descriptor icons into the SDT hierarchy.

3. Edit the new services:

a. Select the middle service icon and change the Service ID value to 3.

b. Select the last service icon and change the Service ID value to 4.

c. Click in the Hierarchic view and note that the text under the service
icons have changed to S 3 and S 4 respectively.

4. Perform an analysis and notice that there are two warnings and an error
message.
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5. Double-click the error message and add a second section to the EIT by
selecting New from the Section menu. Update the section parameters as
follows:

a. For section two, change the following parameters to the values indicated
in the following illustration and note the updated Global view display.

b. Click the� (Previous) button on the lower toolbar to display the first
EIT table section and change the Last Section Number and Segment Last
Section Num. to 1 and 5 respectively.

6. You have created a valid set of EIT sections for Service ID 2, now add and
update the EIT to create valid sections for services 3 and 4.

a. Add four more sections to the EIT. (Note the changes to the Global view
window.)

b. Change the values for each section as indicated in Table 2--2 (leave the
other parameters at their default values).
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Table 2- 2: EIT parameter values for sections 3 through 6

Parameter Section 3 Section 4 Section 5 Section 6

Service ID 3 3 4 4

Section Number 0 1 0 1

Last Section Number 1 1 1 1

Transport Stream ID 1 1 1 1

Segment Last Section Num. 5 5 5 5

Last Table ID 78 78 78 78

7. Perform an analysis and note that the inter-analyses are clear. However, now
there are three warning messages about the reserved value in the service type
field in the SDT.

8. Double-click the top message, and then change the service type to Digital
Television (the text box will update to 1); fill in the Provider Name text box
with Tektronix and the Service Name text box with SVC2.

9. Repeat step 8 for the other two services, using SVC3 and SVC4 for the Service
Name value for the respective services.
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10. Click in the Hierarchic view and the display should look like the following
illustration.

11. Perform an analysis again, noting the fact that there are no further error or
warning messages: Save all of the open table files by selecting Save All

from the File menu.

12. Exit the DVB Table Editor, and then click OK in the SDT dialog box.

13. Save the dvb.CFG file in the multiplexer, and then use the procedure
described in Multiplexing the Transport Stream File on page 2--35 to create
the dvb.TRP transport stream file.

This concludes the tutorial for creating an MPEG-2 transport stream file with
DVB information. Refer to Using the DVB and PSIP Table Editors, beginning
on page 3--93, for additional information about using the table editors. See PSI,
DVB SI, and ATSC PSIP Table Item Parameters, beginning on page 3--143, for
complete descriptions of PSI, SI, and PSIP tables, descriptors, and parameters.

You can proceed to Error Injector Tutorial, beginning on page 3--227, to learn
how to insert errors into the transport stream file you created in this tutorial.
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Reference

This section is the reference for the MTS300 MPEG Test System Stream
Creation Applications and is organized into the following sections (page
references indicate the first page of each section):

� Using the Multiplexer (page 3--3)

� Using Option CA: Scrambling/Conditional Access (page 3--89)

� Using the DVB, PSIP, and ARIB Table Editors (page 3--93)

� PSI, DVB SI, and ATSC PSIP Table Item Parameters (page 3--143)

� Using the Jitter Adder (page 3--191)

� Using the DVB Channel Coder/Decoder (page 3--199)

� Using the TMCC Combiner (page 3--215)

� Using the Error Injector (page 3--225)

� Using the OpenMux Configuration Client (page 3--233)

You can access additional operating information for the applications and
information regarding MPEG-2, DVB, and ATSC bit streams from the following
sources:

� Online Help. Select Contents from the Help menu.

� MPEG-2 Help. This utility contains much of the ISO/IEC 13818-1 MPEG-2
standard in Windows Help format. Double-click the MPEG-2 Help icon in
the Tektronix MPEG Test System program group window.

� Status bar. Located at the bottom of the application windows, the status bar
displays brief messages that describe highlighted menu selections.

� ToolTips. ToolTips display the names of active command buttons. Placing
your mouse cursor over a command button, and leaving it there for a second,
will display the command button name in a small ToolTips window.



Reference

3- 2 MTS300 Stream Creation Applications User Manual



MTS300 Stream Creation Applications User Manual 3- 3

Using the Multiplexer

Overview

You can use the MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream
Multiplexer to specify the characteristics and contents of an MPEG-2, DVB,
ATSC, or ISDB-S/ARIB compliant transport stream. You can then generate a file
that contains the transport stream to test MPEG hardware or software compo-
nents.

Multiplexing is the process of combining and arranging program data
(compressed video, audio, and data streams with timing information) and
overhead (PSI, SI, PSIP, and ISDB-S/ARIB data) so that the data can be
transmitted and later decoded. The broadcast or transmitted product of this
process is called, variously, a multiplex or a transport stream.

A transport stream file is a digital data structure defined by ISO/IEC 13818-1,
tailored to communicate one or more encoded programs according to MPEG-2
standards: the MPEG-2 standard is extended by the DVB, ATSC, and
ISDB-S/ARIB standards. The transport stream file data may be broadcast,
transmitted, or stored in a computer file as it is on system disks or on the
Tektronix MTS300 MPEG Test System data store disks.

When the transport stream file that is broadcast or transmitted in a way designed
to be decoded, it is a transport stream.

To create a compliant transport stream file using the multiplexer, you must first
create a configuration file that contains all the instructions for making the desired
transport stream file. The configuration file contains general information about
the multiplex you are creating, such as the multiplex rate and any program
delays. It also points to (or links to) other required files, such as elementary
stream files and PSI, SI, PSIP, and ARIB table files.

When it generates a transport stream file, the multiplexer combines information
from the configuration file, elementary stream files, and table files according to
instructions contained in a configuration (*.cfg) file. The following illustration
depicts the relationships between configuration file and the other elements of the
transport stream file you are creating.

Definitions

Conventions
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Configuration file
Transport stream
files

Video elementary
stream files

Data files and
Entitlement control
message files

Audio elementary
stream files

Link

Link Link

Link

PSI, DVB SI, ATSC PSIP,
and/or ISDB-S/ARIB table files

Mux rate, program delays, MIP
data, and program paradigm
(data in the configuration file)

The configuration file is similar in structure to a Windows *.ini file. See the
example configuration file at the end of this section, beginning on page 3--85.
The configuration file is independent of the transport stream file. It allows you to
create transport stream files with only minor variations by using the same base
configuration file.

The following steps describe the general procedure for creating a transport
stream file with the multiplexer:

1. Create a new configuration file with default information.

2. Select an alternative environment if applicable (DVB, DVB-T, ATSC, or
ISDB-S/ARIB).

3. Add stream icons to the first program.

4. Add more programs and stream icons as desired.

5. Associate Video, Audio, and Data files with all stream icons.

6. Add and edit PSI, DVB SI, ATSC PSIP or ISDB-S/ARIB tables.

7. Edit multiplex, tables, and other program parameters as necessary; confirm
that the highest actual multiplex rate does not exceed the rate chosen for the
multiplex (transport stream) as a whole.

8. Create the transport stream file from the configuration file.

The material in this section assumes that you have familiarized yourself with the
multiplexer interface and capabilities using the following tutorials in the
Operating Basics section (the tutorials progress from creating a simple file to
creating a complex DVB file with a set of coherent SI table files):

� Creating an MPEG-2 Transport Stream File (page 2--7)

� Creating a Complex Transport Stream File (page 2--21)

� Creating a Configuration File with DVB Information (page 2--39)
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This section describes the view windows, menu selections, and interface
elements of the MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream
Multiplexer. It also provides detailed descriptions of the functions and capabili-
ties of the multiplexer that allow you to create transport stream files.

The Application Window

The multiplexer application window has a title bar, menu bar, toolbar, and status
bar. Once you open a new or existing configuration file, the center workspace is
divided into three parts: the duration gauge, the rate gauge, and the multiplex
window.

Duration gauge

Rate gauge

Multiplex window

Status bar

Menu bar

Toolbar

Title bar

The title bar lists the current (displayed) configuration file name, and provides
common Windows control buttons to the right.

Title Bar
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The Menu Bar accesses the multiplexer menus. Command buttons on the toolbar
provide shortcuts for many menu commands.

File Menu.Use the commands in the File menu (Table 3--1) for creating new files,
opening existing files, saving files, closing files, and exiting the multiplexer
application. You can choose the New, Open, and Save commands by clicking
the equivalent command buttons shown below.

New Open Save

Table 3- 1: Multiplexer File menu commands

Use To

New Open a new configuration file

Open Open an existing configuration file

Save Save the current configuration file

Save As Save the current configuration file under a new name

Close Close the current configuration file

Exit Close the multiplexer application

Edit Menu.Use the Edit menu (Table 3--2) to add and delete items in the
configuration file hierarchy. Both commands on the Edit menu have command
button equivalents as shown below. In the following illustration, the Delete
button is shown in the disabled state (grayed out).

Add Delete

Table 3- 2: Multiplexer Edit menu commands

Use To

Add Add an item to the multiplex

Delete Delete the selected item (and any sub-items) from the multiplex

Menu Bar and Toolbar
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Multiplex Menu. The Multiplex menu (Table 3--3) contains the Go command;
choose it or click the equivalent command button shown below to generate a
transport stream file (multiplex) from the instructions in the configuration file.

Go (generate
a multiplex)

Table 3- 3: Multiplexer Multiplex menu commands

Use To

Go Create (generate) a transport stream file from the configuration file

View Menu.Use the View menu (Table 3--4) to select a hierarchic or dynamic
display of the configuration file. The menu has two shortcut buttons as shown
below.

Hierarchic Dynamic

Table 3- 4: Multiplexer View menu commands

Use To

Hierarchic Display a Hierarchic view of the configuration file

Dynamic Display a timing diagram of the programs listed in the configuration
file

Options Menu. For additional information on the Options menu selections
(Table 3--5), see The Multiplexer Environment, beginning on page 3--20.

Table 3- 5: Multiplexer Options menu commands

Use To

DVB Toggle DVB required table files (SI) on and off

DVB-T Mega-frame Toggle DVB Mega-frame information packet on and off

ISDB-S/ARIB Toggle ARIB table files on and off

Terrestrial ATSC Toggle terrestrial ATSC table files on and off

Cable ATSC Toggle cable ATSC table files on and off
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Table 3- 5: Multiplexer Options menu commands (Cont.)

Use To

Conditional access
license/Scrambling

Enter a password to enable Option CA1 (Conditional Access
Software). This menu entry replaced by the Scrambling selection
following installation.

Dynamic SI Toggle Dynamic SI on/off

Directories Configure default directories

Save Environment Save the current options settings to a file

Load Environment Read and apply a previously saved environment

Default Environment Reset all options to the default settings

1 Refer to Using Option CA: Scrambling / Conditional Access on page 3- 89 for further
information on Conditional Access software.

Help Menu. The Help menu (Table 3--6) provides standard Windows and
application-specific information.

Table 3- 6: Multiplexer Help menu commands

Use To

Contents Open the multiplexer online help

Using Help Display standard Windows help (about using help)

About... Display the application version and copyright information

The duration gauge is active during multiplex (transport stream) generation only.
The gauge shows 0% until you choose the Go command from the Multiplex
menu or click the equivalent command button. The gauge then indicates the
completed portion of the operation. The gauge returns to 0% when you close the
configuration file and later reopen it or when you save the configuration file
under a new name. Refer to Generating a Multiplex, beginning on page 3--84, for
more information.

The rate gauge shows the portion of available transport stream capacity that is
used for program data and overhead. The target maximum multiplex rate appears
above the gauge. The highest actual rate appears below the gauge. For the default
MPEG-2 environment, the actual rate is calculated with the following formula:

Rate = PSI rate+ Video rate+ Audio rate+ Data rate

Duration Gauge

Rate Gauge
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If you have selected DVB, DVB-T Mega-frame, ISDB-S/ARIB, and/or ATSC
environments, the SI, ARIB, PSIP, and/or MIP rates, respectively, are also used
to calculate the actual rate.

Below the actual rate is the time period during which the highest multiplex rate
occurs.

NOTE. The actual rate and the time it occurs represents the worst case for the

resulting transport stream. To see the rate across the entire transport stream,

change to the Dynamic view: refer to The Dynamic View on page 3--16 for more

information.

The color or the rate gauge bar depends on the portion of the available rate used
by the highest actual rate as listed in Table 3--7.

Table 3- 7: Multiplex rate gauge colors

Actual rate/maximum rate Bar color

0 to 69% Green

70% to 89% Yellow

90% and above Red

You can create and save a configuration file with greater than 100% multiplex
rate usages; however the application warns you of multiplex overflow if you
attempt to generate a transport stream from such a configuration.

You can display the current configuration file in the Multiplex Window in either
the Hierarchic or Dynamic view. The Hierarchic view is a graphic representation
of the transport stream configuration that uses icons to show the interrelationship
of stream components. The Dynamic view shows the timing relationships
between the various programs in the transport stream; it is useful for seeing how
programs use the available multiplex rate and for resolving timing conflicts.

The status bar provides brief messages about menu selections as you highlight
them.

Multiplex Window

Status Bar
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The Hierarchic View

The Hierarchic view uses icons to show the interrelationship of transport stream
components and is the workbench for assembling and editing transport stream
configuration files. When you create a new configuration file or open an existing
one, the configuration appears in the Hierarchic view, as shown below.

Each transport stream item (tables, programs, elementary streams) is represented
in the Hierarchic view by a unique icon. Table 3--8, beginning on page 3--11, lists
and explains the icons and actions you can perform by clicking the icon with
either mouse button. The icons are arranged in the following order (which is
generally the order in which they appear in the Hierarchic View):

� Multiplex icon

� PSI table icons

� SI table icons

� PSIP table icons

� ISDB-S/ARIB table icons

� MIP icon

� Program icons

Hierarchy Icons
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Some items (and their icons) apply only to DVB, ISDB--S/ARIB, or ATSC
streams and appear only when DVB, ISDB-S/ARIB, or ATSC options are
selected from the Options menu; refer to Changing Environment Options on
page 3--21 for more information. The CAT icon, and the icons associated with
the CAT (EMM and ECM), are discussed in Using Option CA: Scrambling/

Conditional Access, beginning on page 3--89.

Table 3- 8: Hierarchic view icons

Icon Item Double-click to Right-click to

Multiplex. This is the main icon for the configuration file.

Required.

Set multiplex rate and start
time.

Collapse/expand the
hierarchy at this icon.

Program Specific Information (PSI). MPEG-2 decoders use
PSI when demultiplexing the programs in a transport stream.

Required.

Set the PSI period. Collapse/expand the PSI
table hierarchy at this
icon.

Program Association Table (PAT). The PAT provides the
correspondence between each program in the stream and the
PMT that describes the program. The PAT is always
identified with PID 0.

Required.

Read and set the PIDs of
associated tables and pro-
grams.

No

Program Map Table (PMT). The PMT specifies a PID value
for each elementary stream associated with the program and
describes the program components. Some transmission
systems (such as ATSC and DVB) require specific PID
values.

Required.

Edit the PMT (with the Edit
Table application).

No

Transport Stream Description Table. The TSDT provides a
description of all the components of a transport stream.

Optional.

Edit the TSDT (with the DVB
Table Editor application).

No

T
Conditional Access Table. The CAT table allows you to
associate one or more conditional access systems with the
transport stream.

Optional.

No Collapse/expand the
EMM table at this icon

Entitlement Management Message. Each CAT must have at
least one EMM icon associated with it. An EMM specifies the
conditions under which a program element can be
unscrambled.

Optional.

Select or edit the EMM stream
file and conditional access
parameters.

No
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Table 3- 8: Hierarchic view icons (Cont.)

Icon Right-click toDouble-click toItem

Service Information (SI). SI consists of up to six tables (NIT,
BAT, SDT, EIT, TOT, and TDT) and provides information on
services and events carried by this multiplex, different
multiplexes, and even on other networks.

Required for DVB configuration files.

Add or edit DVB table files (NIT,
BAT, SDT, TOT, and EIT); set
TDT parameters.

Collapse/expand the SI
table hierarchy at this
icon.

Network Information Table (NIT). The NIT provides
information about the physical network.

Optional under MPEG-2 standards, but required by the
multiplexer in DVB and MPEG-2 modes; found under the PSI
icon for non-DVB and under the SI icon for DVB configura-
tions. Not required for ATSC configurations.

Select or edit the NIT file and
set the NIT period.

No

Bouquet Association Table (BAT). The BAT provides
information regarding service bouquets (collections of
services that are marketed as single entities).

Optional (DVB only).

Select or edit the BAT file. No

Service Description Table (SDT). The SDT contains data
describing the services in the system such as names of
services, the service provider, etc.

Optional (DVB only).

Select or edit the SDT file. No

Event Information Table (EIT). The EIT contains data
concerning events and programs (a concatenation of one or
more events under the control of a broadcaster), such as
event name, start time, or duration.

Optional (DVB or ATSC only).

Select or edit the EIT file. No

Time and Date Table (TDT). The TDT provides the UTC time
and data information.

Optional (DVB only).

Set TDT parameters. No

Running Status Table (RST). The RST gives the status of an
event (running or not running).

Optional (DVB only).

Select or edit the RST file. No

Time Offset Table (TOT). The TOT provides information
relative to the actual date and time.

Optional (DVB only).

Select or edit the TOT file. No

Discontinuity Information Table (DIT).

Optional (DVB only).

Select or edit the DIT file. No

Selection Information Table (SIT).

Optional (DVB only).

Select or edit the SIT file. No



Using the Multiplexer

MTS300 Stream Creation Applications User Manual 3- 13

Table 3- 8: Hierarchic view icons (Cont.)

Icon Right-click toDouble-click toItem

Program and System Information Protocol (PSIP). Decoders
use PSIP tables to accurately de-multiplex the ATSC
transport streams in which the tables are carried.

Optional (ATSC only).

Set the period for PSIP tables. Collapse/expand the
PSIP table hierarchy at
this icon.

Virtual Channel Table (VCT). The VCT (TVCT or CVCT for
terrestrial and cable ATSC respectively) defines the attributes
of the MPEG-2 programs embedded in the transport stream
file.

A service_location_descriptor needs to be present for each
virtual channel in the VCT.

Optional (ATSC only).

Select or edit the VCT file and
set the period for the VCT.

No

Master Guide Table (MGT). The MGT defines the types,
PIDs, and versions of the PSIP tables carried in the transport
stream (except the system time table).

Optional (ATSC only).

Select or edit the MGT file and
set the period for the MGT.

No

Rating Region Table (RRT). The RRT defines the parental
guidelines system for different regions. The RRT is
referenced by content advisory descriptors carried in the
transport stream.

Optional (ATSC only).

Select or edit the RRT file and
set the period for the RRT.

No

System Time Table (STT). The SST provides the current time
and date.

Optional (ATSC only).

Select or edit the STT file and
set the period for the SST.

No

Extended Text Table (ETT). The ETT provides optional text
messages that can be used to describe the virtual channels
and events carried in the transport stream.

Optional (ATSC only).

Select or edit the ETT file and
set the period for the ETT.

No

Mega-frame Initialization Packet (MIP). The MIP defines the
start of the mega-frame and the transmission characteristics
of the DVB-T (terrestrial DVB) transport stream.

Optional (DVB-T Mega-frame only).

Set the MIP parameters and
add/remove transmission
power, and time and frequency
offset functions.

No

Association of Radio Industries and Businesses (ARIB). Set the periods for ARIB tables. Collapse/expand the
ARIB table hierarchy at
this icon.

Download Table (DLT)

Optional (ARIB)

Select or edit the DLT file and
set the period and PID for the
DLT.

No
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Table 3- 8: Hierarchic view icons (Cont.)

Icon Right-click toDouble-click toItem

Broadcaster Information Table (BIT)

Optional (ARIB)

Select or edit the BIT file. No

Download Control Table (DCT)

Optional (ARIB)

Select or edit the DCT file. No

Software download trigger table (SDTT)

Optional (ARIB)

Select or edit the SDTT file. No

Program. A multiplex can have up to 40 programs.

Required. Each transport stream must have at least one
program with at least one elementary stream.

Set the PCR period and pro-
gram start delay.

Collapse/expand the
hierarchy of program
items at this icon.

Video Elementary Stream. A program may have up to 5 video
elementary streams and up to 20 elementary streams of all
types.

Optional (although each program must have at least one
elementary stream).

Select a video elementary
stream or set stream parame-
ters.

Collapse/expand the
video splice icon (if
present) at this icon.

Video Elementary Stream Splice. The splice icon allows you
to insert one video splice into a video stream.

Optional.

Select a video elementary
stream or set stream parame-
ters.

No

Audio Elementary Stream. A program may have up to 10
audio elementary streams and up to 20 elementary streams
of all types.

Optional (although each program must have at least one
elementary stream).

Select an audio elementary
stream or set stream parame-
ters.

No

Data Elementary Stream. A program may have up to 10 data
elementary streams and up to 20 elementary streams of all
types.

Optional (although each program must have at least one
elementary stream).

Select a data file or set stream
parameters.

No

Entitlement Control Message. An ECM specifies the control
words and other system specific parameters used with
scrambled elementary streams.

Optional.

Select an ECM file or set condi-
tional access parameters.

No
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You can expand or collapse the hierarchy structure of several items in the
Hierarchic view by right-clicking various icons.

As shown in the following illustration, if you right-click the PSI icon, the PSI
hierarchy collapses at that icon, hiding the icons for the PSI tables that will be
carried in the transport stream. This function can be useful if you are working
with large numbers of programs that have many elementary streams. To restore
the hierarchy to its original appearance, right-click the icon a second time.

Collapsing and Expanding
the Hierarchy
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The Dynamic View

The Dynamic view shows the timing relationships of all programs in the
multiplex. You can use this view to visualize these relationships, or to help you
determine program start delay, or elementary stream initial delay values. Use
these parameters to optimize your configuration file.

To display the Dynamic view, select the Dynamic view button on the toolbar, or
select Dynamic from the View menu. The Hierarchic view window changes to
the Dynamic view.

NOTE. With the Dynamic view displayed, the rate gauge shows the actual

multiplex rate of the transport stream at the time indicated by the cursor

position.

The following figure shows the Dynamic view for a configuration file that has
five programs, each with its start time delayed one second after the end of the
previous program. The programs that make up the multiplex are shown as
narrow bars, each on its own time line. The duration, starting time, and ending
time of each program is approximated by the length and horizontal position of
the individual program bars.

Global multiplex start time Estimated stop time

Previous

Program bar

Next

Slider
bar

Timing
cursor

Cursor
position

Understanding and Using
the Dynamic View
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Global Multiplex Start Time. The global multiplex start time is the system clock
time at the beginning of the transport stream. Double-click the Multiplex icon (in
the Hierarchic view) to set this value.

Estimated Stop Time. The estimated stop time indicates the ending time for the
multiplex; that is, the time when all elementary streams for all programs have
been sent relative to the system clock plus the global multiplex start time.

Program Bar. The program bar indicates the timing relationships of the programs
relative to the entire multiplex (from global multiplex start time to estimated stop
time). Double-click a program bar to open a message window containing
program timing values. You can use this information to determine precise
program delay values for following programs.

NOTE. In some cases, the Program number message window does not display

properly. Usually this occurs when the message window, if displayed, would

overlay the gray area surrounding the slider bar at the bottom of the Dynamic

view window. Try maximizing the multiplexer application window or scrolling

the program bar for which you want to display the message window away from

the bottom of the Dynamic view window. Use the Up and Down arrow buttons to

scroll the program bars.

Move this message window by clicking and dragging the title bar. Click
anywhere else in the multiplex window to dismiss the value message window.

Timing Cursor. The timing cursor is used to determine the instantaneous
multiplex rate of your configuration file. As you move the cursor, the rate gauge,
to the left of the Dynamic view, changes to reflect the multiplex rate at the time
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represented by the cursor position. Use the following techniques to move the
timing cursor:

� Use the slider bar to drag the cursor to a desired position.

� Click on either side of the slider bar to move the cursor one second at a time.
After you have clicked in the gray area around the slider bar (you need to do
this once each time you display the Dynamic view window), you can move
the cursor using one of the following techniques:

� Press the Page Down key on your keyboard to move the cursor one
second to the right; press the Page Up key to move it one second to the
left.

� Press the Home key on your keyboard to move the cursor to the global
multiplex start time; press the End key to move it to the end of the
multiplex.

� Use the right and left arrow keys on your keyboard to move the timing
cursor 0.01 seconds at a time.

Slider Bar.Use the slider bar to drag the timing cursor across the Dynamic view
to an approximate position in the multiplex/configuration file. Use one of the
techniques described above to move the cursor in 1 s or 0.1 s increments. As you
drag the slider bar across the Dynamic view, notice how the multiplex rate gauge
responds to the position of the cursor.

Cursor Position. The cursor position indicates the position of the timing cursor in
the multiplex relative to time equal to zero. If the global multiplex start time is
set to 2 seconds, then the cursor position, when you drag it completely to the
left, is 2.00 s. You can use this indicator to help you determine what your
program start time, or elementary stream initial delay values need to be in order
to optimize your multiplex.

Previous. The Dynamic view can display up to five program bars at once. If there
are more than five programs in the multiplex, click this button to display the
program (if any) with the next lower number.

Next. If there are more than five programs in the current multiplex, click this
command button to display the program (if any) with the next higher number.
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The multiplexer lets you set three timing offsets: global multiplex start time,
program start delay, and elementary stream initial delay.

Global Multiplex Start Time. The global multiplex start time is the system clock
time at the beginning of the transport stream. Double-click the Multiplex icon (in
the Hierarchic view) to set this value.

Program Start Delay. The program start delay is the lapsed time between the start
of the multiplex and the start of the selected program. Program packets are not
transmitted until the time indicated by the program start delay.

Set the program start delay by double-clicking the Program icon in the Hierar-
chic view. Change the value in the Program Start Delay text box, and then click
OK to accept your change and close the Program Parameters dialog box. Click
Cancel at any time to close the dialog box without making any changes.

Elementary Stream Initial Delay. The elementary stream delay determines the time
between the start of the program and the start of the elementary stream in the
transport stream. The net effect of the elementary stream delay is to lengthen the
duration of the program; it does not decrease the multiplex rate, because null
packets are transmitted during the initial delay period.

Set the initial delay value by double-clicking a Video, Audio, or Data icon for
the elementary stream you want to change. Change the value in the Elementary
Stream Initial Delay text box, and then click OK to accept your change and close
the dialog box. Click Cancel at any time to close the dialog box without making
any changes.

You can see the effects of all three delays in the following Dynamic view, which
shows the timing relationships of three identical programs.

In this illustration, the global multiplex start time is 15.00 seconds, programs 2
and 3 have 15.5 second program start delays, and the video elementary stream in
program 3 has a 5 second initial delay.

Setting Timing Offsets
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The following diagram shows the relationship between packet timing delays and
multiplexer execution.

PAT, NIT, and
null packets onlyNo packets

PAT, NIT, PMT, and
null packets

no program packets

All packets

t0 t1 t2 t3

Where:

� t0 = the 27 MHz system clock (clock-on-the-wall) is zero.

� t1 = the global multiplex start time, which is set in conjunction with the total
bit rate.

� t2 = the program start delay, which is set for each program.

� t3 = the elementary stream initial delay, which is set for each video, audio, or
data elementary stream.

The Multiplexer Environment

To prevent confusion with transport stream configurations and configuration
files, this section refers to the multiplexer application settings as the environment
rather than the more familiar configuration. You can change, save, and restore
environment settings using the commands in the Options menu.

Changing Environment Options, beginning on page 3--21, describes how to
change various multiplexer environment options. Saving and Loading Multiplex-

er Environments, beginning on page 3--29, describes how to save and load saved
environment options.

Many environment options are saved when you exit the multiplexer application
and restored the next time you launch it. However, the DVB, DVB-T Mega-
frame, ISDB-S/ARIB, Terrestrial and Cable ATSC, and Dynamic SI settings
become part of the configuration file when you save it.
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The following six Options menu selections allow you to set the multiplexer
environment:

� DVB. See The DVB Environment beginning on this page.

� DVB-T. See The DVB-T Mega-frame Environment beginning on page 3--23.

� ISDB-S/ARIB. See The ISDB-S/ARIB Environment beginning on page 3--25.

� Terrestrial ATSC. See The Terrestrial and Cable ATSC Environments

beginning on page 3--26.

� Cable ATSC. See The Terrestrial and Cable ATSC Environments beginning
on page 3--26.

� Dynamic SI. See Dynamic SI beginning on page 3--27.

� Directories. See Directories beginning on page 3--28.

NOTE. If you have Conditional Access installed on your system, the Scrambling

environment option is also present. See Using Option CA: Scrambling/Condi-
tional Access beginning on page 3--89 for more information about changing this

option and how to create scrambled streams.

The DVB Environment. The DVB (Digital Video Broadcasting) option determines
whether DVB Specific Information (SI) can be added to the configuration file. SI
exists in the NIT and several other tables that are encoded into the multiplex
(transport stream). The SI tables contain information regarding services and
events carried on the current multiplex as well as different multiplexes or
different networks.

The DVB SI tables are briefly described in the following list:

� NIT (Network Information Table). The NIT provides information about the
physical network. This table is required by the multiplexer. (It appears under
the PSI icon in non-DVB mode.)

� BAT (Bouquet Association Table). The BAT provides information regarding
bouquets (collections of services marketed as a single item).

� SDT (Service Description Table). The SDT contains data describing the
services in the system, for example, the name of the services and service
provider.

� EIT (Event Information Table). The EIT contains data concerning events and
programs (a concatenation of one or more events under the control of a
broadcaster), such as event name, start time, and duration.

Changing Environment
Options
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� TDT (Time and Date Table). The TDT contains information relating to the
current time and date.

� RST (Running Status Table). The RST allows the timing status of one or
more event to be accurately and rapidly updated.

� TOT (Time Offset Table). The TOT provides UCT time and local offset
information.

To set the DVB environment, select DVB from the Options menu. When you
toggle the DVB option on, the SI icon appears in the hierarchy with the NIT
beneath it, as shown in the following illustration. This is the default DVB
Hierarchic view.

Refer to Adding and Editing SI Tables, beginning on page 3--52, for more
information about adding other SI tables to the configuration.

Toggling the DVB option off when the hierarchy contains no DVB specific
tables removes the SI icon and the NIT appears under the PSI icon. However, if
you added SI tables, the following warning message appears.

If you click Yes, the SI table references are removed from the configuration file
and the icons are removed from the Hierarchic view; however, the table files
themselves are not deleted or changed. If you click No, the multiplexer remains
in DVB mode.
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The DVB-T Mega-frame Environment. The DVB-T (DVB Terrestrial) Mega-frame
option adds a Mega-frame Initialization Packet (MIP) to the transport stream
hierarchy. The information in the MIP identifies the start of the next DVB-T
mega-frame, and it provides DVB-T mega-frame synchronization information
for terrestrial single frequency networks (SFN). The MIP also allows you to
identify various transmission parameters for the mega-frame and describe
various functions for unique transmitters in a network.

To add a MIP icon to the Hierarchic view, select DVB-T Mega-frame from the
Options menu.

Selecting the DVB-T Mega-frame environment changes the target multiplex rate
for the configuration file to 6.032 Mbps (megabits per second) when the defaults
seen in the following illustration are used. (the rate increases to 31.668 Mbps
when the code rate is 7/8 and QAM64 is selected.)
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Unlike other multiplexer items, you do not associate a MIP file with a MIP icon.
The MIP is created when you multiplex the configuration file, and you specify
MIP parameters using the MIP Parameters dialog box shown below. To access
the MIP Parameters dialog box, double-click the MIP icon in the Hierarchic
view.

To remove a MIP from the hierarchy, select DVB-T Mega-frame from the
Options menu. This removes the icon from the hierarchy, and when you create a
multiplex from the configuration file, the MIP will not be generated.

See Adding and Editing DVB-T MIP Parameters beginning on page 3--56 for
more information about MIP parameters and how to edit them.
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The ISDB-S/ARIB Environment. The ISDB--S/ARIB environment option adds an
ARIB icon (Association of Radio Industries and Businesses) to the hierarchic
view. The ARIB table icon allows you to add ARIB tables to your configuration
file.

To create an ISDB-S/ARIB environment, select the environment from the
Options menu. The following illustration shows an unedited Hierarchic view
after selecting the ISDB-S/ARIB environment option.

To remove an ISDB--S/ARIB environment file from your configuration file,
select the checked option in the Options menu. A warning message is displayed
indicating that they are ARIB tables present in the configuration file. Select Yes
to delete the tables from the configuration file and to remove the associated icons
from the hierarchy (the ARIB table files remain unchanged on your disk). Select
No to cancel the environment change.
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The Terrestrial and Cable ATSC Environments. Both the Terrestrial and Cable
ATSC environment options add a PSIP icon (Program and System Information
Protocol) and several PSIP table icons to the Hierarchic view. The PSIP table
icons allow you to associate PSIP tables with your configuration file. Selecting
an ATSC environment also changes the target multiplex rate for the configura-
tion file (19.392 Mbps for terrestrial or 38.785 Mbps for cable).

To create a terrestrial or cable ATSC environment for your configuration file,
select the appropriate environment from the Options menu. The following
illustration shows an unedited Hierarchic view after selecting the Terrestrial
ATSC environment option.

NOTE. The terrestrial and cable ATSC options are mutually exclusive; you can

use only one of the ATSC environments for a particular configuration file. You

can, however, apply the DVB environment and one of the ATSC environments to

a configuration file. PID conflicts are resolved as described in the ATSC

document Harmonization with DVB SI in the ATSC Digital Television
Standard, Doc A/58.
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To remove a terrestrial or cable ATSC environment from your configuration file,
select the checked option in the Options menu. A warning message is displayed
indicating that there are PSIP tables present in the configuration file. Select Yes
to delete the tables from the configuration file and to remove the associated icons
from the hierarchy (the PSIP table files remain unchanged on your disk). Select
No to cancel the environment change.

See Adding and Editing PSIP Tables beginning on page 3--62 for more informa-
tion about PSIP table parameters and how to edit them.

Dynamic SI.When Dynamic SI is selected, the multiplexer dynamically manages
the contents of the system date table (SDT) and event information table (EIT)
according to the time and date table (TDT) time. All SDT running status fields
are changed according to the program state (running/not running). The EIT is
managed as follows:

� Present events are removed when necessary

� Following events become Present events

� Schedule events change to Following events when necessary

If Dynamic SI is selected and you attempt to generate a multiplex from a
configuration file that does not contain a TDT, the warning message below
appears.

Select OK, add a TDT, and try to generate the multiplex again.
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Directories.You can specify directories that the multiplexer displays when you
open or associate various file types. Use the following procedure to set these
directories:

1. Select Directories from the Options menu.

The Directories Selection dialog box is displayed. The recommended
directories are shown in the following illustration.

2. Change directories by entering the complete path in the appropriate text
boxes.

3. Click OK to accept the displayed paths and close the dialog box, or click
Cancel at any time to close the dialog box without making any changes.
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Use the Save Environment, Load Environment, and Default Environment
Options menu selections to save and later restore multiplexer environments.

Save Environment. To save the current environment settings, use the following
procedure:

1. Choose Save Environment from the Options menu.

2. Use standard Windows NT techniques to save the current environment
settings using the dialog box shown below, and then click OK (or click
Cancel to close the dialog box without saving the current environment).

By default, the file receives the extension *.mcf (multiplexer configuration
file).

Load Environment. To load a saved environment (a *.mcf file), use the following
procedure:

1. Choose Load Environment from the Options menu.

If you choose Load Environment when the DVB, ISDB-S/ARIB, or ATSC
environment option is selected, a warning appears to remind you that the
current environment may not be selected in another environment (shown
here when the DVB environment is the current environment).

Saving and Loading
Multiplexer Environments
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2. Click OK to acknowledge the warning and a Window Open dialog box
appears.

3. Use standard Windows NT techniques to select the appropriate (*.mcf) file
name, and then click OK to load the settings and dismiss the dialog box, or
click Cancel to close the dialog box without making any changes.

Default Environment.Use the following procedure to load the default environ-
ment settings for the multiplexer:

1. Choose Default Environment from the Options menu.

2. In the resulting Message box, click Yes to confirm the command; click No to
cancel it.

If the currently selected environment is DVB and/or ATSC, the following
warning is displayed (shown here with DVB as the current environment).

3. Click OK to acknowledge the warning.

If SI or PSIP tables are selected in the current multiplex configuration, the
following warning message appears (shown here with DVB as the current
environment).

4. Click Yes to remove the tables from the current hierarchy; click No to restore
all defaults but the DVB or PSIP environment option, which will remain
selected.
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Table 3--9 lists the default multiplexer options settings. During normal installa-
tions of MTS300 software, a directory structure is created, which includes
directories for video, audio, and data files. The directories listed in Default
setting column of Table 3--9 indicate the recommended directory configuration
for the data types described in the Option column.

Table 3- 9: Default multiplexer settings

Option Default setting

DVB Not selected

DVB-T Mega-frame Not selected

ISDB-S/ARIB Not selected

Terrestrial ATSC Not selected

Cable ATSC Not selected

Scrambling Not selected

Dynamic SI Not selected

Directories

Output
Video Streams
Audio Streams
Data Streams
Environment Configurations
SI Tables
ECM Streams
EMM Streams
PSIP Streams

c:\mts300\cfg-trp
c:\mts300\video
c:\mts300\audio
c:\mts300\data
c:\mts300\cfg-trp
c:\mts300\cfg-trp
c:\mts300\cfg-trp
c:\mts300\cfg-trp
c:\mts300\cfg-trp
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Creating and Editing a Configuration File

To create an MPEG-2, DVB, or ATSC transport stream with the multiplexer, you
must first create a configuration file that describes the stream. A tutorial for
creating an MPEG-2 configuration file and transport stream begins on page 2--7;
a tutorial for creating a configuration file with DVB information continues on
page 2--39. The process for creating a configuration file with ATSC information
is essentially the same as the process for creating a DVB stream.

This section begins with basic techniques for creating configuration files (the
first four sections), and then provides reference material for adding items to, and
editing the parameters of, a configuration file:

� Creating or Opening a Configuration File (page 3--33)

� Environment Options (page 3--34)

� Adding and Editing Hierarchy Items (page 3--34)

� Deleting Hierarchy Items (page 3--36)

� Editing Multiplex Parameters (page 3--37)

� Editing the PSI Period (page 3--38)

� Editing the SI Period (page 3--39)

� Editing the PSIP Period (page 3--40)

� Editing the ARIB Period (page 3--40)

� Editing PAT Parameters (page 3--41)

� Editing the PMT (page 3--42)

� Editing the NIT (page 3--42)

� Adding Programs to the Multiplex (page 3--44)

� Editing Program Parameters (page 3--45)

� Adding Elementary Streams to a Program (page 3--46)

� Selecting a Video Stream (page 3--47)

� Selecting an Audio Stream (page 3--49)

� Selecting a Data Stream (page 3--51)

� Adding and Editing a Video Splice (page 3--52)

� Adding and Editing SI Tables (page 3--52)

� Adding and Editing DVB-T MIP Parameters (page 3--56)
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� Adding and Editing PSIP Tables (page 3--62)

� Adding and Editing ARIB Tables (page 3--78)

Use the following procedures to create a new configuration file or to open an
existing one:

1. To create a new configuration file, select New from the File menu or click
the New button (the left-most command button on the toolbar). The New
configuration file dialog box appears.

2. Enter an appropriate name in the File name text box and click OK; the *.cfg
extension is added automatically. The default hierarchy appears in the
Multiplex window.

1. To open an existing file, select Open from the File menu or click the Open
button. The Configuration file dialog box appears.

Creating or Opening a
Configuration File
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2. Enter or select the file name and click OK. The configuration file opens with
the hierarchy in the Multiplex window.

The default environment for a new configuration file is MPEG-2. If you intend
to create a DVB, ISDB-S/ARIB, or ATSC transport stream from a new configu-
ration file, be sure that the relevant environment option is selected in the Options
menu before adding or deleting hierarchy items. Refer to Changing Environment

Options, on page 3--21, for more information.

Use the following procedure to add items to the configuration file hierarchy:

1. Select the appropriate hierarchy icon and use one of the following tech-
niques:

� Click the + (Add) button on the toolbar.

� Choose Add from the Edit menu.

� Press the INSERT key on your keyboard.

If there are multiple items that can be added to the item you have selected, a
selection dialog box is displayed (the dialog box shown is the one displayed
when you add elementary streams to a Program icon).

2. Select the item you want to add from the dialog box, and then click OK to
accept the selection and return to the Hierarchic view.

You can select Cancel at any time to close the selection dialog boxes without
adding items to the hierarchy.

An icon for the item you add appears subordinate to the icon you selected.

Table 3--10 on page 3--35 describes the use of the multiplexer Add command for
each item in the Hierarchic view to which you can add items.

Environment Options

Adding and Editing
Hierarchy Items
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Table 3- 10: Using the Add command

Item icon Represents Use the Add command to

Multiplex Add an empty program to the end of the hierarchy.

PSI information Add a TSDT file to the configuration.

Available for all environment options.

If you have Conditional Access (Option CA) installed on
your system, you can also add a CAT to the configuration.
See Scrambling/Conditional Access on page 3--89 for more
information about adding items when Option CA is
installed.

Service information Add DVB files to the configuration file.

Available only when the DVB environment option is
selected.

PSIP information Add ATSC PSIP files to the configuration.

Available only when one of ATSC environment options are
selected.

ARIB information Add ISDB-S/ARIB files to the configuration.

Available only when the ISDB-S/ARIB environment option
is selected.

Program Add an elementary stream to the selected program.

Video elementary
stream

Splice another video stream to the existing stream. The
multiplex rate of the added stream can be no higher than
that of the existing stream.

Available for all environment options.

NOTE. The Add command is not available when other icons are selected.

You can use the Add and Delete command buttons with the selected item if the +
or – symbol on the button is highlighted in blue.

Add/Delete Add only NeitherDelete only
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You can begin editing the contents or characteristics of most items by
double-clicking on the icon. Table and stream file associations and other
parameters are edited with the multiplexer. Table files themselves are edited
using one of the table editors, which you can start from the multiplexer when
necessary. Editing that can be done in the multiplexer is explained in this
section; table editing using the table editors is discussed in Using the DVB and

PSIP Table Editors, beginning on page 3--93.

The Delete command on the Edit menu deletes the selected item and any items
subordinate to it from the configuration file and removes the associated icons
from the Hierarchic view. For example, if you delete a program, all the
associated elementary streams are also deleted. The Delete command in the Edit
menu is equivalent to the – (Delete) button on the toolbar.

You can delete only the following:

� Programs (check first if it has elementary streams)

� Elementary streams: Video, Audio, and Data

� PSI tables: TSDT, CAT, and EMM. The PSI icon itself cannot be deleted.

� SI tables: EIT, SDT, BAT, TDT, TOT, RST, and NIT (replaced with the
default NIT). The SI icon itself cannot be deleted; it represents the DVB
environment. If you want to change the multiplexer environment, refer to
Changing Environment Options, on page 3--21.

� PSIP tables: MGT, VCT, SST, RRT, EIT, and ETT. The PSIP icon itself
cannot be deleted; it represents the PSIP environment. If you want to change
the multiplexer environment, refer to Changing Environment Options, on
page 3--21.

� ARIB tables: DCT, DLT, BIT, SIT, DIT, and SDTT. The ARIB icon itself
cannot be deleted; it represents the ISDB-S/ARIB environment. If you want
to change the multiplexer environment, refer to Changing Environment

Options, on page 3--21.

All multiplexer configuration files require a NIT file (this is a multiplexer
requirement, not an MPEG or DVB requirement). If you delete a NIT icon that is
associated with a NIT file other than the default, the icon remains in the
hierarchy and becomes associated with the Default.NIT file.

If you choose to delete a program and it is not empty (it has elementary streams),
a dialog box appears requesting confirmation before the multiplexer application
will delete the program. Click Yes to delete the program and the associated
elementary streams. Click No to close the warning box without making any
changes.

Deleting Hierarchy Items
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When you delete a program, its PID is automatically removed from the PAT and
the rate gauge is updated.

Double-click the MUX icon to open the Multiplex Parameters dialog box shown
below. Edit the multiplex parameters as required.

Select or enter the appropriate multiplex rate and enter the global multiplex start
time, if appropriate. Click OK to accept the values and dismiss the dialog box.

The Multiplex Rate is the number shown at the top of the multiplexer rate gauge.
This value defines the data rate for the generator. You can either define your own
multiplex rate or use one of the predefined G703 frequencies: 8.448 MHz or
34.368 MHz. The default value is 10 Mbps.

NOTE. If you are creating a transport stream file for a G.703 port, you MUST

select either the 8.448 or the 34.368 MHz option for the correct G.703 rate.

Editing Multiplex
Parameters
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The global multiplex start time is the system clock time at the beginning of the
transport stream. You can see the effect of changing the start time in the
following Dynamic view illustration.

Multiplex start time

Use the following procedure to change the period for the PMT, PAT, and/or CAT
(if Option CA is installed):

1. Double-click the PSI icon to open the PSI Period dialog box shown below
(shown with Option CA installed).

2. Enter the appropriate period for the PAT, PMT, TSDT, and CAT.

3. Click OK to accept the value(s) and close the dialog box, or click Cancel to
close the dialog box without making any changes.

MPEG-2 requires a PSI period of 0.1 s (10 times per second) or less. However,
you can set this value out of specification in order to thoroughly test your
receiving system. Remember that if you make the period too small, you will
have less of the available multiplex rate left in the transport stream for other,
perhaps more important information.

Editing the PSI Period
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Use the following procedure to edit the period(s) for the DVB-SI tables for your
configuration file:

1. Double-click the SI icon to open the DVB Files Selection dialog box shown
in the following illustration. (DVB SI tables already included in the
configuration file are indicated in the table file name field.)

2. For each table type, change the period in the text boxes provided. In order to
modify the TDT period, you must first select the TDT check box.

3. Click OK to accept any changes you have made and close the dialog box, or
click Cancel at any time to close the dialog box without making any
changes.

Editing the SI Period
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Use the following procedure to change PSIP table periods:

1. Double-click the PSIP icon to open the PSIP Period dialog box shown
below.

2. For each table type, make the changes you want in the text boxes provided.

3. Click OK to accept the changes and close the dialog box. Select Cancel at
any time to close the dialog box without making any changes to the PSIP
period(s).

Use the following procedure to change ARIB table periods:

1. Double-click the ARIB icon to open the PSIP Period dialog box shown
below.

Editing the PSIP Period

Editing the ARIB Period
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2. For each table type, make the changes you want in the text boxes provided.

3. Click OK to accept the changes and close the dialog box. Select Cancel at
any time to close the dialog box without making any changes to the ARIB
table period(s).

Use the following procedure to change the transport stream ID and the PID
values for the NIT and program map tables:

1. Double-click the PAT icon to open the Program Association Table dialog
box shown below.

2. To change the transport stream ID, enter the new value in the text box.

NOTE. The multiplexer automatically assigns PIDs when you add programs and

tables. You need not change program PIDs unless the intended stream use
requires it. Many table PIDs are specified in the appropriate MPEG, DVB, or

ATSC standard. Do not change a table PID unless you know the consequences

and have a good reason for doing so.

3. To change the PID of a PMT section, highlight the entry in the PID Values
dialog box and then click Modify.

4. Enter the desired PID number in the resulting PID Modification dialog box,
and then click OK to close the dialog box.

5. Click OK to accept changes made to the transport stream ID and/or the PID
values. Click Cancel at any time to close the dialog box without making any
changes.

Editing PAT Parameters
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Double-click on the PMT icon to start the DVB Table Editor with the *.PMT
file open for editing (the application creates the *.PMT file if it does not already
exist).

Refer to Using the DVB and PSIP Table Editors, beginning on page 3--93, for
complete instructions on editing the PMT. The section describes how to edit the
PMT from the PSIP table editor perspective, but the information applies to the
DVB Table Editor as well.

To select and edit a network information table file, use the following procedure:

1. Double-click the NIT icon to open the NIT dialog box.

Editing the PMT

Editing the NIT
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If you have not already associated a *.NIT file with the NIT icon, the table name
field will contain only the word default. You must select a file before you can
edit the Network Information Table.

2. Click Browse in the NIT dialog box, and the Selection SI File dialog box is
displayed.

3. Select DEFAULT.NIT or another file to use as a template, and then click
OK.

When you complete the file selection, the file selection dialog box closes and
leaves the NIT dialog box open. The name of the opened file is in the table
name field.

4. Click Edit to start the DVB Table Editor with the selected *.NIT file open
for editing.

5. Using the table editor, save the table under a new, unique name (usually the
name of the configuration file); the table automatically receives the *.NIT
filename extension when you save it.

6. Edit the table as necessary. Refer to Using the DVB and PSIP Table Editors,
beginning on page 3--93, for complete instructions on editing DVB table
files.
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7. Save the file again and exit the table editor.

After you exit the table editor, the NIT dialog box remains in front of the
multiplexer application window with the original file name (usually
DEFAULT.NIT) in the table name box.

8. Click Browse to open the Selection SI Tables dialog box again and select the
newly edited and saved table.

9. If appropriate, change the period (the time between occurrences of the NIT in
the transport stream) from within the NIT dialog box.

10. Click OK to accept the NIT file and its period setting and to close the dialog
box, or click Cancel to close the dialog box without making any changes to
the configuration file (the NIT file will maintain whatever changes you made
to it from within the table editor).

The name of the table file and the period appear to the right of the NIT icon
in the multiplexer Hierarchic view.

To add a program to the hierarchy, select theMUX (multiplex) icon, and then
click the + (Add) button (or press INSERT on the keyboard). A new program icon
is added to the end of the configuration hierarchy. A transport stream can contain
up to 20 programs.

Adding a program automatically adds a section to the program map table and
updates the program allocation table to reference the PID of the new section.
Once you have added a program, edit program parameters and add elementary
streams, as necessary.

Adding Programs to the
Multiplex.
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Use the following procedure to edit the program clock reference (PCR) period
and/or the program start delay:

1. Double-click on the Program icon to open the Program Parameters dialog
box.

2. Change the PCR period as needed in the text box provided.

The PCR period determines the frequency of program clock references in the
program stream. MPEG-2 requires at least 10 clock references per second,
for a maximum of 0.1 seconds between PCR signals. If you enter a PCR
period over 0.1 seconds, you will receive a warning when you close the
Program Parameters dialog box.

NOTE. The multiplexer encodes the PCR by default with the first elementary

stream you add to the program. You can, however, change the PID of either PCR

or elementary stream when you edit the PMT (see page 3--42 for instructions). If

the PCR is not encoded with one of the elementary streams, it will be in its own

packets.

3. Change the program start delay as needed in the text box provided.

Program start delay determines the start time of the program relative to the
beginning of the transport stream. Select the Dynamic view to see the effect of
program start delay. (See The Dynamic View beginning on page 3--16 for more
information about viewing the effects of changing the program start delay.)

Editing Program
Parameters



Using the Multiplexer

3- 46 MTS300 Stream Creation Applications User Manual

Adding an elementary stream to a program is a two-step process:

� Add a video, audio, data, or ECM (if Option CA is installed) item icon to the
hierarchy (described in this section).

� Associate a file (of the appropriate type) with the icon (described in the next
three sections).

1. To add an icon to the program, select the PROG icon and click the + (Add)
button (or press INSERT on the keyboard).

The Stream to add dialog box opens (shown here with Option CA installed).

2. Select the type of stream that you want to add and click OK, or click Cancel

to close the dialog box without making any changes.

The selected icon appears in the hierarchy as a component of the program. Each
new stream icon is added to the end of the program hierarchy. Elementary
streams are not sorted by type.

You must associate a stream file with each new icon. Refer to Selecting a Video

Stream (page 3--47), Selecting an Audio Stream (page 3--49), Selecting a Data

Stream (page 3--51) or Creating a Stream with Scrambled Components

(page 3--90).

CAUTION. Although MPEG-2 transport streams allow elementary streams with

encoding changes between field and frame, the multiplexer does not support

such changes.

Adding Elementary
Streams to a Program



Using the Multiplexer

MTS300 Stream Creation Applications User Manual 3- 47

Use the following procedure to associate a video elementary stream file with a
Video icon in the the program hierarchy:

1. Double-click on the Video icon to open the Video Stream dialog box.

Using this dialog box, you can identify a video stream file to associate with
the program icon. You can also set several parameters that determine how the
multiplexer encodes the stream.

2. Click Browse to open the Video Stream Selection box.

3. Use standard Window NT techniques to find and select the video elementary
stream file you want to include in the configuration file. You can select a file
with any file extension, but the multiplexer application will not accept the
file unless it has the correct video header information.

4. Click OK to return to the Video Stream dialog box.

The multiplexer extracts information from the header of the elementary stream
file and displays the extracted values in the Video Stream dialog box. The
parameters you can edit are described in the following list.

Selecting a Video Stream
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� The Elementary Stream Rate is the rate at which the elementary stream is to
be multiplexed into the transport stream, after compression. The default
value is the rate specified in the elementary stream header. This is the
recommended value. You can change the rate to meet your specific require-
ments, as long as you do not intend to decode the transport stream in real
time. A rate that is too slow will not give the decoder all the information
required to decode in real time.

� The PES Packet Size can range from 100 to 64000 bytes. The default value
for MPEG-2 and DVB is 2048 bytes; if you have one of the ATSC environ-
ment options selected, the default is zero. If you specify a packet size of 0,
the multiplexer will put the complete video picture in one PES packet.

� The Elementary Stream Initial Delay determines when the elementary stream
begins appearing in the transport stream. The delay is relative to the start of
the program, which can have its own delay relative to the start of the
transport stream (refer to Editing Program Parameters, on page 3--45, for
more information). Delaying the start of the elementary stream extends
program length by an equal amount of time but does not reduce the fraction
of multiplex rate used during the delay.

NOTE. The multiplex rate is not reduced during an elementary stream initial

delay. Null packets fill in to replace elementary stream packets in the time

between the start of the program and the start of the elementary stream.

� Offset DTS is the time interval between the DTS (decode time stamp) and
the arrival time of the access unit.

� Sequence Header, when selected, causes the multiplexer to ignore any video
stream data before the first sequence header. If you leave Sequence Header
unchecked, the multiplexer inserts the entire video stream into the multiplex.

� Scrambling, when selected, introduces encryption provided by Option CA, if
installed. See Creating a Stream with Scrambled Components beginning on
page 3--90 for additional information about scrambling elementary streams.

5. After you select the video stream file and set the stream parameters, click
OK to confirm the choices and close the dialog box. Information about the
selected file appears to the right of the video icon as shown below.
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Use the following procedure to associate an audio elementary stream file with an
Audio icon in the the program hierarchy:

1. Double-click on the Audio icon to open the Audio Stream dialog box.

Using this dialog box, you can identify an audio stream file to associate with
the program icon. You can also set several parameters that determine how the
multiplexer encodes the stream.

2. Click Browse to open the Audio Stream Selection box.

3. Use standard Window NT techniques to find and select the elementary
stream file you want to include in the configuration file. You can select a file
with any file extension, but the multiplexer application will not accept the
file unless it has the correct header information.

4. Click OK to return to Audio Stream dialog box.

Selecting an Audio Stream
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The multiplexer extracts information from the header of the elementary stream,
including the audio file type (MPEG-2, AC-3, or AAC), and displays the
extracted values in the Audio Stream dialog box. The parameters you can edit are
described in the following list.

� The Elementary Stream Rate is the rate at which the elementary stream is to
be multiplexed into the transport stream. The default value is the rate
specified in the elementary stream header. This is the recommended value.
You can change the rate to meet your specific requirements as long as you do
not intend to decode the transport stream in real time. A rate that is too slow
will not give the decoder all the information required to decode in real time.

� The PES Packet Size can range from 100 to 64000 bytes.

� The Elementary Stream Initial Delay determines when the elementary stream
begins appearing in the transport stream. The delay is relative to the start of
the program, which can have its own delay relative to the start of the
transport stream (refer to Editing Program Parameters, on page 3--45, for
more information). Delaying the start of the elementary stream extends
program length by an equal amount of time, but does not reduce the fraction
of multiplex rate used during the delay.

� Offset PTS is the interval between the PTS (presentation time stamp) and
arrival time.

� Scrambling, when selected, introduces encryption provided by Option CA, if
installed. See Creating a Stream with Scrambled Components beginning on
page 3--90 for additional information about scrambling elementary streams.

5. After you select the audio stream file and set the stream parameters, click
OK to confirm the choices and close the dialog box. Information about the
selected file appears to the right of the audio icon as shown below.

The Audio icon indicates whether the file chosen is an MPEG encoded audio
stream, an AC-3 stream, or an AAC audio stream.
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Use the following procedure to associate an audio elementary stream file with an
Audio icon in the the program hierarchy:

1. Double-click on the Data icon to open the Data Stream dialog box.

Using the Data Stream dialog box, you can identify a data stream file to
associate with the program icon. You can also set parameters that determine
how the multiplexer encodes the stream.

2. Click Browse to open the Data Stream Selection box.

3. Use standard Window NT techniques to find and select the file you want to
include in the configuration file.

4. Click OK to return to Data Stream dialog box.

You can edit the following parameters:

� Rate determines how quickly the data is multiplexed into the transport
stream. The default value is 0.1 Mbps.

� The Initial Delay determines when the data begins appearing in the transport
stream. The delay is relative to the start of the program and works in the
same way as the initial delays for the video and audio elementary streams.

� Use the Data Format selections to specify the transport stream data format:

� Select Without format if the data is not in PES or section format.

� Select PES format if the data is in PES format.

� Select Section if the data is in section format.

� Select Loop sections if the data is in section format and the sections
should be looped.

Selecting a Data Stream
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5. After you select the data stream file and set the stream parameters, click OK

to confirm the choices and close the dialog box. Information about the
selected file appears to the right of the data icon.

To add a video splice to the multiplex, use the following technique:

� Select the video icon for which you want to create the splice, and then click
the + button on the toolbar.

The splice icon is added to the hierarchy immediately below the video icon you
selected. Only one splice can be added to a given video icon.

The procedure for selecting and editing video splice parameters is identical to the
procedure used for selecting and editing a video elementary stream (see Selecting
a Video Stream on page 3--47 for more information).

The SI icon is present in the multiplexer hierarchy when DVB is selected in the
Options menu.

To add and edit SI tables one at a time, use the following procedure:

1. Select the SI icon and click the + (Add) button (or press the INSERT key on
your keyboard). The Selection of a SI Table dialog box is displayed.

2. Select the SI table type you want to add, and then select OK, or select
Cancel to return to the Hierarchic view with making changes to the
configuration file.

Adding and Editing a
Video Splice

Adding and Editing SI
Tables
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If you select OK, a dialog box similar to the one shown in the following
illustration is displayed. This dialog box allows you to associate a specific
DVB SI table file with your configuration file (see step 3), to set the period
for the selected table (see step 5), and to start the DVB Table Editor with the
selected table file displayed (see step 6).

You can click Cancel any time this dialog box is displayed to close the
dialog box without adding items to the hierarchy or changing the configura-
tion file.

3. To associate a DVB SI file with your configuration file, click Browse.

4. Navigate to and select the template file you want using the displayed dialog
box, and then select OK. (The template files are named Default.xxx.) You
can select only files of the type you are trying to add to the hierarchy.

NOTE. During normal installation of the multiplexer, various table template files

are installed in the MTS300\CFG-TRP directory. These files are provided so that

you can start the table editor from the multiplexer. (You need to have a minimally

valid file with which to start the table editor from within the multiplexer.)

5. To change the period of the selected table, edit the Period text box.

6. To edit the DVB table file selected in the file name field, click Edit. The
DVB table editor will start with the selected table file displayed. If you open
a template file, be sure to save it in the table editor using a different file
name.

Refer to Using the DVB and PSIP Table Editors, beginning on page 3--93,
for complete instructions on editing SI tables. The section describes how to
edit tables and table elements using the PSIP table editor for the examples,
but the information applies to the DVB table editor as well.



Using the Multiplexer

3- 54 MTS300 Stream Creation Applications User Manual

NOTE. Be sure that you exit the table editor before you continue to use the

multiplexer.

7. After you edit and save the table, exit the table editor; you are returned to the
table dialog box.

8. Click Browse and select the new table file you just created.

9. After you have made all the changes you want using the table dialog box
shown in the previous illustration, click OK to accept the changes and close
the dialog box, or click Cancel to close the dialog box without making any
changes.

An icon for the table type is added to the Hierarchic view, and the configura-
tion file is updated with the changes you have made.

Time and Date Table. Time and Date Table (TDT) parameters are used to specify
the current time and date and start time of the transport stream; the TDT is
managed by the multiplexer and no files are associated to the TDT icon in the SI
hierarchy.

1. To include a TDT in a configuration file, select the SI icon and click the +
(Add) button.

2. Click TDT in the Selection of a SI Table dialog box, and then click OK. The
Time and Date Table dialog box is displayed with the start date and time and
default period text boxes updated. You can edit these fields as necessary.

3. Click OK to accept the values in the text boxes, close the dialog box, and
add a TDT icon to the SI hierarchy.

Once added to the hierarchy, you can display this dialog box to edit the TDT
values by double-clicking the TDT icon.
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Adding Multiple SI Tables.You can also add and edit multiple SI tables at once
using the following procedure:

1. Double-click the SI icon to open the DVB File Selection dialog box. Table
files that are already associated to the configuration file are indicated in the
table file name fields, otherwise, default or none is indicated in the name
field.

Table file
name field

2. Click Browse to select a table template file for one or more table types.

3. Click Edit next to the table file you want to modify. The DVB Table Editor
will open with the selected DVB SI table displayed.

NOTE. If the table file you are editing with the table editor is a template file, be
sure to save the table file under a new name (usually the name of the configura-

tion file).

4. After you edit and save the table, exit the table editor; you are returned to the
table dialog box.

5. Click Browse and select the new table file you just created.
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6. Change the table period if necessary. You may wish to set the period much
higher than the standard 0.5 seconds to create a transport stream that
thoroughly exercises the MPEG-2 receiving equipment.

7. Click OK to accept your changes and close the DVB Files Selection dialog
box, or click Cancel to close the dialog box without making any changes.

A tutorial for creating a configuration file with DVB information begins on
page 2--39. The tutorial contains detailed instructions for adding SI table files.
For more complete information about editing table files, refer to Using the DVB

and PSIP Table Editors, which begins on page 3--93.

After you add a table, you can double-click the table icon to open a table dialog
box and select a new table file, edit the table, or set the table period.

The MIP (Mega-frame Initialization Packet) icon is present in the multiplexer
hierarchy only when the DVB-T Mega-frame option is selected in the Options
menu (appears with a check mark next to it).

NOTE. The DVB-T Mega-frame option can be selected with or without the DVB

environment option selected. However, the DVB-T Mega-frame option does not

add DVB tables to the configuration file.

The MIP identifies the start of the next DVB-T mega-frame, and it provides
mega-frame synchronization information for terrestrial single frequency
networks (SFN). The MIP also allows you to identify various transmission
parameters for the mega-frame, and allows you to specify parameters for unique
transmitters in a network.

To insert a Mega-frame Initialization Packet (MIP) into the hierarchy and specify
MIP parameters, use the procedures provided in this section.

Adding and Editing DVB-T
MIP Parameters
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NOTE. When you add a MIP to the configuration file and start to associate

elementary stream files to the program icons, you may see a Multiplex Overflow

warning. If so, change one or more of the following multiplex parameters:

� The constellation type (see Table 3--11 beginning on page 3--58)

� The code rate (see Table 3--11 beginning on page 3--58)

� The guard interval (see Table 3--11 beginning on page 3--58)

� The target multiplex rate (see Editing Multiplex Parameters beginning on

page 3--37)

� The start time offset of one or more programs (see Editing Program
Parameters beginning on page 3--45)

1. To add a MIP icon to the Hierarchic view, select DVB-T Mega-frame from
the Options menu.

The DVB-T Mega-frame option will now appear with a check next to it in
the Options menu, and the MIP icon is inserted below the SI icon and any
DVB-SI tables present in the hierarchy.

2. To edit MIP parameters, double-click the MIP icon using the MIP Parame-
ters dialog box shown in the following illustration.

Press Cancel at any time to close the dialog box without making any
changes to the MIP.
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The values that are displayed in the MIP Parameters dialog box are different
for the following two scenarios:

� Default.NIT is referenced in the configuration file, or the referenced NIT
does not include a terrestrial delivery descriptor.

� The referenced NIT includes a terrestrial delivery descriptor.

Table 3--11 indicates the default values for the MIP parameters and the
information that is extracted from the NIT for these two scenarios.

Table 3- 11: MIP parameters

Parameter

Terrestrial delivery
descriptor not
present in the NIT

Terrestrial delivery
descriptor present
in the NIT

Description of parameter
(range of accepted values)

Periodic Selected Selected If selected, the MIP is
inserted into the transport
stream periodically, and the
value of the MIP pointer is
not time varying.

Maximum
delay

100000 (in 100 ns) 100000 (in 100 ns) Specifies the maximum
delay beyond which the
mega-frame is considered
invalid.
(0 to 999999 (in 100 ns))

Mode 2 k Extracted from NIT Transmission mode of the
mega-frame identified by the
MIP.
(2 k or 8 k)

Bandwidth 7 MHz Extracted from NIT Specifies the channel
spacing for re-multiplexed
bitstream.
(7 or 8 MHz)

Priority High High Indicates whether the
associated simulcast
bitstream is a low bitrate
(high priority) or high bitrate
(low priority) stream.

Constellation QPSK Extracted from NIT Identifies the type of modula-
tion used by the associated
bitstream.
(QPSK or 16/64 QAM)

Hierarchy Non hierarchical Extracted from NIT Specifies the transmission
mode use by the associated
bitstream.
(Non hierarchical; or
α (constellation ratio) = 1, 2,
or 4)
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Table 3- 11: MIP parameters (Cont.)

Parameter
Description of parameter
(range of accepted values)

Terrestrial delivery
descriptor present
in the NIT

Terrestrial delivery
descriptor not
present in the NIT

Code rate 1/2 Extracted from NIT Specifies the code rate used
for the transmission environ-
ment of the associated
bitstream.
(1/2, 2/3, 3/4, 5/6, or 7/8)

Guard interval 1/32 Extracted from NIT Specifies the guard interval
of the associated bitstream
as a proportion of the useful
interval.
(1/4, 1/8, 1/16, 1/32)

Functions No functions No functions See Table 3--12.

3. Make the selections and changes appropriate for your environment.

4. To add functions to the MIP (such as power and frequency offset) for a
specific transmitter in the network, or to all transmitters in a network, click
Add in the Functions group at the bottom of the dialog box. The Add
Functions dialog box is displayed.

5. To change a value for one of the defined MIP functions, check the option
box next to the function name, and change the value in the text box as
appropriate.
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Descriptions of the MIP functions and the range of possible values for the
functions are provided in Table 3--12.

Table 3- 12: MIP functions

Function Range of accepted values Description of function

Tx identifier 0 to 65535 A 16 bit identifier for a specific trans-
mitter. The functions added are
applied to the transmitter specified in
this text box. The value 0 (0x000) is
reserved as the identifier for all
transmitters on the network.

Time offset – 32768 to 32767 (in 100 ns
increments)

The transmitted time offset of the
mega-frame.

Frequency offset – 8388608 to 8388607 (Hz) The frequency offset relative to the
center frequency of the RF channel in
use.

Power 0 to 65535 (dBm) The power of the transmitter is defined
as the effective radiated power (ERP).

Private data User defined hexadecimal values. You can use this function to send
private data to the specified trans-
mitter in the MIP.

NOTE. You can add as many functions as you want provided the size of the MIP

does not exceed 188 bytes.

6. To accept the changes you have made in the Add Functions dialog box and
close it, select OK. The functions you have added appear in the Functions
selection box. Click Cancel at any time to close the dialog box without
adding functions to the MIP.
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7. To remove a function, highlight it as indicated in the following illustration,
and then click Remove.

8. To accept your changes and return to the Hierarchic view, click OK. Click
Cancel at any time to close the MIP Parameters dialog box without making
changes to the MIP parameters.

To remove a MIP from the configuration file, select DVB-T Mega-frame from
the Options menu. This will remove the check mark next to the menu item,
remove the icon from the hierarchy, and the MIP will not be generated when you
create a multiplex from the configuration file.
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The PSIP icon is present in the multiplexer hierarchy when either the Terrestrial
ATSC or Cable ATSC option is selected in the Options menu. To add PSIP
information to your configuration file, select the appropriate ATSC menu item
from the Options menu (Terrestrial ATSC or Cable ATSC).

The following illustration shows the default Hierarchic view when the Terrestrial
ATSC option is selected.

Adding and Editing PSIP
Tables
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The following list describes the PSIP icons added to the hierarchy when you
select an ATSC environment option:

� MGT (Master Guide Table). This icon is added to the hierarchy when you
select either terrestrial or cable environment options. The MGT defines the
types of PSIP tables included in the multiplex, and the PIDs for each table,
except for the system time table, which is not managed by the MGT.

� VCT (Virtual Channel Table). This icon is added to the hierarchy when you
select either terrestrial or cable environment options. The VCT defines the
programs included in the multiplex. Depending on whether you selected the
terrestrial or cable environment option, you need to associate the correct
table type to the VCT icon: Terrestrial Virtual Channel Table (TVCT), or
Cable Virtual Channel Table (CVCT).

� RRT (Rating Region Table). This icon is added to the hierarchy when you
select either terrestrial or cable environment options. The RRT defines the
parental guidelines system for different regions. The RRT is referenced by
content advisory descriptors carried in the transport stream.

� STT (System Time Table). This icon is added to the hierarchy when you
select either terrestrial or cable environment options. The SST provides
current time and date information for the multiplex.

� EIT (Event Information Table). This icon is added to the hierarchy only
when you select the terrestrial environment option, although, you can add it
to the cable environment. The EIT contains information about events on the
defined virtual channels carried in the multiplex. An event can be a program,
data broadcasting session, or other information. The descriptive information
carried in the EIT can include event names, start times, and durations. The
EIT can also reference programs carried by other multiplexes or networks.

� ETT (Extended Text Table). The ETT is an optional table for both terrestrial
and cable ATSC environments, and the ETT icon is not initially added to the
multiplex hierarchy when you select an ATSC environment option. The ETT
contains extended text message streams (ETMs) and is used to provide
detailed descriptions of virtual channels and events.

NOTE. During normal installation of the multiplexer, various table template files

are installed in the MTS300\CFG-TRP directory. These files are provided so that

you can start the PSIP table editor from the multiplexer. (You need to have a

minimally valid file with which to start the table editor from within the multi-

plexer.)
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To add PSIP table icons to the hierarchy and edit certain configuration file
parameters use the following procedure:

1. Select the PSIP icon, and then select + (the Add button). The following
dialog box is displayed.

2. Select the appropriate PSIP table option, and then click OK, or click Cancel

to close the dialog box without making any changes to the hierarchy.

After you select OK, a dialog box similar to the one shown in the following
illustration is displayed. This dialog box allows you to associate a specific
PSIP table file with your configuration file (see step 3), to start the PSIP
table editor with the selected file displayed (see step 5), and to set the period
for the selected PSIP table (see step 8).

File name field

You can click Cancel any time this dialog box is displayed to close the
dialog box without adding items to the hierarchy or changing the configura-
tion file.

If you are working with a new configuration file, the table file name in the
file name field is default, or none. To associate a PSIP file with a table icon
in the Hierarchic view, continue with the procedure:

3. From the table dialog box, click Browse.

4. Navigate to and select the appropriate table template file (for instance
Atsc.Vct for a virtual channel table file), and then select OK. You can select
only files of the type you are trying to add to the hierarchy.
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5. To edit the PSIP table file indicated in the file name field, click Edit. The
PSIP Table Editor will start with the selected table file displayed.

6. From the table editor, save the table file under a new name (usually the name
of the configuration file).

NOTE. Be sure that you exit the PSIP Table Editor before you continue to use the

Multiplexer.

7. Click Browse and select the table file you just created.

8. To change the period of the selected table, edit the Period text box.

9. After you have made all the changes you want using the dialog box shown in
the previous illustration, click OK.

An icon for the table type is added to the Hierarchic view, and the configura-
tion file is updated with the changes you have made.

See Using the DVB and PSIP Table Editors beginning on page 3--93 for more
information about creating and editing PSIP tables. See Associating EIT Table

Files on page 3--68, and Adding ETT Instances on page 3--76, for the procedures
to add and edit PSIP EIT and ETT tables using the multiplexer.
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Setting PSIP Table Periods. To set the periods for the MGT, VCT, RRT, and STT,
use the following procedure:

1. Double-click the PSIP icon in the Hierarchic View.

2. Change the periods as appropriate and then click OK to accept your changes
and close the dialog box, or click Cancel at any time to close the dialog box
without making any changes to the PSIP periods.

PSIP EIT Tables. In the ATSC environment, Event Information Tables (EIT) are
used to describe events, such as programs or data broadcast sessions, for the
virtual channels described in the Virtual Channel Table (VCT).

In order to create a valid ATSC transport stream, you need to multiplex at least
four EIT files along with the other program data. Each EIT file specifies events
that occur during sequential, three-hour periods (EIT periods are called time
spans and are designated as EIT-k, where k is a positive integer between 0 and
127). The four required EIT time spans are EIT-0, EIT-1, EIT-2, and EIT-3.

Channels, events, and extended text messages (ETM) are managed using the
following VCT, EIT, and ETT elements:

� Source IDs, which are specified in the channel element of the VCT and in
the EIT.

� Event IDs, which are specified in the event element of the EIT.

� ETM IDs, which are specified in the ETT.

See Using the PSIP Table Editor Global View Window beginning on page 3--136
for more information about how PSIP tables are managed.
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EIT Dialog Box.When you select an ATSC environment, an EIT icon is added to
the PSIP hierarchy. (See the illustration on page 3--62.)

Double-click the EIT icon in the PSIP hierarchy to display the EIT dialog box.

NOTE. Extended Text Tables (ETT) are optional, and an ETT icon is not added to

the PSIP hierarchy when an ATSC environment is selected. You can use the

procedures described in this section to associate, add, edit, and delete ETT

instances after the ETT icon has been added to the PSIP hierarchy. See Adding
ETT Instances beginning on page 3--76 for more information about adding the

ETT icon to the configuration file.

EIT time span

EIT selection box

The EIT dialog box lists the EIT file associated with each EIT-k (each EIT-k
represents a three hour time span, and the selection box includes four EIT
instances by default). The selection box indicates the file name, PID, and
table type (time span) for each EIT instance included in the configuration
file. The word none appears next to EIT-k instances without an associated
EIT file.
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You can modify, delete, or add EIT instances using one of the command
buttons described in the following list:

� Modify. The Modify command button opens another EIT dialog box
with the selected EIT file name shown in the file name field. Use this
button to associate an EIT file with an EIT instance. (See step 2 below.)
Double-clicking an EIT instance in the selection box has the same effect.

� Modify All. The Modify All command button opens the PSIP table
editor with all of the EIT files shown in the EIT selection box open and
the first time span displayed (EIT-0). Any changes to the EIT files that
you save in the table editor will be applied to the configuration file after
you apply the changes in the EIT dialog box.

� Remove. The Remove command button deletes the selected EIT instance
from the configuration file. (The file remains unchanged on your system
disk.)

� Add. The Add command button opens the Add EIT dialog box (see
page 3--71). Using this dialog box you can add another EIT time span to
the configuration file, and specify the PID and table type value for the
new EIT instance. You cannot add a time span that is already specified in
the selection box.

� Add All. The Add All command button opens the Add All EIT dialog
box (see page 3--73). Using this dialog box you can add all EIT time
spans at once, provided the file names follow the naming restrictions for
EIT files.

� OK. This command button confirms the changes you have made and
closes the dialog box.

� Cancel. This command button closes the dialog box without making any
changes to the configuration file.

Associating EIT Table Files. To associate an EIT file with an EIT instance, use the
following procedure:

1. Double-click the EIT icon in the PSIP hierarchy to display the EIT dialog
box.

2. In the EIT selection box, highlight an EIT instance and click Modify. The
following EIT dialog box is displayed. If no EIT file is currently associated
with the EIT-k instance, none is displayed in the file name field.
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File name field

3. Click Browse in the EIT dialog box. This opens the Selection PSIP File
dialog box.

4. Using standard Windows techniques, locate and select Atsc_000.EIT, and
then click OK. This returns you to the EIT dialog box and Atsc_000.EIT is
showing in the file name field.

5. Click Edit to open the Atsc_000.EIT template file in the PSIP table editor.

The EIT template files for the PSIP table editor do not include sections,
events, titles, descriptors, or other EIT elements. You need to modify the
templates files to create a set of EIT that are valid for your configuration file.

6. Modify the file as necessary, and then select Save As from the File menu.

7. Rename the file as abc...nnn.EIT, where abc... are the characters used in the
file name (usually the name of your configuration file without the extension)
and nnn is a three integer designator for the EIT time span index (000
through 127). The three integer designator immediately precedes the file
name extension.

NOTE. This file naming convention allows you to add multiple time spans to your

configuration file using the procedure described on page 3--73. In order to add

more than one EIT or ETT time span at a time, the files need to be named using

the conventions described in step 6, and they must be located in the same

directory. See File Naming Constraints on page 3--111 for more information

about naming EIT and ETT files.

8. Exit the table editor; you are returned to the EIT dialog box.
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9. Select Browse from the EIT dialog box, locate and select the new *.EIT file
in the Selection PSIP File dialog box (in this example, AtscTV_000.EIT),
and then click OK.

10. Click OK again to accept your changes and dismiss the EIT dialog box. The
EIT selection box is updated with the new file for the selected time span.

New EIT file

11. Repeat steps 1 through 10 for the remaining time spans, selecting the
appropriate time span template files as needed.

12. After you have added all of the time spans required for your configuration
file, click OK to accept your changes, close the dialog box, and return to the
Hierarchic view.
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Adding an EIT Instance. To add EIT instances to the configuration file one at a
time, use the following procedure (if you want to add multiple instances at once,
use the procedure beginning on page 3--73):

1. In the EIT dialog box, click Add. The Add EIT dialog box is displayed with
none showing in the file name field.

PID value text
box

Period
text box

Table
type
text
box

Note that the PID value and the Table Type values are already provided.
These default values are inserted based on the number of EIT files already
associated with the EIT icon (for the table type value) and the PID of the
latest EIT-k instance (the PID for new EIT instance is incremented by one).
For example, if your configuration file already has EIT instances for time
spans zero through three, the next EIT instance is EIT-4, and the table type
value for that EIT is 260. If the PID value for EIT-3 is 7503, then the PID
value listed in the text box for the next EIT instance is 7504.

2. Click Browse, select one of the EIT template files from the Selection PSIP
File dialog box, and then click OK.

3. Click Edit in the EIT dialog box and the PSIP table editor opens, displaying
the selected template file.

4. Modify the file as needed, and then select Save As from the File menu.
Name the EIT file using the naming requirements described in File Naming

Constraints on page 3--104. (For example, if you are adding a fifth EIT
instance, name the file newAtsc_004.EIT.)

5. Exit the table editor to return to the Add EIT dialog box with the template
file name showing in the file name field.

6. Click Browse, and then locate and select the new EIT file in the Selection
PSIP File dialog box.

7. Click OK to close the dialog box; the Add EIT dialog box reappears.
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8. Edit the EIT period if necessary, and then click OK to close the Add EIT
dialog box. The EIT selection box is updated showing the new EIT instance
at the bottom of the list.

9. Click OK to accept your changes, close the dialog box, and return to the
multiplexer. The new EIT instance is associated to the EIT icon. Note the
text changes to the right of the EIT icon (increased rate and time spans).
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Adding Multiple EIT Instances.You can also add all of the time spans you need for
your configuration file at once using the following procedure.

1. In the multiplexer, double-click the EIT icon.

2. Remove all of the instances in the EIT selection box by highlighting each
instance individually and clicking Remove. This does not delete the EIT
files from your system disk. It simply removes those files from your
configuration file.

3. Click the Add All command button.

4. Click Browse in the Add All dialog box.

5. Select an EIT template file from the Selection PSIP File dialog box, and then
click OK to accept your selection and close the dialog box.

6. Click Edit in the Add All EIT dialog box. The PSIP table editor is opened
with the EIT-0 file displayed (the other EIT times spans are also open in the
table editor, but are not visible).
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7. Save the open time spans (each time span is an EIT file) using the following
procedure:

a. With the first time span displayed (in this example, EIT-0), select
Save As from the File menu.

b. Rename the file using the naming conventions described in File Naming

Constraints on page 3--104 (in this example, newAtsc_000.EIT).

c. Click the Next command button on the lower toolbar to display the
second time span.

d. Repeat steps a through c to rename the remaining time spans (EIT-1
through EIT-3) using the naming conventions described in File Naming

Constraints on page 3--104.
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8. Select New from the Time Span menu. The EIT Instance Selection dialog
box is displayed.

9. Select the next time span (in this example, EIT 004), and then click OK.

10. Save the new time span using the naming conventions described in File

Naming Constraints on page 3--104.

11. Repeat steps 8 through 10 for all of the EIT instances you need to create for
your configuration file, and then exit the table editor.

12. In the Add All EIT dialog box, click Browse, and then locate and select one
of the newly named EIT-k instances (you do not have to select the EIT-0
instance).

13. Click OK in the Selection PSIP File dialog box and you are returned to the
Add All EIT dialog box. The Table Type, PID, and Period text boxes show
the default values; these values apply to the EIT-0 instance of the set of EIT
files to which the file showing in the file name field belongs.
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14. Click OK to close the Add All EIT dialog box; you are returned to the EIT
dialog box. The dialog box is updated showing all of the EIT time spans that
you have added.

If one or more instances that you thought you added are not included in the
selection box, ensure that you followed the naming conventions described in
File Naming Constraints on page 3--104, and that the files are all located in
the same directory.

15. To edit the EIT period or PID value, click Modify, and then make the
changes in the EIT dialog box that is displayed.

16. To add EIT elements to, or to modify all all of the EIT instances in the
selection box, click Modify All. All of the EIT instances will be opened in
the PSIP table editor with time span zero displayed. Any changes to the files
that you save in the table editor will be reflected in the configuration file
once you apply the changes in the multiplexer.

17. Click OK in the EIT dialog box to apply your changes and close the dialog
box. All of the EIT files will be associated with the configuration file.

Adding ETT Instances. Extended text tables (ETT) are optional in the ATSC
environments and are used to provide additional textual information about the
channels and events described in the VCT and EIT. There are two types of ETT:
Channel ETT and Event ETT. The procedures in this section describe how to add
and edit event ETTs to the ATSC environments. For more information about
creating and modifying ETTs, see Using the DVB and PSIP Table Editors

beginning on page 3--93.
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1. Select the PSIP icon, and then click + (or select Add from the Edit menu).

2. In the dialog box displayed, click ETT, and then click OK. The Add ETT
dialog box is displayed.

3. Click Browse to display the Selection PSIP File dialog box.

4. Select the event ETT template file, Atsc_001.ETT, and then click OK.

5. Click Edit in the Add ETT dialog box to start the PSIP table editor with the
ETT template file displayed.

6. In the PSIP table editor, select Save As from the File menu and save the
ETT file using the conventions described in File Naming Constraints on
page 3--111.

7. Exit the PSIP table editor and return to the Add EIT dialog box.

8. Click Browse, and then select the ETT file you just created.

9. Edit the Table Type, PID, and period as necessary, and then click OK to
accept your changes and return to the multiplexer. The ETT icon is added to
the PSIP hierarchy and the file you selected is now associated with the ETT
icon.

You can now use the procedures described for adding and editing EIT instances
to modify, add, and delete ETT instances:

� To modify the table type, PID, or period of an ETT instance, use the
procedure beginning on page 3--67.

� To add one ETT instance to your configuration file, use the procedure
beginning on page 3--71.

� To add multiple instances to your configuration file, use the procedure
beginning on page 3--73.
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The ARIB icon is present in the Multiplexer hierarchy when ISDB--S/ARIB is
selected in the Options menu. To add ISDB--S/ARIB information to your
configuration file, select ISDB--S/ARIB from the Options menu.

To add ARIB table icons to the hierarchy and edit certain configuration file
parameters, use the following procedure:

1. Select the ARIB icon, and then select + (the Add button). The following
dialog box is displayed. This dialog box allows you to associate a specific
ARIB table file to your configuration file, start the ARIB Table Editor with
the selected file displayed, and set the period for the selected ARIB table.

Click Cancel any time this dialog box is displayed to close the dialog box
without adding items to the hierarchy or changing the configuration file.

If you are working with a new configuration file, the table file name in the
file name field is none. To associate an ARIB file with an ARIB icon in the
hierarchic view, continue with the procedure:

2. From the table dialog box, click Browse.

3. Navigate to and select an ARIB table (DCT, DLT, BIT, SDTT, SIT or DIT),
and then select OK. The table type is analyzed; only ARIB tables are
accepted.

4. To edit the ARIB file indicated in the file name field, click Edit. The ARIB
Table Editor will start with the selected table file displayed.

5. From the table editor, save the table file under a new name (usually the name
of the configuration file).

NOTE. Be sure that you exit the ARIB table editor before you continue to use the

Multiplexer.

6. Click Browse and select the table file you just created.

7. To change the period of the selected table, edit the Period text box.

Adding and Editing ARIB
Tables
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8. After you have made all the changes you want using the dialog box shown in
the previous illustration, click OK.

9. An icon for the table type is added to the Hierarchic view, and the configura-
tion file is updated with the changes you have made.

Setting ARIB Table Periods. To set the periods for the DCT, DLT, SDTT, BIT, SIT
and DIT, use the following procedure.

1. Double click the ARIB icon in the hierarchic view to display the ARIB
Period dialog box.

2. Change the period as appropriate and then click OK to accept your changes
and close the dialog box, or click Cancel at any time to close the dialog box
without making any changes to the ARIB periods.
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Adding DLT Tables.Use the following procedure for adding DLT tables to your
configuration file:

1. Double click the DLT icon in the ARIB hierarchy to display the DLT dialog
box.

The selection box indicates the file name and PID for each DLT included in
the configuration file. You can modify, delete or add DLT instances using
one of the command buttons described in the following list:

� Modify. The modify command button opens another DLT dialog box with
the selected DLT file name in the file name field. Double clicking a DLT in
the list has the same effect.

� Remove. The remove command button deletes the selected DLT Table from
the configuration file. (The file remains unchanged on your system disk.)

� Add. The Add command button opens the Add DLT dialog box. Using this
dialog box you can add another DLT table to the configuration file, and
specify its PID value.

� OK. This command button confirms the changes you have made and closes
the dialog box.

� Cancel. This command button closes the dialog box without making any
changes to the configuration file.
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Associating DLT Table Files. To associate an DLT file, use the following proce-
dure:

1. Double click the DLT icon in the ARIB hierarchy to display the DLT dialog
box.

2. In the DLT selection box, highlight an DLT Table and click Modify. The
following dialog box is displayed:

3. Click Browse in the DLT dialog box. This opens the Selection ARIB file
dialog box.

4. Using standard Windows techniques, locate and select a DLT file, and then
click OK. This returns you to the DLT dialog box and selected DLT file
name is showing in the file name field.

5. Click Edit to open the DLT file in the ARIB Table Editor.

6. Modify the file as necessary, and select Save As from the file menu.

7. Rename the file (usually the name of your configuration file without the
extension).

8. Exit the ARIB table editor, you are returned to the DLT dialog box.

9. Select Browse from the DLT dialog box, locate and select the new DLT file.

10. Click OK to accept your changes and dismiss the DLT dialog box. The DLT
Selection box is updated with the new file.

11. Repeat steps 1 through 10. After you have added all the DLT tables required
for your configuration file, click OK to accept your changes, close the dialog
box and return to the Hierarchic view.
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Adding a DLT Table. To add DLT tables to the configuration file, use the following
procedure:

1. In the DLT dialog box, click Add. The Add DLT dialog box is displayed
with none showing in the file name field.

Note that the PID value is already provided. This default value is based on
PID of the latest DLT table (the PID for new DLT table is incremented by
one.)

2. Click Browse. Select one of the DLT files in the Selection ARIB file dialog
box, and then click OK.

3. Click Edit in the ARIB dialog box and the ARIB table editor opens,
displaying the selected template file.

4. Modify the file as needed, and then select Save As from the file menu.

5. Exit the table editor to return to the Add DLT dialog box with the template
file name showing in the file name field.

6. Click Browse, and then locate and select the new DLT file in the Selection
ARIB File dialog box.

7. Click OK to close the dialog box; the Add DLT dialog box reappears.
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8. Edit the DLT period if necessary, and then click OK to close the Add DLT
dialog box. The DLT Selection dialog box is updated showing the new DLT
file at the bottom of the list.

9. Click OK to accept your changes, close the dialog box, and return to the
multiplexer.

Note the text changes to the right of the DLT icon (increased rate and
number of tables)
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Generating a Multiplex

Once you have finished creating a configuration file, you may generate the
described multiplex/transport stream by choosing Go from the Multiplex menu
or by clicking the Go button on the toolbar.

Go (generate
a multiplex)

If the configuration file definition is not complete, transport stream generation
does not begin, and a message box appears to indicate the problem. The
multiplex definition is not complete in the following cases:

� There is an empty program (a program without an elementary stream).

� There is an undefined elementary stream or the multiplexer cannot find the
linked file.

After you have ensured that the configuration file data is valid, supply a file
name for the transport stream file. The default is the current configuration name
with the *.trp extension.

The duration gauge shows the progress of multiplex generation.

Times shown are “real” stream times; actual *.trp file generation takes much
longer.

� Time (on the left side of the gauge) indicates the stream time elapsed since
the beginning of the stream; it is equivalent to bits written divided by the
multiplex rate.

� Estimated Final Time is an estimate of the duration of the entire stream.

� The percentage shown on the gauge is the current Time (on the left side of
the gauge) divided by the Estimated Final Time (times 100).

� Running Time shows the actual stream duration after generation is complete.

During transport stream file generation, multiplexer commands are disabled
(grayed). Press the ESC key to stop multiplex calculation at any time.
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An Example Configuration File

You can view (and edit) configuration files with a text editing application such as
Notepad. An example of a configuration file is shown below. Each heading is
enclosed in brackets.

[MUX]
CountProg=3
Mux Rate=10.000000
Global time=0.000000
Type of scrambling=0
DVB Option=1
ARIB Option=0
Terrestrial ATSC Option=0
Cable ATSC Option=0
Mega frames Option=0
Dynamic SI Option=0

[PSI]
PAT Period=0.010000
PMT Period=0.100000
CAT Period=0.100000
Transport Stream ID=1
NIT PID=16
PID PMT 1=32
PID PMT 2=48
PID PMT 3=64
CAT=0
Nb EMM=0
TSDT=0

[SI]
BAT=1
SDT=1
EIT=1
TDT=1
RST=0
TOT=0
NIT File=C:\MTS300\Cfg-Trp\dvb.NIT
NIT Period=0.500000
BAT File=C:\MTS300\Cfg-Trp\dvb.BAT
BAT Period=0.500000
SDT File=C:\MTS300\Cfg-Trp\dvb.SDT
SDT Period=0.500000
EIT File=C:\MTS300\Cfg-Trp\dvb.EIT
EIT Period=0.500000
TDT Start Date=12/31/2000
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TDT Start Time=01:00:00
TDT Period=0.100000

[Prog 1]
Nb Video=1
Nb Audio=1
Nb Data=0
Nb Splice=0
Nb ECM=0
PCR period=0.040000
Starting time=0.000000

[Video Stream 1 Prog 1]
Video file=C:\MTS300\Video\525\Mobl_060.mp2
Rate=6.000000
PES packet size=2048
Initial delay=0.000000
Scrambling=0
Offset DTS=0.290411
MPEG=2
Profile Level=132
Chroma format=1
vbv size=229376
Nb frames per s=29.969999
Horizontal size=704
Vertical size=480
Stream Id=224
Picture=1.000000
Sequence header=0
Position SH=0

[Audio Stream 1 Prog 1]
Audio file=C:\MTS300\Audio\10khz.mp2
Rate=0.128000
PES packet size=2048
Initial delay=0.000000
Scrambling=0
Offset PTS=0.032000
Layer=2
ID=1
Sampling frequency=48.000000
Protection=1
Mode=3
Nb Slots=384
Standard type=1
Delta_t_AU=0.024000
Stream Id=193
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[Prog 2]
Nb Video=1
Nb Audio=1
Nb Data=0
Nb Splice=0
Nb ECM=0
PCR period=0.040000
Starting time=15.020000

[Video Stream 1 Prog 2]
Video file=C:\MTS300\Video\625\Demo_015.mp2
Rate=1.500000
PES packet size=2048
Initial delay=0.000000
Scrambling=0
Offset DTS=0.691222
MPEG=2
Profile Level=132
Chroma format=1
vbv size=135168
Nb frames per s=25.000000
Horizontal size=352
Vertical size=288
Stream Id=224
Picture=1.000000
Sequence header=0
Position SH=0

[Audio Stream 1 Prog 2]
Audio file=C:\MTS300\Audio\10khz.mp2
Rate=0.128000
PES packet size=2048
Initial delay=0.000000
Scrambling=0
Offset PTS=0.032000
Layer=2
ID=1
Sampling frequency=48.000000
Protection=1
Mode=3
Nb Slots=384
Standard type=1
Delta_t_AU=0.024000
Stream Id=193

[Prog 3]
Nb Video=1
Nb Audio=1
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Nb Data=0
Nb Splice=0
Nb ECM=0
PCR period=0.040000
Starting time=20.700001

[Video Stream 1 Prog 3]
Video file=C:\MTS300\Video\625\Demo_015.mp2
Rate=1.500000
PES packet size=2048
Initial delay=0.000000
Scrambling=0
Offset DTS=0.691222
MPEG=2
Profile Level=132
Chroma format=1
vbv size=135168
Nb frames per s=25.000000
Horizontal size=352
Vertical size=288
Stream Id=224
Picture=1.000000
Sequence header=0
Position SH=0

[Audio Stream 1 Prog 3]
Audio file=C:\MTS300\Audio\10khz.mp2
Rate=0.128000
PES packet size=2048
Initial delay=0.000000
Scrambling=0
Offset PTS=0.032000
Layer=2
ID=1
Sampling frequency=48.000000
Protection=1
Mode=3
Nb Slots=384
Standard type=1
Delta_t_AU=0.024000
Stream Id=193
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Using Option CA: Scrambling / Conditional Access

To create a stream with scrambled components, you must first enable Option CA
and copy the appropriate EMM and ECM sample files onto the computer system
disk. Version 6.0 of the MPEG Test System software includes simple example
files, Sample.emm and Test.ecm in the C:\MTS300\Cfg-trp directory.

Activating Option CA

If you purchased Option CA with your MPEG Test System, it is already
activated. If you are adding Option CA to a test system, you must perform the
following steps to activate the option:

1. Exit the multiplexer or the MPEG-2 System Analyzer if either application is
running.

2. Double-click the License Manager icon (located in the Tektronix MPEG
Test System program group window) to start the application.

The Tektronix Software Protection window appears.

3. Consult the password document supplied with your Option CA upgrade kit
and identify the General password. Enter the three 6-character Hexadecimal
numbers of the password in the corresponding window entry fields (lower-
case characters are acceptable) and then click OK. A License message
window appears.
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4. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK and return to step 3.

When you enter the correct password, Option CA is available the next time you
start the multiplexer or MPEG-2 System Analyzer.

Creating a Stream with Scrambled Components

Creating a scrambled stream is a five step process:

� Create a configuration file.

� Add a CAT to the PSI hierarchy, and designate the scrambling algorithm to
use.

� Add an EMM to the CAT, and associate a

� Add an ECM to each program icon with streams that will be scrambled.

� Designate which streams

Use the following procedure to create a stream with scrambled components:

1. Create the configuration (.cfg) file with all required tables (PSI/SI/PSIP) and
elementary streams.

2. Select Scrambling from the Options menu and then choose the appropriate
scrambling algorithm (CCETT or DVB) from the resulting Type of
scrambling window. Click OK to confirm the choice and close the window.

3. For conditional access scrambling, add a conditional access table (CAT) and
associated entitlement management messages (EMM):

a. Highlight the PSI hierarchic icon and then click + (Add).

b. Click the CAT option in the dialog box, and a CAT icon is added to the
PSI hierarchy.
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c. Highlight the new CAT icon and then click + (Add) again. An EMM
icon is added below the CAT.

d. Double-click the EMM icon to open an EMM Stream window.

e. Click Browse to locate and select an EMM file.

f. After selecting an EMM file, make all necessary changes to the fields in
the EMM Stream dialog box

g. Click OK to accept your changes and close the dialog box, or click
Cancel to close the dialog box without making any changes.

h. Repeat steps a through g as necessary to add all required EMMs.

4. Add an Entitlement Control Message (ECM) to each program that will have
scrambled streams:

a. Highlight the PROG icon of the program and then click + (Add).

b. Select ECM in the resulting Stream to add dialog box.

c. Click OK to confirm the choice and close the window. An ECM icon is
added to the program hierarchy.
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d. Double-click the new ECM icon to display the ECM Stream dialog box.

e. Click Browse to locate and select an ECM file. You can only select
appropriate file types.

f. When you are finished making changes to the fields in the ECM Stream
dialog box, click OK to accept your choices and close the dialog box.
Click Cancel to close the dialog box without making any changes.

5. Designate the elementary streams to be scrambled:

a. Double-click the Video, Audio, or Data elementary stream icon (in a
program that now has an ECM) to open the stream selection/configura-
tion window.

b. In the Stream Selection dialog box, click the Scrambling check box to
designate the elementary stream for scrambling.

c. Click OK to confirm the selection and close the window. The elemen-
tary stream icon selected for scrambling will be displayed with a blue
padlock scrambling symbol.

d. Repeat steps 4 and 5 for every elementary stream that is to be scrambled.
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Using the DVB, PSIP, and ARIB Table Editors

This section describes DVB and PSIP table editor applications. Because the table
editors are similar in design and function, most of the information in this section
applies equally to the MTS300 DVB Table Editor, the MTS300 PSIP Table
Editor., and the MTS300 ARIB Table Editor. The table item parameters for the
DVB and the ATSC table editors are fully described in PSI, DVB SI, and ATSC

PSIP Table Item Parameters beginning on page 3--143.

In this section, you will find procedures for modifying PSI, SI, PSIP, and ARIB
table files by adding, editing, and deleting table items. You will also find
procedures for analyzing the open tables, using the DVB and ATSC table editors,
as you build them in order to create a set of coherent tables.

The information in this sections is organized as described in the following list:

� The Application Window describes the table editor including descriptions of
the views, menu commands, icons, and toolbar buttons enabled by the table
editors (see page 3--95).

� Table File Operations describes basic operations such as creating, opening,
saving, and closing table files, and selecting from among the open tables
(see page 3--108).

� Table Sections describes how to create, insert, delete, and move among table
sections and time spans (see page 3--112).

� Table Items describes how to add, remove, search for and copy table items
such as streams, services, events, and descriptors (see page 3--116).

� Table Analysis describes the table analyses enabled by the table editors and
how to interpret table editor error messages (see page 3--126).

� Global View describes how to use the Global view window. This section also
shows how the associations among selected SI and PSIP tables are managed
(see page 3--132).



Using the DVB ,PSIP, and ARIB Table Editors

3- 94 MTS300 Stream Creation Applications User Manual

Use the table editors to create and edit the components of the MPEG-2 PSI
(program specific information), DVB SI (service information), ATSC PSIP
(program and system information protocol), and ISDB-S/ARIB (service and
system information) tables listed in Table 3--13. Table 3--13 shows which tables
can be edited in both applications and which tables can be edited in only one of
the table editors.

NOTE. Although you can view and edit the contents of the PAT and CAT, you

cannot export changes made to these files to the multiplexer. The PAT and CAT
are created and updated dynamically by the multiplexer; PAT and CAT parame-

ters can be edited for configuration files only from within the multiplexer.

Table 3- 13: PSI / SI / PSIP Tables

All table editors PSIP Table Editor DVB Table Editor ARIB Table Editor

PAT
(Program Allocation
Table)

MGT
(Master Guide Table)

NIT
(Network Information
Table)

BIT
(Broadcaster Informa-
tion Table)

PMT
(Program Map Table)

VCT
(Virtual Channel
Table)

SDT
(Service Description
Table)

DCT
(Download Control
Table)

CAT
(Conditional Access
Table)

RRT
(Rating Region Table)

BAT
(Bouquet Association
Table)

DLT
(Download Table)

EIT
(Event Information
Table)

STT
(System Time Table)

RST
(Running Status
Table)

SDTT
(Software Download
Trigger Table)

ETT
(Extended Text Table)

TOT
(Time Offset Table)

DIT1

(Discontinuity Infor-
mation Table)

TSDT
(Transport Stream
Description Table)

SIT1

(Selection Information
Table)

1 DVB table

NOTE. The table editors comply with ETSI Draft ETS 300 468 and ATSC

Standard Doc A/65. Please refer to these documents for more details on

parameter values in order to generate correct tables.
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The Application Window

You can access the table editors using one of the following techniques:

� Use the Windows Start menu.

� Double-click the icons in the Tektronix MPEG Test System program group
window.

� From within the MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream
Multiplexer, click Edit in one of the table selection dialog boxes. This
method helps to ensure correct association of the table and configuration
files.

The figure below shows the default application window with the default PAT
table file displayed. Most parts of the table editor application windows are
similar for all table types. The contents of the Hierarchic and Edit windows vary
depending on the table displayed.

Edit window

Menu bar

Upper toolbar

Hierarchy
window

Status bar

Lower toolbar

Section navigation
buttons

Time span
navigation buttons
(PSIP editor only)
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In the DVB and ATSC table editors, you can also display another window,
separate from the application window, that shows the association between
selected SI and PSIP table files, called the Global view window. See Global
View on page 3--132 for information about displaying and using this table editor
view window.

NOTE. Most of the illustrations used in this section show the MTS300 PSIP Table

Editor in use. Unless otherwise stated, these illustrations can be applied to both

table editors. Significant differences between the two interfaces and descriptions
are indicated in the text and in some cases with separate illustrations.

The Hierarchy window displays the structure of the currently selected table. Add
and delete table items in this view.

Beginning of the
table.

Elementary stream
loop (second loop)

Table type Table section

Main descriptor
loop (first loop)

Elementary
stream descriptor
loop (first nested
loop)

The structure of the table sections are depicted as a hierarchy of icons (only one
section is displayed at at time). Each icon represents a logical part of the table
structure. Loops in the table data structures are shown as subordinate parts of the
hierarchy.

You can collapse or expand a table hierarchy by double-clicking an icon that has
subordinate parts. If a parts of a table are collapsed, the icon at the top-level of
the collapsed part of the hierarchy appears three-dimensional. Double-click the
icon to expand the table at that point.

Hierarchy Window
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The following list describes the other features of the Hierarchic view:

� Table type. An abbreviation for the current table is listed in the top line of
view window.

� Table section. Most tables are made up of multiple sections. The top line in
the Hierarchic view indicates which section of the table is currently being
edited. It also indicates how many sections make up the table.

Depending on the table type, the meaning of sections (what they correspond
to in the bitstream syntax) vary. For instance, PAT sections refer to transport
streams; whereas, PMT sections relate to separate programs. For the EIT,
sections relate to different events on specific channels (PSIP) and different
services (DVB). See Table 3--23 on page 3--113 for descriptions of what table
sections represent.

� Table item icons. Each logical part of a table is associated with an icon that
depicts the part of the table being edited. The type of information being
edited is generally depicted by the icon graphic. See Table 3--22 on
page 3--104 for more information about what each icon in the Hierarchic
view represents.

Use the Edit window to display and edit parameters of the currently selected
table item icon. Add and delete table items in the Hierarchy window.

Parameter value text box

Parameter value drop-down
selection box

Parameter name

Table item
name

Edit Window
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The following list describes some of the features of the Edit view:

� Table item name. The top line of the window displays the name of the table
item currently being edited, and it changes as you select different icons in the
Hierarchic view.

� Parameter name. The parameter name identifies the parameter you are
editing.

� Parameter value text box. Each part of a table structure has parameters that
you can edit. Usually, the default value of the parameter is displayed, or it is
zero or left blank. However, since the both the table editor and the MTS300
MPEG-2 DVB / ATSC / ISDB-S Transport Stream Multiplexer can edit the
same file, when you start the table editor from within the multiplexer, some
parameter values are non-default values. For instance, you can set PID
values for some tables from the multiplexer; if you start the table editor with
the edited file after changing the PID values, the changes are reflected in the
Edit view.

� Parameter options selection box. Some table parameters can only take a
limited set of values, usually expressed as options. In such cases, choose the
appropriate option from a drop-down selection box, as shown in the previous
illustration. The parameter value text box immediately preceding the
drop-down selection box changes to show the value for the option you have
chosen.

The following section lists the commands available from the Menu bar and
explains their function and use.

File Menu. The File menu (Table 3--14) provides file management commands.
Use it to access the Global View, open new or existing table files, and close the
application.

Table 3- 14: Table editor File menu commands

Use To

New Create a new table file.

Open Open an existing table file.

Save Save the current selection to disk.

Save as Save the current selection with a new file name.

Save All Save all open tables to their respective files.

Close Close the currently selected table.

Close All Close all of the open table files (ATSC Table Editor only).

Menu Commands
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Table 3- 14: Table editor File menu commands (Cont.)

Use To

Global View Show the association between selected NIT, SDT, and EIT table files
(DVB), or the selected VCT, EIT, and ETT table files (ATSC).

Printer Setup Set paper orientation, paper size, and printer.

Print ATSC Table Editor only — Select from one of the following options:

Hierarchical View Print the contents of the Hierarchic view.

Edit View Print the contents of the Edit view.

Global View If displayed, print the contents of the Global view.

Exit Exit (quit) the application.

Below the Exit menu selection is a list of table types that the table editor can
display. When you select one of these table types, the table editor displays the
currently open table. If no table of the selected type is open, a dialog box is
displayed that allows you to create a new file or open an existing table file.

Edit Menu. The Edit menu (Table 3--15) allows you to add and delete items from
the table files.

Table 3- 15: Table editor Edit menu commands

Use To

Add Add various items to the table file.

Delete Delete the currently selected item and all its sub-items. Deleted items
are not copied to the Windows clipboard. (The main icon cannot be
deleted.)

Find Complete the dialog boxes to search for section-specific information in
a table. (DVB Table Editor only)

Cut Cut the currently select item and all its sub-items and copy them to
the Windows clipboard. (The main icon cannot be deleted.)

Copy Copy the currently selected item and all available sub-items to the
Windows clipboard. (The main icon cannot be copied to the clipboard.)

Paste Paste the contents of the clipboard at the currently selected location.
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Section Menu. The Section menu (Table 3--16) allows you to navigate the
sections of a table. Each table file can have up to 800 sections. The sections of a
PMT correspond to programs. The sections of an NIT describe the physical
organization of the multiplex (network). The sections of the SDT describe
transport streams. The sections of a BAT describe a bouquet. The sections of the
EIT each describe a service.

Table 3- 16: Table editor Section menu commands

Use To

Next Display the next section.

Previous Display the previous section.

Number Display the entered section number.

New Create a new section with the default values.

Insert Insert a previously saved section (from the Open dialog box) into a
table.

Delete Delete the current section (without warning or recovery).

Time Span menu (PSIP Table Editor only). The PSIP EIT and ETT tables are split
into three-hour time spans. The Time Span menu (Table 3--17) allows you to
create, delete, and navigate time spans.

Table 3- 17: Table editor Time Span menu commands

Use To

Next Display the next time span.

Previous Display the previous time span.

Number Display the entered time span.

New Create a new time span with the default values.

Delete Delete the current selection (without warning or recovery).
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Analysis Menu. The Analysis menu (DVB and ATSC table editors only), shown
in Table 3--18, allows you to check the integrity of selected table files.

Table 3- 18: Table editor Analysis menu commands

Use To

Consistency Check the open table files for both internal and intra-table consistency
with the standards.

Result Print Send contents of message window to printer.

Option menu (PSIP Table Editor only). The Option menu (Table 3--19) commands
let you switch between ACSII and Hexadecimal formats, and start an MGT
wizard that automates creating a consistent (coherent) master guide table.

Table 3- 19: PSIP table editor Option menu commands

Use To

ASCII Display information in ASCII format.

Print Display information in hexadecimal format.

MGT Wizard Start a wizard that automates creating a consistent MGT.

Help Menu. The Help menu (Table 3--20) provides standard Windows and
application-specific information.

Table 3- 20: Table editor Help menu commands

Use To

Contents Display the table editor online help contents.

Using Help Display the Using Windows Help.

About... Open the About window and discover version information for the Table
Editor.
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The command buttons on the upper and lower toolbars act as shortcuts for
several menu commands. Table 3--21 shows the toolbar command buttons and
briefly describes their functions. Command buttons specific to a table editor are
indicated. A blue dot on a tool type button indicates that a table file of that type
is open in the table editor.

Table 3- 21: Toolbar command buttons

Icon Location Function Equivalent menu command

Upper toolbar Select, create, or open a PAT File: Program Allocation Table

Upper toolbar Select, create, or open a PMT File: Program Map Table

Upper toolbar Select, create, or open an EIT File: Event Information Table

Upper toolbar Select, create, or open a CAT File: Conditional Access Table

Upper toolbar
(DVB)

Select, create, or open an NIT File: Network Information Table

Upper toolbar
(DVB)

Select, create, or open an SDT File: Service Description Table

Upper toolbar
(DVB)

Select, create, or open a BAT File: Bouquet Association Table

Upper toolbar
(DVB)

Select, create, or open an RST File: Running Status Table

Upper toolbar
(DVB)

Select, create, or open a TOT File: Time Offset Table

Upper toolbar
(DVB)

Select, create, or open a TSDT File: Transport Stream Descrip-
tion Table

Upper toolbar
(PSIP)

Select, create, or open an MGT File: Master Guide Table

Upper toolbar
(PSIP)

Select, create, or open a CVCT File: Cable Virtual Channel Table

Upper toolbar
(PSIP)

Select, create, or open a TVCT File: Terrestrial Virtual Channel
Table

Upper toolbar
(PSIP)

Select, create, or open an RRT File: Rating Region Table

Upper toolbar
(PSIP)

Select, create, or open an STT File: System Time Table

Upper toolbar
(PSIP)

Select, create, or open an ETT File: Extended Text Table

Upper toolbar
(ARIB)

Select, create, or open an SIT File: Extended Text Table

Command Buttons
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Table 3- 21: Toolbar command buttons (Cont.)

Equivalent menu commandFunctionLocationIcon

Upper toolbar
(ARIB)

Select, create, or open a DIT File: Extended Text Table

Upper toolbar
(ARIB)

Select, create, or open a BIT File: Extended Text Table

Upper toolbar
(ARIB)

Select, create, or open a DCT File: Extended Text Table

Upper toolbar
(ARIB)

Select, create, or open a DLT File: Extended Text Table

Upper toolbar
(ARIB)

Select, create, or open an
SDTT

File: Extended Text Table

Upper toolbar Add an item to the selection Edit: Add

Upper toolbar Cut the selected item Edit: Cut

Upper toolbar Analyze the table coherence Analysis: Coherence

Upper toolbar Access the Global View File: Global View

Lower toolbar View the previous section Section: Previous

Lower toolbar View a specific section Section: Number

Lower toolbar View the next section Section: Next

Lower toolbar
(PSIP)

View the previous time span Time Span: Previous

Lower toolbar
(PSIP)

View a specific time span Time Span: Number

Lower toolbar
(PSIP)

View the next time span Time Span: Next

NOTE. Although you can view and edit the contents of the PAT and CAT, you

cannot export changes made to these files to the multiplexer. The PAT and CAT

are created and updated dynamically by the multiplexer; PAT and CAT parame-

ters can be edited for configuration files only from within the multiplexer.
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Table 3--22 lists all of the icons displayed by the table editors, what they
represent, and where they are used in the table editors.

Table 3- 22: Table editor icons

Icon Represents

Beginning of a Program Allocation Table

Hierarchic view window of both the DVB and PSIP table editors

Beginning of a Program Map Table

Hierarchic view of both the DVB and PSIP table editors

Beginning of a Conditional Access Table

Hierarchic view of both the DVB and PSIP table editors

Beginning of a Network Information Table

Hierarchic and Global view windows of the DVB table editor

Beginning of a Service Descriptor Table

Hierarchic and Global view windows of the DVB table editor

Beginning of Bouquet Association Table

Hierarchic view window of the DVB table editor

Beginning of an Event Information Table

Hierarchic and Global view windows of both the DVB and PSIP table editors

Beginning of a Running Status Table

Hierarchic view window of the DVB table editor

Beginning of a Transport Stream Description Table

Hierarchic view window of the DVB table editor

Beginning of a Time Offset Table

Hierarchic view window of the DVB table editor

Beginning of a Master Guide Table

Hierarchic and Global view windows of the PSIP table editor

Beginning of a Terrestrial Virtual Channel Table

Hierarchic and Global view windows of the PSIP table editor

Beginning of Cable Virtual Channel Table

Hierarchic and Global view windows of the PSIP table editor

Table Editor Icons
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Table 3- 22: Table editor icons (Cont.)

RepresentsIcon

Beginning of System Time Table

Hierarchic and Global view windows of the PSIP table editor

Beginning of a Rating Region Table

Hierarchic and Global view windows of the PSIP table editor

Beginning of an Extended Text Table

Hierarchic and Global view windows of the PSIP table editor

Beginning of a Selection Information Table

Hierarchic view window of the ARIB table editor

Beginning of a Discontinuity Information Table

Hierarchic view window of the ARIB table editor

Beginning of a Broadcaster Information Table

Hierarchic view window of the ARIB table editor

Beginning of a Download Control Table

Hierarchic view window of the ARIB table editor

Beginning of a Download Table

Hierarchic view window of the ARIB table editor

Beginning of a Software Download Trigger Table

Hierarchic view window of the ARIB table editor

SIT service ID

Hierarchic view window of the ARIB table editor

BIT broadcaster ID

Hierarchic view window of the ARIB table editor

DCT transport stream ID

Hierarchic view window of the ARIB table editor

DCT maker and model ID

Hierarchic view window of the ARIB table editor

SDTT group ID

Hierarchic view window of the ARIB table editor

SDTT schedule

Hierarchic view window of the ARIB table editor

Beginning of a Title Multiple String Structure

Hierarchic view window of the PSIP table editor
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Table 3- 22: Table editor icons (Cont.)

RepresentsIcon

Beginning of a Multiple String Structure

Hierarchic view window of the PSIP table editor

String of a Multiple String Structure

Hierarchic view window of the PSIP table editor

Segment of a Multiple String Structure

Hierarchic view window of the PSIP table editor

Rating Region Table Dimension

Hierarchic view window of the PSIP table editor

Rating Region Table Dimension Value

Hierarchic view window of the PSIP table editor

Program

Hierarchic view window of both the DVB and PSIP table editors

Table definition

Hierarchic view window of the PSIP table editor

Elementary Stream

Hierarchic view window of both the DVB and PSIP table editors

Transport Stream

Hierarchic and Global view windows of both the DVB and PSIP table editors

Channel

Hierarchic and Global view windows of the PSIP table editor
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Table 3- 22: Table editor icons (Cont.)

RepresentsIcon

Service

Hierarchic and Global view windows of the DVB table editor

Event

Hierarchic and Global view windows of both the DVB and PSIP table editors

Descriptor

Hierarchic view window of both the DVB and PSIP table editor

Subdescriptor

Hierarchic view window of both the DVB and PSIP table editor

A television service

Global view window of the DVB table editor

Analog television

Global view window of the PSIP table editor

Digital television

Global view window of the PSIP table editor

A radio service

Global view window of both the DVB and PSIP table editor

A teletext service

Global view window of the DVB table editor

Data broadcast

Global view window of the PSIP table editor
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Table File Operations

Table descriptions are contained in individual files. Only one table file of a given
type can be open at a time.

Some tables, for instance the PAT, PMT, and NIT, are generated automatically
and dynamically managed when you create a configuration file using the
MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream Multiplexer. If you
open these tables in a table editor from the multiplexer, many of the table
elements and parameter values are completed for you. This is a very good way to
create coherent tables for an existing set of programs and elementary streams in a
multiplex. Other tables tables must be built from scratch or from a template.

To create a new table without using a template file, use the following procedure:

1. Click the New button on the Upper toolbar or select New from the File
menu. The Table Type dialog box is displayed.

2. Click the option for the type of table you want to create, and then click OK.

NOTE. Although you can view and edit the contents of the PAT and CAT, you

cannot export changes made to these files to the multiplexer. The PAT and CAT
are created and updated dynamically by the multiplexer; PAT and CAT parame-

ters can be edited for configuration files only from within the multiplexer.

Creating a New Table
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If a table of the selected type is open, the table editor automatically closes it
unless you have changed the table since it was last saved. If there are unsaved
changes, the Save Table dialog box is displayed. Choose one of the following
options:

� Save, to save the open table. (If the file is untitled, the Save as dialog box is
displayed.)

� No, to close the current table file without saving the changes.

� Cancel, to quit the dialog box and return to the open table.

To open an existing table file, use the following procedure:

1. Select Open from the File menu. The Table Type dialog box is displayed.

2. Select the type of table you want to open, and then click OK. A standard
Windows Open dialog box is displayed.

3. Navigate to and select the table file you want to open, and then click OK.

The selected file is displayed in the Hierarchy and Edit windows.

The Save, Save As, and Close commands are functionally identical to the other
Windows File menu commands. The table editors also have a Save All command
that lets you save all open table files in one operation. The PSIP editor also has a
Close all command that allows you to close all saved table files in one operation.

Save. The Save command saves the current table file. If the current table file is
untitled, then the Save As dialog box is automatically displayed.

Save As. Choose the Save As command to save a table file under a new name.
The Save As dialog box appears. Navigate to the appropriate directory and select
or enter a new name in the File Name text box. The correct extension for the
table type is added automatically to the file name.

NOTE. The table editors require correct file name extensions. Do not use

different extensions.

Opening an Existing Table

Saving Tables
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Save All. The Save All command allows you to save all open table files at the
same time. If any of the files are untitled, the Save As dialog box opens.

� Save, to save the open table. (If the file is untitled, the Save as dialog box is
displayed.)

� No, to close the current table file without saving the changes.

� Cancel, to quit the dialog box and return to the open table.

After you name the file, the application continues saving the remaining files.

Close. The Close command closes the current table file window, but it does not
close the application.

The Save Table dialog box appears if the table file has unsaved changes or if it is
currently untitled. Choose one of the following:

� Save, to save the open table. (If the file is untitled, the Save as dialog box is
displayed.)

� No, to close the current table file without saving the changes.

� Cancel, to quit the dialog box and return to the open table.

Close All (PSIP and ARIB editors only). The Close All command allows you to
close all open table files at the same time. (The Close command closes the
displayed file only.)

If any of the files are untitled or have unsaved changes, the Save Table dialog
box opens. Make one of the following choices:

� Save, to save the open table. (If the file is untitled, the Save as dialog box is
displayed.)

� No, to close the current table file without saving the changes.

� Cancel, to quit the dialog box and return to the open table.

After you save a file, the application continues closing the remaining files.
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There are special naming constraints for the PSIP EIT and ETT. These files are
divided in multiple time spans, and the file name must be formatted consistently
using the following method:

abc...111.exx

Where:

� abc... stands for the letters in the file name (usually the name of the
configuration file used by the multiplexer).

� 111 stands for the time span index [000 – 127] for the EIT and [000 – 128]
for the ETT. The value 128 is reserved for the channel ETT.

� exx stands for the appropriate file name extension for the EIT and ETT.

The following list illustrates the file naming constraints on the EIT and ETT. In
these examples test indicates the name of a configuration file.

� test000.eit indicates an EIT file for time span zero

� test012.eit indicates an EIT file for time span twelve

� test020.ett indicates an ETT file for time span twenty

� test0128.ett indicates a channel ETT file

You can have one of each table type open simultaneously in the table editors.
However you can display only one of the open tables at a time. To display an
open table, click the command button that corresponds to the desired table type
or select the type of table from the list of table types at the bottom of the File
menu. The selected open table is displayed in the Hierarchic view window.

File Naming Constraints

Selecting Among
Open Tables
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In ATSC environments, the MGT identifies all of the table types, table PIDs,
version numbers, and table sizes for the VCT, EIT, ETT, RRT, and private tables
in the multiplex. To automatically create an MGT based on the open table files in
the PSIP Table Editor, use the following procedure:

1. Select MGT Wizard from the Options menu. The MGT Wizard dialog box
is displayed.

2. Click OK to use the PID values suggested by the wizard, or enter a new
starting table item PID in the PID text box, and then click OK.

After you click OK, the wizard builds the appropriate MGT table items and
correctly assigns the table type, PID, version, and size parameters for each
table open in the table editor, except for the STT and RRT.

3. Save the MGT.

Table Sections

Most table files are composed of multiple sections: Depending on the table type,
sections describe or correspond to different MPEG or network items:

� The sections of a PMT correspond to programs.

� The sections of the SDT describe transport streams, as do the sections of the
TVCT and CVCT.

� The sections of a BAT describe a bouquet (or collection of services).

� The sections of the EIT each describe a service (DVB), or an event or
collection of events for a virtual channel (ATSC).

Table 3--23 briefly describes what a section describes or corresponds to for each
PSI, SI, and PSIP table type displayed by the table editors. It also lists how
many sections each table file can have. (See the ISDB-S/ARIB standards
documents for similar information for the ARIB tables.)

Creating an MGT
Automatically
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Table 3- 23: Table sections

Table Number of sections Sections describe/correspond to

PAT 1 to 256 A transport stream

PMT 1 to 20 A program

CAT 1 to 256 A conditional access system (or collection of systems)

NIT 1 to 256 The organization of the multiplex on a network

EIT 1 to 128 (at least four
for ATSC environments)

A service (collection of events) (SI) or
Events for a virtual channel defined in the VCT (PSIP)

BAT 1 to 256 A collection of services marketed together

SDT 1 to 256 Services for a specific transport stream ID

TSDT 1 to 256 A description of services carried on a specific transport
stream

RST 1 to 256 A transport stream

TOT Usually 11 A local time offset (relative to UTC)

MGT Usually 11 The PSIP tables in the configuration file (except for the
STT and RRT)

VCT 1 to 256 A transport stream

RRT Usually 11 A rating region (systems are different by region)

STT Usually 11 The UTC time reference

ETT 1 to 256 An extended text message describing a channel (channel
ETT) or an event (event ETT)

1 These tables are usually transmitted as one section. However, multiple sections can
be created and edited in the table editors.

This rest of this section describes how to create and delete table file sections, and
how to move among the sections of a table file.

NOTE. Although you can view and edit the contents of the PAT and CAT, you

cannot export changes made to these files to the multiplexer. PAT and CAT

parameters can be edited for a configuration file only from within the multi-

plexer.
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Use the Section menu commands New, Insert, and Delete to add and delete table
sections to the displayed table file.

New.Use the New menu selection to create a new table section.

Newly created sections become the last section in the displayed table, and the
Hierarchical view changes to display the new, last section in the table. For
example, if the current section is Section 4 of 6 in the table, and you then select
New from the Section menu, the display will change to Section 7 of 7 in the

table. The new section contains only the default information for that table type.

Insert. The Insert command adds an existing file, as a new section (or sections) to
the end of a table. Use the following procedure:

1. Select Insert from the Section menu. The Open dialog box is displayed.

2. Navigate to and select the desired file, and then click OK.

Inserted table file sections are appended to the current table, and the display
changes to show the last table section of the new file. For example, if the current
section is Section 4 of 6 in the table and you insert a table file that has four
sections, the display will change to Section 10 of 10 in the table. (The table file
you selected to insert remains unchanged.)

Delete. The Delete command removes the currently displayed section. If the
deleted section is a middle section, the sections that follow are re-numbered
appropriately.

CAUTION. Sections are deleted without confirmation. You cannot recover deleted

sections.

Use the Section menu commands Next, Previous, and Number (and the
command buttons on the Lower toolbar of the same name) to move among table
sections. (Use the left-most set of command buttons for navigating table sections
in the PSIP table editor.)

Next. Choose the Next command (or click the Next command button) to display
the next section of the table file.

If the last section is currently displayed, you receive a message indicating that
the current section is the last section in the table, and the application continues to
display the current section.

Creating, Inserting, and
Deleting Table Sections

Moving Among Table
Sections
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Previous. To display the previous section of the current table file, select Previous
from the Section menu (or click the Previous command button).

If the first section is currently displayed, you receive an error message indicating
that the current section is the first section in the table, and the application
continues to display the current section.

Number.Use the Number command button (or menu selection) to display a
section of a table that is not within a few Next or Previous button clicks. To
display a specific table section, click the Number command button (or select
Number from the Section menu). The Section Number dialog box appears.

Enter the desired section number in the text box and click OK. If you enter a
section number that is beyond the range, the last available section is displayed.

In ATSC environments, EIT and ETT table files represent specific three-hour
time spans. When these files are displayed, the Time Span menu selections are
active. These menu selections are identical to those described for creating,
deleting, and moving among table sections.

The command buttons for navigating time spans are the right-most set of buttons
on the lower toolbar of the PSIP table editor. See the illustration on page 3--95.

Creating, Deleting, and
Moving Among

Time Spans
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Table Items

Often, table files are started from templates; for example, the table template files
provided on the CD-ROM that ships with the Tektronix MTS300 MPEG Test
System applications. However, to create the files you need to build transport
streams with complex associations, you need to add table items to your table
sections. This section describes the techniques you use to add and modify these
items in the Hierarchic view.

The term table items refers any of the following table elements:

� Transport streams

� Programs

� Elementary streams

� Descriptors

� Events

� Services

� Titles

� Messages

Once added, icons appear in the Hierarchic view window that represent these
items. To these items, you can often add other items.

For PSI, SI, and PSIP tables to be valid and coherent, you need to edit the table
and item parameters in the Edit view window. The following sections provide
the information you need about the specific fields and values for table items in
order to create valid and coherent tables:

� PSI and SI Table Item Parameters, beginning on page 3--143

� PSIP Table Item Parameters, beginning on page 3--155
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To add an item to a table section, use the following procedure:

1. Select the Hierarchic view icon to which you want to add a table item.

2. Select Add from the Edit menu, or click the + command button on the upper
tool bar.

If there is only one appropriate type of item, that item is automatically
added. Otherwise, the Add dialog box shown in the following illustration is
displayed. This dialog box allows you to specify the type of item to add.

Available items listed in the Add dialog box depend on the table type and
insertion point. Table 3--24 on page 3--118 describes the choices available at
the table icon level.

3. If the Add dialog box is displayed, select the appropriate option, and then
click OK. The item selected will be added to the table hierarchy. Click
Cancel at any time to close the dialog box without making changes to the
hierarchy.

If you are adding a descriptor, the Descriptors Selection dialog box is
displayed. This dialog box is represented by the following illustration.

Adding Table Items
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See Adding Descriptors on page 3--122 for more information about adding
descriptors to tables and table items.

Table 3- 24: Items added to table sections

Selected icon Items that can be added

PAT Programs

PMT An elementary stream or a descriptor

NIT A transport stream or a descriptor

BAT A transport stream or a descriptor

SDT A service

EIT An event (DVB) or a time span (PSIP)

RST An event

TOT A local time descriptor

TSDT A descriptor

VCT A channel or a descriptor

MGT A table or a descriptor

RRT A dimension, rating region name, or descriptor

ETT A message

STT A descriptor

CAT A conditional access system

SIT A service or a descriptor

DIT ------ -- --

BIT A broadcaster or descriptor

DCT A transport stream

DLT ------ -- --

SDTT An SDTT group

NOTE. Although you can view and edit the contents of the PAT and CAT, you

cannot export changes made to these files to the multiplexer. The PAT and CAT

are created and updated dynamically by the multiplexer; PAT and CAT parame-

ters can be edited for configuration files only from within the multiplexer.
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You can add items listed in Table 3--25 at the stream, event, or service level.

Table 3- 25: Items added to other table items

Icon Items

Transport stream Another transport stream or a descriptor

Program Another program

Elementary stream Another elementary stream or a descriptor

Channel Another channel or a descriptor

Table Another table or a descriptor

Service Another service or a descriptor

Event (EIT) Another event or a descriptor

Event (RST) Another event

Message/Title/Name A string

String A segment

Segment Another segment

Dimension (RRT) A dimension name or a value

Broadcaster (BIT) A descriptor

SDTT group SDTT schedule

Descriptor and Sub-
Descriptor

Other descriptors, sub-descriptors, and/or sub-sub-descriptors

When you add an item to an icon that does not represent the beginning of a table,
the item icon is added “in parallel” to the existing item. When you add a
descriptor, the descriptor icon is added to the right of the item.

Stream selected,
stream added

Stream selected,
descriptor added
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At the descriptor level, you can add another (parallel) descriptor. You can also
add a subdescriptor to some descriptor types (refer to PSI, DVB SI, and ATSC

PSIP Table Item Parameters, beginning on page 3--143).

Descriptor selected,
subdescriptor added

Descriptor selected,
descriptor added

At the subdescriptor level, you can add another parallel subdescriptor. In certain
cases, you can also add a sub-subdescriptor.

Subdescriptor selected,
subdescriptor added

Subdescriptor selected,
sub-subdescriptor added

When you add a transport stream, service, event, or conditional access to a table,
the icon is placed immediately in the hierarchy. When you choose to add an
elementary stream to a PMT, the following warning window appears.

NOTE. Because it is likely to produce incoherence in the configuration file and

between tables, do not add or delete elementary streams when you start the table

editor from the MTS300 MPEG-2 DVB / ATSC / ISDB-S Transport Stream

Multiplexer.

Adding a Stream,
Service, or Event
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After you add a new item, select the icon and enter the appropriate values in the
Edit window text boxes (to the right of the Hierarchic view window).

Drop-down
selection box

Text box

There are two types of Edit view fields you can modify: drop-down selection
boxes and text boxes.

Drop-down selection boxes allow you to select from a list of options available
when you click the� button to the right of the drop-down box. After you make
your selection, the text field immediately above it automatically changes to the
appropriate value.

Text boxes take alpha-numeric characters. In the PSIP Table Editor you can
toggle the input format for some parameters between ASCII and hexadecimal
(select the appropriate option from the Options menu).

See the following sections for more information about the various stream,
service, and event parameters.

� PSI, DVB SI, and ATSC PSIP Table Item Parameters, beginning on
page 3--143

� PSIP Table Item Parameters, beginning on page 3--155



Using the DVB ,PSIP, and ARIB Table Editors

3- 122 MTS300 Stream Creation Applications User Manual

Use the following procedure to add descriptors to a table item:

1. Select a Descriptor in an Add dialog box, and then click OK. The Descrip-
tors Selection dialog box is displayed.

2. Select the type of descriptor you want to add from the List of Descriptors
drop-down selection box.

3. Click Add. The descriptor name appears in the Descriptors Selected list.

4. Repeat steps 2 and 3 until the Descriptors Selected field lists all the
descriptors you want to add to the selected table item.

In the PSIP Table Editor, you can select multiple descriptors using the Shift
and Control keys.

5. Click OK to add the selected descriptors to the table and hierarchy. Click
Cancel to close the dialog box without adding any descriptors.

Adding Descriptors
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6. Select the descriptor icons one at a time and enter the appropriate informa-
tion in the Edit window text boxes.

Drop-down
selection box

Text box

Selected
descriptor

Table item name

There are two types of Edit view fields you can modify: drop-down selection
boxes and text boxes.

Drop-down selection boxes allow you to select from a list of options available
when you click the� button to the right of the drop-down box. After you make
your selection, the text field immediately above it automatically changes to the
appropriate value.

Text boxes take alpha-numeric characters. In the PSIP Table Editor you can
toggle the input format for some parameters between ASCII and hexadecimal
(select the appropriate option from the Options menu).

See the following sections for more information about the descriptor parameters.

� PSI, DVB SI, and ATSC PSIP Table Item Parameters, beginning on
page 3--143

� PSIP Table Item Parameters, beginning on page 3--155
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Use the Delete, Cut, Copy, and Paste commands of the Edit menu to edit table
sections.

Delete. The Delete command (Del key) removes the selected item and any items
below it in the hierarchy display. The icons that represent the file type cannot be
deleted. The delete command does not place removed items onto the clipboard.

Cut. The Cut command (CTRL-x) is identical to the Delete command except that
cut items are placed on the clipboard. They can then be pasted back in the table
file at the same or a different location.

Copy. The Copy command (CTRL-c) copies the currently selected item to the
clipboard. It is then available to paste at different locations. All items below the
selected item on the hierarchy are also copied to the clipboard.

NOTE. To copy the entire table, use the File menu Save As command and save the

table file under a different name.

Paste. The paste command (CTRL-v) adds the contents of the clipboard to the
selected icon in the table file. If the top-level item being pasted is at the same
level as the selected icon, the item(s) are inserted immediately below the selected
icon.

Removing, Copying, and
Pasting Table Items
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This command is part of the DVB Table Editor Edit menu. Use it to search for
section-specific information in a table.

1. In an open section, select Find from the Edit menu. A Find dialog box
appears.

2. Complete the requested section information and click OK.

The Find dialog box contents vary depending on the type of section you are
searching.

PSI tables are defined in the ISO/IEC 13818-1 international standard. This
standard is included in the Tektronix MTS300 MPEG Test System as a Windows
help file. To open the file, double-click the MPEG-2 Help icon in the Tektronix
MPEG Test System program group window.

You can also refer to ISO/IEC 13818-2 for additional information about video
encoding or ISO/IEC 13818-3 for information about audio encoding. These
publications are available through the ISO (International Organization for
Standardization.

SI tables and descriptors are defined in ETS 300 468. PSIP tables and descriptors
are defined in ATSC Document A/65. Use these documents to learn more about
tables and descriptors for DVB and ATSC environments.

Refer to the following ARIB (Association of Radio Industries and Business) and
ITU-R (International Telecommunications Union) standards for more informa-
tion about ISDB-S and ARIB transport stream elements:

� ARIB STD-B10 (1.2), 1999, Service Information for Digital Broadcasting

System

� ARIB STD-B16 (1.1), 1999, Digital Receiver Commonly Used for Digital

Satellite Broadcasting Services Using Communication Satellite

� ARIB STD--B20 (1.1), Digital Broadcasting System and Related Operation-

al Guidelines for Broadcasting Satellites

� ITU-R BO. 1408, Transmission System for Advanced Multimedia Services

Provided by Integrated Services Digital Broadcasting in A Broadcasting

Satellite Channel,

Searching for Table Items
(Find)

Learning More About PSI,
SI, PSIP, and ISDB-S/ARIB

Table Items
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Table Analysis

Using the DVB and ATSC table editors, you can easily check the open tables for
conformance to the relevant standard. During an analysis, the table editors check
all open table files for consistency/coherence both within a table file (called
intra-analyses) and between the open table files (called inter-analyses).

NOTE. The information in this section does not apply to the ARIB Table Editor.

This section provides the following information:

� Performing Consistency/Coherence Analyses (this page)

� Using the Error Message WIndow (page 3--128)

� Interpreting Error Messages (page 3--130)

The table editors use slightly different terminology for the analyses performed,
but they both perform similar functions:

� In the MTS300 PSIP Table Editor, the menu selection that initiates an
analysis is Consistency from the Analysis menu.

� In the MTS300 DVB Table Editor, the menu selection that initiates an
analysis is Coherence from the Analysis menu.

The procedure for performing an analysis is slightly different for the DVB and
PSIP table editors. To perform an analysis on all open tables using the PSIP table
editor, use the following procedure; to perform an analysis using the DVB table
editor, skip steps 3 and 4.

1. Save all open tables by selecting Save All from the File menu (see Save All
on page 3--110).

Performing Table
Analyses
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2. Click A on the Upper toolbar, or select Consistency from the Analysis menu
(for the DVB table editor, select Coherence). The Analysis Parameters
dialog box is displayed.

3. Enter the transport stream ID for the tables you want to analyze in the
Transport Stream ID text box. If you do not know the value of the transport
stream ID, leave it at zero.

4. Select either the Terrestrial or Cable option in the Types of Broadcast group,
and then click OK to close the dialog box and begin the analyses. Click
Cancel to close the dialog box without performing any analyses.

After you click OK, the message window is displayed, showing the error
messages resulting from both the intra-analyses (within table file analyses)
and inter-analyses (between table files analyses). The last inter-analysis error
message is highlighted.

You can resize and position the message window as necessary to make the error
messages easier to read.

Intra-analyses are performed first, and, if the analyses generates many messages,
you may need to scroll up in the message window to see the beginning of the
intra-analyses messages.
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NOTE. The PSIP Table Editor does not check the program paradigm and service

location descriptors within the VCT.

The error message window list errors and warnings that result from performing
table analyses on the open tables in the table editor. This message window is
interactive and allows you to display the nonconforming table item directly from
the Message window. Use the following procedure to display the table file and
item with the indicated error:

1. Perform an analysis on the open tables in the table editor. (See Performing
Table Analyses on page 3--126.)

2. If the analysis reports any errors, double-click on an error listed in the
message window.

The table and item (such as a stream, event, service, or descriptor) that
contains the error is displayed in the Hierarchic and Edit view windows.

The hierarchy of the appropriate table section appears in the Hierarchy
window with the nonconforming table or table item highlighted. For
instance, in the following illustration the AC-3 audio descriptor needs to be

Using the Error Message
Window
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added to the elementary stream, and the relevant icon is highlighted in the
Hierarchic view.

Table item with
selected error

3. Correct the error(s) by adding the indicated table item or editing the
parameter value in the Edit window, and then rerun the analysis to check the
corrections. Often, correcting one value removes multiple error messages
from the Message window.

You may need to scroll up or down in the Edit view window to locate the
parameter name and text box in order to edit it.

You can print the contents of the message window by selecting Print from the
Analysis menu. Use the resulting Print dialog box to select the printer and print
the error messages.
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The error messages displayed in the Message window have certain characteristics
that will help you locate the item in error and correct the problem. These
characteristics are shown in the following illustration.

Type of error
message

Table type
and section

Error message header
(location of error) Error text

Error message ID
(if present)

Type of table
analysis

Table Analysis Types. The table editors perform the following types of analyses
on all of the open table files in the table editor:

� Intra-analyses check each open table file value and structure for coherence to
the appropriate standard. For example, when required AC-3 descriptor is not
found in a section of the PMT, the error is an intra-analysis error.

� Inter-analyses check the open table files for consistency between table files.
For example, if an MGT defines the length of an EIT-0 table that is different
from the actual length of the table, the error is an inter-analysis error.

Type of Error Message, Table Type, and Section. The first part of an error lists the
type of error reported on that line. The table editors report two types of errors.
The differences relate to the different error levels of ETR 290:

� Error messages relate to level one and two errors. The DVB Table Editor
reports only one error per analysis (it stops upon encountering an error).

� Warning messages relate to level three errors.

Immediately following the type of error is the table type and the table section in
which the error is found.

Interpreting Error
Messages
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Error Message Headers. The error message header identifies the location of the
error. Each header uses a prefix described in Table 3--26 to identity a table, item,
or section. The text following the prefix uniquely identifies that part of the table
item with an error.

Table 3- 26: Table editor error prefixes

Prefix1 Meaning

S% Section number (outside of the square brackets)

L% Loop number in section

FDL First descriptor loop

D% Descriptor number in loop

Nid% The network_id parameter

Tid% The table_id parameter

Tsid% The transport_stream_id parameter

Sid% The service_id parameter

Onid% The original_network_id parameter

Eid% The event_id parameter

Bid% The bouquet_id parameter

Pn% The program_number parameter

Sn% The section_number parameter

Vn% The version_number parameter

1 Numeric values replace the % in the error messages

Error text. The text of the error messages provide some clue as to the reason for
the error, and often the solution is obvious. However, when you need more
information on a specific error message, use the online help to access the topic
that corresponds to the error message. (See Online Help for the PSIP Table

Editor Error Messages and Online Help for the DVB Table Editor Error

Messages on page 3--131.)

Error Message IDs. The PSIP Table Editor also uses an error message ID that will
help you locate a specific error message description in the online help. See PSIP
Table Editor error message online help below to learn how to use this
message ID.

Online Help for the PSIP Table Editor Error Messages.Use the following procedure
to display online help for PSIP Table Editor error messages:

1. Scroll the error message window to the right and note the error message ID.
(The error message ID will look similar to [A_PSI_PRPA_OO1].)
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2. Select Contents from the Help menu.

3. From the Contents tab, double-click the Consistency analysis book, and
then open the Analysis messages book. The books are organized by type of
message, which relate to the first letter in the error message ID as indicated
in the following list:

� A. Messages about the constraints on MPEG2

� B. Messages about the PSIP requirements

� C. Messages about the PSIP constraints

� D. Messages about the compliance between PSIP and MPEG2

The last book, General messages, provides descriptions and possible
solutions for error messages without error message IDs.

4. Open the appropriate book, and then select the appropriate error message ID.
Error message IDs are organized alpha-numerically in each book.

Online Help for the DVB Table Editor Error Messages. The DVB Table Editor
analysis messages are displayed in the format header : message. Also, two
types of messages are displayed in the DVB Table Editor message window:
Warnings and Errors. The analysis stops when an Error is encountered. Use the
following procedure to display online help for Warning and Error messages in
the DVB Table Editor.

1. Select Contents from the Help menu.

2. From the Contents tab, double-click the DVB SI & PSI Table Editor book,
and then the Table editor functionalities.

3. Open the Analysis messages book and then select the topic related to the type
of error message listed in the Message window: Error or Warning.

Global View

The Global View window is a separate window that shows the association
between selected SI and PSIP table files. Not all open table files are represented
in the Global view window. You can use the Global view window for the
following purposes:

� To visualize the associations among the transport streams, services, and
events described in the managed table files (the NIT, SDT, and EIT for
MPEG-2 and DVB environments and the VCT, EIT, and ETT table files for
the ATSC environment).
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� To move among tables and from one table element to another. This can be
especially useful when you are trying to create a set of tables with complex
associations.

� To open specified files in order to perform coherence analyses on the
interrelated parts of MPEG-2, DVB, and ATSC table files.

NOTE. The information in this section does not apply to the ARIB Table Editor.

One way to display table files is to open the following Global View window and
specify the table files you want to open during the procedure. This technique
allows you to open multiple table files at once, and display them in both the
Global and Hierarchic view windows.

CAUTION. Opening files using the Global view will close any open table files of

the same type without giving you a chance to save those files. Make sure you

save all open files before using this technique.

1. Save any open files in table editor.

2. Select Global view from the File menu, or click G on the upper toolbar.

3. If you are using the PSIP table editor, the VCT File Selection dialog box is
displayed, which allows you to specify the VCT type you want to open
(cable or terrestrial). Select the appropriate environment, and then click OK.

Opening the Global View
Window
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4. The Global View File Selection dialog box is displayed, which is shown in
the following illustration using the PSIP table editor. (Currently open table
file names appear in text boxes).

5. If a table you want to display is not named in the table type text box, click
Browse.

6. For PSIP EITs and ETTs, a dialog box is displayed allowing you to choose
to open all time spans or only a specific time span. Make the appropriate
selection, and then click OK.

A standard Windows NT Open dialog box is displayed. Select the table file
you want to open.

7. Click OK to close the Global View File Selection dialog box. The Global
view window is displayed with the selected table files open in the both the
Hierarchic and Global view windows.
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When the Global view window first opens, the hierarchy of each displayed table
is fully expanded and all of the table elements are displayed, as shown in the
following illustration using the PSIP table editor.

To collapse any part of a table hierarchy, double-click on an icon at the point
below which you want to hide table elements. For instance, to collapse the
service icons (SID icons) in the previous illustration, double-click a TS icon.

In the following illustration, all of the service icons except SID 4 have been
collapsed. Note the slight shadow behind the icons. This indicates that other
table elements are hidden behind that table element.

To expand a table, double-click on the icon at which the hierarchy is collapsed.

Collapsing and Expanding
Tables in the Global View
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In the ATSC environment, transport streams, channels, and events are managed
using the VCT and EIT. In the following example, the ETT files are included to
show how extended text messages are associated with events occurring on the
transport stream. When you use the Global view for the purposes of specifying
these relationships, you need to open only the VCT, EIT, and ETT. You can
select other PSIP files when you want to open all of the files at once, for
instance, when you want to perform coherence analyses on a set of PSIP table
files.

VCT and EIT tables can show no association or a very high degree of associa-
tion, as depicted in the following illustration.

Unassociated tables Highly associated tables

Channels, events, and Extended Text Messages (ETMs) are managed using the
following VCT, EIT, and ETT values:

� Source IDs, which are specified in the channel element of the VCT and in
the EIT.

� Event IDs, which are specified in the event element of the EIT.

� ETM IDs which are specified in the ETT and define the specific event in the
transport stream to which an Extended Text Message (ETM) applies. (See
page 3--138 for more information about ETM ID values.)

The following three illustrations depict these relationships. In the first illustra-
tion, the transport stream and channels in the VCT are defined. However, the
source IDs in the events of the EITs are not the same as the source IDs in the
channel elements of the VCT. Also, the event IDs and ETM IDs are not defined.

Using the PSIP Table
Editor Global View

Window
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In the next illustration, the source ID in the four EIT time spans have been
updated correctly for the first channel in the VCT, SID 1. Consequently, the first
EIT time span is now associated with the channels described in the VCT.
However, the remaining sections of the EITs and the ETM IDs have not been
updated.
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In the next illustration, the source IDs in all EIT time spans have been updated
correctly, as have the ETM ID values for all of the events described for SID 1.

The ETM ID value in extended text tables specifies the event to which the
extended text message belongs. The following list describes how the ETM ID
value specifies the relationship:

NOTE. In order for an Extended Text Message (ETM) to be associated with an

event described in an EIT, the time span for the ETT must be the same as the

time span for the EIT.

� The first five places in the ETM ID text box define the source ID of the
event to which the extended text message applies.

� The middle five places in the ETM ID text box define the specific event
(defined in the EIT) to which the extended text message applies. For channel
ETMs, the middle five places are 00000 (the message applies to a channel
rather than an event).

� The last digit in the ETM ID field indicates whether the message is an event,
in which case the value is two (2), or a channel message, in which case the
value is zero (0).

Using this information, the ETM ID value shown above indicates that the
message applies to the third event in the EIT-0 instance of SID 1.
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Tables displayed in the Global view can exhibit no association or a high degree
of association, as shown in the following illustration.

Unassociated tables Highly associated tables

In the DVB and MPEG-2 environments, the following mechanisms are used to
manage the programs or events that occur in the transport stream:

� The transport stream ID, which is specified in the transport stream element
of the NIT and in the SDT.

� The service ID, which is specified in the service element of the SDT and in
the EIT.

� The event ID, which is specified in the event element of the EIT.

The event element specifies the start time, status, and duration of one specific
event occurring in a transport stream.

Using the DVB Table
Editor Global View

Window
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The following four illustrations depict how these elements manage services and
events that occur on a given transport stream. In the first illustration, the table
files are not associated with each other.

In the next illustration, the transport stream ID value in the SDT has been
updated to that of the transport stream defined in the NIT. In the Global view, the
NIT and SDT depict the transport stream ID identity they share.

In the next illustration, the service IDs in the three sections of the EIT have been
updated to that of the three services described in the SDT. However, only the
first two sections of the EIT have the correct transport stream ID value.
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Consequently, the third section of the EIT is not associated with any service
defined in the transport stream.

In the last illustration, all of the transport stream IDs and service IDs are
updated:

� The transport stream ID values in the NIT, SDT, and EIT are identical

� The service ID values in the SDT and the EIT are identical

In this example, the three services described in the SDT have service descriptors
that indicate the type of service carried in the transport stream. Also, the EIT
sections each describe specific events.
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PSI, DVB SI, and ATSC PSIP Table Item Parameters

Editing a table involves entering the appropriate information and parameter
values for each table section, elementary stream, descriptor, and sub-descriptor.
For example, an TVCT channel must have the appropriate channel transport
stream ID and program number if it is to be correctly associated to a program in
the transport stream.

Drop-down
selection box

Text box

There are two types of Edit view fields you can modify: drop-down selection
boxes and text boxes. In each case, click in the Hierarchic view window to apply
the changes made in the Edit window.

Drop-down selection boxes allow you to select from a list of options available
when you click the� button to the right of the drop-down box. After you make
your selection, the text field immediately above it changes to the appropriate
value.

Text boxes take alpha-numeric characters. In the PSIP Table Editor you can
toggle the input format for some parameters between ASCII and hexadecimal
(select the appropriate option from the Options menu).
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This remainder of this section describes the fields and parameters of each table
and table item displayed in the table editors In most cases, a range of possible
values is provided for each parameter. Other PSI, SI, and PSIP parameters are
either fixed or determined automatically by the table editors. For more informa-
tion about table items, refer to Learning More About PSI, SI, and PSIP Table

Items, on page 3--125.

PSI and SI Table Parameters

You can specify the parameters of the following ten PSI and SI tables using the
MTS300 DVB Table Editor:

� BAT

� CAT

� EIT

� PAT

� PMT

� NIT

� RST

� SDT

� TOT

� TSDT

This section describes the parameters for these tables, with the exception of the
PAT. See PSIP Table Parameters on page 3--155 for similar information about
PSIP table fields and parameters. See pages 3--163, 3--169, and 3--185 for similar
information about PSI, SI, and PSIP descriptor parameters respectively.

NOTE. Although you can view and edit the contents of the PAT and CAT, you

cannot export changes made to these files to the multiplexer. The PAT and CAT

are created and updated dynamically by the multiplexer; PAT and CAT parame-

ters can be edited for configuration files only from within the multiplexer.
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The Bouquet Association Table groups possible services used by the decoder to
present available services to the viewer. A particular service can belong to one or
more bouquets.

BAT parameter Possible values Notes

Bouquet ID 0 to 65535 ETSI publication ETR 162 lists valid IDs
for various bouquets.

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the list box or enter 0 or 1;
the corresponding entry changes automati-
cally.

You can define a BAT further by adding the following descriptors:

� Stuffing

� Bouquet_name

� Country_availability

� Linkage

� CA_identifier

� Private_data_specifier

� User defined

Refer to SI Descriptors, beginning on page 3--169, for more information. See the
online help for a description of the syntax for this element.

The Conditional Access Table provides the association between scrambled
elementary streams and one or more conditional access systems. The association
is specified in the conditional access descriptor loop; however, the table also
tracks version number and current/next status.

Parameter Possible Values Notes

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the list box or enter 0 or
1; the corresponding entry changes
automatically.

You can further define a CAT by adding the Conditional_access descriptor

Refer to PSI Descriptors, beginning on page 3--163 for more information. See
the online help for a description of the syntax for this element.

BAT

CAT
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The Event Information Table transmits information relating to all events that
occur in the MPEG multiplex. The EIT contains information about the current
transport stream and optionally covers other transport streams that the decoder
can receive.

EIT parameter Possible values Notes

Table ID 78 (actual TS present/follow)
79 (other TS present/follow)
80 to 95
(actual TS, schedule)
96 to 111
(other TS, schedule)

Select through the list box or enter the
appropriate number; the corresponding
entry changes automatically.

Service ID 1 to 65535 Value is identical to the program defined
in the corresponding PMT.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the list box or enter 0 or
1; the corresponding entry changes
automatically.

Section number 0 to 255 Is incremented by 1 for each additional
section with the same table ID, service
ID, TSID, and original network ID.

Last section number 0 to 255 The number of the last section with the
same table ID, service ID, TSID, and
original network ID.

Transport stream ID 0 to 65535 Identifies the transport stream that this
EIT pertains to.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

Segment last section
number

0 to 255 The last section of this sub-table
segment. If the sub-table is not seg-
mented, it is the same as the last section
number.

Last table ID 0 to 255 The last table ID used. Equal to the ID of
this table, if there are no other tables.

EIT (DVB)
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The EIT structure allows you to describe various aspects of events described
elsewhere in the SI tables.

Parameter Possible values Notes

Event ID 0 to 65535 Identifies the event

Start time Date

Time (24 hour)

yyyy/mm/dd (today’s date is suggested)

hh/mm/ss

Duration 00:00:00 to 99:59:59 hh/mm/ss

Running status 0 (Undefined)
1 (Not running)
2 (Starts in a few seconds)
3 (Pausing)
4 (Running)

Select through the list box or enter the
value and click the EIT icon; the table
editor changes the corresponding entry.

Free CA mode 0 (Not scrambled)
1 (Scrambled)

Select through the list box; the table
editor changes the numeric value.

You can further define EIT events by adding the following SI descriptors:

� Stuffing

� Linkage

� Short_event

� Extended_event

� Time_shifted_event

� Component

� CA_identifier

� Content

� Parental_rating

� Telephone

� Private_data_specifier

� Short_smoothing_buffer

� User defined

Refer to SI Descriptors, beginning on page 3--169, for more information. See the
online help for a description of the syntax for this element.

EIT Events
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The Program Map Table identifies the streams that make up each service and the
packets that contain the service streams and PCRs.

PMT parameter Possible values Notes

Program number 0 to 65535 Identifies the program.

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the list box or enter 0 or 1;
the corresponding entry changes automati-
cally.

PCR PID 0 to 8191 The PID of the transport packets that
contain the PCR fields for this program. By
default, it is the PID of the first ES in the
program. If you enter a PID other than
those of the program streams, the PCRs
reside in their own transport packets.

You can define a PMT further by adding the following descriptors:

� Registration

� Conditional_access

� ISO_639_language

� System_clock

� Multiplex_buffer_utilization

� Copyright

� Maximum_bitrate

� Private_data_indicator

� Smoothing_buffer

� Service_move

� User defined

Refer to PSI Descriptors (page 3--163) and SI Descriptors (page 3--169) for more
information. See the online help for a description of the syntax for this element.

PMT
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The Network Information Table conveys information relating to the physical
organization of the multiplexes (transport streams) carried on a given network
and to the characteristics of the network itself.

NIT parameter Possible values Notes

Table ID 64 (actual network)
65 (other network)

Select through the list box or enter 64 or
65; the corresponding entry changes
automatically.

Network ID 0 to 65535 ETSI publication ETR 162 lists valid IDs
for various networks.

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the list box or enter 0 or 1;
the corresponding entry changes automati-
cally.

You can define a NIT further by adding the following descriptors:

� Network_name

� Stuffing

� Linkage

� Private_data_specifier

� User defined

Refer to SI Descriptors, beginning on page 3--169, for more information. See the
online help for a description of the syntax for this element.

NIT
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The Running Status Table updates the timing status of one or more events, which
may be necessary when a scheduling change causes an event to be early or late.
The RST has no parameters or descriptors of its own; event parameters describe
the event and indicate its running status.

Parameter Possible values Notes

Transport stream ID 0 to 65535 Identifies the transport stream to which
the RST pertains; the TS can be in any
multiplex within the delivery system.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

Service ID 1 to 65535 Must be the same as the program
number in the corresponding PMT.

Event ID 0 to 65535 Identifies the event.

Running status 0 (Undefined)
1 (Not running)
2 (Starts in a few seconds)
3 (Pausing)
4 (Running)

Select through the list box or enter the
value and click the event icon; the table
editor changes the corresponding entry.

Refer to SI Descriptors, beginning on page 3--169, for more information. See the
online help for a description of the syntax for this element.

The Service Description Table lists the names and other parameters associated
with each service in a particular multiplex.

SDT parameter Possible values Notes

Table ID 66 (actual transport
stream)
70 (other transport stream)

Select through the list box or enter 66 or
70; the corresponding entry changes
automatically.

Transport stream ID 0 to 65535 Identifies the transport stream that this
SDT pertains to.

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the list box or enter 0 or 1;
the corresponding entry changes auto-
matically.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

RST

SDT
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You can define a SDT further by adding the following descriptors:

� Stuffing

� Bouquet_name

� Service

� Country_availability

� Linkage

� NVOD_reference

� Time_shifted_service

� Mosaic

� CA_identifier

� Telephone

� Private_data_specifier

� Multilingual_service_name

� Data_broadcast

� User defined

Refer to SI Descriptors, beginning on page 3--169, for more information. See the
online help for a description of the syntax for this element.

The Time Offset Table carries the universal coordinated time, date, and local
time offset for the current transport stream.

Parameter Possible Values Notes

UCT time:

Date

Time

YYYY/MM/DD (numeric)

XX:YY:ZZ

Y = a digit for the year
M = a digit for the month
D = a digit for the day of the month

X = hours
Y = minutes
ZZ = seconds

You can also further define a TOT by adding the following descriptor:

� Local_time_offset

Refer to SI Descriptors, beginning on page 3--169, for more information. See the
online help for a description of the syntax for this element.

TOT
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The Transport Stream Description Table describes the transport stream primarily
using the descriptor loop; however, the table also tracks version number and
current/next status.

Parameter Possible Values Notes

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the list box or enter 0 or
1; the corresponding entry changes
automatically.

You can further define a TSDT by adding the following descriptors:

� Video_stream

� Audio_stream

� Hierarchy

� Registration

� Data_stream_alignment

� Target_background_grid

� Video_window

� Conditional_access

� ISO_639_language

� System_clock

� Multiplex_buffer_utilization

� Copyright

� Maximum_bitrate

� Private_data_indicator

� Smoothing_buffer

� STD

� IBP

� User defined

Refer to SI Descriptors, beginning on page 3--169, for more information. See the
online help for a description of the syntax for this element.

TSDT
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The PMT can have up to ten elementary streams. A transport stream (and
therefore a single PMT) can have no more than five elementary streams of a
given type.

ES PMT parameter Possible values Notes

Stream type See Table 3--27 Select through the list box; the table
editor changes the corresponding value.

Elementary PID 16 though 8190 Assigned automatically by the table
editor; change to prevent conflicts with
other elementary streams in other
programs.

Table 3--27 on page 3--153 describes the options available in the stream type
parameter selection box.

Table 3- 27: Elementary stream types for MPEG-2 and DVB environments

Stream Type Description Value

ITU--T | ISO/IEC Reserved 0

ISO/IEC 11172 Video (MPEG1) 1

ITU--T Rec. H.262 | ISO/IEC 13818--2 Video or ISO/IEC 11172--2 constrained
parameter video stream

2

ISO/IEC 11172 Audio 3

ISO/IEC 13818--3 Audio 4

ITU--T Rec. H.222.0 | ISO/IEC 13818--1 private_sections 5

ITU--T Rec. H.222.0 | ISO/IEC 13818--1 PES packets containing private data 6

ISO/IEC 13522 MHEG 7

ITU--T Rec. H.222.0 | ISO/IEC 13818--1 Annex A DSM CC 8

ITU--T Rec. H.222.1 9

ISO/IEC 13818--6 type A 10

ISO/IEC 13818--6 type B 11

ISO/IEC 13818--6 type C 12

ISO/IEC 13818--6 type D 13

ISO/IEC 13818--1 auxiliary 14

ITU--T Rec. H.222.0 | ISO/IEC 13818--1 Reserved 15 – 127

User Private 128;
130 – 255

Audio Dolby AC-3 (user private) 129

Elementary Streams
(in PMT)
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You can further define an elementary stream by adding the following descriptors:

� Video_stream

� Audio_stream

� Hierarchy

� Registration

� Data_stream_alignment

� Target_background_grid

� Video_window

� Conditional_access

� ISO_639_language

� Multiplex_buffer_utilization

� Copyright

� Maximum_bitrate

� Private_data_indicator

� Smoothing_buffer

� STD

� IBP

� Mosaic

� Stream_identifier

� Teletext

� User defined

Refer to PSI Descriptors (page 3--163) and SI Descriptors (page 3--169) for more
information.

The transport streams carried in a network or bouquet are uniquely identified by
a combination of transport_stream_id and original_network_id.

Parameter Possible values Notes

Transport stream ID 0 to 65535 Identifies the transport stream; correlates
to TSID parameters in the SDT and EIT
following an analysis.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

You can further define transport streams by adding the following SI descriptors:

� Service_list

� Stuffing

� Satellite_delivery_system

� Cable_delivery_system

� Terrestrial_delivery_system

Transport Streams
(in NIT or BAT)
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� Private_data_specifier

� Frequency_list

� User defined

Refer to SI Descriptors, beginning on page 3--169, for more information.

PSIP Table Parameters

You can specify the parameters of the following ten PSI and PSIP tables using
the MTS300 PSIP Table Editor:

� PAT

� PMT

� CAT

� EIT

� ETT

� MGT

� SST

� RRT

� TVCT and CVCT

This section describes the parameters for the PSIP tables listed above. See PSI
and SI Table Parameters, on page 3--144 for similar information about PSI and
SI table items, including the CAT. See pages 3--163, 3--169, and 3--185 for
similar information about PSI, SI, and PSIP descriptor parameters respectively.

NOTE. Although you can view and edit the contents of the PAT and CAT, you

cannot export changes made to these files to the multiplexer. The PAT and CAT

are created and updated dynamically by the multiplexer; PAT and CAT parame-

ters can be edited for configuration files only from within the multiplexer.
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The EIT contains information (title, start times, etc.) for events on defined virtual
channels. An event is in most case, a typical TV program, however its definition
may be extended to include particular data broadcasting session and other
information segments.

Parameter Possible Values Notes

Source Id 0 to 65535 Specifies the source id of the virtual
channel carrying the events described in
this section.

Located in the top level of EIT section.

Event Id 0 to 16383 Identification number of the event
described.

Located in the Event EIT element.

Start time 0 to 4 294 967 295 Input the start time as indicated:
XX/YY/ZZZZ AA:BB:CC where:

XX indicates the month (01 – 12)
YY indicates day of the month (01 –31)
ZZZZ indicates the year
AA indicates the hour (00 – 23)
BB indicates the minutes (00 – 59)
CC indicates the seconds (00 – 59)

Located in the Event EIT element.

ETM location 0 : No ETM
1 : ETM located in the PTC carrying this PSIP
2 : ETM located in the PTC specified by the channel_TSID

3 : [Reserved for future ATSC use]

Length in second 0 to 1048576
(12 d, 3 h 16 m 15s)

Input the length of the event in hours,
minutes, and seconds as described
above for the Start time.

Located in the Event EIT element.

Title text Event title Located in the Title multiple string
structure.

An EIT can be further defined with the addition of the following descriptors:

� Stuffing

� User

� AC--3 audio

� Caption Service

� Content Advisory

See page 3--185 for descriptions of PSIP descriptors. See the online help for a
description of the syntax for this element.

EIT (PSIP)
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The Extended Text Table contains one or more Extended Text Message (ETM)
stream. ETTs are optional and are used to provide detailed description of virtual
channels and events. An ETM is a multiple string data structure (seeMultiple

String Structure on page 3--162). An ETT can be a message that applies to a
channel specified by the VCT, or an event specified by the EIT; the method of
specifying the ETM_id is different depending on whether the ETT is an event or
channel message.

Parameter Possible values Notes

ETM id Unique 32 bit identifier of an extended
text message.

An ETM_id is specified using the method describe in Table 3--28.

Table 3- 28: Channel and Event ETM id

ETM_id type
First 5 digits
(MSB 32....16)

Middle 5 digits
(bits 15....2) Last digit (LSB )

Channel ETM_id source_id 0s 0 – 0

Event ETM_id source_id event_id 1 – 0

See the online help for a description of the syntax for this element.

The Master Guide Table lists version numbers, length in bytes, and PIDs for all
the PSIP tables with the exception of the STT, which is independent of the other
PSIP tables.

This table is normally transmitted in only one section; however, several sections
can be edited

Parameter Possible values Notes

Table type See Table 3--29. Identifies the type of the table which is
described.

Table type PID 0 to 8191 Identifies the PID of the described table.

Table type version
number

0 to 31 Identifies the version number of the
described table.

Number bytes 0 to 4 294 967 295 Identifies the size in bytes of the the
described table.

ETT

MGT
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Table 3--29 describes the options available in the table type parameter drop-down
box.

Table 3- 29: Table type values for the MGT

Table type value Meaning

0 Terrestrial VCT with current_next_indicator=1

1 Terrestrial VCT with current_next_indicator=0

2 Cable VCT with current_next_indicator=1

3 Cable VCT with current_next_indicator=0

4 Channel ETT

5--255--0x00FF Reserved

256 to 383 EIT--0 to EIT--127

384 to 511 Reserved

512 to 639 Event ETT--0 to event ETT--127

640 to 768 Reserved

769 to 1023 RRT with rating_region 1 to255

1024 to 4095 User private

4096 to 65535 Reserved

A MGT can be further defined with the addition of the following descriptors:

� Stuffing

� User

See page 3--185 for descriptions of PSIP descriptors. See the online help for a
description of the syntax for this element.
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The Rating Region Table (RRT) carries rating information for multiple
geographical regions. Each RRT sub-table identifies a rating_region. This table
is normally transmitted in only one section; however, several sections can be
edited.

Parameter Possible values Notes

Rating Region 0 : Forbidden
1: US (50 states + possessions)
2 to 255 : Reserved

Rating region name Limited to 32 characters Located in multiple string structure.

Dimension name Limited to 20 characters Located in Table Dimension multiple
string structure.

Graduated scale 1 : graduated scale
2 : not graduated

Located in Table Dimension.

Abbrev rating value Limited to 8 characters Located in Dimension Value multiple
string structure.

Rating value Limited to 150 characters Located in Dimension Value multiple
string structure.

A RRT can be further defined with the addition of the following descriptors:

� Stuffing

� User

See page 3--185 for descriptions of PSIP descriptors. See the online help for a
description of the syntax for this element.

The System Time Table provides the current date and time of day information.
This table is normally transmitted in only one section; however, several sections
can be edited.

Parameter Possible values Notes

GPS UTC offset 0 to 255 Current offset in whole second between
GPS and UTC time standards.

A STT can be further defined with the addition of the following descriptors:

� Stuffing

� User

See page 3--185 for descriptions of PSIP descriptors. See the online help for a
description of the syntax for this element.

RRT

STT
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The Virtual Channel Table contains a list of attributes for virtual channel carried
in the Transport Stream. A VCT can be specified for either Terrestrial broadcast
(TVCT), or Cable broadcast (CVCT).

Parameter Values Notes

Transport stream id 0 to 65535 Identifies the transport stream Id.

Short name 7 UNICODE characters

Major channel
number

1 to 999

Minor channel
number

0 to 999

Modulation mode See the table below Defines the used modulation.

Carrier frequency 0 to 4 294 967 295

Channel TSID 0 to 65535 Identifies the Transport stream of the
currently defined program.

Program number 0 to 65535 Identifies the program, which must
match a program number in a PMT.

ETM location 0 : No ETM
1 : ETM located in the PTC carrying this PSIP
2 : ETM located in the PTC specified by the channel_TSID

3 : [Reserved for future ATSC use]

Access controlled 1 : Events are access controlled
0 : Events are not restricted

Hidden 1 : Not accessible by a direct entry in the VCT
0 : Accessible

Path select1 0 : Path 1
1 : Path 2

Out of band1 1 : Carried in an out of band physical transmission channel
0 : Carried within a standard tuned multiplex at that frequency

Service type See the table below

Source id 0 to 65535 Identifies the programming sources
associated with the virtual channel.

1 Only used in the CVCT

Table 3--30 describes the options available in the drop-down selection box for the
modulation mode parameter.

VCT
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Table 3- 30: Modulation mode values for the VCT

Modulation value Associated modulation type

0 [Reserved]

1 Analog — The virtual channel is modulated using standard analog
methods for analog television.

2 SCTE_mode_1 — The virtual channel has a symbol rate of 5.057 Msps,
transmitted in accordance with Digital Transmission Standard for Cable
Television, Ref. [12] (Mode 1). Typically, mode 1 will be used for
64 QAM.

3 SCTE_mode_2 — The virtual channel has a symbol rate of 5.361 Msps,
transmitted in accordance with Digital Transmission Standard for Cable
Television, Ref. [12] (Mode 2). Typically, mode 2 will be used for
256 QAM.

4 ATSC (8 VSB) — The virtual channel uses the 8--VSB modulation
method conforming to the ATSC Digital Television Standard.

5 ATSC (16 VSB) — The virtual channel uses the 16--VSB modulation
method conforming to the ATSC Digital Television Standard

6 to 127 [Reserved for future use by ATSC]

128 Modulation parameters are defined by a private descriptor

129 to 255 [User Private]

Table 3--31 describes the options available in the drop-down selection box for the
service type parameter.

Table 3- 31: Service type values for the VCT

Service type value Associated service type

0 [Reserved]

1 Analog_television — The virtual channel carries analog television
programming

2 ATSC_digital_television — The virtual channel carries television
programming (audio, video and data) conforming to the ATSC Digital
Television Standard

3 ATSC_audio_only — The virtual channel conforms to the ATSC Digital
Television Standard, and has one or more standard audio and data
components but no video.

4 ATSC_data_broadcast_service — Conforming to the ATSC data
broadcast standard under development by T3/S13.

5 to 63 [Reserved for future ATSC use]
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A TVCT and CVCT can be further defined with the addition of the following
descriptors:

� Stuffing

� User

� Extended Channel Name

� Service Location

� Time--Shifted Service

See page 3--185 for descriptions of PSIP descriptors.

This is a general data structure used specifically for text strings. Text strings
appear as event titles, long channel names, the ETT messages, and RRT text
items. The text in Multiple string structures is not compressed or uncompressed.
If a table is opened with a compression mode the data can be displayed in
hexadecimal mode.

Parameter Possible values Notes

ISO_639_language_
code

3 bytes for the language code

Compression type 0 : No compression

1 : Huffman coding using standard encode/decode tables defined in
Table C.4 and C.5 in Annex C.

2 : Huffman coding using standard encode/decode tables defined in
Table C.6 and C.7 in Annex C.

3 to 175 : Reserved

176 to 255 : User private

Mode Text mode to be used to interpret
characters.

Multiple String Structure
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PSI Descriptors

Descriptors are structures which may be used to extend the definitions of the
elements to which they refer. This section describes the descriptor parameters for
PSI structures. In most cases, a range of possible values is given for each
descriptor.

See the online help for syntax descriptions of PSI descriptors.

The audio_stream_descriptor identifies the coding version of an audio elementa-
ry stream.

Parameter Possible values Notes

Free format flag Bitrate index≠ 0000 (0)
Bitrate index= 0000 (1)

Select through the list box; the table
editor changes the numeric value.

ID 0 or 1 Set this to the same value as the ID
fields in the audio stream.

Layer 0 to 3 Set this to the same value as the layer
fields in the audio stream.

Variable rate audio
indicator

No decoding discontinuity (0)
Decoding discontinuity (1)

Select through the list box; the table
editor changes the numeric value.

The conditional_access_descriptor is used, where required, to enable scrambling,
either system-wide or of a service, program, elementary stream, or event.

Parameter Possible values Notes

CA system ID 0 to 65535 Indicates the applicable type of CA
(scrambling) system; private and not
defined in international standards.

CA PID 0 to 8191 The PID of the transport stream packets
that contain conditional access (ECM or
EMM) information.

Private data bytes An even number of hexade-
cimal characters

May be specified by the CA system
provider.

Audio Stream Descriptor

Conditional Access
Descriptor
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The copyright_descriptor can identify copyrighted work. The descriptor applies
to the entire program when added to a PMT and to a single elementary stream
when added to an ES.

Parameter Possible values Notes

Copyright identifier 0 through 232 Identifies the copyright registration
authority; number is provided by
ISO/IEC JTC1/SC29.

Additional copyright
information

An even number of hexade-
cimal characters

May be specified by the copyright
registration authority.

The data_stream_alignment_descriptor indicates the type of alignment used in
the elementary stream.

Parameter Possible values Notes

Alignment type 1 (Slice, video access unit,
or audio syncword)
2 (Video access unit)
3 (GOP or SEQ)
4 (SEQ)

Select through the list box; the table
editor changes the numeric value.

(GOP = group of pictures)

The hierarchy_descriptor identifies program elements that contain parts of
elementary streams that are multiplexed in multiple transport streams.

Parameter Possible values Notes

Hierarchy type 1 (Spatial scalability)
2 (SNR scalability)
3 (Temporal scalability)
4 (Data partitioning)
5 (Extension bitstream)
6 (Private stream)
15 (Base layer)

Select through the list box or enter the
number and click the descriptor icon; the
table editor changes the corresponding
entry.

Hierarchy layer index 0 to 63 The hierarchy index of the elementary
stream; no two streams in a program can
have the same index.

Hierarchy embedded
layer index

0 to 63 Defines the hierarchy table index of the
program element that must be accessed
before the elementary stream can be
decoded.

Hierarchy channel 0 to 63 Indicates the intended transmission
channel of the elementary stream.

Copyright Descriptor

Data Stream Alignment
Descriptor

Hierarchy Descriptor
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The IBP_descriptor indicates how groups of (I, P, and B) pictures are encoded in
the video elementary stream.

Parameter Possible values Notes

Closed GOP flag 0 or 1 Set to 1 when a group of pictures header
is encoded before every I-frame.

Identical GOP flag 0 or 1 Set to 1 when the sequence of picture
types between I-frames is the same
throughout the sequence.

Max GOP length 1 to 16383 The maximum number of coded pictures
between any two I-pictures in the
sequence.

The ISO_639_language_descriptor, through sub-descriptors, identifies the
language or languages used in associated program elements. You can set two
sub-descriptor parameters through the table editor.

Parameter Possible values Notes

ISO 639
language code

Three alpha characters See ISO 639

Audio type 1 (clean effects)
2 (hearing impaired)
3 (visual impaired commen-
tary)

Select through the list box; the table
editor changes the numeric value.

The maximum_bitrate_descriptor indicates the highest bitrate, including
transport overhead, to be encountered in the program or program element. If you
add the descriptor to the PMT, the indicated bitrate applies to the entire program.
If you add the descriptor to the ES icon, it applies to a single elementary stream.

Parameter Possible values Notes

Maximum bitrate 0 to 4194303 (222) Units are 50 bytes/second

IBP Descriptor

ISO 639 Language
Descriptor

Maximum Bitrate
Descriptor



PSI, DVB SI, and ATSC PSIP Table Item Parameters

3- 166 MTS300 Stream Creation Applications User Manual

The multiplex_buffer_utilization_descriptor provides upper and lower time
limits for occupancy of the T-STD multiplex decoder. This information may be
used by some remultiplexing devices.

Parameter Possible values Notes

Bound valid flag Not valid (0)
Valid (1)

Applies to the LTW offset bounds of this
descriptor; select through the list box;
the table editor changes the numeric
value.

LTW offset
lower bound

0 to 32767 The lower limit, in (27 MHz/300) clock
periods, of LTW offset values in the
stream(s) referenced by this descriptor.

LTW offset
Upper bound

0 to 32767 The upper limit, in (27 MHz/300) clock
periods, of LTW offset values in the
stream(s) referenced by this descriptor.

The private_data_descriptor can facilitate compatible private extensions to the
PSI data stream.

Parameter Possible values Notes

Private data indicator 0 to 232 The value of this parameter has no
universal meaning; the target decoder
must be able to interpret the value.

The registration_descriptor identifies private data formats.

Parameter Possible values Notes

Format identifier 0 to 232 Assigned by a registration authority.

Additional identifica-
tion information.

An even number of hexade-
cimal characters

Defined by the assignee of the for-
mat_identifier.

The smoothing_buffer_descriptor describes the smoothing buffer for the program
or elementary stream.

Parameter Possible values Notes

SB leak rate 0 to 4194303 (222) The rate at which data is removed from
the buffer, in units of 400 bits/second.

SB size 0 to 4194303 (222) Size of the smoothing buffer, in bytes.

Multiplex Buffer Utilization
Descriptor

Private Data Descriptor

Registration Descriptor

Smoothing Buffer
Descriptor
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The STD_descriptor determines how the T-STD transfers elementary stream data
from the multiplex buffer to the elementary stream buffer. The leak method is the
default, used if this descriptor is not present.

Parameter Possible values Notes

Leak valid flag 0 (VBV_delay method)
1 (Leak method)

Select through the list box; the table
editor changes the numeric value.

The system_clock_descriptor conveys information about the system clock used
to generate program time stamps.

Parameter Possible values Notes

External clock refer-
ence indicator

0 (Internal reference)
1 (External reference)

Select through the list box; the table
editor changes the numeric value

Clock accuracy
integer

0 to 63 These parameters together indicate
system clock accuracy in ppm; if
clock accuracy integer 0 system

Clock accuracy
exponent

0 to 7
clock_accuracy_integer = 0, system
clock accuracy is, by default, 30 ppm.

The target_background_grid_descriptor, combined with the video_window_des-
criptor, determines the placement of an undersized picture on the display area.
The target_background_grid_descriptor describes the display area.

Parameter Possible values Notes

Horizontal size 0 to 16383 Horizontal size, in pixels, of the target
background grid (display area).

Vertical size 0 to 16383 Vertical size, in pixels, of the target
background grid (display area).

Aspect ratio
information

1 (1.0000)
2 (0.6735)
3 (0.7031)
4 (0.7615)
5 (0.8055)
6 (0.8437)
7 (0.8925)
8 (0.9157)
9 (0.9815)
10 (1.0255)
11 (1.0695)
12 (1.0950)
13 (1.1575)
14 (1.2015)

Select the correct ratio through the list
box; the table editor automatically
changes the parameter value.

See ISO/IEC13818-2 for a definition of
aspect_ratio_information.

STD Descriptor

System Clock Descriptor

Target Background Grid
Descriptor
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The video_stream_descriptor identifies the coding parameters of a video elementa-
ry stream.

Parameter Possible values Notes

Multiple frame rate
flag

0 (Single frame rate)
1 (Multiple frame rates)

Select through the list box; the table
editor changes the numeric value

Frame rate code 1 (23.976)
2 (24.0, 23.976*)
3 (25.0)
4 (29.97, 23.976*)
5 (30.0, 23.976*, 24*, 29.97*)
6 (50.0, 25.0*)
7 (59.94, 23.976*, 29.97*)
8 (60.0, 23.976*, 24.0*,
29.97*, 30.0*, 59.94*)

Frames per second

Starred (*) rates are permitted when the
multiple frame rate flag = 1

MPEG-1 only flag 0 (MPEG-1 or -2 video data)
1 (MPEG-1 video data)

Select through the list box; the table
editor changes the numeric value.

Constrained
parameter flag

0 or 1 Set to 0 when the video stream may
contain both constrained and uncon-
strained video data; always set to 1
when the MPEG-1_only_flag is set to 0.

Still picture flag 0 (Moving and still pictures)
1 (Still pictures)

Available when the MPEG1_only_flag
is 0; Select through the list box; the table
editor automatically changes the numeric
value.

Profile and level
indicator

0 to 255 Available when the MPEG1_only_flag
is 0; set this to the same value as the
profile_and_level_indication fields in the
video stream.

Chroma format 1 (4:2:0)
2 (4:2:2)
3 (4:4:4)

Available when the MPEG1_only_flag
is 0; set this to the same value as the
chroma_format fields in the video
stream.

frame rate extension
flag

0 or 1 Available when the MPEG1_only_flag
is 0; set this flag to 1 when either the
frame_rate_extension_n or the
frame_rate_extension_d field in the
video stream is non-zero.

Video Stream Descriptor
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The video_window_descriptor, combined with the target_background_grid_des-
criptor, determines the placement of an undersized picture (or window) on the
display area. The video_window_descriptor determines the location of the
smaller picture on the display area and the priority of the picture when it
overlaps with other pictures on the same display.

Parameter Possible values Notes

Horizontal offset 0 to 16383 Horizontal position of the video window,
in pixels, from the left edge of the
background grid (display area).

Vertical offset 0 to 16383 Vertical position of the video window, in
pixels, from the top edge of the back-
ground grid (display area).

Window priority 0 to 15 Zero is the lowest priority, 15 is the
highest; windows with priority 15 are
always visible.

SI Descriptors

Descriptors are structures which may be used to extend the definitions of the
elements to which they refer. This section describes the descriptor parameters for
SI structures. In most cases, a range of possible values is given for each
descriptor. Descriptors are listed alphabetically.

See the online help for syntax descriptions of SI descriptors.

The bouquet_name_descriptor carries the bouquet name in text form.

Parameter Possible values Notes

Name Alphanumeric characters —

Video Window Descriptor

Bouquet Name Descriptor
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The CA_identifier descriptor indicates that the bouquet, service, event, or
component is associated with a conditional access system and identifies the type
of CA system. You must add a sub-descriptor in order to specify the CA system;
the table lists values for the CA system sub-descriptor parameter.

Parameter Possible values Notes

CA system ID Reserved (0)
Standardized Systems (1)
Canal Plus (256)
CCETT (512)
Deutch Telecom (768)
Eurodec (1024)
France Telecom (1280)
Irdeto (1536)
Jerrold/GI (1792)
Matra Communication (2048)
News Datacom (2304)
Nokia (2560)
Norwegian Telecom (2816)
NTL (3072)
Philips (3328)
Scientific Atlanta (3584)
Sony (3840)
Tandberg Television (4096)
Thomson (4352)
TV/Com (4608)
HPT—Croatian P&T (4864)
HRT—Croatian R&TV (5120)
IBM (5376)
Nera (5632)
BetaTechnik (5888)

When you select the system ID through
the list box, the table editor automatically
changes the numeric value.

Each CA system specifier has been
assigned a range of numeric values; see
ETR 162 for more information.

Enter an appropriate number in the value
box and click the sub-descriptor icon; the
table editor automatically changes the
CA system specifier name to match.

CA Identifier Descriptor
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The cable_delivery_system descriptor identifies the characteristics of the cable
delivery system.

Parameter Possible values Notes

Frequency 0000.0000 to 9999.9999 MHz

FEC outer 1 (No outer FEC coding)
2 (RS 204/188)

Select through the list box or enter the
appropriate value and click the descriptor
icon.

Modulation 1 (16 QAM)
2 (32 QAM)
3 (64 QAM)
4 (128 QAM)
5 (256 QAM)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Symbol rate 000.0000 to 999.9999 Msymbols/second.

FEC inner 1 (1/2 conv. code rate)
2 (2/3 conv. code rate)
3 (3/4 conv. code rate)
4 (5/6 conv. code rate)
5 (7/8 conv. code rate)
15 (No conv. coding)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

The component_descriptor identifies the type of component stream and may be
used to provide a text description of the elementary stream.

Parameter Possible values Notes

Stream content 1 (Video)
2 (Audio)
3 (Teletext)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-

i h di fi ldComponent type Value depends on stream
content; see Table 3--32

; pp pp p
ate entry in the corresponding field.

Component tag 0 to 255 Enter the same value as in the PMT
stream_identifier descriptor (if present).

ISO 639 language
code

A 3-character language code
as defined in ISO 639

Use when the stream content is audio or
teletext.

Description Alphanumeric characters A text description of the elementary
stream.

Cable Delivery System
Descriptor

Component Descriptor
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The possible component types depend on the value of the stream content
parameter.

Table 3- 32: Component type values

Stream Content Possible component type values

Video (1) 1 (4:3 aspect ratio)
2 (16:9 aspect ratio with pan vectors)
3 (16:9 aspect ratio without pan vectors)
4 (Greater than 16:9 aspect ratio)

Audio (2) 1 (Single mono channel)
2 (Dual mono channel)
3 (Stereo (2 channel))
4 (Multi-lingual, multi-channel)
5 (Surround sound)
64 (For visually impaired)
65 (For the hard of hearing)

Teletext (3) 1 (EBU teletext subtitles)
2 (Associated EBU teletext)
10 through 13, 32 through 35 (Various DVB subtitle types; refer to
ETS 300 468)

The content_descriptor classifies event content. ETS 300 468 lists more than 75
content classifications such as “motor sport” or “musical/opera.” The content
descriptor must have a content nibble sub-descriptor. The following table
describes the sub-descriptor parameters.

Parameter Possible values Notes

Content nibble level 1 1 (Movie)
2 (News/current affairs)
3 (Show/game show)
4 (Sports)
5 (Children/youth programs)
6 (Music/ballet/dance)
7 (Arts/culture)
8 (Social/political/economics)
9 (Education/science/factual
10 (Leisure hobbies)

The content class. Select through the list
box; the table editor automatically
changes the numeric value.

You may also enter an appropriate
number in the value box and click the
sub-descriptor icon; the table editor
automatically changes the CA system
specifier name to match.

Content nibble level 2 Choices depend on and
correspond to the level 1
selection. See ETS 300 468
for a complete list.

The content sub-class. Select through
the list box, the table editor automatically
changes the numeric value.

User nibble (2 fields) 0 to 15 Defined by the broadcaster

Content Descriptor
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The country_availability_descriptor can list either the countries for which the
bouquet or service is intended or countries for which it is not intended. You can
add both an intended and a not intended descriptor; if the lists conflict, the not
intended descriptor takes precedence.

Parameter Possible values Notes

Country availability
flag

0 (Not intended)
1 (Intended)

Enter the flag value or select from the list
box.

Country code One or more 3-character
country codes as specified in
ISO 3166 [2] or ETR 162

Do not insert spaces between the codes.
For example, to specify both the UK and
Scandinavia, enter GBR900.

The extended_event_descriptor can provide a detailed description of an event.
You may use a set of up to 16 extended event descriptors in addition to the short
event descriptor.

Parameter Possible values Notes

Descriptor number 0 to 15 Determines the order of this descriptor in
the set of associated descriptors.

Last descriptor
number

0 to 15 The number of the last descriptor in this
set of extended event descriptors.

ISO 639 language
code

A 3-character language code
as defined in ISO 639

The language of the descriptor text.

Text char Up to 256 alphanumeric
characters

The descriptor text.

You can use extended event sub-descriptors to arrange text into two columns.
Each sub-descriptor Edit window has an “item description char” field and an
“item char” field. In a typical application, the information in the extended event
sub-descriptors is arranged as follows:

item_description_chars_1 item_chars_1
item_description_chars_2 item_chars_2
item_description_chars_3 item_chars_3

Actual content could resemble the following:

Title: MTS300 Series, The Movie
Director: John D. Rector
Producer: Jack Producer

The number of sub-descriptors appears as “Nb item:” (in gray characters) on the
extended event descriptor Edit window.

Country Availability
Descriptor

Extended Event
Descriptor
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If a transport stream is to be transmitted over multiple frequencies, the
frequency_list_descriptor provides a complete list of frequencies. The
frequency_list descriptor itself describes the deliver system for the frequency
specified in the center_frequency sub-descriptor

Parameters Possible values Notes

Coding type 0 : Not defined
1 : Satellite
2 : Cable
3 : Terrestrial

Select through the list boxes or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Center frequency Sub-descriptor. Enter the values in 10 Hz
increments.

The linkage_descriptor identifies a service that can be presented when the
consumer requests additional information.

Parameter Possible values Notes

Transport stream ID 0 to 65535 Identifies the TS that contains the
indicated information service

Original network ID 0 to 65535 The network ID of the originating delivery
system for the indicated information
service.

Service ID 0 to 65535 Uniquely identifies an information service
within a transport stream; must be the
same as the program number in the
corresponding PMT.

Linkage type 1 (Information)
2 (Electronic program guide)
3 (CA replacement)

Enter the value or select from the list
box.

Private data bytes An even number of hexade-
cimal characters

Frequency List Descriptor

Linkage Descriptor
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The local_time_offset descriptor allows you to add a local time offset to the
TOT.

Parameter Possible values Notes

Country code A (a) through Z (z) Three letter country identifier

Country region ID 0 to 63 Zone in the country indicated by the
country_code parameter (if the country
includes more than one zone).

Local time offset
polarity

0: Positive polarity
1: Negative polarity

Direction to apply the offset from UTC.
Positive poliarity indicates that the local
time is ahead of UTC; negative polarity
indicates that the local time is behind
UTC.

Local time offset XX:YY

X = hours (0 through 24)
Y = minutes (0 through 60)

Current offset time relative to UTC

Time of change:

Date

Time

YYYY/MM/DD (numeric)

XX:YY:ZZ

Y = year
M = month 1 through 12
D = day of the month (1 through 31)

X = hours (0 through 24)
Y = minutes (0 through 60)
ZZ = seconds (0 through 60)

Next time offset XX:YY

X = hours (0 through 24)
Y = minutes (0 through 60)

Next offset time when the time change
occurs.

UCT time:

Date

Time

YYYY/MM/DD (numeric)

XX:YY:ZZ

Y = year
M = month )1 through 12)
D = day of the month (1 through 31)

X = hours (0 through 24)
Y = minutes (0 through 60)
ZZ = seconds (0 through 60)

Local Time Offset
Descriptor
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The multilingual_service_name_descriptor provides the service name in one or
more languages. The descriptor itself indicates the number of sub-descriptors
used (you can describe a service in any number of languages, however, you need
to use a sub-descriptor for each language). The sub-descriptor parameters are
described below.

Parameter Possible values Notes

ISO 639 language
code

Three alpha characters See ISO 639

Service provider
name

Alpha-numeric characters This field is not used for the component
or bouquet name sub-descriptors.

Service name Alpha-numeric characters This field is analogous to the Bouquet
name and the Text description parame-
ters in the multilingual_bouquet_name
and the multilingual_component_name
sub_descriptors.

The definitions provided in the preceding table for the ISO 639 and the Service
name sub-descriptor parameters are also used for the following descriptors:

� multilingual_bouquet_name_descriptor

� multilingual_component_name_descriptor

The mosaic_descriptor and sub-descriptors can describe a mosaic component,
which is a collection of different video images that form a coded video compo-
nent. Each video image occupies a small region of the screen. The information in
the descriptors and sub-descriptors determines the content and arrangement of
the mosaic. Refer to ETS 300 468 for a full explanation of the mosaic descriptor
and sub-descriptors.

Parameter Possible values Notes

Mosaic entry point 0 or 1 A value of 1 indicates that this mosaic is
the highest in a hierarchy.

Nb of horizontal
elementary cells

0 (one cell)
1 (two cells)
...
7 (eight cells)

Cells = value+1

Enter the value or select from the list
box.

Nb of vertical
elementary cells

0 (one cell)
1 (two cells)
...
7 (eight cells)

Cells = value+1

Enter the value or select from the list
box.

Multilingual Service,
Component and Bouquet

Name Descriptors

Mosaic Descriptor
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The mosaic sub-descriptors have the following parameters:

Parameter Possible values Notes

Logical cell ID 0 to 63

Cell presentation info 0 (undefined)
1 (video)
2 (still picture)
3 (graphics/text)

Enter the value or select from the list
box.

Cell linkage info 0 (undefined)
1 (bouquet related)
2 (service related)
3 (other mosaic related)
4 (event related)

Enter the value or select from the list
box.

Bouquet ID 0 through 65535 Present only if the cell linkage info value
is 1.

Original network ID 0 through 65535 Present when cell linkage info value is
2 3 4

Transport stream ID 0 through 65535
2, 3, or 4.

Service ID 0 through 65535

Event ID 0 through 65535 Present only if the cell linkage info value
is 4.

Each mosaic sub-descriptor may have several sub-sub-descriptors. The sub-sub-
descriptors have only one parameter, the elementary cell ID, which can have a
numeric value from 0 to 63.

The network_name_descriptor provides the network name.

Parameter Possible values Notes

Network name Alphanumeric characters The network name

The NVOD_reference_descriptor, in conjunction with the time-shifted service
and time-shifted event descriptors, provide a mechanism for describing a group
of services that carry the same event sequence at start times that are offset from
one another. Such a group of time-shifted services is known as near video on
demand, or NVOD.

The NVOD reference descriptor uses sub-descriptors to list the services that
together form an NVOD service. The following table lists the NVOD reference
sub-descriptor parameters.

Network Name Descriptor

NVOD Reference
Descriptor
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Parameter Possible values Notes

Transport stream ID 0 to 65535 Identifies the TS that contains the
service.

Original network ID 0 to 65535 The network ID of the originating delivery
system for the service.

Service ID 0 to 65535 Uniquely identifies the service within a
transport stream; must be the same as
the program number in the correspond-
ing PMT.

The parental_rating_descriptor, through sub-descriptors, can contain a rating
based on country and age of the potential viewers. The following table lists the
parental rating sub-descriptor parameters.

Parameter Possible values Notes

Country code A 3-character country code Codes are specified in ISO 3166 [2]

Rating (+3 = mini-
mum age)

1 to 15 The suggested minimum age of viewers
is the rating plus three; thus a rating of 4
suggests that viewers should be at least
7 years old.

The private_data_specifier_descriptor identifies the source of private data used in
the SI stream so the decoder can reliably interpret the private data. The location
of this descriptor determines the entities (network, bouquet, events, or services)
to which it applies; refer to ETS 300 468 for a complete explanation.

Parameter Possible values Notes

Private data specifier 0 to 232 Assigned in ETR 162 [6]

Parental Rating Descriptor

Private Data Specifier
Descriptor
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The satellite_delivery_system_descriptor identifies the characteristics of the
satellite delivery system.

Parameter Possible values Notes

Frequency (GHz) 000.00000 to 999.99999 —

Orbital position 000.0 to 999.9 Degrees; many possible entries are
meaningless.

West east flag 0 (Western position)
1 (Eastern position)

Enter the value or select from the list
box.

Polarization 0 (linear–horizontal)
1 (linear–vertical)
2 (circular–left)
3 (circular–right)

Enter the value or select from the list
box.

Modulation 0 (undefined)
1 (QPSK)

Enter the value or select from the list
box.

Symbol rate 000.0000 to 999.9999 Msymbols/second.

FEC inner 1 (1/2 conv. code rate)
2 (2/3 conv. code rate)
3 (3/4 conv. code rate)
4 (5/6 conv. code rate)
5 (7/8 conv. code rate)
15 (No conv. coding)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

The service_descriptor provides the service type, service name, and service
provider.

Parameter Possible values Notes

Service type 0 (reserved)
1 (digital television)
2 (digital radio sound)
3 (teletext)
4 (NVOD reference)
5 (NVOD time-shifted service)
6 (mosaic)
7 (PAL coded signal)
8 (SECAM coded signal)
9 (D/D2–MAC)
10 (FM radio)
128 to 254 (user defined)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Provider name Alphanumeric text

Service name Alphanumeric text

Satellite Delivery System
Descriptor

Service Descriptor
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The service_list_descriptor uses sub-descriptors to list the services in a transport
stream by service ID and type. The table lists the service list sub-descriptor
parameters.

Parameter Possible values Notes

Service ID 0 to 65535 Uniquely identifies the service within a
transport stream; must be the same as
the program number in the correspond-
ing PMT except when the service type is
NVOD reference.

Service type 0 (reserved)
1 (digital television)
2 (digital radio sound)
3 (teletext)
4 (NVOD reference)
5 (NVOD time-shifted service)
6 (mosaic)
7 (PAL coded signal)
8 (SECAM coded signal)
9 (D/D2–MAC)
10 (FM radio)
128 to 254 (user defined)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

The service_move_descriptor enables a decoder to track a service as it is moved
from one transport stream to another.

Parameter Possible values Notes

New
original network ID

0 to 65535 The ONID of the transport stream after
the move.

New
transport stream ID

0 to 65535 The TSID after the move.

Service List Descriptor

Service Move Descriptor
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The short_event descriptor provides the event name and a short text description
of the event. If a longer description is required, use up to 15 extended event
descriptors in addition to this descriptor.

Parameter Possible values Notes

ISO 639 language
code

A 3-character language code
as defined in ISO 639

The language of the text used in this
descriptor.

Event name Alphanumeric text

Description Alphanumeric text

The short_smoothing_buffer_descriptor can appear in EIT present/following and
EIT schedule tables to indicate the bit rate of each event.

Parameter Possible values Notes

SB size 0 (DVB reserved)
1 (buffer = 1536 bytes)

Enter the value or select from the list box

SB leak rate 0 (DVB reserved)
1 (0.0009 Mbits/s)
2 (0.0018 Mbits/s)
...
60 (108.0 Mbits/s)

Refer to ETS 300 468 for a complete list
of possible values.

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

DVB reserved bytes An even number of hexade-
cimal characters

—

The stream_identifier_descriptor can attach a component tag to PMT transport
stream descriptions. This component tag allows the EIT, through the same tag in
a component descriptor, to reference the stream.

Parameter Possible values Notes

Component tag 0 to 255 —

The stuffing_descriptor provides a means of inserting dummy descriptors for
table stuffing.

Parameter Possible values Notes

Descriptor length 0 to 255 Bytes

Short Event Descriptor

Short Smoothing Buffer
Descriptor

Stream Identifier
Descriptor

Stuffing Descriptor
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The telephone_descriptor provides a telephone number that can be used for
modem dial-up; communication via modem may be used with narrow band
interactive channels.

Parameter Possible values Notes

Foreign availability 0 (from inside the country)
1 (from outside the country)

Enter the value or select from the list box

Connection type 0 to 31 Type must be recognized by the decoder

Country prefix Alphanumeric characters Consistent with international and local
t l i ti t d d

Int’l area code Alphanumeric characters
telecommunications standards.

Operator code Alphanumeric characters

National area code Alphanumeric characters

Core number Alphanumeric characters

The teletext_descriptor, with sub-descriptors, can appear in an ES definition in
the PMT to identify streams that contain EBU teletext data. The table lists the
teletext sub-descriptor parameters.

Parameter Possible values Notes

ISO 639 language
code

A 3-character language code
as defined in ISO 639

The language of the teletext data.

Teletext type 1 (initial teletext page)
2 (teletext subtitle page)
3 (addit’l information page)
4 (program schedule page)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Teletext magazine
number

0 to 7 Identifies the magazine.

Teletext page
number

0 to 255 Identifies the page.

Telephone Descriptor

Teletext Descriptor
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The terrestrial_delivery_system descriptor identifies the characteristics of the
terrestrial delivery system.

Parameter Possible values Notes

Center frequency 10 to 42,949,672,950 Type value in 10 Hz increments

Bandwidth 0 : 8 MHz
1 : 7 MHz

Select through the list boxes or enter the
appropriate value and click the descriptor
icon

Constellation 0 : QPSK
1 : 16 QAM
2 : 64 QAM

icon.

Hierarchy information 0 : Non-hierarchical
1 : Alpha = 1
2 : Alpha = 2
3 : Alpha = 4

Code rate HP stream 0 : 1/2
1 : 2/3
2 : 3/4
3 : 5/6
4 : 7/8

Code rate LP stream 0 : 1/2
1 : 2/3
2 : 3/4
3 : 5/6
4 : 7/8

Guard interval 0 : 1/32
1 :1/16
2 : 1/8
3 : 1/4

Transmission mode 0 : 2k
1 : 8k

Select through the list box or enter the
appropriate value and click the descriptor
icon

Other frequency flag 0 : No other frequency in use
1: Other frequency in use

icon.

The time_shifted_event_descriptor identifies an event that is a time-shifted copy
of another event.

Parameter Possible values Notes

Reference service ID 0 to 65535 The ID of the NVOD reference service.

Reference event ID 0 to 65535 Identifies the reference event (of which
this event is a copy).

Terrestrial Delivery
System Descriptor

Time Shifted Event
Descriptor
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The time_shifted_service_descriptor identifies a service that is a time-shifted
copy of another service.

Parameter Possible values Notes

Reference service ID 0 to 65535 The ID of the NVOD reference service
(of which this service is a copy); does
not have a corresponding service in the
PMT.

You can define a descriptor an add it to almost any table, stream, service, or
event definition.

Parameter Possible values Notes

Descriptor tag 128 to 254 Define your own.

Private bytes An even number of hexade-
cimal characters

—

Time Shifted Service
Descriptor

User Descriptor



PSI, DVB SI, and ATSC PSIP Table Item Parameters

MTS300 Stream Creation Applications User Manual 3- 185

PSIP Descriptors

Descriptors are structures which may be used to extend the definitions of the
elements to which they refer. This section describes the descriptor parameters for
PSIP structures. In most cases, a range of possible values is given for each
descriptor. Descriptors are listed alphabetically. Descriptors are listed alphabeti-
cally.

See the online help for syntax descriptions of PSIP descriptors.

The AC--3 Audio Descriptor provides information on the audio elementary
stream.

Parameter Possible values Notes

Sample rate code 0 : 48 kHz
1 : 44.1 kHz
2 : 32 kHz
3 : Reserved
4 : 48 kHz or 44.1 kHz
5 : 48 kHz or 32 kHz
6 : 44.1 kHz or 32 kHz
7 : 48 kHz or 44.1 kHz or
32 kHz

Indicates the sample rate of the
associated AC-3 audio stream.

Bsid The same value as the bsid field in the
associated AC-3 audio stream.

Bit rate code Indicates the bit rate.

Surround mode 0 : Not indicated
1 : Not Dolby Surround
encoded
2 : Dolby Surround encoded
3 : Reserved

Indicates whether Dolby Surround is
used.

Bsmod The same value as the bsmod field in
the associated AC-3 audio stream.

Num channels Indicates the number of channels for the
associated AC-3 audio stream

Full svc 1 : Full service suitable for
presentation
0 : Not sufficiently complete
to be presented without
being combined with another
audio service

Langcod 0 : Language is unknown The same value as the Langcod field in
the associated AC-3 audio stream.

Langcod2 The same value as the Langcod2 field in
the associated AC-3 audio stream.

AC- 3 Audio Descriptor
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Parameter NotesPossible values

Mainid 0 to 7 Identifies a unique main audio service.

Asvcflags 0 to 7 Indicates the main audio service with
which this partial audio service must be
combined.

Text code 1 : Text is 1 byte characters
encoded using the ISO Latin
1 alphabet
0 : UNICODE

The Caption Service Descriptor provides closed captioning information, such as
closed captioning type and language code

Parameter Possible values Notes

Language A 3 byte language code

CC_type 1 : Advance television close
caption service is present
0 : Not present

Line21 field 1 : Line 21closed caption
service is associated with
field 1 of the NTSC wave-
form
0 : Not present

Caption service
number

0 to 63

Easy reader 1 : Text tailored to the needs
of beginning readers
0 : Not tailored

Wide aspect ratio 1 : Formatted for displays
with 16 :9 ratio
0 : Formatted for the 4 :3
ratio

The Component Name Descriptor is a multiple string structure that defines an
optional textual name tag for any component of the service. (SeeMultiple String

Structure on page 3--162.)

Caption Service
Descriptor

Component Name
Descriptor
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The Content Advisory Descriptor indicates, for a given event, ratings for any or
all the rating dimension defined in the RRT.

Parameter Possible values Notes

Rating region 0 to 255 Indicates the RRT with the matching
information.

Rating dimension j 0 to 255 The dimension index in the RRT rating
region.

Rating value 0 to 15 The rating value of the rating dimension j
in the RRT rating region.

Rating description
text

Field is limited to 16 characters.

The Extended Channel Name Descriptor is a multiple string structure that
provides a long channel name for the VCT. (SeeMultiple String Structure on
page 3--162.)

The Program Identifier Descriptor provides a means of identify programs in the
PMT.

Parameter Possible values Notes

Provider index 0 to 65353 This 16 bit unsigned integer field
identifies the provider that assigns the
program_event_id

Program event id 0 to 16,777,215 This 24 bit unsigned integer field
identifies the program or product.

Provider index 0 to 65353 This 16 bit unsigned integer field
identifies the provider that assigns the
program_event_id

Program event id 0 to 16,777,215 This 24 bit unsigned integer field
identifies the program or product.

Episode number This 12 bit unsigned integer number identifies the version of the
production or episode (1 to 4095 inclusive).

Different versions of the program/production may be assigned for
different languages, program lengths, different titles for the same
program/product etc

Version number
program/product, etc.

For instance, a film product may be released as a 120 minute version in
English for North American theatrical release, a 180 minute version in
French for European theatrical release, and a 110 minute release in
English and French for use on Canadian television.

Content Advisory
Descriptor

Extended Channel Name
Descriptor

Program Identifier
Descriptor
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Parameter NotesPossible values

Original date year This 8 bit unsigned integer number represents the offset from 1900 to
the year of first presentation.

Year minus 1900; that is. if first presentation was 1984, the
original_date_year would have a value of 84 or 0x54).

Original date month 1 = January -- 12 = December

Original date day 1to31

Program id string A sequence of zero to 40 characters which represent a human--readable
version of the Program Identifier.

The characters are coded according to ISO/IEC 8859--1 (Latin--1).

The program_id_string is not intended for display or processing by
consumer equipment; it may be provided by the creator of the
program_id_string as a human--readable reference check on the
Program Identifier.

ISAN field The 9 byte optional field may be used to cross--reference the ISAN
number for the program when one exists.

ISAN is an identification system used for certain audio/visual properties.
It consists of a 16 digit integer number coded in bcd
(binary--coded--decimal) notation in a 64 bit (8 byte) string.

The most significant byte of the ISAN_field is used to carry the ISAN
registration authority eight bit value
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The Service Location Descriptor provides the stream types, PID and language
code for each elementary stream.

Parameter Possible values Notes

PCR_PID 0 to 8191 The PID of the transport packets carrying
the PCR information for the Elementary
stream.

Stream type 0 : Reserved
1 : ISO/IEC 11172-2 Video
2 : ISO/IEC 13818-2 Video
3 : ISO/IEC 11172-3 Video
4 : ISO/IEC 13818-3 Audio
5 : ISO/IEC 13818-1 private
section
6 : ISO/IEC13818-1 PES
7 : ISO/IEC 13522 MHEG
8 : ISO/IEC 13818-1 Annex
A DSM
9 : IUT-T Rec. H.222.1
10 : ISO/IEC 13818-6 type A
11 : ISO/IEC 13818-6 type B
12 : ISO/IEC 13818-6 type C
13 : ISO/IEC 13818-6 type D
14 : ISO/IEC 13818-6 auxil-
iary
15 : ISO/IEC 13818-7 Audio
w/ADT
16 to 127 : Reserved
128 : User private
129 : Audio Dolby AC-3

Select the stream type from the selection
box, and the table editor will change the
appropriate value.

elementary PID 0 to 8191 PID of the transports packets carrying
this Elementary stream

IOS 639 language
code

3 byes language code

Service Location
Descriptor
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The Time-Shifted Service Location Descriptor links one virtual channel with one
or more virtual channels that carry the same programming on a time-shifted
basis.

Parameter Possible values Notes

Time shift 0 to 720 The number of minutes the services
indicated by the major/minor channel
number are time shifted.

Major channel
number

1 to 999 Thew index on the major channel
number.

Minor channel
number

0 to 999 The index on the minor channel number.

Time-Shifted Service
Location Descriptor
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Using the Jitter Adder

The Jitter Adder application allows you to create transport stream files with
known multiplex errors. By introducing errors into the PCRs, transmission delay
variations can be simulated. Use these transport streams to test the robustness of
decoders under various conditions.

This application opens a transport stream file (*.trp), introduces clock jitter, and
creates a new *.trp file.

This section explains the commands available from the Jitter Adder application.

Application

The main purpose of Jitter Adder files is to aid in the design of decoder PLLs.
The errors produced by the Jitter Adder application introduce known amounts of
jitter into the transport stream. The application modulates the data values of the
PCRs away from their correct values.

Use the Jitter Adder transport stream files in real-time hardware experiments at
the receiver. The receiving PLL will have to filter out the introduced modulations
in order to produce a stable clock reference. You can use the MTS300 MPEG
Test System test system Deferred-Time Analyzer application to view Jitter Adder
errors introduced into the PCR data.

Terms

This application is similar to the Multiplexer application in that it outputs a
transport stream file not a transport stream. Since there is an important difference
between the two terms, the definitions are repeated here for emphasis.

A transport stream is the signal that comes out of (or into) one of the connectors
on the rear panel of the Tektronix MTS300 MPEG Test System.

A transport stream file is a file on a disk. When the test system sends this file out
one of the rear panel connectors (properly timed), it becomes a transport stream.
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Starting the Application

Double-click the Jitter Adder icon in the Tektronix MPEG Test System

program group window to start the application.

Menu Commands

The Jitter Adder menu commands are shown in the following table.

Menu Command Function

File Open Opens a transport stream file for addition of jitter

Quit Exits the Jitter Adder application

Jitter Definition Allows you to define the PCRs and type of jitter added

Calculate Calculates a new transport stream file with jitter added (*.jit)

Help Contents Provides help for the Jitter Adder application

Using Help Obtain information on the Help system

About Jitter Adder Displays application version and copyright information.

The File Menu commands select transport streams and close the application.

Open.Opens theMultiplex Transport File dialog box.

File Menu
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Select a file from the File Name list and click OK. This returns the List of
Programs window in the application window. Use this as a quick reference for
PID numbers when defining jitter.

Quit. Closes the Jitter Adder application. No verification of the Quit command is
given before exiting the application.

The Jitter Menu commands set parameters and initiate calculations.

Definition.Opens the PCR Clock Selection dialog box.

Use this dialog box to choose if the jitter calculation is done to all PCR clocks or
to only the PCR for one PID (program). You can have a set of reference PCRs in
the same transport stream file.

Jitter Menu
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Once the option is selected, click OK. This opens the Jitter Type dialog box.

Use this dialog box to set the jitter parameters inserted into the PCR. Select
from: Offset, Square, Sine, or Random. Only one option is allowed.

� Offset. Adds the time (in seconds) entered in the Value text box to the PCR:

PCR = PCR + offset

� Square. Adds the time (in seconds) defined by the following equation to the
PCR:

PCR(n) = PCR(n) + square(t)

Square(t) is the value of the square wave defined by the Amplitude and
Period text boxes at the time defined by PCR(n). See Figure 3--1.

Using PCR2 from Figure 3--1 as an example, the value of the square wave at
PCR2 is A. After jitter is applied, PCR2 = PCR2 + A.
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+A

-A

0

PCR1 PCR2 PCR3

Time (+)

T

Figure 3- 1: Illustration of the square jitter function

� Sine. Adds the time (in seconds) defined by the following equation to the
PCR:

PCR(n) = PCR(n) + Asin(t)

Asin(t) is the value of the sine function defined by the Amplitude and
Period entered in the text box boxes at the time defined by PCR(n). See
Figure 3--2.

+A

-A

PCR1 PCR2 PCR3

Time (+)

T

PCR4

Figure 3- 2: Illustration of the sine jitter function

Using PCR2 from Figure 3--2 as an example, the sine wave value at PCR2 is
–0.55A. After jitter is applied, PCR2 will equal the correct value of PCR2 less
0.55A.
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� Random. Adds a uniformly distributed random value to the PCR. The range
of values is between 0 and the value (plus or minus) defined in the Value
box in seconds:

PCR = PCR � random

When the desired type of jitter is defined, click OK. This does not cause any
changes to the *.trp file. It only defines the changes that will be made when the
Calculate command is called.

You can set jitter frequency independent of the PCR rate. To prevent misleading
results, only use jitter frequencies less that one-half the PCR frequency. For
example, if the PCR rate is 25 per second (period = 0.04 second) then the
maximum jitter frequency the user should specify is 12.5 Hz (period = 0.08
second). For an example of a jitter frequency that is too high for the PCR
frequency, see Figure 3--1.

NOTE. The PCR Analysis uses the previous PCR as the reference point to

calculate the error in the current PCR. This can cause the error calculation to be

misleading for some PCR jitter functions. Specifically, the jitter added by the test

system may not be easily interpreted by the PCR analysis display.

Calculate.Uses the parameters defined by the Definition command to create a
new transport stream file with introduced jitter. The Calculate command opens
the Output File dialog box.

Use this dialog box to name the resulting transport stream file. Enter the desired
name in the File Name dialog box; the *.trp extension is automatically added.

Once you click OK, the jitter calculation begins. There is a status gauge that
shows you how far the calculation has progressed. It also shows the type of Jitter
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being added and the parameters. The Status Bar also gives information on the
calculation.

Figure 3- 3: The display during jitter calculation

When the calculation is complete, the status gauge reads 100%. The new file can
be used as a transport stream file.

The following illustration shows a jitter file with PCRs analyzed by the test
system. If you viewed the analysis on screen, most clocks appeared in red,
indicating an error.
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The Help menu commands provide access to the Help system.

Contents.Displays the Help table of contents, index, and find routine.

Using Help. Explains how to use and customize the Help system.

About Jitter Adder.Displays the application version and copyright.

Toolbar

The following commands are available from the toolbar: Open, Definition, and
Calculate.

Icon Name Function

Open Chooses the transport stream file and places its program PID
numbers in the List of programs window. (See page 3--193.)

Definition Defines the type of packet jitter added to the transport stream
file. (see page 3--193.)

Calculate Creates a new transport stream file with the defined amounts
of jitter added to the PCRs. (see page 3--196.)

Help Menu
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Using the DVB Channel Coder/Decoder

The European Digital Broadcasting Project (DVB) specifies a baseline system
for satellite broadcasting. The transport stream channel coding portion of the
specification has the following flow:

� MPEG-2 Transport stream file (Multiplexer)

� Energy Dispersal — randomizing

� Outer Coder RS (204, 188) — for byte error correction

� Interleaver — better burst error correction

� Inner Coder (Viterbi p/q) — bit error correction

� QPSK Modulator

The DVB Channel Coding and Decoding application also provides decoding to
return the coded file to a standard transport stream file.

Table 3--33 lists the type of coding/decoding, the type of input expected, and the
resulting file.

Table 3- 33: Expected input file types

Operation Expected input Output

Energy Dispersal *.trp *.eds

Reed-Solomon *.eds *.res

Byte Interleaving *.res *.inl

Viterbi Encoding *.inl *.vtb

Byte Deinterleaving *.inl *.din

Reed-Solomon decoding *.din *.drs

Energy Dispersal removal *.drs *.edr
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Starting the Application

Double-click the DVB channel Coding & Decoding icon in the Tektronix
MPEG Test System program group window to start the application. The
application window opens as shown below.

Status bar

Duration gauge

Title bar

Menu bar

Duration Gauge.Displays the coding or decoding process status in percent.
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Menu Commands

Figure 3--34 lists the Jitter Adder menu commands.

Table 3- 34: Jitter Adder menu commands

Menu Commands Function

File Quit Exits the Coder/Decoder application

Coding Chain Defines a list of coding modulesg

Energy Dispersal Defines and performs Energy Dispersal coding on a
selected file

Reed-Solomon Defines and performs Reed-Solomon coding on a
selected file

Interleaver Defines and performs Interleaver coding on a selected
field

Viterbi Defines and performs Viterbi coding on a selected file

Decoding Chain Defines a string of decoding modules for a fileg

DeInterleaver Decodes a file for Interleaver coding

Reed-Solomon Decodes a file for Reed-Solomon coding

Energy Dispersal
Removal

Decodes a file for Energy Dispersal coding

Generation Pattern Generates a user-defined repetitive pattern and puts it in
a file

Transport Packet Generates a user-defined pseudo transport packet and
puts it in a file

? Help Provides useful information on all the commands and
additional information on coding in general

About... Displays the application version and copyright

The File menu offers the Quit command, which exits the Coder/Decoder
application.

File Menu
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The Coding menu provides access to the required DVB channel coding for
satellite broadcasting (Energy Dispersal, Reed-Solomon, Interleaver, and
Viterbi). It also provides for chaining the various coding methods together.

Chain. The Chain command opens the Coding Chain dialog box, which allows
you to create DVB-compliant files.

Each check box defines one module in the coding chain. When all check boxes
are selected, the coding will produce a DVB-compliant file. If you deselect any
of the check boxes, you will generate a noncompliant file. (This feature is
provided for testing purposes.)

NOTE. If Energy Dispersal is not selected, it is replaced by a “B8 sync byte add

only” module in the chain.

When you select OK, the Open dialog box appears. Identify the file to code.

Although all file types (*.*) are available, the expected transport stream file type
for DVB compliance is *.trp. Use a fle created by the Multiplexer application or
acquire one from a transport stream input through a rear-panel connector.

Select OK to initiate the coding process. Each coding module is performed in
the order given in the dialog box. During the coding process, a gauge in the

Coding Menu
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Application Window reports the coding status. The gauge range is 0 to 100% for
each type of coding.

NOTE. To stop the coding process at any time, press the ESC key. This ends the

coding with the current coding module.

The “READY” statement in the status bar indicates that the coding process is
complete for the selected modules. There are now three additional files in the
original directory with the transport stream file. The new files share the original
name with the following extensions: *.eds, *.res, and .*ini.

For more information on individual coding modules, see Energy Dispersal
Coding on page 3--211, Reed-Solomon Coding on page 3--212, and Convolution-

al Interleaving Coding on page 3--212.

Energy Dispersal. The Energy Dispersal command allows you to use this coding
scheme alone, instead of in conjunction with the other code modules using the
Chain command. This module performs sync byte inversion for the first of each
group of eight transport packets, and randomizing of data using a PRBS (Pseudo
Random Binary Sequence). For more information on the actual coding, refer to
Energy Dispersal Coding on page 3--211.

Selecting Energy Dispersal opens the following dialog box.

This first byte of the selected input file should be the first byte of a transport
stream packet file (the sync byte, 47HEX). The input file should be a*.trp
transport stream file. Other file types are permitted, as long as they meet the sync
byte requirement, however.

Click OK to begin the coding process. A gauge in the Application Window
states the coding process status. When the gauge reads 100% and “READY” is
displayed in the Status bar, the coding process is complete.
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Completion of the coding results in a file with the same base name as the
original, except the extension is *.eds.

If you choose a file that is inappropriate for Energy Dispersal, coding will occur
anyway. You can stop the coding process at any time by pressing the ESC key.

Reed-Solomon. Reed-Solomon coding takes the randomized transport packet
(from the Energy Dispersal coding) and adds 16 bytes to the field. (188 initial
packet size + 16 bytes of Reed-Solomon = 204 bytes.) For a more detailed
explanation of Reed-Solomon coding, see Reed-Solomon Coding on
page 3--212.

The Reed-Solomon dialog box is displayed after choosing this command. Enter
the desired Coded Block Size and Size of Block to Code in the appropriate text
boxes. The maximum for both parameters is 255. The default values (204 and
188) are correct values for DVB.

If you choose the Configuration command, the Reed-Solomon Configuration

dialog box appears.

Use the Reed-Solomon Configuration dialog box to define different values for
p(x) (the Field Generator Polynomial) and alpha, which is the first root of p(x).
The default values are correct for DVB applications.
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When the configuration is complete, return to the Reed-Solomon dialog box by
selecting OK. If you are ready to code a file, select OK. This returns the Open
dialog box. The coding module accepts *.eds files (previously Energy Dispersal
coded) only.

Select a file and enter it in the File Name text box; then click OK. This initiates
the Reed-Solomon coding process. The Application Window gauge tracks the
progress of the coding process. When coding is complete, the gauge reads 100%
and the Status bar reads READY.

The coding process outputs a file with the original name and an added*.res
extension.

Interleaver. This module performs convolutional byte interleaving. See
page 3--212 for more information on this coding process.

When you choose the Interleaver command, the Open dialog box appears.
There are no parameters to adjust for this coding module.

The Interleaver requires a *.res file (a file previously Reed-Solomon encoded).
After selecting a file to code, click OK. This starts the Interleaver coding
module.

A gauge in the Application Window monitors the coding progress. Coding is
complete when the gauge reads 100% and the Status bar reads “READY.”
Interleaver coding results in a file with the same base name as the selected file,
except the extension is *.inl.

Viterbi.Viterbi performs inner coding based on the Viterbi punctured convolu-
tional code. For more information on this coding process, refer to Viterbi Coding

on page 3--213.

NOTE. This application does not provide a method to decode Viterbi coding.
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When you choose Viterbi, the following dialog box appears.

Use the Viterbi dialog box to select the Viterbi Code. The code can be 1/2, 2/3,
3/4, or 7/8 (the default is 7/8). When you click OK, the Open dialog box
appears.

Use the Open dialog box to select a file for Viterbi coding. The expected file
type is an *.inl (Interleaver coding result). Once you select the file, click OK.
This begins the Viterbi coding process.

A gauge in the Application Window tracks the progress of the coding. The
coding is complete when the gauge reads 100% and the Status bar says
“READY”. The output of this module is a file with the same base name as the
original file, but it now has *.vtb as the extension.

The Decoding menu provides access to the required DVB Channel Decoding for
satellite broadcasting (Deinterleaving, Reed-Solomon Decoding, and Energy
Dispersal Removal). It also provides for chaining the various decoding methods
together.

Decoding Menu
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Chain.With the Chain command, you can decode the transport stream file using
the DVB-compliant method. The figure below shows the dialog box associated
with the Chain command.

You can deselect any of the check box, however, all boxes must be checked to
generate a DVB-compliant file. You purposely deselect modules to create DVB
noncompliant files for testing purposes.

Choose OK to begin Chain decoding. A gauge in the Application window
reports the progress of each decoding operation. All chain decoding is complete
when the gauge reads 100% and the status bar says “READY.”

If the Energy Dispersal Removal module is not selected, it is replaced by a B8
sync byte removal module in the chain.

To stop the decoding process at any time, press the ESC key. This ends the entire
decoding chain with the current module.

Deinterleaver.When you choose the Deinterleaver command, the Open dialog
box appears. The expected input file is one generated by the Interleaver coding
module (*.inl), although the Deinterleaver module will accept any file.

When you click OK, Deinterleaving begins. A gauge in the Application window
reports the decoding process status. Decoding is complete when the gauge reads
100% and the Status bar says “READY”. The resulting file has the same name as
the original, with the extension *.din added.

To end the decoding at any time, press the ESC key.
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Reed-Solomon.When you choose the Reed-Solomon command, the Open dialog
box appears. The expected input file is one generated by the Deinterleaver
coding module (*.din).

When you click OK, Reed-Solomon decoding begins. A gauge in the Applica-
tion window tracks the decoding process status. Decoding is complete when the
gauge reads 100% and the Status bar says “READY”. The resulting file has the
same name as the original, with the extension *.drs.

To end the decoding at any time, press the ESC key.

Energy Dispersal Removal.When you choose the Energy Dispersal Removal
command, the Open box appears. The expected input file is one generated by the
Deinterleaver coding module (*.drs), although this decoding module will accept
any file type.

When you click OK, Energy Dispersal Removal decoding begins. A gauge in the
Application window tracks the decoding process status. Decoding is complete
when the gauge reads 100% and the Status bar says “READY”. The resulting file
has the same name as the original, with the extension, *.edr added.

To end the decoding at any time, press the ESC key.

The Generation menu allows you to create new *.trp files by defining a pattern
or transport packets.

Pattern. This command generates a user-defined pattern. When you select the
Generation Pattern command, the Save As dialog box appears to name the file.
A default extension is not provided for the file name. However, if you enter a file
name without an extension, *.plp is automatically added.

Click OK to confirm the entry and close the dialog box. The Pattern entry box
appears; enter the number of bytes in the pattern and click OK.

Generation Menu
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The Composition Motif entry box appears to define the repetitive pattern. Enter
the desired byte value in hexadecimal. One Composition Motif dialog box
appears for each byte you specified in the pattern.

Click OK to confirm the entry and close the dialog box.

The Pattern entry box appears. Define the number of times you want the pattern
to repeat; then click OK.

The pattern is created and stored in the file specified above.

Transport Packet. This command generates a repetitive pattern of user-defined
transport packets.

When you select the Transport Packet command, The Transport Packets dialog
box appears to define the payload or to have random data loaded.
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If you choose the CCITT 2^15-1 check box, random data is generated for the
payload. If you set the value of the first text box under the Transport Packet
Header, the last three text boxes will gray. The default value of the first text box
is 47. You can also enter a value.

If the CCITT 2^15-1 check box is not selected, you can define the values of all
text boxes under the Transport Packet Header. The default value is 47 00 00 00.
You must define the payload, which is then repeated 184 times. Click OK to
confirm the selections.

The Number of Packets dialog box appears.

Enter the number of transport packets in the transport stream; then click OK.
The Save As dialog box opens to name the file. A default extension is not
provided for the file name. However, if you enter a file name without an
extension, *.plp is automatically added.

Click OK, the application creates the desired transport stream file. When the
Gauge reads 100%, the transport stream file is complete.

The Help menu commands provide access to the Help system.

Help. Provides access to the application Help system.

About MPEG2 DVB Channel Coder and Decoder.Displays the application version
and copyright.

Help Menu
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Coding Types

This section defines the application coding types.

This is the first coding module and last decoding module.

The input of this coding module is an MPEG-2 transport stream, which is a
concatenation of packets of 188 bytes (1 sync byte plus 187 data bytes).

SYNC
1 byte

187 bytes

47HEX

To comply with DVB and ensure adequate binary transitions, the data from the
MPEG-2 multiplex (transport stream file) is scrambled with a Pseudo Random
Binary Sequence (PRBS). The processing order at the transmitting side always
starts from the Most Significant Bit (MSB) of the synchronization byte (0 of
01000111).

The polynomial for the PRBS generation is : X15 + X14 + 1. It uses the 15-bit
shift register illustrated below for scrambling and descrambling (in the channel
coding process).

Enable
Clear/scrambled

data input

Scrambled/descrambled
data output

2 3 4 5 6 7 8 9 10 11 12 13 14 151

At the start of every eighth transport packet, the sequence 100101010000000
loads into the shift register. This provides an initialization signal for the
descrambler. The MPEG-2 sync byte (for the first transport packet in the group
of eight packets) is then inverted bit-wise from 47hex to B8hex. The first bit at the
output of the PRSB generator is applied to the first bit (MSB) of the first byte
following the inverted MPEG-2 sync byte (B8hex).

Energy Dispersal Coding
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To optimize synchronization of the subsequent seven transport packets, PRSB
generation continues with its output disabled, leaving these bytes unrandomized.
Thus the period of the PRSB sequence is 1503 bytes as shown below.

B8 187 randomized bytes 187 randomized bytes 187 randomized bytes 187 randomized bytes47 47 B8

8 randomized transported packets

The Reed-Solomon RS (204, 188) code corrects up to 8 bytes in a 204 byte
block. This module takes each randomized transport packet at the output of the
Energy dispersal module and produces 204 bytes by calculating and adding 16
bytes at the end of the packet (188 bytes).

The Reed-Solomon calculates in a Gallois Field generated by the polynomial:

p(x) = x8 + x4 + x3 + x2 + 1

The RS code generator polynomial (used for the 16 byte calculation) is:

g(x) = (x + α
0)(x + α

1)....(x + α
15)

where α = 02hex

The RS (204,188), shortened code from the original RS (255,239), is implement-
ed by adding 51 bytes, all set to zero, before the information bytes (a transport
packet) at the input of an RS (255, 239) encoder. After the RS coding procedure,
these null bytes are discarded, and the transport packet remains as shown in the
following illustration.

B8 187 randomized bytes 16 bytes

Convolutional Interleaving, with depth I = 12, is applied to the error protected
packets. The following is a conceptual diagram of the Interleaver.

Interleaver
input

Interleaver
output

17 = M cells

17x2 cells

17x11 cells

0

1

2

11

Reed-Solomon Coding

Convolutional Interleaving
Coding
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The Interleaver has 12 branches, cyclically connected to the input byte-stream by
the input switch. Each branch is a FIFO shift register, with depth (MJ) cells.

where M = 17 or N/I
N = 204 the error protected frame length
I = 12 the interleaving depth
J = branch index

The cells of the FIFO contain 1 byte, and the input and output switches are
synchronized.

For synchronization purposes, the sync bytes and the inverted sync bytes are
always routed in the branch “0” of the Interleaver (corresponding to a null
delay).

The Deinterleaver is similar to the Interleaver, but the branch indexes are
reversed (j = 0 corresponds to the largest delay). The deinterleaver synchroniza-
tion can be carried out by routing the first recognized sync byte in the “0”
branch. The following diagram shows the interleaved transport packets.

B8 203 interleaved bytes 203 interleaved bytes47

The inner coding is based on a Viterbi punctured convolutional code as
diagrammed below.

Data outputData input 1 2 3 5 6 74

1

2

Each byte of the input stream (MSB first) loads in a 7 (K = 7, constant length)
bit shift register. It then executes two polynomial operations. To produce a p/q
code (q output bits for p input bits) a puncture is applied to the output of the 1/2
coder.

For example, in 7/8 mode, 7 bits produce 14 bits of 1/2 code and only 8 are
transmitted. (The puncture pattern for 7/8 is 11010101100110.)

Viterbi Coding
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Using the TMCC Stream Combiner

Transmission and Multiplexing Configuration Control (TMCC) data is used to
inform receivers of the various modulation schemes and transport stream IDs
used in the multiplex.

The MTS300 TMCC Combiner (MTS300 Option TM or MTS3FTM) is a wizard
that guides you through creating single- and multiple-stream transport stream
files for ISDB-S environments. Inputs to the TMCC Combiner are shown below:

� An MPEG-2 transport stream file (188- or 204-byte packet) is used to create
single-transport stream files with TMCC information (S_TMCC files).

When used to create S_TMCC transport stream files, the TMCC Combiner
inserts TMCC basic information (consistent with the ISDB-S standard) into
the Reed-Solomon area of the 204-byte packets that are the TMCC Combin-
er output.

� From one to eight S_TMCC files are used to create multiple-transport stream
files with TMCC information (M_TMCC files).

When used to create M_TMCC transport stream files, the TMCC Combiner
extracts the TMCC data from the S_TMCC files and reprocesses it, creating
the 48-byte TMCC data specified in the ISDB-S standards.

For more detailed information about TMCC data and the structure of frames and
superframes, see the ISDB-S ITU--R standards documents.

Limitations.Note the following limitations for using the MTS300 TMCC
Combiner:

� Valid input for generating an S_TMCC transport stream file is a valid
MPEG-2 transport stream file (*.trp file)

� Valid inputs for generating an M_TMCC transport stream file are from one
to eight S_TMCC transport stream files (*.trp file)

Minimum PC requirements.Note the following minimum requirements for
installing and using the MTS300 TMCC Combiner on a PC:

� 400 MHz Pentium II processor

� 256 MB of memory

� 140 MB free disk space

� Windows NT version 4.0 with Service Pack 5 or above
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TMCC Information

This section briefly describes the TMCC information inserted by the MTS300
TMCC Combiner. The information is different for TMCC Basic (S_TMCC) and
TMCC Data (M_TMCC) streams.

Table 3--35 lists the contents of the basic TMCC information inserted by the
TMCC Combiner when generating S_TMCC transport streams. The fields are
described following the listing.

Table 3- 35: TMCC basic information fields

S_TMCC data Bits (64 total)

ID information 8

Extended data 4

Alarm signal 1

Update indication 1

Transmission frame id 1

Super frame id 1

Transmission mode and slot information 40

Transmission mode 1 4

Number of slots for transmission mode 1 6

Transmission mode 2 4

Number of slots for transmission mode 2 6

Transmission mode 3 4

Number of slots for transmission mode 3 6

Transmission mode 4 4

Number of slots for transmission mode 4 6

Transport stream ID 16

� The extended data field is used to signal extended information.

� The alarm signal field is set to one to indicate alarm status.

� The update indication field is set to one to indicate that TMCC data has
changed.

� The super frame ID field is set to one when the current packet is the first
packet of the super frame.

TMCC Basic Information
(S_TMCC Stream)
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� The transmission frame ID field is set to one when the current packet is the
first packet of the frame.

� The transmission mode field is used to signal the transmission parameters for
the modulation scheme and coding rate.

� The number of slots for the transmission mode is used to indicate how many
slots are processed with a particular transmission mode. The total number of
slots must be less than 48.

� The transport stream ID is the sixteen-bit ID of the corresponding transport
stream.

Table 3--36 lists the contents of the TMCC information inserted by the TMCC
Combiner when generating M_TMCC transport streams. Differences between
the S_TMCC and M_TMCC fields are discussed following the listing.

Table 3- 36: TMCC data information fields

M_TMCC data Bits (384 bits total)

Update Indication 5

Transmission mode and Slot information 40

Transmission mode 1 4

Number of slots for transmission mode 1 6

Transmission mode 2 4

Number of slots for transmission mode 2 6

Transmission mode 3 4

Number of slots for transmission mode 3 6

Transmission mode 4 4

Number of slots for transmission mode 4 6

Relative transport stream and slot information 144

Relative transport stream number slot 1 3

Relative transport stream number slot 2 3

...

Relative transport stream number slot 48 3

Relative transport stream and transport stream ID 128

Transport stream ID for relative transport stream 0 16

Transport stream ID for relative transport stream 1 16

...

Transport stream ID for relative transport stream 7 16

TMCC Data Information
(M_TMCC Stream)
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Table 3- 36: TMCC data information fields (Cont.)

M_TMCC data Bits (384 bits total)

Alarm control 5

Emergency alarm 1

Reserved 4

Extended data 62

Extended data flag 1

Extended data 61

� The total number of slots defined in an M_TMCC frame must be 48.

� Up to eight S_TMCC transport streams can comprise an M_TMCC transport
stream.

� Instead of transmitting transport stream IDs for each slot, a 3-bit relative
TS ID is used. The relative IDs are transmitted sequentially from slot one
and followed by the eight 16-bit transport stream IDs from 0 to 7.

� The 4-bit alarm control field is reserved for future use and is not defined.

� If the extended data flag is set to one, the following 61 bits are used for
extended data. When the flag is zero, all 61 bits are set to one.

Creating TMCC Transport Streams

This section describes each of the TMCC Combiner windows in sequential order.
You can this section as a tutorial to help you become familiar with the combiner.
First, you will learn how to create an S_TMCC stream, and then you will then
learn how to create an M_TMCC stream using the MTS300 TMCC Combiner.

Common TMCC Combiner buttons (found at the bottom of the windows) are
described below:

� Back displays the previous window.

� Next displays the next window in the process.

� Help displays the TMCC Combiner help system.

� Cancel quits the application without making any changes to files on your
disk.

� Transition displays another Basic Properties window with which you
describe a new configuration of transmission modes and slot information.
This button is only available when creating S_TMCC streams.
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� Finish begins the multiplexing process using the information you have input.

1. Start the TMCC Combiner by selecting the icon from the Tektronix MPEG
Test System program group. The Welcome window is displayed.

2. Select the appropriate option, and then click Next.

Starting the TMCC
Combiner
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3. If you selected the S_TMCC option, you will see the General Properties
window.

4. Click the upper Browse button to specify the *.trp file (188- or 204-byte
packets) to which you will add TMCC basic information. (You can enter the
full path to a file on your local PC.)

5. Enter a transport stream ID in the text box provided.

6. Click the lower Browse button to specify a location for the S_TMCC file
you will create

NOTE. Remember, these files can be large, so ensure that you have enough disk

space for the file. Also, ensure that you have write permission for the file
location.

Specifying Inputs and
Outputs
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7. Click Next and the Basic Properties window is displayed.

The packets in the input transport stream can be processed with different
transmission modes and slot parameters. You define different sets of
parameters called transitions. Each subsequent Basic Properties window after
the first represents a transition.

NOTE. The sum of packets processed across all transitions should equal the

number of packets available in the input transport stream. If the sum of packets

you process is less than the number of packets in the input file, only the packets

(up to the total specified) are processed, and the output file is smaller than the

input file.

If the you want to process more packets than there are in the input file, a

warning message alerts when you try to generate the transport stream file.

Defining TMCC Properties
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Use the following information to make changes to the Properties window
(the elements of the window are described from the top down):

� The frame size text box indicates the number of slots in a frame. This
value must be less than or equal to 48. If at least one transition has
already been defined, the value of the frame size displayed is the frame
size of the last transition.

� The super frame size indicates the number of frames in a super frame.
The default value is eight.

� The number of super frames available indicates the number of super
frames available in the input file based on the frame size, and is updated
each time you change the frame size value.

� The number of super frames to process in this transition has no initial
default value. However, if at least one transition has already been
defined, then this text box is displayed with a calculated, default value,
which is defined as the number of super frames available in the input
transport stream less the number of super frames which have already
been assigned to a previous transition or transitions.

� The alarm signal has a default value of zero. If set to one, an alarm is
indicated and the alarm flag in the TMCC data is set to one.

� The extended data text box represents the 4-bit extended data field (in
binary). The default value is 0000.

� The four Transmission selection boxes allow you to choose from among
seven modulation modes. You can define up to four different modulation
modes for each transition.

� The Number of slots selection boxes allow you to assign the number of
slots to each modulation mode.

� The total number of slots used by the the modulation modes (shown at
the bottom of the Number of slots column) must equal the frame size.

NOTE. You cannot define a new transition if the number of super frames already

processed is greater than or equal to the number of super frames available in the

input.

If the number of super frames in the current transition (or the sum of the
super frames defined previously) is less than the number of super frames
available in the input stream, you can define another configuration of
modulation modes and slots by clicking the New Transition button.
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8. After you have defined all of the parameters necessary for your environment,
click the Finish button. The TMCC Combiner generates the TMCC basic
information, based on your inputs and the values you specified in the
Properties windows, and consistent with the ISDB-S/ARIB standards.

The following dialog box is displayed when the process is complete.

After you dismiss the dialog box, initial window of the TMCC Combiner is
displayed.

Using from one to eight S_TMCC transport stream files, you can create a
multiple transport stream multiplex (M_TMCC transport stream).

1. Select TMCC Combiner from the Tektronix MPEG Test System program
group to start the TMCC Combiner.

Generating a TMCC
Transport Stream

Creating a Multiple
Transport Stream TMCC

File
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2. Select the M_TMCC option and then click Next to display the Properties
window.

3. Click the Add TMCC Basic file button to specify the S_TMCC transport
stream file you will include in the M_TMCC multiplex.

The list box displays both the file name (the full path), and the number of
packets in each file.

� Repeat this step to add more transport stream files, up to a total of eight.

� Highlight a transport stream file name and click the Remove File button
to remove a file from the configuration.

4. Click the Browse button to specify a location and file name for the output of
the TMCC Combiner.

5. When you are finished, click the Finish button.

The 8-byte basic TMCC information from each of the S_TMCC input files is
extracted and processed to create the 48-byte TMCC data information used
in M_TMCC data streams, according to the ISDB-S/ARIB standards.

6. A message is displayed when the process is complete. After you click OK,
the initial TMCC Combiner window is displayed.
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Using the Error Injector

You can introduce errors into an MPEG-2 transport stream and use the erroneous
stream to stress-test MPEG-2 systems and components with the Error Injector.

The MTS300 Error Injector reads an input transport stream file, modifies
selected transport packets according to instructions in the error configuration file
(*.EFG file) that you create, and writes the modified stream into another
transport stream file. The following illustration shows how the error injector
inputs and outputs are related:

Error Injector
Modified transport
stream file

Input stream
(transport stream file)

Link

Error configuration
file (*.efg file)

The process for adding errors to a transport stream file is described by the
following general procedure:

1. Use the MTS300 MPEG Test System MPEG-2 DVB/ATSC System
Analyzer to identify the packet numbers and fields you want to modify.

2. Start the error injector and create an error configuration file (or open an
existing file).

3. Edit and save the configuration file.

4. Choose the Multipass option if necessary (see the online help for more
information about this option).

5. Generate an output transport stream file.
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Error injector configuration files themselves are simply text files into which you
enter the following error information:

� Error strings

� Operators, as described below:

� = Assignment (assigns the error value to the error string field)

� + Addition (adds the error value to the error string field)

� – Subtraction (subtracts the error value from the error string field)

� & Bitwise AND (the output bit is 1 only if the input bit and the offset
bit, the error value, are both 1)

For example, if the input byte is 0100 0111 (the value of the
sync_byte) and the error value is 0000 1001 (9), the output byte is
0000 0001).

� | Bitwise OR (the output bit is 1 if either the input bit or the offset bit,
the error value, are 1)

For example, if the input byte is 0100 0111 (the value of the
sync_byte) and the error value is 0000 1001 (9), the output byte is
0100 1111).

� ^ Bitwise XOR (the output bit is one if the input bit and the offset bit,
the error value, are different; the output bit to zero if the input and
offset bits are identical)

For example, if the input byte is 0100 0111 (the value of the
sync_byte) and the error value is 0000 1001 (9), the output byte is
0100 1110).

� ~ Bitwise complement (changes the output bit to the opposite of the
input bit)

� Error values

� Packet numbers

NOTE. Packet numbers are not the same as PID values. Find packet numbers by

displaying the PID map in the system analyzer.



Using the Error Injector

MTS300 Stream Creation Applications User Manual 3- 227

The following list indicates the characteristics of valid error lines in an error
configuration file:

� Each error line is one line in the error configuration file.

� There are no spaces or extraneous characters between the error string,
operator, and error value.

� All error values are decimal integers.

� One space precedes the list of packet IDs.

� Only commas separate packet numbers in a string of packet numbers.

The following tutorial will illustrate these concepts more fully and will help you
become familiar with the basic operation of the error injector.

Error Injector Tutorial

In this tutorial you will learn how to open, edit, and save error configuration
files. You will then create a modified transport stream file. As an input stream for
this tutorial, you will use the dvb.trp file you created in the tutorial, Creating a

Transport Stream File with DVB Information (see page 2--39).

1. Double-click the Error Injector icon in the Tektronix MPEG Test System
program group window to start the application. The Error Injector applica-
tion window is displayed.

2. Select Open from the File menu (or click the Open command button), and
then select sample1.efg from the Open dialog box.

3. Click OK. The Error Injector Edit window opens with the contents of the
sample1.efg file displayed as shown in the following illustration.

4. Select Save as from the File menu and save the file as dvberr.efg.

Creating an Error
Configuration File
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Normally, before you edit the error configuration file you would identify the
packets and fields you want to modify using the MPEG-2 System Analyzer. In
this tutorial you will modify the dvb.trp file.

1. Maximize the Edit window. This will make editing the error configuration
file easier.

2. Click in the text file, and then select Delete All from the Edit menu. This
deletes all of the text from the Edit window.

3. Add the following lines of comment:

#dvberr.efg
#dvb.trp input
#dvberr.trp output

NOTE. Note the use of the # symbol to start the comment lines; this symbol must

begin all lines of comments in error configuration files. Use this symbol to

“comment out” a specific error line without removing it from the error configu-

ration file.

4. Select Show Error Types from the Options menu. The Error Types window,
shown below, is displayed.

Double-clicking an error in this window adds the text to the line immediately
below your cursor in the Edit window. Entering error types this way
minimizes problems with misspelled errors in the error configuration file.

Edit the Error
Configuration File
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5. Double-click the transport_priority selection in the Error Types window.

6. Set the cursor at the end of the error line and enter the following bold text:

transport_priority^1 1,4

This will change the one-bit transport_priority field from 0 to 1 for the first
and fourth packets in the transport stream.

7. Repeat steps 5 and 6 for the error strings in Table 3--37, adding the operators,
error values, and packet strings as indicated.

Table 3- 37: Error configuration file parameters

Error string Operator
Error
value1 Packets2 Notes

adaptation_field_control ~ 1 1,166 Changes the adapta-
tion_field_control field for the
packets indicated.

continuity_counter + 7 1,2 Adds 7 to value the conti-
nuity_counter for the first and
second packets.

program_clock_refer-
ence_extension

^ 240 4 Changes the
program_clock_refer-
ence_extension field to 70 for
the first video packet.

sync_byte & 9 269,4323,
4

Changes the sync_byte to 1
for the indicated packets.

PID = 5 1 Assigns 5 to the PID of
packet 1.

1 Use a space after this value in the error configuration file

2 No spaces between these integers and commas in the error configuration file

8. Dismiss the Error Type selection window, and then select Save Config from
the File menu (or click the Save command button).
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The error configuration file should look similar to the following illustration.
Note that you can use empty lines between error lines to make reading the error
configuration file easier.

Using the following procedure you will generate a transport stream with the
errors you have just specified.

1. Select Start from the Run menu (or click the R, Save and Start, command
button). The Start Injection Engine dialog box is displayed with the name of
the error configuration file displayed in the Configuration box.

2. Click the top Browse button to open a standard Window Open dialog box.

3. Select dvb.trp as the Input Stream. The Start Injection Engine dialog box
changes to show the total number of packets in the selected transport stream.

Generate an Output
Transport Stream File
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4. Click the Output Stream Browse button.

5. In the Open dialog box, type dvberr.trp, which will be the name of the
modified transport stream file you will generate.

NOTE. Include the three-letter file name extension, .trp, when you enter the file

name for the output stream. The injector does not add the extension to file

names.

Once the output stream is identified, the dialog box changes to show that you
are ready to generate a modified transport stream.

6. Click Start and the dialog box changes indicating that the error injector is
running. The number of modifications made to the transport stream file is
reported dynamically below the progress bar display.

7. To pause the injector, click Cancel, and then use one of the following
techniques:

� Click Continue to resume creating the modified transport stream file.

� Click Cancel again to stop the injector and dismiss the dialog box.

The time it takes to modify the transport stream depends on the size of the
input stream and whether you have selected the Multipass option.

8. Once the error injector has processed the complete transport stream file, the
dialog box changes to show that the process is complete. Click OK to
dismiss the dialog box.

For more information about the Error Injector and how to use it, see the online
help.
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Using the OpenMux Configuration Client

Overview

The Tektronix MTS300 MPEG Test System real-time multiplexer server and
OpenMux Configuration Client allow you to filter multiple MPEG inputs and
remultiplex those inputs to generate a new transport stream. The following list
shows examples of the tasks you perform using the OpenMux server and client:

� Dynamically manage MPEG-2 PSI, DVB--SI, and ATSC PSIP tables

� Remultiplex single and multiple program transport stream files

� Generate single or multiple program transport streams

� Dynamically allocate and filter PIDs

� Restamp PCRs

The MTS300 OpenMux is actually two separate applications:

� The MTS300 Real-Time Multiplexer server (called the real-time multiplexer
server) is the engine that combines the inputs you specify to produce the
output you want. This application runs in the background and has no user
interface.

� The MTS300 OpenMux Configuration Client application (called the
OpenMux) allows you to set broadcast environments (MPEG-2, DVB, or
ATSC), define automatic configuration parameters, specify inputs and
outputs to a multiplexer server, and monitor the status of the inputs and
outputs.

NOTE. The sources of the inputs can be local or remote to the real-time

multiplexer, but must be local to the multiplexer server.

The real-time multiplexer uses the following MPEG structures for inputs:

� Single program transport stream (SPTS) files

� Multiple program transport streams (MPTS) files

� Elementary stream files (MPEG-2 audio and video, and AC-3 audio)

The Real-Time Multiplexer

Multiplexer Inputs
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The OpenMux generates an output transport stream that you can use to test your
MPEG system components, or, using the Stream Recorder application, you can
capture the output and write it directly to the local disks for future use. With the
OpenMux, you can specify the following parameters for the transport stream:

� Multiplex rate (system processor dependant, see Table 3--38)

� Output stream environment (MPEG, DVB, ATSC)

� Output properties including ASI byte or packet format and M2S

Table 3--38 indicates the limits of the listed parameters for the OpenMux:

Table 3- 38: Real-time multiplexer limits

Parameter Limit Notes

Number of inputs 1 – 26

Number of PSI-SI-PSIP inputs 1

Number of transport stream file
inputs

0 – 25 Transport stream file inputs can be
MPEG-2, DVB, ATSC single or
multiple program transport streams.

Number of elementary stream
program inputs

0 – 6 A program requires one video
elementary stream file input and
optionally an audio elementary
stream file input (MPEG-2 or AC-3).

Number of outputs 1

Number of clients (per multiplexer
server)

1 – 10 A client is the OpenMux documented
in this manual.

Rate Up to 140 Mbps

If you purchased the MTS300 OpenMux as an upgrade to your existing system,
use the procedures described in the upgrade instructions. If one or more of the
OpenMux program components is corrupt, use the procedures described in
Appendix B: Software Repair for un-installing and re-installing MTS300
applications and entering the license password.

If you ordered Option OM with your MTS300 system, the OpenMux server
starts automatically with the rest of the MPEG Analysis Services, and you can
ignore this section. If you did not order Option OM, you can enable the
OpenMux server and client application for a thirty day demonstration period at
any time using the following procedure. Performing this procedure will also
clear the Failure in socket connection error message that appears when you try to
connect the OpenMux server to the local Server Manager without a valid license
password.

Multiplexer Outputs

Multiplexer Limits

Installing the Real-Time
Multiplexer

Enabling the OpenMux
Demonstration Period
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NOTE. Once the demonstration period begins, it lasts for 30 consecutive days

and then ends. You cannot start, stop, and restart the demonstration period.

Also note that the demonstration license enables all MTS300 applications for the

same thirty day demonstration period. So, you cannot enable one application for

a thirty day period and then enable other applications for a subsequent thirty

day period.

1. Double-click the OpenMux Mode.exe file located in the C:\MTS300\Bin
directory.

2. Click the Start OpenMux server automatically option and then click OK

as shown below.

3. Reboot the test system and enter the demonstration license password that
shipped with the MTS300 test system when prompted to do so.

If you enabled the demonstration period for the OpenMux server and you want to
remove the message that appears at startup after the demonstration period is over,
use the following procedure:

1. Double-click the OpenMux Mode.exe file located in the C:\MTS300\Bin
directory.

2. Clear the Start OpenMux server automatically option and then click OK.

3. Reboot the test system.

Disabling the OpenMux
Server Startup
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The OpenMux is started from the Master Client using the following procedure:

1. Start the Master client.

a. Double click the Master Client icon in the MPEG Test System program
group window.

b. Click the Connect locally button on the toolbar.

The Master Client display changes showing that you are connected to a
Server Manager (in this case the local Server Manager).

Port Manager Panel

Free I/O ports

2. In the Master Client Port Manager panel, right click the port from which you
will output the transport stream, point to Assign Server in the popup menu,
and then select Stream Player from the submenu as shown Figure 2--35.

Starting the Real-time
Multiplexer
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In the following illustration, the OpenMux server is being assigned to I/O
port two.

3. Right-click the server icon in the Port Manager panel, and select Launch
OpenMux Configuration Client from the popup menu. The OpenMux
application is displayed. If you have not saved any configurations, or when
the OpenMux is started the first time, the display is blank as shown in the
following illustration.
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Before you can generate a transport stream you need to connect to a multiplexer
server, which is the engine that filters your inputs and remultiplexes the output
transport stream. You can connect to a multiplexer server running on your local
machine, or you can connect to a server running remotely.

NOTE. The multiplexer server and the OpenMux use standard TCP/IP client/

server network communications protocols. See your network administrator for

creating the network connections between the multiplexer server and the

OpenMux.

Use the procedure described in step 1 on page 3--240 to connect to a multiplexer
server that is running on the same computer as the OpenMux application.

Connecting to a Remote Multiplexer Server. In order to access a remote multi-
plexer server, follow the procedures in this section.

1. If you are currently connected to a real-time multiplexer server, click the
Disconnect button.

2. Click the Connect button and select the real-time multiplexer server as
shown in the following illustration.

The OpenMux application window changes to display the current configuration
of the remote real-time multiplexer server.

Connecting to an MTS300
Real-Time Multiplexer



Using the OpenMux Configuration Client

MTS300 Stream Creation Applications User Manual 3- 239

To exit the OpenMux configuration client, click the Close box in the title bar of
the OpenMux window, and click OK in the close confirmation message box.

To stop generating a transport stream and to remove the real-time multiplexer
server from the I/O, use the following procedure:

1. In the Master Client Port Manager Panel, right-click the OpenMux icon and
select Stop Mux Generation from the submenu..

2. Right-click again on the now disabled OpenMux icon and select Free I/O
from the submenu.

Quitting the Real-Time
Multiplexer Server and

OpenMux Client
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Real-Time Multiplexer Tutorial

In this tutorial you will learn how to set up the OpenMux to create a simple
MPEG-2 transport stream with one transport stream input and one program
input. The tutorial introduces you to the basic functionality and interface
elements of the OpenMux. References to more detailed information are provided
throughout the tutorial.

Once the OpenMux is displayed, the basic procedure for creating a transport
stream is described in the following list:

� Connect to a local multiplexer server.

� Set the multiplex rate.

� Add an output.

� Add PSI-SI-PSIP inputs.

� Add transport stream and program inputs.

� Start the inputs.

� Start the multiplex.

1. Click the Home button to connect to the local real-time multiplexer
server.

2. The OpenMux Spy view is displayed showing the last saved configuration of
the server. The first time the OpenMux Spy View is displayed, the window is
blank except for the server icon in the center.
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3. Set the multiplex rate to the transport stream you will create:

a. Select Multiplex Rate from the Multiplex menu.

b. Enter a rate in the Multiplex Rate text box. (See Table 3--38 on
page 3--234 for multiplex rate limits.)

c. Click OK and the multiplex rate is updated in the OpenMux Spy view as
shown in the following illustration.

4. Add PSI-SI-PSIP inputs:

a. Select Add Input from the Input menu, and then select PSI-SI-PSIP
from the submenu. The Advanced PSI dialog box is displayed. (See
Multiplexer Inputs on page 3--263 for more information about this dialog
box.)
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b. Click the DVB check box to remove the checkmark. This hides the DVB
tab and will prevent any DVB specific tables in the input from being
processed.

c. Change the values in the Refresh Period text boxes as needed. The
default values represent the maximum period (time between packets
carrying table data) for each table type based on the MPEG standard.

d. Change the Transport Stream ID value if necessary. The value in this text
box will be the TSID value of the transport stream that you output.

e. Click Apply to accept your changes and close the dialog box. The
PSI-SI-PSIP input icon is added to the OpenMux Spy view.
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5. Add a transport stream input:

a. Select Transport File from the Input menu. The Input File dialog box is
displayed. (SeeMultiplexer Inputs beginning on page 3--263 for more
information about this dialog box.)

b. Click Browse and use the Windows Open dialog box to select a
transport stream file (in this example,
C:\MTS300\CFG-TRP\SAMPLE.TRP).

c. Edit the transport stream parameters as necessary, or accept the default
values that have been extracted from the transport stream file.

d. Click Apply to accept your changes and close the dialog box. A
transport stream icon is added to the OpenMux Spy view. (SeeMulti-

plexer Inputs beginning on page 3--263 for more information about
adding and editing inputs using the input icons.)
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6. Add program inputs:

a. Select ES Program from the Input menu. The ES Program dialog box is
displayed. (See the procedure on page 3--285 for more information about
this dialog box.)

Programs must have at least one video elementary stream. In this tutorial
you will add both video and audio elementary stream files. There are a
number elementary stream parameters that you can edit after the
elementary stream files have been specified. However, for this tutorial
you will accept the default PID values, rates, and time stamps extracted
from the elementary stream files.

b. Click Browse in the MPEG-2 Video Component group and use the
Windows Open dialog box to select a video elementary stream file (in
this example, C:\MTS300\VIDEO\525\MOBL_60.MP2).

c. Ensure that the Add Audio Component check box is selected.

d. Click Browse in the MPEG-2 Audio Component group and use the
Windows Open dialog box to select an audio elementary stream file (in
this example, C:\MTS300\AUDIO\10KHZ.MP2).

e. Click Apply to accept your changes and close the dialog box. A program
icon is added to the OpenMux Spy view. (SeeMultiplexer Inputs

beginning on page 3--263 for more information about adding and editing
inputs using the input icons.)
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7. Start the inputs:

a. Double-click the transport stream icon. The Control view for the input is
displayed.

b. In the Control view, click the� (Start) button. (You can leave the
Control view open or you can close it without affecting the input.)

c. Repeat steps a and b for the program input.

8. Start the multiplex selecting Start Multiplex from the Multiplex menu (or
by clicking the� (Start Multiplex) button on the toolbar).

The OpenMux Spy view should look similar to the following illustration.

Transport stream
icon

Elementary stream
program icon

Output
icon

PSI-SI-PSIP
icon

You are now generating a simple transport stream using the inputs you specified.
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Multiplexer Windows, Views, and Interface Elements

The MTS300 OpenMux application window provides menus and toolbar
command buttons through which you add, edit, delete, and monitor OpenMux
inputs and outputs. The inputs and outputs to the multiplexer are visualized
using various multiplexer views and icons. This section describes the windows,
views, menu selections, command buttons, and icons enabled by the OpenMux.

When you first start the MTS300 OpenMux, the application window is
displayed. The following illustration shows the application window after you
have added the inputs and outputs used in the multiplexer tutorial and are
generating a transport stream. The menus and menu selections, toolbar command
buttons, and status bar are described in this section.

Status bar

Menu bar

Toolbar

OpenMux
Spy view

Transport
stream icon

Program icon

Output icon

PSI icon

Real-time
multiplexer icon

Real-time multiplexer
application window

Multiplexer Application
Window
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File Menu. Control server connections using the menu selections described in
Table 3--39.

Table 3- 39: Real-time multiplexer File menu selections

Menu selection When selected Comments

Connect Displays a list of servers. Select a server with a real-time
multiplexer running on it.

Disconnect Removes the connection to the
real-time multiplexer.

Exit Quits the real-time multiplexer.

Input Menu.Add, edit, delete, and monitor the inputs to the OpenMux using the
menu selections described in Table 3--40.

Table 3- 40: Real-time multiplexer Input menu selections

Menu selection When selected Comments

Add Input Displays the following selections:

PSI/SI/PSIP Displays the Advanced PSI
dialog box.

Use this dialog box to configure how
the OpenMux manages the input
PSI-SI-PSIP tables and the tables
regenerated in the output stream.

Transport File Displays the Input File dialog
box.

Use this dialog box to select a
transport stream file input.

ES Program Displays the ES Program dialog
box.

Use this dialog box to select audio
and video elementary stream file
inputs.

Input management Displays a dialog box with a list
of input tasks.

Select an input task and click OK to
toggle control over an input. You
cannot take control of an input
managed by another user.

Delete Input Displays the Delete Input Task
dialog box.

Enter an Input ID, select a stop
method, and click OK to remove the
specified input from the OpenMux.

Delete All Inputs Removes all inputs to the
OpenMux.

Edit Settings Displays a dialog box with a list
of input tasks.

Select an input task and click OK to
display the Edit Settings dialog box
for the selected input.
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Table 3- 40: Real-time multiplexer Input menu selections (Cont.)

Menu selection CommentsWhen selected

Control Input Displays a dialog box with a list
of input tasks.

Select an input task from the dialog
box and click OK to display the
Control view for the selected input.

Hierarchic view Displays a dialog box with a list
of input tasks.

Select an input task from the dialog
box and click OK to display the
Hierarchic view for the selected input.

Multiplex Menu. Control the status of the OpenMux (off or on) and define the
multiplex rate using the menu selections described in Table 3--41.

Table 3- 41: Real-time multiplexer Multiplex menu selections

Menu selection When selected Comments

Start Multiplex Starts multiplexing the inputs.

Stop Multiplex Stops multiplexing the inputs.

Multiplex Rate Displays the Multiplex Rate
dialog box.

Specify the multiplex rate in megabits
per second (Mbps). See Table 3--38
on page 3--234 for multiplex rate
limits.

Output Menu.Add, delete, and monitor the OpenMux output using the menu
selections described in Table 3--42.

Table 3- 42: Real-time multiplexer Output menu selections

Menu selection When selected Comments

Output Properties Displays the Output Properties
dialog box.

This dialog box allows you to name
the output and to set ASI format
options.

Hierarchic view Displays the Hierarchic view of
the output stream.

This view is available only if the
PSI-IS-PSIP input task is present.

Multiplex Allocation

Program Displays the Program Multiplex
Allocation view for the output
stream.

This view is available only if the
PSI-IS-PSIP input task is present.

PID Displays the PID Multiplex
Allocation view for the output
stream.
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View Menu. Control whether or not the toolbar and status bar are displayed and
refresh the OpenMux Spy view using the menu selections described in
Table 3--43.

Table 3- 43: Real-time multiplexer View menu selections

Menu selection When selected Comments

Refresh (F5) Refreshes all OpenMux view
windows with current data.

OpenMux Spy View Displays the OpenMux Spy view
for the OpenMux.

Toolbar Toggles the display of toolbar on
or off.

If checked, the toolbar is displayed.

Status Bar Toggles the display of status bar
on or off.

If checked, the status bar is
displayed.

Options Menu. Specify OpenMux Spy view display options using the menu
selections described in Table 3--44.

Table 3- 44: Real-time multiplexer Options menu selections

Menu selection When selected Comments

OM Spy Frequency Displays the Refresh Frequency
dialog box.

Specify the frequency in seconds that
data is updated in the OpenMux Spy
view.

Automatic Configu-
ration

Displays the Automatic Configu-
ration dialog box.

Use this dialog box to save and apply
OpenMux configurations.

Hexadecimal (F2) Toggles between displaying
decimal and hexadecimal values
in the Hierarchic views

If checked, hexadecimal values are
displayed.

Function key F2

Small Size (F3) Toggles between displaying large
or small icons in the OpenMux
Spy and Hierarchic views.

If checked, small icons are displayed.

Collapse (F4) Toggles between showing the
Hierarchic view collapsed or
expanded.

If checked, the hierarchy is collapsed
in the Hierarchic views.

Display Displays the following selections:

Basic (F6) Displays only the essential
information in the hierarchic
views.

Function key F5
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Table 3- 44: Real-time multiplexer Options menu selections (Cont.)

Menu selection CommentsWhen selected

Partial
(F7)

Displays more program informa-
tion in the hierarchic view.

Function key F5

Total (F8) Displays the most information in
the hierarchic views.

Function key F5

Font Not available.

Window Menu. Control how view windows are displayed using the menu
selections described in Table 3--45.

Table 3- 45: Real-time multiplexer Window menu selections

Menu selection When selected Comments

Cascade Arranges the view windows so
that they overlap.

Tile Arranges the view windows so
that they tile without overlapping.

Arrange Icons Arranges the view window icons
at the bottom of the application
window.

List of active views Displays the selected view
window.

Help Menu.Access the online help and version information about the MTS300
OpenMux using the menu selections described in Table 3--46.

Table 3- 46: Real-time multiplexer Help menu selections

Menu selection When selected Comments

Contents Displays the MTS300 OpenMux
online help.

Using Help Displays the Windows NT online
help.

About OpenMux
Configurator

Displays version information for
the MTS300 OpenMux.

Toolbar Command Buttons. Table 3--47 lists the command buttons and menu
equivalents for the OpenMux.
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Table 3- 47: Real-time multiplexer toolbar buttons

Button
Button name
Menu selection equivalent When clicked

Home Displays the OpenMux Spy view of the
local multiplexer server

Connect

File | Connect

Displays the Connect to a Server
selection list from which you select a
machine with a multiplexer server

Disconnect

File | Disconnect

Disconnects from the multiplexer server
displayed in the OpenMux Spy view

Stop Multiplex

Multiplex | Stop Multiplex

Stops the multiplexer server (stops
generating a transport stream)

Start Multiplex

Multiplex | Start Multiplex

Starts the multiplexer server (starts
generating a transport stream)

Spy View

View | OpenMux Spy

Opens the OpenMux Spy view window

Program Multiplex Allocation

Output | Multiplex Allocation | Program

Opens the Program Multiplex Allocation
view window

Status Bar. The status bar displays brief messages explaining the highlighted
menu selection or the command button over which the cursor is positioned.
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The OpenMux Spy view is the OpenMux view window you use to configure the
inputs to the real-time multiplexer server. The top line of each view window
indicates the machine name of the multiplexer server to which you are connected
(the multiplexer server can be running on a local or remote machine).

If not already displayed, click the Spy view button on the toolbar to display
the OpenMux Spy view.

Transport
stream icon

Program icon

Output
icon

PSI icon

The display shows the current configuration of the multiplexer server. If
there is no transport stream being generated by the multiplexer server you are
connected to, the OpenMux Spy view is blank, except for the multiplexer
icon in the center of the view window.

The OpenMux Spy view uses icons to represent the input and output to the
OpenMux. The icons, and the actions you can perform on them, are described in
Table 3--48.

OpenMux Spy View

OpenMux Spy View Icons
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Table 3- 48: OpenMux Spy view icons

Icon
Icon name
Double-click to Right-click to

PSI-SI-PSIP icon Display a submenu that
allows you to see the
properties of the task and
to manage, edit, or delete
the input.

Transport stream file icon

Display the Control view
for the input.

Display a submenu that
allows you to see the
properties of the task, to
control, manage, edit, or
delete the input, and to
view the hierarchy of the
input stream.

Elementary stream
program icon

Display the Control view
for the input.

Display a submenu that
allows you to see the
properties of the task, to
control, manage, or delete
the input, and to view the
hierarchy of the input.

Output icon Display a submenu that
allows you to display the
hierarchy, program alloca-
tion, or PID allocation of
the output stream.

Multiplexer server icon



Using the OpenMux Configuration Client

3- 254 MTS300 Stream Creation Applications User Manual

Each input icon includes information about the management state of the input in
the upper left corner of the icon. SeeManaging Multiplexer Inputs beginning on
page 3--263 for more information about this topic.

Input icons provide the following information:

Task ID

Input name

Management state

File location
or file type

Bit rate
Status

Input type

� Input name. This name appears in the Multiplex Program Allocation view
for the output. For PSI-SI-PSIP and transport stream file inputs, you can edit
the input name at any time using the Edit Settings dialog box. For elemen-
tary stream program inputs, you need to edit the name when you create the
input.

� Task ID. The task ID is allocated as inputs are created. The task ID of a new
input is incremented one based on the task ID of the previously created
input. Task IDs are not dynamically managed; therefore, removing inputs
does not change task ID values.

� Status. The possible status for each input type is listed in Table 3--49 on
page 3--255.
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Table 3- 49: Icon type image characteristics for each possible input status

Input Status Icon image characteristic

PSI-SI-PSIP Running Green

Transport File Running Green

Paused Black and white

Stopped Grey

ES Program Running Green

Paused Reverse video with a ❚❚ symbol in the image

Stopped Reverse video with a � symbol in the image

Underflow Yellow

Overflow Pink

Error Red

One state, start in a few seconds is a temporary state for inputs: the input is
initializing. In this state, the icon is black and white and changes to green as
soon as the input status changes to running. If the input is not looped, when
the file has been read in to the multiplexer server, the status is End. If the
connection to the server is lost, input states are Undefined.

� Bit rate. The bit rate (given in bits per second) is extracted from transport
stream file and elementary stream file program inputs. The bit rate is
calculated for PSI-SI-PSIP inputs.

� Management state. The management state options are described in Managing

Multiplexer Inputs beginning on page 3--263.

� Input type. The input type image reflects whether the input is a PSI-SI-PSIP,
Transport File, or ES Program input and changes according to the status of
the input as indicated in Table 3--49.

� File location or file type. The file location or file type indicates the source
file for transport stream file inputs, and the elementary stream types used for
elementary stream program inputs.

Because the PSI-SI-PSIP information is extracted from the transport stream file
inputs and managed dynamically by the OpenMux, the PSI-SI-PSIP icon does
not include file location or file type information.
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The OpenMux uses a Hierarchic views, similar to the Hierarchic views of the
table editors and the multiplexer, to show the structure of input and output
transport stream elements.

NOTE. The Hierarchic view for the output stream is available only if the

PSI-SI-PSIP input task is present.

� To display the Hierarchic view of an input or output stream element, right
click an input or output icon and then select Hierarchic View from the
submenu. (This view is not available for PSI-SI-PSIP input tasks.)

Both view windows are displayed at the bottom of the MTS300 OpenMux
window. You can select the blue bar to the left of a Hierarchic view window to
drag it to a new location.

The following illustration shows the Hierarchic view of an output transport
stream.

Click here to collapse
the hierarchy at this icon

You can expand and collapse the elements by clicking on a box next to an
icon with subordinate transport stream elements.

Hierarchic Views
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You can display the information presented in the Hierarchic views as small icons
by pressing the F3 function key on your keyboard (or by selecting Small Size
from the Options menu).

The following illustration shows the input Hierarchic view of a transport stream.

There are two important aspects of this illustration:

� Icons with a cross (X) over them indicate that the elements they represent are
excluded in the output stream, or, in the case of PSI, SI, and PSIP tables, are
being regenerated by the multiplexer server.

� The program icons (the PMT and elementary stream files) have popup
menus associated with them that you can display by right-clicking on an
icon. You can use these menus to add, remove, or change program elements.



Using the OpenMux Configuration Client

3- 258 MTS300 Stream Creation Applications User Manual

You can visualize the output transport stream using the Program Multiplex
Allocation view and the PID Multiplex Allocation view. Both of these views use
a pie chart to depict the percentage of the output transport stream used by the
programs or PIDs respectively. Both views are dynamic, and both views allow
you to see at a glance the make-up of your transport stream.

Program Multiplex Allocation View. The Multiplex Program Allocation view
represents the percentage of the output transport stream used by each program,
PSI-SI-PSIP input, and null packets.

NOTE. The Program Multiplex Allocation view for the output stream is available
only if the PSI-SI-PSIP input task is present.

� To display the Program Multiplex Allocation view, right-click the output
icon, and then select Program Multiplex Allocation from the submenu.
This view window is displayed at the bottom of the MTS300 OpenMux
window. You can select the blue bar to the left of a Hierarchic view window
to drag it to a new location.

You can resize and reposition this view window to make viewing the contents
easier.

Multiplex Allocation Views
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PID Multiplex Allocation View. The PID Multiplex Allocation view represents the
percentage of the output transport stream used by each PID in the transport
stream.

� To display the PID Multiplex Allocation view, right-click the output icon,
and then select PID Multiplex Allocation from the submenu. This view
window is displayed at the bottom of the MTS300 OpenMux window. You
can select the blue bar to the left of a Hierarchic view window to drag it to a
new location.
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A configuration is a set of defined inputs and the output multiplex rate applied to
a multiplexer server. The current configuration of the multiplexer server is
displayed and managed using the OpenMux and the icons in the OpenMux Spy
view. Using the procedures described in this section, you can automatically save
the displayed configuration and have it appear the next time you restart the
multiplexer server. You can also save multiple configurations of one or more
multiplexer servers.

NOTE. When you create, save, or delete configurations, you are specifying the
parameters of the multiplexer server (the application running in the back-

ground)). If the multiplexer server is being used by another OpenMux, the

current status of the inputs and output parameters are displayed in the OpenMux

Spy view, regardless of the configuration parameters you may have saved earlier.

To save a configuration of inputs, outputs, and server connection, use the
following procedure:

1. When you add inputs to the OpenMux, ensure that the Automatic Saving
check box is selected. When you add inputs (PSI-SI-PSIP, transport stream
file, or elementary stream program), this is a default value.

The following illustration shows the Advanced PSI dialog box with the
check box selected. After an input is added, you can change this setting for
any input you manage, using the Edit Settings dialog box.

Saving Multiplexer Server
Configurations
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NOTE. For inputs to be saved to a configuration, the Automatic Saving input

check box must be selected. If this input option is not selected, when a configura-

tion is created using the input, the input is ignored and will not appear when the

configuration is applied.

2. Once you have the configuration of inputs, outputs, and multiplex rate set
the way you want, select Automatic Configuration from the Options menu.
The Automatic Configuration dialog box is displayed.
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The following list describes each of the options in the Automatic Configura-
tion dialog box and how to use them:

� Apply Following Configuration at OpenMux Starting.

If this check box is selected, the configuration listed in the text box will
be applied the next time you restart the multiplexer server. If this check
box is not selected, no configuration is applied when you restart the
multiplexer server.

Select a configuration name from the drop-down list box, or enter a
name into the text box. New names are added to the list of configura-
tions available from the drop-down list boxes.

� Automatically Save the OpenMux Configuration in.

NOTE. For inputs to be saved to a configuration, the Automatic Saving input

check box must be selected. See page 3--261.

If this check box is selected, the multiplexer server configuration
displayed when you quit the multiplexer server application is saved into
the configuration indicated in the text box. If the check box is not
selected, the configuration is not saved.

Select a configuration name from the drop-down list box, or enter a
name into the text box. New names are added to the list of configura-
tions available from the drop-down list boxes.

� Configurations Management.

� You can save the currently displayed configuration by entering a new
configuration name into the text box and clicking the Save Now
button.

� You can save the currently displayed configuration into an existing
configuration by selecting a configuration name from the drop-down
list box and clicking the Save Now button.

� You can delete configurations by selecting a configuration name
from the drop-down list box and selecting Delete.

The changes you make to the list of configurations are reflected in the
other drop-down list boxes in the dialog box.

3. After you have made the configuration changes you need, click OK to accept
your changes and close the dialog box. Click Cancel to close the dialog box
without making any configuration changes.
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Multiplexer Inputs

The MTS300 OpenMux allows you to create a transport stream using three
different types of inputs. These inputs and how you can work with them are
described in the following sections:

� Managing Multiplexer Inputs. The management state of an input determines
which OpenMux can control the status of the input or remove it from the
input. Only the OpenMux that manages an input can make changes to that
input. This section describes the concept of input management and provides
procedures for releasing and taking management of OpenMux inputs.

� PSI-SI-PSIP Input. Specific PSI, SI, and PSIP tables are extracted from the
other inputs and modified dynamically by the multiplexer server. This
section describes the table types filtered and regenerated by the multiplexer
server. The section also provides procedures for adding, modifying, and
deleting PSI-SI-PSIP inputs. See page 3--264.

� Transport Stream File Input. Transport stream inputs can be any combina-
tion of MPEG-2, DVB, or ATSC single or multiple program transport stream
files. This section provides procedures for adding, modifying, deleting,
controlling, and monitoring transport stream file inputs. See page 3--275.

� Elementary Stream Program Input. Each elementary stream program must
minimally include an MPEG-2 video elementary stream file and can
optionally include an MPEG-2 audio elementary stream file. This section
describes how to add this input and lists the error messages associated with
creating the input. See page 3--284. Most of the tasks described in Transport

Stream File Input also apply to the elementary stream program input.

Each input icon in the OpenMux Spy view includes information about the
management state of the input in the upper left corner of the icon. The manage-
ment of an input (who controls it) determines which OpenMux can control the
status of the input: present, running, paused, or stopped. There are three possible
management states as shown in the following illustration (note the differences in
the presence of the hand image in the upper left corner of the illustrations).

Managed by you Managed elsewhere
(some other OpenMux)

Not managed

When you create an input, by default you manage that input. If you manage an
input, no other OpenMux can control it or remove it as an input. To release
management of an input, right-click the icon for the input and select Toggle
Management from the submenu.

Managing Multiplexer
Inputs



Using the OpenMux Configuration Client

3- 264 MTS300 Stream Creation Applications User Manual

If an input is not managed (someone has released management of the input), you
can take over management using one of the following techniques:

� Right-click the icon for the input you want to manage and select Toggle
Management from the submenu.

� Select Input Management from the Input menu. In the dialog box that is
displayed, select the input for which you want to take management, and then
click OK.

� Right-click the icon in the OpenMux Spy view and select Edit Settings.
When an Edit Settings dialog box is opened for an un-managed input,
management for the input is automatically given to the OpenMux that
accessed the input settings.

NOTE. When an input has an open Control view, you cannot toggle the manage-

ment for that input. Close the Control view window to toggle management. Also,

if the Hierarchic view for the output is displayed, you cannot toggle management

of the PSI-SI-PSIP task. Close the Hierarchic view to toggle management.

The PSI-SI-PSIP input is an essential MTS300 OpenMux task if you want to
remultiplex multiple inputs. Using the PSI-SI-PSIP input, you can perform the
following tasks:

� Configure the PSI-SI-PSIP input task to display the next time you restart to
the multiplexer server. Select the Automatic Saving check box shown in the
illustration on page 3--265.

� Specify and change the output environment for the output stream. Select any
combination of the DVB and ATSC check boxes on the MPEG panel.

� Specify and change the input task name that appears in the Hierarchic view
of the output. Enter the name you want in the Name text box on the MPEG
panel.

� Specify and change the refresh, or input rate for the tables in the output
stream. Change the rates in the table type groups on each panel.

� Specify and change which DVB SI and ATSC PSIP tables are included in the
output transport stream. Select the appropriate check boxes on the DVB and
ATSC panels.

PSI-SI-PSIP Input
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Through this input task, the multiplexer server filters the table types shown in
Table 3--50 and regenerates them as appropriate depending on the output stream
environment, number and type of inputs, and the parameters you specify in the
Advanced PSI dialog box.

Table 3- 50: PSI-SI-PSIP tables filtered by the multiplexer server

PSI (required) SI (optional) PSIP (optional)

Program allocation table Network information table Master guide table

Program map table Service description table Virtual channel table

Conditional access table Time and date table System time table

When the PSI-SI-PSIP input is present, all the tables in the input transport
streams are filtered and the tables regenerated as described in this section. Input
PID values are reassigned by the OpenMux to avoid conflicts.

This section describes how the multiplexer server filters and regenerates each
PSI, SI, and PSIP table required in the output transport stream.
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PSI Tables.All transport streams created using the OpenMux include the
following PSI tables. These tables are extracted from the input transport streams
and modified for output according to the parameters you specify on the MPEG
tab and the configuration of ES and transport stream file inputs to the OpenMux.
The illustration on page 3--265 shows the Advanced PSI dialog box with the
MPEG panel displayed.

� Program allocation table (PAT)

All the original PAT sections of the transport stream inputs are automatically
filtered when the PSI input is present. The sections are updated dynamically
as inputs are added to and removed from the output.

The PAT rate and transport stream ID for the output stream are specified in
the PAT group. The transport stream ID is used for the transport stream ID
parameters of the PMT and SDT, and, if present, the NIT, SDT, MGT, and
VCT. The PAT rate and transport stream ID can be changed after the
PSI-SI-PSIP input has been added using the Edit Settings dialog box (see
page 3--273).

� Program map table (PMT)

All the original PMT sections of the transport stream inputs are automati-
cally filtered when the PSI input is present. PMTs are regenerated with the
same program number if possible or with different program numbers if there
are PID conflicts with other inputs. Changes to PID values are indicated in
the PID Couple text box of the Filtered PID dialog box. PMT sections are
added, removed, and updated as inputs are added and removed.

The PMT rate is specified in the Advanced PSI dialog box. You can change
this value after the PSI-SI-PSIP input has been added using the Edit Settings
dialog box (see page 3--273).

All of the original descriptors present in the input transport stream except
those in the following list are rejected:

� Video stream

� Audio stream

� Language

If the ATSC option is selected, the PMT PIDs, program numbers, and
elementary stream PIDs are reallocated, if needed, to be fully compliant with
the ATSC environment program paradigm.



Using the OpenMux Configuration Client

MTS300 Stream Creation Applications User Manual 3- 267

� Conditional access table (CAT)

All CAT sections, if present, are passed through to the output unless you
specify which services or PIDs to remove from the output (see Adding and

removing programs from transport stream file inputs beginning on
page 3--279). The input rate is computed according to the value specified in
the Advanced PSI dialog box. This value can be changed using the Edit
Settings dialog box (see page 3--273).

DVB Tables. If the DVB option is selected, the DVB tab is present in the
Advanced PSI dialog box. To display the DVB panel so that you can specify
DVB-SI parameters, click the DVB tab. The DVB panel is displayed as shown in
the following illustration.

NOTE. The NIT is a static transport stream output. To create a transport stream

that meets DVB requirements, the file openmux.nit must be in the same directory

as the multiplexer server to which you are connected. The default directory for

the multiplexer server is C:\MTS300\BIN.
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� Network information table (NIT)

You can specify the period of the NIT from the Advanced PSI dialog box.
You can change this value after the PSI-SI-PSIP input has been added using
the Edit Settings dialog box (see page 3--273).

� Service description table (SDT)

When the SDT check box on the DVB panel is selected, the SDT in the input
is filtered, and a new SDT is generated and multiplexed into the output
stream. The services and parameters of the SDT are based on the number and
type of inputs and the options you specify in the SDT group. You can change
these values after the PSI-SI-PSIP input has been added using the Edit
Settings dialog box (see page 3--273).

The following parameters of the input SDT sections are modified as
indicated:

� The transport stream ID is the same value that you specify in the PAT.

� The original network ID value is not changed in the SDT sections.

� The free CA mode is set to zero (not scrambled).

� The EIT present/following flag is set to zero (not present).

� The EIT schedule flag is set to zero (not present).

� The running status is set to four (running). Inputs that are stopped or
paused after the PSI-SI-PSIP input has been added are not included in
the regenerated SDT (or any other table regenerated by the OpenMux);
therefore, the running status can only be set to running (4).

� All descriptors in the original SDT are rejected, except the service name
descriptor. The way the service name and provider name values are
handled in the output stream is described below:

If the original SDT includes a service name descriptor, and if the
Replace Service Name or Replace Provider Name check boxes are not
selected, the original values are used in the output stream.

If there is no service name descriptor in the original SDT, and if the
Replace Service Name or Replace Provider Name check boxes are not
selected, the service name descriptor is not added to the output SDT.

If there is no service name descriptor in the original SDT, and if the
Replace Service Name or Replace Provider Name check boxes are
selected, the provider name you specify in the SDT group and the name
you specify in the Input File dialog box (see page 3--275) replace those
values in the original SDT.
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If there is no service name descriptor in the original SDT, and if the
Replace Service Name or Replace Provider Name check boxes are
selected, a service name descriptor is added to the output SDT using the
provider name you specify in the SDT group and the name you specify
in the Input File dialog box.

� Time and date table (TDT)

To include a TDT in the output stream, click the DVB tab in the Advanced
PSI dialog box, and then ensure that the TDT check box is selected. In the
TDT group, you can specify the TDT period.

By default, the OpenMux uses the computer time for the start time and date
elements of the TDT. When this option is selected, the start time and date are
the current time and date based on your system clock. You can specify
different times by clicking the Use Computer Time check box to deselect the
option, and then modifying the time and date text boxes.

After the PSI-SI-PSIP input has been added, you can change any of the TDT
options using the Edit Settings dialog box (see page 3--273).

ATSC Tables. If the ATSC option is checked, the ATSC tab is present in the
Advanced PSI dialog box. To display the ATSC panel so that you can specify
ATSC PSIP parameters, click the ATSC tab. The ATSC panel is displayed.
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The following PSIP tables are filtered and regenerated for output according to
the parameters you specify in the ATSC tab.

� Master guide table (MGT)

You can specify the MGT period in the MGT group. All other MGT values
are filtered and regenerated based on the inputs. You can change this value
after the PSI-SI-PSIP input has be added using the Edit Setting dialog box
(see page 3--273).

� Virtual channel table (VCT)

If the CVCT or TVCT check boxes are selected, the appropriate tables are
generated by the multiplexer server. All of the VCT sections and descriptors
from the input transport streams are filtered, and all of the descriptors are
kept for each virtual channel except the service location descriptor. The
service location descriptor is regenerated by the OpenMux based on the
inputs to the OpenMux to build consistent VCT sections.

You can specify the following VCT parameters only when either the CVCT
or TCVT check box is selected (you can select any combination of CVCT
and TVCT options):

� VCT period.

� Major channel number.

� Default language.

� Replace short name. If this check box is selected, the short name is
replaced by the program number of the virtual channel. If this check box
is not selected, the short name in the original VCT is used in the output.

� TVCT Modulation Mode defines the Modulation Mode field value in the
terrestrial VCT. The drop-down selection box is available only when
TVCT is selected.

� TVCT Carrier Frequency defines the Carrier Frequency field value in the
terrestrial VCT. The drop-down selection box is available only when
TVCT is selected.

� CVCT Modulation Mode defines the Modulation Mode value in the
cable VCT. The drop-down selection box is available only when CVCT
is selected.

� CVCT Carrier Frequency defines the Carrier Frequency field value in the
cable VCT. The drop-down selection box is available only when CVCT
is selected.

You can change these values after the PSI-SI-PSIP input has been added
using the Edit Settings dialog box (see page 3--273).
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� System time table (STT)

If the STT check box is selected, the STT is added to the output and the
following fields are available for you to specify:

� STT period

� Use Computer Time. If this check box is selected, the current time of the
computer is used to generate the STT. If this check box is not selected,
the values you specify in the system time and date text boxes are used.

The system time and date specifies the time and date of the first
occurrence of the STT table in the output transport stream.

� GPS UTC Offset. This value defines the GPS UTC Offset value (in
seconds) in the STT.

Adding PSI-SI-PSIP Tables. The PSI-SI-PSIP input task is required to create a
valid output transport stream using multiple inputs, and you can have only one
PSI-SI-PSIP input for an output stream. To add PSI-SI-PSIP input to the
OpenMux, use the following procedure:

1. If necessary, perform steps 1 through 3 of the tutorial beginning on page
3--240 (connect to a multiplexer server and set the multiplex rate).

2. Select PSI-SI-PSIP from the Input menu. The Advanced PSI dialog box is
displayed. The following illustration shows the Advanced PSI dialog box
with the DVB option selected.

3. Enter a name for the PSI-SI-PSIP input in the Name text box. This name
appears in the PSI-SI-PSIP icon in the OpenMux Spy view.
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4. If you want the PSI-SI-PSIP input to be present the next time you restart the
multiplexer server, ensure that the Automatic Saving option is selected. (See
Saving Multiplexer Server Configurations beginning on page 3--260 for more
information about this option.)

5. To include PSIP tables in the PSI-SI-PSIP task (to filter PSIP tables from the
inputs and to modify them for output), click the ATSC option. The ATSC
tab is added to the dialog box.

NOTE. For SI or PSIP tables to be filtered and modified for output, the corre-

sponding check box must be selected, and the tab visible in the Advanced PSI

dialog box.

6. Modify the parameters listed for each table type using the options available
in the table type groups on each panel.

7. After you have made all of the changes you want, click Apply to accept your
changes and close the dialog box. The PSI-SI-PSIP input icon is added to the
OpenMux Spy view, and the input status is running. PSI-SI-PSIP input
cannot be stopped, it can only be removed or running.
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Changing Parameters for PSI-SI-PSIP Tables.You can modify the rate, and other
parameters of output PSI, SI, and PSIP tables using the following procedure:

NOTE. To display the Edit Settings dialog box, you must manage the input, or the

input must not be managed elsewhere.

1. Right-click a PSI-SI-PSIP icon in the OpenMux Spy view, and then select
Edit Settings from the submenu. The Edit Settings dialog box is displayed.

2. Click the tab for the environment that uses the table type for which you want
to change the rate.

3. In the table type group, change the value in the Refresh Period text box.

4. Click Apply to accept your changes and close the dialog box. You can click
Cancel at any time to close the dialog box without making any changes to
the input.

The Rate value in the PSI-SI-PSIP icon changes to reflect the changes to the
table rate.
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Alternatively, you can use the following procedure to display the Edit Settings
dialog box for inputs that you manage, or for inputs that are not managed:

1. Select Edit Settings from the Input menu. The dialog box that is displayed
lists only those inputs that you manage or that are not managed by another
OpenMux.

2. Select the input that you want to modify in the Select an Input selection box,
and then click OK. The Edit Settings dialog box for the selected input is
displayed (see the illustration on page 3--273).

Changing the Output Environment.You can change the output environment by
removing the DVB-SI or ATSC PSIP task from the PSI-SI-PSIP input. Use the
following procedure:

1. Right-click the PSI-SI-PSIP icon in the OpenMux Spy view, and then select
Edit Settings from the submenu. The Edit Settings dialog box is displayed
(see the illustration on page 3--273).

2. To change the environment, use one of the following techniques:

� To add SI tables to the output, select the DVB check box on the MPEG
panel. If the check box is selected, the DVB SI tables will be filtered and
remultiplexed into the output stream. If the check box is not selected, SI
tables are removed from the output of the OpenMux.

� To add PSIP tables to the output, select the ATSC check box on the
MPEG panel. If the check box is selected, the ATSC program paradigm
will be used when assigning PID values to table types and program
elements, and ATSC PSIP tables will be filtered and remultiplexed into
the output stream. If the check box is not selected, PSIP tables are
removed from the output of the OpenMux.

� You can use both environment settings in the output, and the multiplexer
server will automatically reallocate PID values to avoid conflicts.
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The transport stream file input can be MPEG-2, DVB, or ATSC single or
multiple program transport stream files. The inputs are filtered and remultiplexed
according to the output environment, number and type of other OpenMux inputs,
and the values you specify in the Input File dialog box.

Using the procedures described in this section, you can add, control, delete,
modify, and monitor the transport stream file inputs that you manage, or that are
not managed by another OpenMux. SeeManaging Multiplexer Inputs on page
3--263 for information about how to manage inputs. SeeMultiplexer Limits on
page 3--234 for the limits on the number and type of transport stream file inputs
to the multiplexer server.

Adding a Transport Stream File Input.After you have connected to a multiplexer
server and set the multiplex rate, use the following procedure to add a transport
stream file input.

1. Click Add Input from the Input menu, and then select Transport File from
the submenu. The Input File dialog box is displayed .

2. Click Browse to select a transport stream file.

3. Select a transport stream file using the Open dialog box and click OK to
return to the Input File dialog box. The transport stream file you selected is
displayed in the Input File Name text box.

Transport Stream File
Input
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4. Make changes to the text and check boxes as explained in the following list:

� Name. This parameter is used in the input icon, the Program Multiplex
Allocation view, and as the value used if the Replace Service Name
check box is selected in the SDT group of the DVB input panel. The
default name is the name of the transport stream file.

� Rate. After the transport stream file has been selected, the OpenMux
analyzes the PSI information for the transport stream file and displays
the transport stream file rate in this text box.

� Begin locator. This parameter specifies an index in bytes from which you
want the transport stream file input to start. By default the index is set to
zero, the beginning of the file. If the Loop check box is selected, the file
loops from this position to the End Locator.

� End locator. This parameter specifies an index in bytes at which you
want the transport stream file input to stop. By default the index is set to
zero, the end of the file. If the Loop check box is selected, the file loops
from the position indicated by the Begin Locator value to this position.

� Loop. Select this check box to continuously loop the input. The loop
starts and the position indicated by the Begin Locator index and restarts
at the position indicated by the End Locator index.

� Continuity Counter. If this check box is selected, the continuity counters
are incremented for each PID of this input. If the check box is not
selected, the packets are sent with the original continuity counters of this
input.

� Lock. If this check box is selected, the input task waits for the hard disk
to fill buffers before emptying them with the remultiplexing task. This
option avoids underflow.

� Automatic saving. See Saving Multiplexer Server Configurations

beginning on page 3--260 for more information about this check box.

� Filtered PID. See Removing and Adding Programs from a Transport

Stream File Input beginning on page 3--279 for more information about
this dialog box. If you select this button before the input is added to the
OpenMux, all the text boxes are blank. Since the input has not yet been
read by the multiplexer server, and PIDs have not been compared to the
output transport stream requirements and other inputs, no PID values can
be represented in the dialog box.

� Allow Bouquet Mode. If checked, you can combine multiple inputs into
a single service.

� Allow PMT Sharing. If checked you can use one PID for multiple PMTs.
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5. Select Apply to accept your changes and close the dialog box. The Transport
Stream File icon is added to the OpenMux Spy view. The input status is
stop.

6. To start the input, double-click the input icon in the OpenMux Spy view, and
then click the� (Start) button in the Control view. The status changes to
running, and the PSI-SI-PSIP rate changes to reflect the change to the output
stream.

Controlling a Transport Stream File Input.After you have added a transport stream
file input to the OpenMux, the input status is stop. The input, and the associated
PSI-SI-PSIP data, is added to the output stream only when the input is running.
Use the following procedure to control the status of an input.

1. Double-click the icon for the input in the OpenMux Spy view. The Control
view for the input is displayed.

NOTE. In order to change the management of an input, the Control view for that

input must be closed.

Use one of the following techniques to change the status of an input:

� To start an input, click the� (Start) button. The slider and the position
indicator just below it, change to reflect the change in status. The associated
PSI-SI-PSIP data, is added to the output stream.

� To pause an input, click the ❚❚ (Pause) button. The associated PSI-SI-PSIP
data is removed from the output stream. When you restart the input, the
input starts at the point in the file at which it was paused.

� To stop an input, click the� (Stop) button. The associated PSI-SI-PSIP data
is removed from the output stream. When you restart the input, the input
starts at the beginning.

2. To close the Control view for an input, click the Close title bar button.
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Deleting a Transport Stream File Input.You can delete only those inputs that you
manage, or that are not managed by another OpenMux. After an input is added to
the OpenMux, you can delete it using the procedure described in this section.
(This procedure can also be used for deleting elementary stream program inputs.)

1. Right-click the icon for the input you want to delete, and then select Delete
from the submenu.

2. In the Delete an Input dialog box that is displayed, make one of the
following choices:

� Select No to close the dialog box without making any changes to the
OpenMux.

� Select Yes to display the Delete Input Task dialog box. In this dialog box
you specify whether you want the input task to finish, or whether you
want the input deleted immediately. Select an option, and then close the
dialog box.

If you do not manage the input you selected, the dialog box displays the
following message. Click OK to dismiss the dialog box.

You can delete all inputs at once by selecting Delete All Inputs from the Input
menu.
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Removing and Adding Programs from a Transport Stream File Input. Programs, in
this case, refer to the PSI-SI-PSIP sections specific to a service or virtual channel
and the elementary stream files associated with that service or virtual channel.
After an input is added to the OpenMux, you can use this procedure to remove
programs from, or add programs to the output stream. (You can use this
procedure for removing an audio stream file from a program input.)

1. In the OpenMux Spy view, right-click the input icon for the multiple
program transport stream from which you want to remove one or more
programs.

2. Select Hierarchic View from the submenu. The Hierarchic view for the
selected input is displayed.

NOTE. Programs are represent in the Hierarchic view by a PMT icon and the

elementary stream icons subordinate to it. However, when you remove a program

from the output stream, you also remove all PSI-SI-PSIP data related to the

program in the output.

3. Right-click the PMT icon for the program you want to remove, and then
select Suppress Service from the submenu.
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4. The Hierarchic view is updated, showing that the program elements (the
PMT and the elementary stream icons) have been removed. The PSI-SI-PSIP
rate changes to reflect the new input parameters, and the program does not
appear in the output stream.

5. You can add the service (program) again, by repeating step 3 and selecting
Restore Service from the submenu.

NOTE. You can also remove specific video, audio, data, or conditional access

elements and change PIDs using the procedure described in this section.
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Using the Filtered PID Dialog Box to Exclude Packets in Transport Stream Inputs.
You can use the procedure in this section to specify PID values for specific
packets that you want to exclude from the output stream. You can use the
MTS300 System Analyzer to determine the PIDs for the packets you want to
exclude from the output. Alternatively, you can use the Hierarchic view for the
input; however, this view does not list PMT PIDS or program numbers.

1. Do one of the following to display the Edit Settings dialog box:

� Right-click the icon of an input for which you want to exclude specific
PIDs, and then select Edit Settings from the submenu. The Edit Settings
dialog box for the input is displayed.

� Select Edit Settings from the Input menu, and then double-click the
input task number in the dialog box as shown in the following illustra-
tion. The tasks that are displayed in the selection box are tasks that you
manage or that are not managed by another OpenMux.

2. Click the Filtered PID button (toward the bottom of the dialog box), and the
Filtered PID dialog box is displayed.
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The values in the PID text box are PID values that the multiplexer excludes
from the output stream by default. The following list describes how to use
the Filtered PID dialog box to exclude or change PIDs in the output stream.

� Select the All Reject Except check box to exclude the PIDs not listed in
the PID text box. When this check box selected, those PIDs appearing in
the PID text box are the only PIDs present in the output stream.

� Clear the All Reject Except check box to exclude all PIDs listed in the
PID text box. When this check box is not selected, PIDs appearing in the
PID text box will not be present in the output stream.

� Change PID values using the PID Couple text box. Parentheses group
PID couples: the first number is the input PID value, and the second
number is the output PID value.

3. Ensure that the All Reject Except check box is not selected, and then enter
the PID for the packets you want to exclude in the PID text box. (It is okay
to delete the PIDs in the text box, they will be replaced when you close the
dialog box.) PIDs can be entered in any order.

4. After you have made the all the PID modifications you need to, click OK to
accept your changes and close the dialog box. Click Cancel at any time to
close the dialog box without making any changes.

5. Click Apply in the Edit Settings dialog box to accept the changes. Click
Cancel to close the dialog box without making any changes to the output
stream.

The PIDs you specified no longer appear, or are changed, in the output stream.
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Monitoring Inputs.You can use the views described in Hierarchic Views

beginning on page 3--256 to monitor transport stream file and elementary stream
file program inputs and to monitor output streams. You can use the views
described in Multiplex Allocation Views beginning on page 3--258 to monitor
output streams. You can use the Information message window shown below to
monitor all three input types: PSI-SI-PSIP, transport stream file, and elementary
stream file program inputs. To display the Information window for an input,
right-click the input icon, and then click Information from the submenu.

This message window displays the status of the input, where in the file the
OpenMux is reading, and other information about the input.
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In addition to remultiplexing transport stream files, you can include video and
audio elementary stream files as inputs to the OpenMux. Since this type of input
does not include associated PSI, SI, or PSIP table files, the multiplexer server
creates them dynamically or updates the tables already being created to account
for the elementary stream file input.

The following lists describe the constraints on the elementary stream program
input and the constraints on the video and audio file components:

Elementary Stream File Program Constraints.

� No more than six elementary stream program inputs for an output

� The PCRs for the program (service) are carried by the video packets

� One video elementary stream file is required for each input; audio elemen-
tary stream files are optional

Video Elementary Stream File Constraints.

� MPEG 2, Main Profile@Main Level video elementary stream files only

Audio Elementary Stream File Constraints.

� MPEG-2, Layer II audio elementary stream files only

� AC-3 audio elementary streams must have a constant bit ratio

Table 3--51 shows the valid configurations of bit rate and sampling frequency:

Table 3- 51: Bit rate and sampling frequency for the audio component

Sampling frequency

Bit rate (kbps) 32 kHz 44.1 kHz 48 kHz

32 � � �

40 � � �

48 � � �

56 � � �

64 � � �

80 � � �

96 � � �

112 � � �

160 � � �

Elementary Stream
Program Input
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Table 3- 51: Bit rate and sampling frequency for the audio component (Cont.)

192 � � �

224 � � �

256 � � �

320 � � �

384 � � �

448 � � �

512 � � �

576 � � �

640 � � �

Many of the procedures described in Transport Stream File Input, beginning on
page 3--275, can be used to control, modify, monitor, and delete this type of
input. Unlike transport stream file input, once elementary stream program input
is added to the OpenMux, the program parameters cannot be changed through
the Edit Settings dialog box; however, PID values can be changed in the
Hierarchic view, and you can view ES Program input settings.

1. Click Add Input from the Input menu, and then select ES Program from
the submenu. The ES Program dialog box is displayed.

2. Enter a name for the input task in the Input Name text box.

3. Enable the following options if appropriate:

� Allow Bouquet Mode allows you to combine multiple inputs into a
single service.

� Allow PMT Sharing allows you to use one PID for multiple PMTs.

4. Click Browse in the MPEG 2 VIDEO Component group, and then select a
video elementary stream file using the Open dialog box.

5. If the Add Audio Component check box is selected, repeat step 4 for the
audio elementary stream.

6. Change the values of the PSI and elementary stream parameters using the
check and text boxes if necessary.

7. Click OK to accept your changes and add an elementary stream program
input to the OpenMux. The input icon is added to the OpenMux view. Click
Cancel to close the dialog box without adding the input.
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Video Component Error Messages.

It is not a video data file. The name of the video data file does not correspond to a
video file or the video file does not exist. Video files with PES packets or
Transport Packets are not accepted.

The PID of the video must have a value between 16 and 8190. The current value is
set by default.

The video file does not respect the constraint : “constant bit rate”. The real-time
multiplexer deals only with constant bit rate stream. If it is not respected, the
video file name is not saved.

NOTE. During the analysis of the video file, the bit rate value is read in the first

sequence header and the size of Video Buffer Verifyer in bits is read in the first
sequence header.

If the bit rate value is set to 0x3FFFF and size of the Video Buffer Verifyer is set

to 0xFFFF, the video file is not accepted. Otherwise the video will be treated as

though it has a constant bit rate.

The video file does not respect the constraint : “main level”. The real-time
multiplexer only processes elementary streams with main levels. If it is not
respected, the video file name is not saved.

NOTE. The value of level is read in the first sequence extension after the first

sequence header during the analysis of the video file.

The video file does not respect the constraint : “main profile”. The real-time
multiplexer only processes elementary streams with main profiles. If it is not
respected, the video file name is not saved.

NOTE. When a video file name has been specified, the video file is analyzed. The

read value of profile level, is in the first sequence extension after the first

sequence head. This message indicates that the value does not correspond to

main profile.
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The video file does not respect the constraint: “MPEG- 2 mode”. The real-time
multiplexer only processes the MPEG--2 standard stream. If it is not respected,
the video file name is not saved.

NOTE. The standard is recognized as MPEG-1 if there is no sequence extension,

otherwise, it is considered to be MPEG--2.

You must give the name of the video and audio files.At the creation of the input,
when clicking on the OK button or pressing the RETURN key (after filling a
field), the presence of file names is checked. If there is no video name and no
audio name (and audio is present), the input cannot be created.

You must give the name of the video file.At the creation of the input, when
clicking on the OK button or pressing the RETURN key (after filling a field), the
presence of the video file name is checked. If there is no video name, the input
cannot be created.

Audio Component Error Messages.

Audio mode does not correspond to expected mode according to the bit rate and
sampling frequency values.According to the bit rate and sampling frequency
values, the OpenMux expects to have a given audio mode. If it is not respected,
the audio file name is not saved.

NOTE. Bitrate and sampling frequency are both read in the first audio header.

It is not an audio data file. The name of the audio data file does not correspond to
an audio file or the audio file does not exist. Audio files with PES packets or
Transport Packets are not accepted.

Audio files with 22.05 kHz sampling frequency are not treated. The real-time
multiplexer does not process streams with 22.05 kHz sampling frequency. If it is
not respected, the audio file name is not saved.

NOTE. The value of sampling frequency index is read in the first audio header.
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The audio file does not respect the constraint: “layer 2”. The real-time multiplexer
does not process streams with a layer other than layer 2. If it is not respected, the
audio file name is not saved.

NOTE. The value of the layer index is read in the first audio header. Then a table

given by the standard provides the layer value.

The PID of the audio must have a value between 21 and 8190. The current value is
set by default.

The rate of the audio file is null! In such a case, The real-time multiplexer cannot
accept the rate because it is used to compute other information such as frame
length. If the rate is null, the audio file name is not saved.

NOTE. Bit rate is defined from the read value of the mode index (MPEG--1 or

MPEG--2), of the bit rate index, of the layer index and the corresponding table in

MPEG standard. Rate value can be null because the read layer index is incorrect

or the value in table is null.

The sampling frequency of the audio file is null! In such a case, the OpenMux
cannot accept the rate because it is used to compute other information such as
frame length. If sampling frequency is null, the audio file name is not saved.

NOTE. Sampling frequency is defined from the read value of the mode index

(MPEG--1 or MPEG--2), of the sampling frequency index and the corresponding

table in standard.

You must give the name of the audio file.At the creation of the input, when the
audio component is specified, when clicking on the OK button or pressing the
RETURN key (after filling a field), the presence of audio file name is checked. If
there is no audio file name, the input cannot be created.

You must give the name of the video and audio files.At the creation of the input,
when clicking on the OK button or pressing the RETURN key (after filling a
field), the presence of file names is checked. If there is no video name and no
audio name (and audio is present), the input cannot be created.
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PID Error Messages.

The PID of the PMT must have a value between 21 and 8190. The current value is
set by default. The program number must have a value between 0 and 65535.
The current value is set by default.

The PID is already used for the PMT or for the audio component.

The PID is already used for the PMT or for the video component.

The PID is already used for the video or the audio component.

Multiplexer Outputs

The output task allows you to generate a transport stream with the inputs and
parameters you specify using the OpenMux. Once an output is added to the
OpenMux Spy view, you can remove it, change the multiplex rate, or you can
monitor the output using the views described in Multiplexer Windows, Views,

and Interface Elements, beginning on page 3--246. Use the procedures described
in this section to add and remove an output and to change the multiplex rate.

To add an output to the OpenMux configuration, select Start Multiplex from the
Multiplex menu (or click the� button on the toolbar).

To remove an output task, click the� button on the toolbar.

The sum of input rates may be different than the output rate. In fact, because null
packets in the inputs are discarded by the OpenMux, the ideal output rate can be
lower than the sum of the input rates. To change the output rate, use the
following procedure:

1. Click the� (Stop Multiplex) button on the toolbar.

2. Select Multiplex Rate from the Multiplex menu and change the rate in the
dialog box.

3. Click the� (Start Multiplex) button on the toolbar to restart the multiplex.

Adding an Output

Removing an Output

Changing the Multiplex
Rate
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Appendix A: What to Do if an Application Locks Up

In the event an application locks up or freezes, perform the following steps to
close the application.

1. Press CTRL+ALT+DEL to open the Windows NT Security dialog box.

2. Click Task Manager to open the Windows NT Task Manager.

3. Click the Applications tab, and then highlight the locked-up application
(usually the status of the application will indicate Not responding).

4. Click End Task.

5. In some circumstances, a window opens prompting you to wait, end the task,
or cancel your “end task” instruction. Follow the window instructions; if you
click End Task, the application should close immediately.

6. If the above procedure fails to close the application, press
CTRL+ALT+DEL again to return to the Windows NT Security dialog box.

7. Click Shut Down. This opens the Shutdown Computer dialog box.

8. Select Shutdown and Restart; then click OK.

CAUTION. To avoid data loss, do not power off the computer without first exiting

Windows NT. Only use the manual reset if the computer does not respond.

If the above procedures do not close the application or restart the computer,
manually power off the computer, and then proceed with a normal power on. To
ensure that all parameters are reset, perform a complete power cycle following an
application lock up.
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Appendix B: Software Repair

This appendix tells you how to uninstall and reload the test system software if
the installed copy is corrupted. See theMTS300 MPEG Test System Hardware

and Software Installation Technical Reference (Tektronix part number,
071-0667-xx) for information about rebuilding the operating system for the
MTS300 test system.

Reinstalling the MTS300 Software

Use the procedures below to reinstall your applications accidently deleted or
corrupt. Software is supplied on CD ROM.

NOTE. The following instructions are for reinstalling MPEG Test System

software on a machine running Windows NT Workstation 4.0 only; procedures

for upgrading your software could be different. If you are installing a software

upgrade, follow the instructions provided with the upgrade kit.

Reinstalling the software involves three procedures:

� Uninstalling the current software

� Installing the software

� Entering passwords for licensed applications

NOTE. You may need to reinstall the Java run--time environment before you

re--install the MTS300 software (if you are installing either the TMCC Expert or

Configuration clients, or the TMCC Deferred--Time Analyzer). The correct

version of the Java run--time environment is located on the Application CD in

the jre directory. To install the correct version of the run--time environment, run

the executable file in this directory.
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Remove the existing software using the unInstallShield application.

1. Restart Windows NT and log on as the administrator (Username = adminis-
trator; password = MPEG2). This is the default auto-logon username and
password for MTS300 Test Systems.

2. Quit any applications that automatically started at login.

3. Double-click the Uninstall MTS3... icon in the Tektronix MPEG Test
System program group window.

4. When the dialog box asks you to confirm the file deletion, click Yes.

5. When uninstall is complete, Click OK to close the Remove Programs From
Your Computer window.

6. If prompted, click OK to restart your computer.

1. If you are not already logged on, log onto your NT workstation as Adminis-
trator (this is the default user name, so unless you have changed this
parameter, you will be able to install software using the default user name
and password: Administrator and MPEG2 respectively).

2. Right-click theMy Computer icon on your Windows NT desktop, and then
select Explore from the submenu. In the Exploring window, select the icon
that represents the disk drive onto which you will install the software
(usually drive C:).

3. Check the status bar at the bottom of the Exploring window to verify that the
target disk has at least 140 MB of free space. You cannot install the software
on a disk that has less than 140 MB of free space.

Free space

Status bar

4. Place the MPEG Test System Version 6.0 Installation Software CD ROM
into the CD ROM drive.

5. Click the Windows NT Start button, and then select Run.

Uninstalling Software

Installing Software
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6. Enter d:\Setup.exe in the resulting Run window as depicted in the
following illustration (in this example, d is the drive letter for the CD ROM
drive; use the drive letter that is correct for your computer), and then click
OK.

7. In a few seconds, the Tektronix MTS300 Series window appears on the
computer screen.

8. Read the Copyright and Setup text and then click Next to proceed to the
Choose Destination Directory window.

NOTE. It is strongly recommended that you use the default destination folder.

9. The default destination folder is C:\Mts300. Click Next to accept the default
folder.

10. The Setup Type window opens.
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� If you are installing the software on a machine that has no MPEG Test
System hardware, select MTS300 Software Only.

� If you are installing software onto an MPEG Test System, select MPEG

Test System and continue with the procedure as described in the
MTS300 MPEG Test System Hardware and Software Installation

Technical Reference that accompanied the test system.

11. Click Next in the Select Program Folder window to accept the default folder
name (Tektronix MPEG Test System) and continue.

12. Review the Destination Directory, Selection, and Start Menu Folder
selections in the Selection Summary window. If the selections are incorrect,
click Back and change the information as needed. Once the information is
correct, click Next to proceed with installation.

The setup program begins installing the software and related sample files.
The activity and progress gauges appear at first to show that installation is
progressing.

Installation proceeds without your input (and sometimes with no apparent
activity) for approximately two minutes, depending on your computer
platform.

During a normal setup, two empty program group windows are displayed
after the program files have been copied to your disk drive. Shortly after
these windows appear, a message reminds you to verify that the Dongle
(software key) is installed.
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13. Ensure that the software key is installed on the parallel printer port as
described in Software Key on page 1--10, and then click OK.

14. The Setup Complete window opens; click Finish to continue.

15. A Notepad window opens to display the Readme file. Read this file for
important information, and then exit Notepad.

16. Another Setup Complete window opens. Accept the Yes, I want to restart my

computer now option, remove the MPEG Test System disc from the
CD ROM drive, and click Finish to complete setup and reboot the system.

NOTE. You need to restart your computer before you enter the license password

in the next procedure.



Appendix B: Software Repair

B- 6 MTS300 Stream Creation Applications User Manual

17. If prompted, log on as any user.

18. If not already displayed, open the Tektronix MPEG Test System program
group window by double-clicking the folder icon on the desktop.

The program group window resembles the following illustration.
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Perform the remaining steps to enter the general password that corresponds to the
attached software key. Doing so enables the applications that are included with
your MTS300 MPEG Test System product.

1. Double-click the License Manager icon in the Tektronix MPEG Test
System program group window to start the Tektronix Software Protection
application.

The Tektronix Software Protection window appears.

2. Consult the password document supplied with your software and identify the
general password.

3. Enter the three 6-character hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields (lowercase
characters are acceptable).

4. Click OK. A License message window appears.

5. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK and return to step 2.

When you enter the correct password, software installation is complete. You will
need to restart the computer before you can start any of the stream creation
applications.

Entering the General
License Password
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Glossary

NOTE. Additional information about MPEG-2 is available through the MPEG-2

Help application, part of the MPEG Test System software.

AC-3

Audio coding scheme developed by Dolby Laboratories, Inc. and adopted by
ATSC.

ARIB (Association of Radio Industries and Business)

ARIB is a body of broadcasters, manufacturers, and communication carriers
who are responsible for preparing standards on radio spectrum use in Japan.

ATSC (Advanced Television Systems Committee)

The Advanced Television Systems Committee was formed to establish
voluntary technical standards for advanced television systems, including
digital high definition television (HDTV).

BAT (Bouquet Association Table)

The BAT provides information regarding bouquets. DVB only.

BIT (Broadcaster Information Table)

ARIB only. The BIT provides broadcaster name and ID and descriptions of
the services encoded in the transport stream for each broadcaster.

Bouquet

A group of transport streams in which programs are identified by the
network ID and PID pair of values.

CAT (Conditional Access Table)

The CAT provides the association between one or more CA systems, their
EMM (Entitlement Management Message) streams, and any special
parameters associated with them. See ECM and EMM.

CVCT

VCT for cable broadcast environments.

DCT (Download Control Table)

ARIB only. This table provides a list of available downloads encoded in the
transport stream.

DIT (Discontinuity Information Table)

DVB table. This table is included only in partial streams; the DIT is never
broadcast.
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DLT (Download Table)

ARIB only. This table is used when downloading software to set top boxes.

DTS (Decode Time Stamp)

Time when the packet should be decoded.

DVB (Digital Video Broadcast)

A project group of the European Broadcasting Union (EBU).

DVB IRD (Digital Video Broadcasting Integrated Receiver Decoder)

A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

DVB-SI (Digital Video Broadcast Service Information)

The DVB-SI adds the information that enables DVB IRDs to automatically
tune to particular services and allows services to be grouped into categories
with relevant schedule information. DVB-SI information is transmitted in
several tables, including: NIT, SDT, BAT,and EIT.

ECM (Entitlement Control Message)

Conditional access information specifying control words or other stream-spe-
cific scrambling parameters.

EIT (Event Information Table)

DVB. The EIT contains data concerning events (a grouping of elementary
broadcast data streams with a defined start and end time belonging to a
common service) and programs (a concatenation of one or more events under
the control of a broadcaster, such as event name, start time, duration, etc.).

ATSC. The EIT contains information for the events defined on defined on
the virtual channels of the transport stream. An event is, in most cases, a
typical TV program, however its definition may be extended to include
particular data broadcasting sessions and other information segments.

EMM (Entitlement Management Message)

Conditional access information specifying authorization levels or services of
specific decoders.

ETM (Extended Text Message)

An ETM is a multiple string data structure. Thus, it may represent a
description of an event or channel in several different languages (each string
corresponding to one language).

ETT (Extended Text Table)

The Extended Text Table (ETT) contains Extended Text Message (ETM)
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streams, which are optional and are used to provide detailed descriptions of
virtual channels (channel ETM) and events (event ETM).

EPG (Electronic Program Guide)

The EPG gives the content of the current program.

Frame

An ISDB-S/ARIB structure comprised of 48 slots. See Slot and Super frame.

ISDB-S (Integrated Service Digital Broadcast Satellite)

Standard adopted by ARIB describing the TMCC information used in
satellite broadcast environments.

Mega-frame

A mega-frame is a valid MPEG-2 structure used in DVB terrestrial
environments in which the transport packets are organized into groups called
mega-frames. Each mega--frame consists of n packets, where n is an integer
number that depends on the number of Reed-Solomon (RS)-packets per
super-frame in the DVB-T mode being used for DVB-T emission of the
MPEG-2 transport stream. Each mega-frame includes exactly one MIP.

MGT (Master Guide Table)

The MGT lists version numbers, length in bytes, and PIDs for all of the PSIP
tables with the exception of the STT which works independently from the
other tables. ATSC only.

MIP (Mega-frame Initialization Packet)

The MIP is an MPEG--2 compliant TS packet made up of a 4--byte header
and a 184--byte data field. The MIP is used to indicate the start of the
following mega--frame and is used for synchronization of the Single
Frequency Networks (SFN) as well as for the optional control of other
important parameters in an SFN.

M_TMCC

An ISDB-S compliant multiplex with multiple transport streams. See TMCC.

NIT (Network Information Table)

The NIT conveys information relating to the physical organization of the
multiplex, transport streams carried via a given network, and the characteris-
tics of the network itself. Transport streams are identified by the combination
of an original network ID and a transport stream ID in the NIT.

NVOD (Near Video on Demand)

A group of services that carry the same event sequence at start times that are
offset from one another.
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PAT (Program Association Table)

For each program (service) in the multiplex, the PAT specifies the PID
values of the corresponding PMT. It also specifies the PID of the NIT.

PCR (Program Clock Reference)

The program reference clock or “clock on the wall” time when the video is
multiplexed.

PES (Packetized Elementary Stream)

A structure defined in the MPEG-2 standard used to carry elementary stream
data.

PID (Packet Identifier)

One of the parameters defined by the MPEG-2 standards. A unique integer
value, PIDs are used to associate elementary streams of a program in a single
or multi-program transport stream.

PMT (Program Map Table)

The PMT identifies and indicates the locations of the streams that make up
each service and the location of the Program Clock Reference (PCR) fields
for a service. This table is transmitted in sections.

Program paradigm

In ATSC environments, the program paradigm specifies the method that
shall be used for systematically allocating PID values of transport packets.

PSI (Program Specific Information)

The PSI contains all the tables that define the MPEG-2 transport stream. It
consists of the PAT, PMT, CAT, and NIT tables. (NIT is also used for
DVB-SI.)

PSIP (Program and System Information Protocol)

SI and program guide tables contained within packets carried in the
Transport Stream multiplex for digital multiplex bit streams constructed in
accordance with ISO/IEC 13818--1 (MPEG--2 Systems).

PTS (Presentation Time Stamp)
When the packet should arrive and its destination.

RRT (Rating Region Table)

The RRT carries rating information for multiple geographical regions. ATSC
only.

SDT (Service Description Table)

The SDT contains data describing the services in the system. Examples
include: names of services, the service provider, etc.

SDTT (Software Download Trigger Table)

ARIB only. This structure is used to define the service, group, and schedule
for downloadable items encoded in the transport stream.
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SFN (Single Frequency Network)

SFN is an extension of the DVB system in which all transmitted signals are
identical; therefore, the MPEG--2 TS inputs to the various DVB--T
modulators have to be bit identical.

SI (Service Information)

SI provides information on services and events carried by different multi-
plexes, and even other networks. SI is structured as several tables (BAT, EIT,
NIT, RST, SDT, and TSDT).

SIT (Selection Information Table)

DVB--SI table. This table is used only with partial streams; the SIT is never
broadcast.

Slot

An ISDB-S/ARIB structure corresponding to one, 204-byte error coded
packet. See Frame and Super frame.

S_TMCC

An ISDB-S/ARIB compliant multiplex with only one transport stream. See
TMCC.

STT (System Time Table)

The STT provides the current date and time of day information. ATSC only.

Super frame

An ISDB-S/ARIB structure comprised of eight frames. See Frame and Slot.

TMCC (Transmission and Multiplexing Configuration and Control)

Information encoded in the first eight bytes of the 16-byte Reed-Solomon
area of 204-byte packet transport streams. TMCC information includes
modulation modes, slot assignments, and alarms.

TVCT

VCT for terrestrial broadcast environments.

VCT (Virtual Channel Table)

The VCT contains a list of attributes for virtual channels carried in the
transport stream. ATSC only.
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Index

A
AC-3, definition, Glossary--1
AC-3 audio descriptor, 3--185
Actual rate, multiplexer, 3--8
Add

button, 3--35
multiplexer

ARIB icon to hierarchy, 3--25
button, 3--6
EIT instances, 3--71
elementary stream files to the configuration file,

2--10
elementary streams, 3--46
ETT instances, 3--76
items to the hierarchic view, 3--34
MIP icon to hierarchy, 3--23
multiple EIT instances, 3--73
programs, 3--44
PSIP icon to hierarchy, 3--26
PSIP tables, 3--62
SI icon, 3--22
SI tables, 3--52
TDT, 3--54
TSDT, 3--35
use of with multiplexer icons, 3--35
using the Add button, 3--35
video splice, 3--52

real-time multiplexer
a program to a transport stream input, 3--279
elementary stream program input, 3--285
output, 3--289
PSI-SI-PSIP tables, 3--271
SI and PSIP tables to the output, 3--274
transport stream files, 3--275

table editors, 2--31
descriptors, 3--122
stream, service, or event, 3--120
table items, 3--117

Address, Tektronix, xvii
Advanced Television Systems Committee. See ATSC
Algorithms for scrambling streams, CCEIT and DVB,

3--90

Analysis
coherence, 3--126
consistency, 3--126
interpreting error messages, 3--130
tables, 3--126
types of, 3--130
using the message window, 3--128

Analysis menu, table editors, 3--101
Application, locked, A--1
Application window

multiplexer, 2--8, 3--5
real-time multiplexer, 3--246
table editors, 3--95

Apply Following Configuration at OpenMux Starting,
real-time multiplexer, 3--262

ARIB
changing environment options, 3--25
definition, Glossary--1
edit period parameters, 3--40
multiplexer, adding the environment, 3--25
remove multiplexer environment option, 3--25

ASCII, text in table editors, 3--121
Associating ETT to events, PSIP table editor, 3--136,

3--138
Associating VCT, EIT, and ETT, 3--136
ATSC

changing environment options, 3--26
definition, Glossary--1
program paradigm, multiplexer, 2--25
real-time multiplexer, 3--269

ATSC DVB multiplexer, description, 1--1
ATSC Table Editor, description, 1--2
Audio, file types, 3--50

displayed in the Audio Stream dialog box, 3--49
Audio elementary stream

adding to a multiplexer configuration file, 2--15
adding to the multiplex, 3--49
initial delay parameter, 3--50
multiplexer, icon, 3--14

Audio Stream Analyzer, description, 1--8
audio stream descriptor, 3--163
Audio Stream dialog box, 2--15
Automatically Save the OpenMux Configuration,

real-time multiplexer, 3--262
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B
B Sync Byte

add only module, 3--202
removal, 3--207

Bandwidth, MIP parameter, 3--58
BAT

bouquet association table, 3--21
definition, Glossary--1
multiplexer, icon, 3--12
table editors, parameters, 3--145
transport streams in, 3--154

BIT, definition, Glossary--1
Bit Stream CD ROM, 1--2
blue dot, on toolbar buttons, table editors, 3--102
bouquet name descriptor, 3--169
Buttons

Jitter Adder, 3--198
real-time multiplexer commands, 3--250
table editors, 3--102
TMCC Combiner, 3--218

Bytes, Number of bytes in the pattern, 3--208

C
CA (conditional access) identifier descriptor, 3--170
Cable ATSC, multiplexer environment option, 3--25,

3--26
cable delivery system descriptor, 3--171
Calculate packet jitter, 3--196

command button, 3--198
caption service descriptor, 3--186
CAT

definition, Glossary--1
multiplexer

adding, 3--90
icon, 3--11
period, 3--38

real-time multiplexer, 3--267
table editors, parameters, 3--145

CCEITT, scrambling algorithm, 3--90
Chain command

coding and decoding, 3--202
decoding menu, 3--207

Changing
ARIB environment options, 3--25
ATSC environment options, 3--26
DVB environment options, 3--21
DVB-T Mega-frame environment options, 3--23
Dynamic SI environment options, 3--27
multiplexer

ARIB parameters, 3--40
PAT parameters, 3--41
PSI parameters, 3--38
PSIP parameters, 3--40
PSIP periods, 3--64
SI parameters, 3--39

multiplexer environment options, 3--21
passwords, 1--15
PSI period in multiplexer, 2--28
real-time multiplexer

multiplex rate, 3--289
output environment, 3--274
PSI-SI-PSIP tables, 3--273

Choosing
audio elementary streams in multiplexer, 3--49
data stream in multiplexer, 3--51
video streams in multiplexer, 3--47

Clock jitter, 3--191
Close All, PSIP table files, 3--110
Close table files, 3--110
Code rate, MIP parameter, 3--59
Coded block size, Reed-Solomon, 3--204
Coding

convolutional interleaving, 3--212
DVB, 3--199
energy dispersal, 3--211
menu, 3--202
Reed-Solomon, 3--212
Satellite broadcasting, 1--3
Viterbi, 3--213

Coding Flow, 3--199
Coding types, 3--211
Coherence/Consistency analyses, table editors, 3--126
Collapse/Expand hierarchy

global view, 3--135
multiplexer, 3--15
table editors, 3--96
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Colors, multiplex rate gauge, 3--9
Command buttons, table editor, 3--102
component descriptor, 3--171
component name descriptor, 3--186
Composition Motif, pattern, 3--209
Conditional access, 3--89

adding in the table editors, 3--120
in the Options menu (multiplexer), 3--8
multiplexer, 3--8
selecting an algorithm, 3--90

conditional access (CA) identifier descriptor, 3--170
conditional access descriptor, 3--163
Configuration

multiplexer. See Environment
real-time multiplexer, saving, 3--260
Reed-Solomon coding, 3--204

Configuration file
creating a new file, 3--33
error injector, 3--229

creating, 3--227
example, 3--85
multiplexer, 3--3, 3--32

illustration, 3--4
number of programs, 2--22

opening an existing file, 3--33
Configurations management, real-time multiplexer,

3--262
Connecting to a real-time multiplexer server, 3--238
Connecting to a remote multiplexer server, 3--238
Constellation, MIP parameter, 3--58
Contacting Tektronix, xvii
content advisory descriptor, 3--187
content descriptor, 3--172
Controlling a transport stream file input, real-time

multiplexer, 3--277
Convolutional Interleaving Coding, 3--212
Copying table items, table editors, 3--124
copyright descriptor, 3--164
Correcting errors, table editors, 3--129
country availability descriptor, 3--173
Create

an MGT automatically, 3--112
EIT time span, 3--115
multiplexer, a transport stream file, 3--84
table editors, a new table, 3--108

Creating a new configuration file, multiplexer, 3--33
Creating and editing a configuration file, 3--32

creating TMCC transport streams
TMCC basic streams (S_TMCC), 3--218
TMCC data streams (M_TMCC), 3--223

Cursor
position, 3--18
timing, 3--18

Cutting table items, table editors, 3--124
CVCT

definition, Glossary--1
real-time multiplexer, 3--270
table editors, parameters, 3--160

D
Data elementary stream

adding to the multiplex, 3--51
multiplexer, icon, 3--14

Data format, data elementary stream, 3--51
data stream alignment descriptor, 3--164
DCT, definition, Glossary--1
decimal/hexadecimal views, OpenMux, 3--249
Decoder testing, 3--191
Decoding

DVB, 3--199
menu, 3--206

Definition command button, Packet Jitter, 3--198
DeInterleaver command, 3--207
Delete

button, 3--35
MIP, 3--61
MIP icon, 3--24
multiplexer, 2--18

button, 3--6
EIT instances, 3--73
hierarchy items, 3--36

real-time multiplexer
output, 3--289
transport stream and program inputs, 3--278

table editors
removing table items, 3--124
table sections, 3--114

time spans, 3--115
demonstration license, OpenMux, 3--234
Descriptors

adding, 2--32
selection, 2--32
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descriptors
AC-3 audio, 3--185
audio stream, 3--163
bouquet name, 3--169
CA (conditional access) identifier, 3--170
cable delivery system, 3--171
caption service, 3--186
component, 3--171
component name, 3--186
conditional access, 3--163
content, 3--172
content advisory, 3--187
copyright, 3--164
country availability, 3--173
data stream alignment, 3--164
editing, 3--123
extended channel name, 3--187
extended event, 3--173
frequency list, 3--174
hierarchy, 3--164
IBP, 3--165
ISO 639 language, 3--165
linkage, 3--174
local time offset, 3--175
maximum bitrate, 3--165
mosaic, 3--176
multilingual bouquet name, 3--176
multilingual component name, 3--176
multilingual service name, 3--176
multiplex buffer utilization, 3--166
network name, 3--177
NVOD (near video on demand) reference, 3--177
parental rating, 3--178
private data (indicator), 3--166
private data specifier, 3--178
program identifier, 3--187
registration, 3--166
satellite delivery system, 3--179
service, 3--179
Service ID, table file associations, 3--141
service list, 3--180
service location, 3--189
service move, 3--180
short event, 3--181
short smoothing buffer, 3--181
smoothing buffer, 3--166
STD (system target decoder), 3--167
stream identifier, 3--181
stuffing, 3--181
system clock, 3--167
target background grid, 3--167
telephone, 3--182

teletext, 3--182
terrestrial delivery system, 3--183
time shifted event, 3--183
time shifted service, 3--184
time shifted service location, 3--190
user, 3--184
video stream, 3--168
video window, 3--169

Digital Video Broadcast. See DVB
Directories, multiplexer defaults, 3--28
disabling the OpenMux license message, 3--235
Display the OpenMux Spy view, real-time multiplexer,

3--252
DIT, definition, Glossary--1
DLT, definition, Glossary--2
Dolby Digital (AC-3) Audio Stream Analyzer,

description, 1--8
Dongle. See Software key
Drop down selection box

table editor edit view, 3--98
table editors, 3--121

DTS, definition, Glossary--2
Duration gauge

coding and decoding, 3--200
multiplexer, 2--8, 3--8

DVB
changing environment options, 3--21
definition, Glossary--2
multiplexer environment option, 2--40
multiplexer file selection dialog box, 2--41
real-time multiplexer, 3--267
scrambling algorithm, 3--90

DVB ATSC multiplexer, description, 1--1
DVB Channel Coder Decoder, description, 1--3
DVB Coding and Decoding, 3--199–3--214

coding menu, 3--202
convolution interleaving, 3--212
decoding, 3--206
Help menu, 3--210
Reed-Solomon, 3--212

DVB compliant files, 3--207
creating, 3--202

DVB File Selection dialog box, 3--55
DVB IRD, definition, Glossary--2
DVB Table Editor

description, 1--2
using, 3--93

DVB-SI, definition, Glossary--2
DVB-T Mega-frame, 3--56

changing environment options, 3--23
Dynamic SI, changing environment options, 3--27
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Dynamic view
multiplexer button, 3--7
multiplexer window, 3--16
switching to, 2--25
using (multiplexer), 3--16

Dynamic view command button, multiplexer, 3--7

E
ECM

definition, Glossary--2
multiplexer

adding, 3--91
icon, 3--14

selecting an ECM file, 3--92
Edit menu

multiplexer, 3--6
table editors, 3--99

Edit view window, text and drop-down boxes, 3--121,
3--123, 3--143

Edit window
features, 3--98
table editors, 3--97

Editing
error injector, configuration file, 3--228
MIP parameters, 3--56
multiplex parameters, 3--37
multiplexer

ARIB periods, 3--40
DVB SI parameters, 3--39
ETT, 3--67
hierarchy items, 3--34
MIP parameters, 3--57
NIT parameters, 3--42
PAT table parameters, 3--41
PMT parameters, 3--42
program parameters, 3--45
PSI table parameters, 3--38
PSIP parameters, 3--66
PSIP periods, 3--40
PSIP tables, 3--62
table parameters, 3--52
TDT values, 3--54

real-time multiplexer, PSI-SI-PSIP tables, 3--273
table editors

parameters, 3--123
table parameters, 3--121

table item parameters, 3--143

EIT
association with NIT and SDT, 3--139
definition, Glossary--2
DVB table parameters, 3--146
event information table, 3--63
event information table for DVB, 3--21
file naming restrictions for PSIP EIT, 3--111
multiplexer

adding and editing, 3--66
associating files to icons, 3--68
icon, 3--12

multiplexer dialog box, 3--67
PSIP table parameters, 3--156
table editors

associating channels and events, 3--136
creating, deleting, and moving among, 3--115
parameters for DVB events, 3--147

Elementary stream
audio elementary stream initial delay, 3--50
files, 2--3

FTP site, 2--5
in PMT, 3--153
maximum in multiplexer transport stream, 1--1
multiplexer

adding, 2--10
adding to a program, 3--46
initial delay, 3--19

undefined, 3--84
video elementary stream initial delay, 3--48

Elementary stream rate
audio elementary stream, 3--50
video elementary stream, 3--48

EMM
definition, Glossary--2
multiplexer

adding to a CAT, 3--90
icon, 3--11

enabling the OpenMux demonstration period, 3--234
End, locked application, A--1
End task, A--1
Ending, locked application, A--1
Energy Dispersal

coding, 1--3, 3--202, 3--211
coding command, 3--203
removal command, 3--208
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Environment
ARIB, 3--25
ATSC, 3--26
changing, 2--40
DVB, 3--21
DVB-T Mega-frame, 3--23
Dynamic SI, 3--27
multiplexer, 3--20

scrambling, 3--90
multiplexer defaults, 3--31
real-time multiplexer, changing output environment,

3--274
saving and restoring options, 3--29

EPG, definition, Glossary--3
Error

correcting in the table editor, 3--129
creating using the error injector, 3--225
failure in socket connectio, OpenMux, 3--234
real-time multiplexer

messages about PID types, 3--289
messages about the audio component, 3--287
messages about the video component, 3--286

table editors
error IDs, 3--131
message headers, 3--131
message types, 3--130
message window, 3--127
printing, 3--129
types of analyses, 3--130
using online help to interpret, 3--131
using the message window, 3--128

Error Injector, 3--225–3--232
description, 1--3
operators, 3--226
tutorial, 3--227

estimated stop time, multiplexer dynamic view, 3--17
ETM, definition, Glossary--2
ETM ID, use to associate events and messages, 3--138
ETT

associating messages to events, 3--136
definition, Glossary--2
extended text message, 3--63
file naming constraints, 3--111
multiplexer

adding, 3--76
icon, 3--13

table editors
associating messages and events, 3--138
create, delete, and moving among, 3--115
parameters, 3--157

Event, adding in the table editors, 3--120
Event ID

associating VCTs and EITs, 3--136
managing event in a transport stream, 3--139

Event parameters, EIT, 3--147
Events, associating messages with, 3--138
Exit, applications, 1--16
Expand/Collapse hierarchy

global view, 3--135
multiplexer, 3--15
table editors, 3--96

Expert client, overview, 1--5
extended channel name descriptor, 3--187
extended event descriptor, 3--173

F
Faliure in socket connection, OpenMux, 3--234
Field encoding changes, 3--46
File menu

coding and decoding, 3--201
multiplexer, 3--6
Packet Jitter, 3--192
real-time multiplexer, 3--247
table editors, 3--98

File names, PSIP EIT files constraints, 3--111
Filtered PID dialog box, 3--281
Filtering PIDs, real-time multiplexer, 3--281
Find, Edit menu selection (DVB table editor), 3--125
First time operation, ix, 1--14
frame, definition, Glossary--3
Frame encoding changes, 3--46
frame size, TMCC basic streams, 3--222
frequency list descriptor, 3--174
Frequency offset, MIP functions, 3--60
FTP site, elementary stream files, 2--5
Functions of toolbar buttons, table editors, 3--102

G
G.703, multiplex rate, 3--37
General license password, 1--13, B--7
Generate button (Go), multiplexer, 3--7
Generating a multiplex, 3--84
Generation menu, coding and decoding, 3--208
Global multiplex start time, 3--19

multiplexer dynamic view, 3--17
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Global view, 3--132
collapsing and expanding tables, 3--135
opening, 3--133
opening without saving existing files, 3--133
selecting files to display, 3--134
using in the DVB table editor, 3--139
using in the PSIP table editor, 3--136

Go button, multiplexer, 3--7
Green, multiplex rate gauge, 3--9
Guard interval, MIP parameter, 3--59

H
Hardware installation, ix
HASP, 2--1
Help menu

DVB Channel Coding and Decoding, 3--210
multiplexer, 3--8
Packet Jitter, 3--198
real-time multiplexer, 3--250
table editors, 3--101

Hexadecimal, text in table editors, 3--121
Hiding multiplexer icons, 3--15
Hiding table elements, Global view, 3--135
Hierarchic view

multiplexer, 2--9, 3--10
adding a MIP icon, 3--57
adding and editing items, 3--34
button, 3--7
icons, 3--11

real-time multiplexer, 3--256
collapse/expand hierarchy, 3--256

table editors, description, 3--96
Hierarchy

collapsing/expanding, multiplexer, 3--15
MIP parameter, 3--58

hierarchy descriptor, 3--164

I
IBP descriptor, 3--165
Icons

multiplexer, 3--11
real-time multiplexer, 3--252
sizes, OpenMux, 3--249
table editors, hierarchic and global views, 3--104

Information view, real-time multiplexer, 3--283
Initial delay, data elementary stream, 3--51
Inner Coder, 1--3
Input File dialog box, real-time multiplexer, 3--275
Input menu, real-time multiplexer, 3--247

Inputs
error injector, 3--225
multiplexer, 3--4
real-time multiplexer, 3--233, 3--263

adding elementary stream program, 3--285
controlling transport and elementary streams,

3--277
deleting elementary stream program components,

3--279
deleting transport and elementary streams, 3--278
elementary stream program, 3--284
elementary stream program limitations, 3--284
filtering, 3--281
icon description, 3--254
managing inputs, 3--263
monitoring, 3--283
PSI-SI-PSIP, 3--264
status, 3--254
transport stream file, 3--275

Insert section, table editor, 3--114
Installation, 1--9

hardware, ix
Installing Option CA, 3--89
Inter-analyses, 3--126, 3--130
Interleaver

coding, 1--3
command, 3--205
file type required, 3--205

Intra-analyses, 3--126, 3--130
ISDB--S, definition, Glossary--3
ISO 639 language descriptor, 3--165
ISO/IEC 1318-1, included as a help file on disc, 3--125

J
Jitter

define, 3--193
offset, 3--194
sine, 3--195
square, 3--194
type, 3--194

Jitter Adder, description, 1--3
Jitter Adder menu, 3--193

K
Key, software, 1--12
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L
License manager, entering your password, 1--13, B--7
Limitations

error injector, 3--227
multiplexer, 1--1
real-time multiplexer, 3--234

elementary stream program inputs, 3--284
linkage descriptor, 3--174
Loading environment options, 3--29
local time offset descriptor, 3--175
Locked application, A--1
Logging on, 1--15

M
M_TMCC, definition, Glossary--3
M_TMCC streams

data fields, 3--217
defined, 3--215

Managing streams, services, and events, PSIP table
editor, 3--136

Manual Reset, A--1
Master client, overview, 1--4
maximum bitrate descriptor, 3--165
Maximum delay, MIP parameter, 3--58
Maximum number of table sections, table editors,

3--100
Mega-frame, definition, Glossary--3
Mega-frame initialization packet (MIP)

adding and editing parameters, 3--56
definition, Glossary--3

Menus
coder/decoder, 3--201
jitter adder, 3--192
multiplexer, 3--6
real-time multiplexer, 3--247
table editors, 3--98

Messages, channel and event ETT, 3--138
MGT

definition, Glossary--3
master guide table, 3--63
multiplexer, icon, 3--13
real-time multiplexer, 3--270
table editors, parameters, 3--157
wizard, 3--112

Minimum requirements, 1--9

MIP
adding functions to, 3--59
functions dialog box, 3--59
functions explained, 3--60
multiplexer, icon, 3--13
parameters explained, 3--58
removing from configuration file, 3--61

MIP parameters, dialog box, 3--57
Mode, MIP parameter, 3--58
Modify, real-time multiplexer, PSI-SI-PSIP tables,

3--273
Monitoring an input, real-time multiplexer, 3--283
mosaic descriptor, 3--176
Moving

among tables, 3--111
the timing cursor, 3--18

MPEG2 DVB/ATSC Multiplexer, description, 1--1
MPEG-2 DVB/ATSC System Analyzer, description,

1--8
MTS200 Series applications, descriptions, 1--4
multilingual bouquet name descriptor, 3--176
multilingual component name descriptor, 3--176
multilingual service name descriptor, 3--176
Multiple string structure, 3--162
Multiplex

cannot generate, 3--84
global start time, 3--37
icon, 2--9, 3--11
overflow, 2--14
overflow message, 3--57
press ESC to stop generation, 3--84
rate, 3--48
rate gauge, 2--14
rate gauge colors, 3--9
rate overflow, 3--9
real-time multiplexer, tutorial, 3--240
real-time multiplexer inputs, 3--263

Multiplex allocation views, real-time multiplexer,
3--258

multiplex buffer utilization descriptor, 3--166
Multiplex menu, 3--84

multiplexer, 3--7
real-time multiplexer, 3--248

Multiplex window
Dynamic view, 3--9
Hierarchic view, 3--9

Multiplexer
default environment settings, 3--31
Hierarchic view, 2--9
icon description and use, 3--11
real-time multiplexer application window, 3--246
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Multiplexer server
connecting to remotely, 3--238
quitting, 3--239
saving configuration of, 3--260
starting, 3--236

N
network name descriptor, 3--177
New button, multiplexer, 3--6
New table sections, creating, 3--114
Next

button in the dynamic view, 3--18
table editors, section, 3--114

NIT
association with EIT and SDT, 3--139
definition, Glossary--3
editing in the multiplexer, 3--42
multiplexer, icon, 2--9, 2--40, 3--12
network information table, 3--21
parameters extracted by the MIP, 3--58
real-time multiplexer, 3--268
table editors, parameters, 3--149
transport streams in, 3--154

NIT and SDT association, 2--58
NT log on, user name and password, 1--15
Number of sections

in table files, 3--113
table editors, 3--115

NVOD, definition, Glossary--3
NVOD (near video on demand) reference descriptor,

3--177

O
Offset jitter, 3--194
Offset PTS

audio elementary stream, 3--50
video elementary stream, 3--48

Online help, using to interpret PSIP Table editor error
messages, 3--131

Open a Table, PSIP table editor dialog box, 3--134
Open button, multiplexer, 3--6
Open command, File menu, Packet Jitter, 3--192
Open command button, Packet Jitter, 3--198
opening an existing configuration file, multiplexer,

3--33
Opening existing tables, 3--109
OpenMux demonstration period, enabling and

disabling, 3--234

OpenMux Spy view, real-time multiplexer, 3--252
Operators, error injector, 3--226
Option CA (Conditional Access), installing, 3--89
Option menu, PSIP table editor, 3--101
Options menu

multiplexer, 3--7
real-time multiplexer, 3--249

Output
error injector, 3--225
multiplexer, 3--4
real-time multiplexer, 3--234, 3--289

add, 3--289
change the multiplex rate, 3--289
changing environment, 3--274
remove, 3--289
stopping, 3--289

Output menu, real-time multiplexer, 3--248
Overflow, multiplex rate, 3--9
Overview

Expert client, 1--5
Master client, 1--4
TMCC Configuration client, 1--7
TMCC Expert client, 1--5

P
Packet Jitter, Help menu, 3--198
Packet Jitter application, 3--191
packet size, for the TMCC Combiner, 3--215
Parameters

editing, 3--123
MIP, 3--58
table editors, 3--143

editing, 3--121
parental rating descriptor, 3--178
Password, B--7

and user name, NT log on, 1--15
changing, 1--15

emergency repair disk, 1--15
for installing Option CA (conditional access), 3--89
for installing software, 1--13

Pasting table items, table editors, 3--124
PAT

definition, Glossary--4
dialog box, 2--29
editing, 2--29
multiplexer

icon, 2--9, 3--11
parameters, 3--41
period. See PSI period

real-time multiplexer, 3--266
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Pattern
composition motif, 3--209
generation command, 3--208
repetition, 3--209

PCR, 3--191
definition, Glossary--4
encoded automatically by multiplexer, 3--45

PCR Clock Selection, packet jitter, 3--193
PCR period, change with the multiplexer, 3--45
Performing analyses, table editors, 3--126
Periodic, MIP parameter, 3--58
PES, definition, Glossary--4
PES Packet Size

audio elementary stream, 3--50
video elementary stream, 3--48

Phone number, Tektronix, xvii
PID, 3--193

definition, Glossary--4
PID allocation view, real-time multiplexer, 3--259
PID modification, using the multiplexer, 2--29
PLL, decoder design, 3--191
PMT

definition, Glossary--4
descriptors, 2--31
displaying sections in multiplexer, 2--31
editing, 2--30
editing with the multiplexer, 3--42
elementary stream parameters in, 3--153
multiplexer

icon, 2--9, 3--11
period. See PSI period

real-time multiplexer, 3--266
sections added automatically (multiplexer), 3--44
table editors, parameters, 3--148

Popup menus, real-time multiplexer hierarchic view,
3--257

Power, MIP functions, 3--60
Power switch, 1--14
PRBS, 3--203, 3--211
Previous

button in the dynamic view, 3--18
table editors, section, 3--115

Printing error messages, 3--129
Priority, MIP parameter, 3--58
Private data, MIP functions, 3--60
private data (indicator) descriptor, 3--166
private data specifier descriptor, 3--178
Product support, contact information, xvii

Program
adding, 2--21
changing the starting time, 2--25
elementary streams in a program, 2--22
empty, 3--84
multiplexer

adding, 3--44
dynamic view icon, 3--17
editing start delay, 3--45
icon, 2--9, 3--14
start delay, 3--19
timing relationships shown in the dynamic view,

3--17
number in configuration file, 2--22
start delay, 2--25

Program allocation view, real-time multiplexer, 3--258
Program and System Information Protocol. See PSIP
program identifier descriptor, 3--187
Program number vs program_number, multiplexer

dynamic view, 2--25
Program paradigm, 3--266, 3--274

definition, Glossary--4
Program Specific Information. See PSI
Program Stream Analyzer, description, 1--8
Protection, software key, 1--10
PSI

definition, Glossary--4
descriptors, 3--163
editing, 2--27
multiplexer, icon, 2--9, 3--11
period dialog box, 2--28
real-time multiplexer, 3--266
table editors, tables, 3--94
table parameters, 3--144

PSIP
definition, Glossary--4
descriptors, 3--185
edit period parameters, 3--40
managing events with source IDs, 3--136
multiplexer

adding more icons to the hierarchy, 3--64
adding the environment, 3--26

multiplexer icon, 3--13
table editors, tables, 3--94
table parameters, 3--155

PSIP events, associating extended text message with,
3--138

PSIP Table Editor
description, 1--2
using, 3--93

PTS, definition, Glossary--4
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Q
QPSK Modulating, coding, 1--3
Quit command, File menu, Packet Jitter, 3--193
Quitting applications, 1--16

R
Random jitter, 3--196
Rate

data elementary stream, 3--51
multiplex calculation, 3--8
multiplexer

gauge, 2--14
how calculated, 2--8

specifying in multiplexer, 3--37
Rate gauge, multiplexer, 2--8, 3--8
Real-Time Analyzer, description, 1--4
Real-time multiplexer

connecting to a server, 3--238
description, 1--3
elementary stream program input, 3--284
elementary stream program input limitations, 3--284
input icon status, 3--254
inputs, 3--233
installing, 3--234
limitations, 3--234
output, 3--234
PSI-SI-PSIP, 3--264
server, 3--233
transport stream file, 3--275
tutorial, 3--240
windows, views, and interface, 3--246

Red, multiplex rate gauge, 3--9
Reed-Solomon

coded block size, 3--204
coding, 3--212
coding command, 3--204
coding configuration, 3--204
decoding command, 3--208
size of block, 3--204

registration descriptor, 3--166
Remove

a program from a transport stream file input, 3--279
audio stream from a program input, 3--279
DVB-T multiplex environment, 3--24

Removing, copying, and pasting table items, table
editors, 3--124

Repair, software, B--1
Requirements, software and hardware, 1--9
Reset, A--1
Restoring environment options, 3--29

RRT
definition, Glossary--4
multiplexer, icon, 3--13
rating region table, 3--63
table editors, parameters, 3--159

RS(204, 188), 3--212
coding, 1--3

RST
multiplexer, icon, 3--12
running status table, 3--22
table editors, parameters, 3--150

S
S_TMCC, definition, Glossary--5
S_TMCC streams

defined, 3--215
TMCC basic field descriptions, 3--216

Sarnoff, video test sequences CD-ROM, 1--9
Satellite broadcasting, 3--199

coding, 1--3
satellite delivery system descriptor, 3--179
Save

environment options, 3--29
error injector, transport stream file, 3--230
error injector configuration files, 3--229
real-time multiplexer, configurations, 3--260
table editors, 3--109

Save All, table editors, 3--110
Save As, table editors, 3--109
Save button, multiplexer, 3--6
Scrambling, 3--89

in the Options menu (multiplexer), 3--8
option in audio stream selection, 3--50
option in video stream selection, 3--48
scrambling a stream, 3--92
selecting an algorithm, 3--90

SDT
association with EIT and NIT, 3--139
definition, Glossary--4
multiplexer, icon, 3--12
real-time multiplexer, 3--268
service description table, 3--21
table editors, parameters, 3--150

SDT and NIT association, 2--58
SDTT, definition, Glossary--4
Searching for table items (Find), DVB table editor,

3--125
Section menu, table editors, 3--100
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Sections
creating, inserting, and deleting, 3--114
describe/correspond to, 3--112
moving among, 3--114
number of in tables, 3--112

Security, Windows NT dialog box, A--1
Selecting, multiplexer

a NIT, 3--43
PSIP files, 3--64

Selection boxes, table editors, 3--98
Sequence Header, Video Stream dialog box, 3--48
Sequence header, option in video stream selection,

3--48
Service

adding in the table editors, 3--120
ID, managing events in a transport stream, 3--139
SDT, table file associations, 3--141

service descriptor, 3--179
Service Information. See SI
service list descriptor, 3--180
service location descriptor, 3--189

real-time multiplexer, 3--270
service move descriptor, 3--180
service name descriptor, real-time multiplexer, 3--268
Service support, contact information, xvii
Setting

DVB multiplexer environment, 3--22
elementary stream initial delay, 3--19, 3--50
global multiplex start time, 3--19
program start delay, 3--19, 3--45
video stream initial delay, 3--48

Setup, hardware, ix
SFN, single frequency networks, 3--56
SFN (Single Frequency Network), definition,

Glossary--5
short event descriptor, 3--181
short smoothing buffer descriptor, 3--181
Showing table elements, Global view, 3--135
Shutdown, computer, 1--16, A--1
SI

adding and editing in the multiplexer, 3--52
definition, Glossary--5
descriptors, 3--169
multiplexer, editing table period, 3--39
multiplexer icon, 2--40, 3--12
table editors, tables, 3--94
table parameters, 3--144

SI tables present, warning (multiplexer), 3--22
Sine jitter, 3--195
SIT, definition, Glossary--5
Size of block, Reed-Solomon coding, 3--204
Slider bar, multiplexer dynamic view, 3--18
slot, definition, Glossary--5

smoothing buffer descriptor, 3--166
Software

installation, 1--9
key, 1--12
reinstall, B--1
repair, B--1

Software description
ATSC (PSIP) Table Editor, 1--2
Dolby Digital Audio Stream Analyzer, 1--8
DVB Channel Coder and Decoder, 1--3
DVB Table Editor, 1--2
Error Injector, 1--3
Jitter Adder, 1--3
MPEG Audio Stream Analyzer, 1--8
MPEG Video Stream Analyzer, 1--8
MPEG2 DVB/ATSC System Analyzer, 1--8
MPEG-2 DVB/ATSC Transport Stream Multiplexer,

1--1
MTS200 Series Applications, 1--4
Program Stream Analyzer, 1--8
PSIP (ATSC) Table Editor, 1--2
Real-Time Analyzer, 1--4
Real-Time Multiplexer, 1--3
stream player, 1--7
stream recorder client, 1--7

Software key, 1--10, B--5
Software version, xii
Specifications, ix
Splice, adding to the configuration file, 3--52
Square jitter, 3--194
Standards conformed to (table editors)

ATSC Doc A/65, 3--94
Draft ETS 300 468, 3--94

Starting
applications, 1--15
multiplexer server, 3--236
software installation, B--3

starting the TMCC Combiner, 3--219
Status bar

multiplexer, 3--9
real-time multiplexer, 3--251

STD (system target decoder) descriptor, 3--167
Stop, real-time multiplexer, output, 3--289
Stream, adding in the table editors, 3--120
stream identifier descriptor, 3--181
Stream Player, description, 1--7
Stream Recorder, description, 1--7
STT

definition, Glossary--5
multiplexer, icon, 3--13
real-time multiplexer, 3--271
system time table, 3--63
table editors, parameters, 3--159
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stuffing descriptor, 3--181
super frame, 3--222

definition, Glossary--5
Suppress service, real-time multiplexer, 3--279
Sync byte, 3--203
system clock descriptor, 3--167
system target decoder (SDT) descriptor, 3--167

T
Table, real-time multiplexer, PSI-SI-PSIP, 3--265
Table analyses, performing in the table editor, 3--126
Table editor, command buttons, 3--102
Table editors, starting from the multiplexer, 2--31, 3--95
Table file associations

DVB table editor, 3--139
PSIP table editor, 3--136

Table Items, 3--116
adding, 3--117
adding a stream, service, or event, 3--120
adding descriptors, 3--122
collapsing and expanding in the Global view, 3--135
editing, 3--121
items you can add to tables, 3--118
removing, copying, and pasting, 3--124
searching for (Find, DVB only), 3--125

Table parameter values, values extracted from the
multiplexer, 3--98

Table sections
creating, inserting, and deleting, 3--114
describe/correspond to, 3--112
in the hierarchic view, 3--97
moving among, 3--114

target background grid descriptor, 3--167
Task Manager, A--1
TDT

multiplexer
adding, 3--54
creating, 2--54
icon, 3--12
setting parameters, 2--42
setting the period, 2--54

real-time multiplexer, 3--269
time and date table, 3--22

Technical support, contact information, xvii
Tektronix, contacting, xvii
telephone descriptor, 3--182
teletext descriptor, 3--182
Terrestrial ATSC, multiplexer environment option,

3--26
terrestrial delivery system descriptor, 3--183

Text boxes
table editor edit view, 3--98
table editors, 3--121

Time and Date Table, multiplexer dialog box, 3--54
Time offset, MIP functions, 3--60
time shifted event descriptor, 3--183
time shifted service descriptor, 3--184
time shifted service location descriptor, 3--190
Time spans

creating, deleting, and moving among, 3--115
ETT and EIT must be the same, 3--138
PSIP table editor menu, 3--100
shown in the global view, 3--137

Timing
cursor handle, 2--26
diagram showing relationships, 3--20
multiplex global start time, 3--37
multiplexer, cursor, 3--17
relationships shown in the dynamic view, 3--9, 3--16
viewing and setting offsets, 3--19

TMCC, definition, Glossary--5
TMCC Combiner

buttons, 3--218
configuring transitions, 3--222
creating a TMCC basic stream, 3--218
defining properties for an S_TMCC stream, 3--221
input for a TMCC basic stream, 3--215, 3--220
input for a TMCC data stream, 3--215
limitations, 3--215
minimum requirements, 3--215
properties window described, 3--222
S_TMCC fields, 3--216
starting, 3--219

TMCC Configuration client, overview, 1--7
TMCC Expert client, overview, 1--5
Toggle management, real-time multiplexer, 3--264
Toolbar

multiplexer, 3--6
Packet Jitter, 3--198
real-time multiplexer, 3--250
table editors, 3--102

TOT
multiplexer, icon, 3--12
table editors, parameters, 3--151
time offset table, 3--22

transitions, 3--222
Transmission errors, 1--3, 3--191
transmission mode, TMCC Combiner, 3--222
Transmitter functions, in the MIP, 3--60
Transport Packet command, 3--209
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Transport stream
adding in the table editors, 3--120
creating errors, 1--3
generating with multiplexer, 3--84
generating with the real-time multiplexer, 3--233
jitter adder, 3--191
multiplexer

generating, 2--38
item icons in hierarchic view, 3--10

naming, 3--84
table editors, parameters in NIT and BAT, 3--154

Transport stream file, 2--19
creating using the multiplexer, 2--19
error injector, generating, 3--230
generating with the error injector, 3--230
jitter adder, 3--191
multiplexer, 3--3

Transport stream ID, managing events in a transport
stream, 3--139

TS. See Transport Stream
TSDT

multiplexer
adding, 3--35
icon, 3--11

table editors, parameters, 3--152
Tutorials

error injector, 3--227
multiplexer

complex DVB, 2--39
complex MPEG-2, 2--21
simple, 2--7

real-time multiplexer, 3--240
TVCT

definition, Glossary--5
real-time multiplexer, 3--270
table editors, parameters, 3--160

Tx identifier, MIP functions, 3--60
Types of table analyses, 3--130

U
URL

for ISO, ETSI, and ATSC, 3--125
Tektronix, xvii

user descriptor, 3--184
user name and password, NT log on, 1--15
Using the DVB Channel Coder/Decoder, 3--199
Using the DVB, PSIP, and ARIB Table Editors, 3--93
Using the Error Injector, 3--225
Using the error message window, 3--128
Using the Jitter Adder, 3--191
Using the Multiplexer, 3--3
Using the Real-Time Multiplexer, 3--233

V
VCT

definition, Glossary--5
multiplexer, icon, 3--13
real-time multiplexer, 3--270
table editors

managing services, streams, and events, 3--136
parameters, 3--160

virtual channel table, 3--63
Version, software, xii
Video elementary stream

adding to multiplexer configuration file, 2--11
adding to the multiplex, 3--47
initial delay parameter, 3--48
multiplexer, icon, 3--14
selecting, 2--11

Video splice
adding to the configuration file, 3--52
multiplexer icon, 3--14

Video Stream Analyzer, description, 1--8
video stream descriptor, 3--168
video window descriptor, 3--169
View menu

multiplexer, 3--7
real-time multiplexer, 3--249

Views
OpenMux Spy, 3--252
real-time multiplexer

hierarchic, 3--256
multiplex allocation, 3--258

Viterbi
coding, 1--3, 3--213

file type expected, 3--206
decoding, 3--205
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W
Warning

delete SI tables, 3--30
messages

interpreting error messages, 3--130
using the message window, 3--128

multiplex overflow options, 3--57
SI tables present (multiplexer), 3--22
SI tables suppressed, 3--29
TDT not present, 3--27

Web site address, Tektronix, xvii

Window menu, real-time multiplexer, 3--250
Windows, real-time multiplexer, 3--246
Windows NT

initialization, 1--15
security dialog box, A--1

Wizard, using, 3--112

Y
Yellow, multiplex rate gauge, 3--9
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